
frniir.'II
~
US Army Corps
of Engineers
Hydrologic Engineering Center

HEC-RAS
River Analysis System

User's Manual

Version 3.1
November 2002

Approved for Public Release. Distribution Unlimited CPD-68



US Army Corps
of Engineers
Hydrologic Engineering Center

HEC-RAS
River Analysis System

User's Manual

Version 3.1
November 2002

Approved for Public Release. Distribution Unlimited CPO·58



REPORT DOCUMENTATION PAGE Form Appl"oved
OM8 No. 0704·0J88

Public ..epalting burden for lhis collection of mfOml.3l;on is eSllmJled tu al"crage I 111,10 .. pel response, Including the lime for rel'iewing inSlnLCtionJ, $earchmg eXIsting d/lIJ SOUfUS.
gathering and maintaining the d31e needed. and completing ilnd re\"lew;ng the colle.:llOn of ll1fUmlluion. Send cummelllS regarding Ihis burden eSlimalC or any Olher lI5pccl of Ihl$
cOllecllC»1 of information. mduding ID~ge5tions for reducing this burden. 10 WaslimSlO1l H..adquanc~ Ser...ices, Directorate for InfonUllllon Openuions and Repo.ts, 1115 Jdferson
Oal'is HI2hw.". Suite 1204, Arlimrton. VA 11202-4302. and to the Omce of Manill!cmcnl and ~ud'-el. Paoerwork Reduction Proecl (07~'()1881.WarJlInI[10n. DC 10503.

I. AGENCY USE ONLY (Lr",..,Ma"t) 2. REPORT DATE 3. REPORT TYPE AND DATES COVEREn
November 2002 Computer Program Documentation

4. TITLE AND SUBTITLE s. FUNDING NUMBERS

HEC-RAS, River Analysis System User's Manual

6. A TIIOR(S)

Gary W. Brunner

7. PERFORMING ORGANIZATION NAM£(S) AND ADDRESS(ES) 8. PERFORMING
US ARMY CORPS OF ENGINEERS ORGANIZATION REPORT

HYDROLOGIC ENGINEERING CENTER (HEC) NUMBER

609 Second Street
CPD-68

Davis, CA 95616-4687
9. SPONSORING J iHONITORlNG AGENCY NAJ\'IE(S) AND ADDRESS(ES) 10. SPONSORING I

MONITORING AGENCY
REPORT NUMBER

II. SUPPLEMENTARY NOTES

12a. DISTRIBUTION I AVAILABILITY STATEM£NT I2b. DISTRIBUTION CODE
Distribution is unlimited.

13. ABSTRACT (MaXimum 100 lmrds)

The U.S. Anny Corps of Engineers' River Analysis System (HEC-RAS) is sofhvare that allows you to perfOnl1 one-
dimensional steady and unsteady flow river hydraulics calculations.

HEC-RAS is an integrated system of software, designed for interactive use in a multi-tasking, multi-user network
environmenl. The system is comprised of a graphical user interface (GUI), separate hydraulic analysis components,
data storage and management capabilities, graphics and reporting facilities.

The HEC-RAS system will ultimately contain Ihree one-dimensional hydraulic analysis components for: (I) steady
flow water surface profile computations; (2) unsteady flow simulation; and (3) movable boundary sediment transport
computations. A key element is that all three components will use a common geometric data representation and
common geometric and hydraulic compulation routines. In addition to the three hydraulic analysis components, the
system contains several hydraulic design features that can be invoked once the basi9"water surfacc;profiles are
computed. ." ""

The current version ofHEC-RAS supports Steady and Unsteady flow water surface profile calculations. New
features and additional capabilities will be added in future releases. -

14. SUBJECT TERMS 15. NUMBER OF

water surface profiles, river hydraulics, steady and unsteady flow, computer program PAGES
420
16. PRICE CODE

11. SECURITY CLASSIFICATION 18. SECURJTY CL,\SSIFICATION 19. SECURITY CLASSIFICATION 2U. LIMITATION
OF REPORT OFTHIS PAGE OF ABSTRACT OF ABSTRACT

UNCLASSIFIED UNCLASSIFIED UNCLASSIFIED UNLIMITED

)



)

HEC-RAS

River Analysis System

User's Manual

Version 3.1

November 2002

US Army Corps of Engineers
Institute For Water Resources
Hydrologic Engineering Center
609 Second Street
Davis, CA 95616

(530) 756-1104
(530) 756-8250 FAX
www.hec.usace.army.mil



River Analysis System, HEC-RAS
Software Distribution and Availability Statement

The HEC-RAS executable code and documentation are public domain software that were developed by
the Hydrologic Engineering Center for the U.S. Army Corps of Engineers. The software was developed
at the expense of the United States Federal Government, and is therefore in the public domain. This
software can be downloaded for free from our internet site (www.hec.usace.army.mil). HEC cannot
provide technical support for this software to non-Corps users. See our software vendor list (on our web
page) to locate organizations that provide the program, documentation, and support services for a fee.
However, we will respond to all documented instances of program errors. Documented errors are bugs
in the software due to progranuning mistakes not model problems due to user-entered data.

Cover sketch adapted from:

Flood Plain Management Program, Handbook for Public Officials
Department of Water Resources
State of California
August 1986



)



TahIr a(Coufenly

HEC-RAS User's Manual
Table of Contents

Foreword viii

Chapter 1 Introduction 1-1
General Philosophy of the Modeling System 1-2
Overview of Program Capabilities 1-2

User Interface 1-2
Hydraulic Analysis Components 1-3
Data Storage and Management. 1-4
Graphics and Reporting 1-4

HEC-RAS Documentation 1-5
Overview of This Manual 1-5

Chapter 2 Installing HEC-RAS 2-1
Hardware and Software Requirements 2-2
Installation Procedure 2-2
Uninstall Procedure 2-3

Chapter 3 Working With HEC-RAS - An Overview 3-1
Starting HEC-RAS 3-2
Steps in Developing a Hydraulic Model With HEC-RAS 3-6

Starting a New Project.. 3-6
Entering Geometric Data 3-7
Entering Flow Data and Boundary Conditions 3-9
Performing The Hydraulic Computations 3-10
Viewing and Printing Results 3-12

Importing HEC-2 Data 3-16
What You Should Know First 3-16
Steps For Importing HEC-2 Data 3-19

Reproducing HEC-2 Results .. 3-20
Getting and Using Help 3-22

Chapter 4 Example Application 4-1
Starting a New Project 4-2
Entering Geometric Data 4-3

Drawing the Schematic of the River System 4-3
Entering Cross Section Data 4-4
Entering Junction Data 4-9
Saving the Geometry Data 4-1 0

Entering Steady Flow Data 4-1 0
Performing the Hydraulic Calculations 4-13
Viewing Results 4-14
Printing Graphics and Tables 4-20

Sending Graphics Directly to the Printer 4-20
Sending Graphics to the Windows Clipboard ... 4-20
Sending Tables Directly to the Printer. . 4-21
Sending Tables to the Windows Clipboard .4-21

'"



TaNe a/Colltent£

iv

Exiting the Program 4-22

Chapter 5 Working With Projects 5-1
Understanding Projects 5-1
Elements of a Project. 5-2

Plan Files 5-2
Run Files 5-2
Output Files 5-3
Geometry Files 5-3
Steady Flow Data Files 5-3
Unsteady Flow Data Files 5-3
Sediment Data Files 5-4
Hydraulic Design Data Files 5-4

Creating, Opening, Saving, Renaming, and Deleting Projects 5-6
Project Options 5-6

Chapter 6 Entering and Editing Geometric Data 6-1
Developing the River System Schematic 6-2

Building the Schematic 6-2
Adding Tributaries into an Existing Reach 6-4
Editing the Schematic 6-4
Interacting With the Schematic 6-7
Background Pictures 6-9

Cross Section Data 6-10
Entering Cross Section Data 6-10
Editing Cross Section Data 6-12
Cross Section Options 6-13
Plotting Cross Section Data 6-21

Stream Junctions 6-21
Entering Junction Data 6-21
Selecting a Modeling Approach 6-22

Bridges and Culverts 6-23
Cross Section Locations 6-24
Contraction and Expansion Losses 6-26
Bridge Hydraulic Computations 6-26
Entering and Editing Bridge Data 6-28
Bridge Design Editor 6-42
Culvert Hydraulic Computations 6-44
Entering and Editing Culvert Data 6-45
Bridge and Culvert Options 6-50
Bridge and Culvert View Features 6-52

Multiple Bridge and/or Culvert Openings 6-53
Entering Multiple Opening Data 6-54
Defining The Openings 6-57
Multiple Opening Calculations 6-58

Inline Structures (Weirs and Gated Spillways) 6-59
Entering and Editing Iniine Structure Data 6-59

Lateral Structures (Weirs, Gated Spillways, Culverts, and
Diversion Rating Curves) 6-67
Entering and Editing Lateral Structure Data 6-67



)

Tahle Q/eantenty

Linear Routing Option 6-77
Storage Areas 6-79
Storage Area Connections .. 6-81
Pump Stations 6-85
Cross Section Interpolation 6-89
River Ice 6-95

Entering and Editing Ice Data 6-95
Entering Ice Data at a Cross Section 6-95
Entering Ice Data Through a Table 6-98
Entering Ice Data at Bridges 6-99
Setting Tolerances for the Ice Jam Calculations 6-1 00

Viewing and Editing Data Through Tables 6-101
Manning's n or k values 6-1 01
Reach Lengths 6-103
Contraction and Expansion Coefficients 6-1 03
Bank Stations 6-1 04
Levees 6-1 04
Ice Cover 6-104
River Stationing 6-105
Node Names 6-1 05
Node Descriptions 6-106
Picture File Associations 6-106
Bridge Width Table 6-106
Weir and Gate Coefficient Table 6-1 07

Importing Geometric Data 6-107
GIS Format 6-108
USACE Survey Data Format... 6-1 08
HEC-2 Data Format........ 6-1 08
HEC-RAS Data Format 6-108
UNET Geometric Data Format 6-1 09
MIKE 11 Cross Section Data 6-1 09

Geometric Data Tools 6-109
Graphical Cross Section Editor 6-1 09
Reverse Stationing Data.. .. 6-111
Set Ineffective Areas to Permanent Mode 6-111
Cross Section Points Filter 6-112
Fixed Sediment Elevations 6-114
Pilot Channels 6-115
GIS Cut Line Check.......... .. .. 6-117
View Reach Connectivity 6-118
Datum Adjustment 6-118
Fix Overlapping Ineffective Areas 6-118
GIS Coordinates 6-118
Plot GIS Bounds 6-119

Attaching and Viewing Pictures 6-119
Saving the Geometric Data......... .. 6-121

Chapter 7 Performing a Steady Flow Analysis 7-1
Entering and Editing Steady Flow Data .7-1

Steady Flow Data............. .. 7-1

v



Table a(Content"

VI

Boundary Conditions 7-2
Steady Flow Data Options 7-4

Saving the Steady Flow Data 7-7
Importing Data from the HEC Data Storage System (HEC-DSS) 7-7
Performing Steady Flow Calculations 7-10

Defining a Plan .. 7-11
Saving the Plan Information 7-11
Simulation Options 7-11
Starting the Computations 7-17

Chapter 8 Performing an Unsteady Flow Analysis 8-1
Entering and Editing Unsteady Flow Data 8-1

Unsteady Flow Data 8-1
Boundary Conditions 8-2
Initial Conditions 8-9
Unsteady Flow Data Options 8-11
Saving The Unsteady Flow Data 8-12

Performing Unsteady Flow Calculations 8-13
Defining A Plan 8-13
Selecting Programs to Run 8-14
Simulation Time Window 8-18
Computation Settings 8-19
Simulation Options 8-20
Saving The Plan Information 8-31
Starting The Computations 8-32

Calibration of Unsteady Flow Models 8-33
Observed Hydrologic Data 8-33
River and Floodplain Geometry 8-35
Roughness Coefficients 8-36
River and Floodplain Storage 8-41
Hydraulic Structure Coefficients 8-43
Steps To Follow In The Calibration Process 8-44
General Trends When Adjusting Model Parameters 8-44
Calibration Suggestions and Warning's 8-46

Model Accuracy, Stability, and Sensitivity 8-47
Model Accuracy.......... 8-47
Model Stability 8-47
Model Sensitivity 8-60

Chapter 9 Viewing Results....................... .. 9-1
Cross Sections, Profiles. and Rating Curves 9-1

Viewing Graphics on the Screen 9-1
Graphical Plot Options 9-4
Plotting Velocity Distribution Output.. 9-6
Plotting Other Variables in Profile .. 9-8
Plotting One Variable Versus Another .. 9-8
Sending Graphics to the Printer or Plotter .. .. 9-9
Sending Graphics to the Windows Clipboard......... .. 9-10

Stage and Flow Hydrographs............ 9-10
x-Y-Z Perspective Plots..... 9-11



Table orCOn/ents

Tabular Output. . 9-13
Detailed Output Tables 9-13
Detailed Output Table Options , 9-17
Profile Summary Tables .................................•..................... 9-17
User Defined Output Tables 9-20
Sending Tables to the Printer 9-21
Sending Tables to the Windows Clipboard 9-22

Viewing Results From the River System Schematic 9-22
Viewing Ice Information 9-24

Viewing Graphical Ice Information on the Screen 9-24
Viewing Tabular Ice Information 9-26

Viewing Data Contained in an HEC-DSS File 9-26
Exporting Results To HEC-DSS 9-30

Chapter 10 Performing a Floodway Encroachment Analysis 10-1
General 10-2
Entering Floodplain Encroachment Data 10-3
Performing the Floodplain Encroachment Analysis 10-6
Viewing the Floodplain Encroachment Results 10-7
Floodway Encroachments With Unsteady Flow 10-11

Chapter 11 Troubleshooting With HEC-RAS 11-1
Built in Data Checking 11-1

Checking The Data as it is Entered 11-1
Checking Data Before Computations are Performed 11-2

Errors, Warnings, and Notes 11-3
Log Output 11-6

Steady Flow Log Output... 11-6
Unsteady Flow Log Output... 11-7
Viewing The Log File 11-7

Reviewing and Debugging the Normal Output 11-8
Viewing Graphics 11-8
Viewing Tabular Output... 11-8
The Occurrence of Critical Depth 11-8

Computational Program Does Not Run To Completion 11-9

Chapter 12 Computing Scour at Bridges 12-1
General Modeling Guidelines 12-2
Entering Bridge Scour Data 12-3

Entering Contraction Scour Data 12-4
Entering Pier Scour Data 12-6
Entering Abutment Scour Data 12-10

Computing Total Bridge Scour 12-13

Chapter 13 Performing Channel Modifications 13-1
General Modeling Guidelines 13-2
Entering Channel Modification Data 13-2
Performing the Channel Modifications 13-6
Comparing Existing and Modified Conditions 13-8

VI!



Table o/Conten1£

Vll]

Chapter 14 Using GIS Data With HEC·RAS 14-1
General Modeling Guidelines 14-2
Importing GIS/CADD Data Into HEC·RAS 14-4
Completing The Data and Performing The Computations 14-7

Completing The Geometric Data 14-7
Entering Additional Cross Section Data 14-7
Performing The Computations and Viewing Results 14-9

Exporting Computed Results to The GIS or CADD 14-10

Chapter 15 Stable Channel Design Functions 15-1
General Modeling Guidelines 15-2

General Command Bultons 15-2
Uniform Flow Computations 15-2

Solving For Slope, Discharge, and W/S Elevation 15-2
Solving For Boltom Width 15-4
Applying Uniform Flow Data To The Geometry File 15-7
Saving Uniform Flow Data 15-7

Stable Channel Design 15-8
Copeland Method 15-8
Regime Method , 15-12
Tractive Force Method 15-13

Sediment Transport Capacity 15-15

Chapter 16 Advanced Features For Unsteady Flow Routing 16-1
Mixed Flow Regime 16-2
Dam Break Analysis 16-6

Entering Dam Break Data 16-7
Estimating Dam Break Parameters 16-11
HEC-RAS Output For Dam Break Analyses 16-12

Levee Overtopping and Breaching 16-14
Model.ing Pump Stations 16-21
Navigation Dams 16-25

Pool Only Control 16-26
Hinge Point Only Contro!. 16-28
Hinge Point and Minimum Pool Operations 16-31
Hinge Point and Minimum and Maximum Pool ControL 16-34

Appendix A References A-1

Appendix B HEC-RAS Import/Export Files For Geospatial Data B-1

Appendix C List of HEC-RAS Output Variables C-1





Chapter 1 Introduction

CHAPTER 1

Introduction

Welcome to the U.S. Anny Corps of Engineers River Analysis System (HEC­
RAS) developed by the Hydrologic Engineering Center. This software allows
you to perform one-dimensional steady flow, unsteady flow calculations.
Sediment transport computations will be added in a future version.

The HEC-RAS modeling system was developed as a part of the Hydrologic
Engineering Center's "Next Generation" (NexGen) of hydrologic engineering
software. The NexGen project encompasses several aspects of hydrologic
engineering, including: rainfall-runoff analysis; river hydraulics; reservoir
system simulation; flood damage analysis; and real-time river forecasting for
reservoir operations.

This chapter discusses the general philosophy of HEC-RAS and gives a brief
overview of the capabilities of the modeling system. Documentation for
HEC-RAS is discussed, as well as an overview of this manuaL

Contents

• General Philosophy of the Modeling System

• Overview of Program Capabilities

• HEC-RAS Documentation

• Overview of This Manual
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General Philosophy of the Modeling System

HEC-RAS is an integrated system of software, designed for interactive use in
a multi-tasking environment. The system is comprised of a graphical user
interface (GUI), separate hydraulic analysis components, data storage and
management capabilities, graphics and reporting facilities.

The HEC-RAS system will ultimately contain three one-dimensional
hydraulic analysis components for: (I) steady flow water surface profile
computations; (2) unsteady flow simulation; and (3) movable boundary
sediment transport computations. A key element is that all three components
will use a common geometric data representation and common geometric and
hydraulic computation routines. In addition to the three hydraulic analysis
components, the system contains several hydraulic design features that can be
invoked once the basic water surface profiles are computed.

The current version of HEC-RAS supports Steady and Unsteady flow water
surface profile calculations. New features and additional capabilities will be
added in future releases.

Overview of Program Capabilities

HEC-RAS is designed to perform one-dimensional hydraulic calculations for
a full network of natural and constructed channels. The following is a
description of the major capabilities ofHEC-RAS.

User Interface

The user interacts with HEC-RAS through a graphical user interface (GUI).
The main focus in the design of the interface was to make it easy to use the
software, while still maintaining a high level of efficiency for the user. The
interface provides for the following functions:

1-2
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•
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File management

Data entry and editing

Hydraulic analyses

Tabulation and graphical displays of input and output data

Reporting facilities

On-line help



Chapter 1 Introduction

Hydraulic Analysis Components

Steadv Flaw Water Surface Profiles. This component of the modeling system
is intended for calculating water surface profiles for steady gradually varied
flow. The system can handle a full network of chanoels, a dendritic system,
or a single river reach. The steady flow component is capable of modeling
subcritical, supercritical, and mixed flow regime water surface profiles.

The basic computational procedure is based on the solution of the one­
dimensional energy equation. Energy losses are evaluated by friction
(Manning's equation) and contraction/expansion (coefficient multiplied by the
change in velocity head). The momentum equation is utilized in situations
where the water surface profile is rapidly varied. These situations include
mixed flow regime calculations (i.e., hydraulic jumps), hydraulics of bridges,
and evaluating profiles at river confluences (stream junctions).

The effects of various obstructions such as bridges, culverts, weirs, and
structures in the flood plain may be considered in the computations. The
steady flow system is designed for application in flood plain management and
flood insurance studies to evaluate floodway encroachments. Also,
capabilities are available for assessing the change in water surface profiles
due to channel improvements, and levees.

Special features of the steady flow component include: multiple plan
analyses; multiple profile computations; multiple bridge and/or culvert
opening analysis; and split flow optimization.

Unsteadv Flow Simulation. This component of the HEC-RAS modeling
system is capable of simulating one-dimensional unsteady flow through a full
network of open channels. The unsteady flow equation solver was adapted
from Dr. Robert L. Barkau's UNET model (Barkau, 1992 and HEC, 1997).
This unsteady flow component was developed primarily for subcritical flow
regime calculations. However, with the release of Version 3.1, the model can
now performed mixed flow regime (subcritical, supercritica!, hydraulic
jumps, and draw downs) calculations in the unsteady flow computations
module.

The hydraulic calculations for cross-sections, bridges, culverts, and other
hydraulic structures that were developed for the steady flow component were
incorporated into the unsteady flow module.

Sediment Transport/Movable Boundary Computalions. This component of
the modeling system is intended for the simulation of one-dimensional
sediment transport/movable boundary calculations resulting from scour and
deposition over moderate time periods (typically years, although applications
to single flood events are possible).

The sediment transport potential is computed by grain size fraction, thereby
allowing the simulation of hydraulic sorting and armoring. Major features
will include the ability to model a full network of streams, channel dredging,

1-3



Chapter 1 Introductioo

1-4

various levee and encroachment alternatives, and the use of several different
equations for the computation of sediment transport.

The model will be designed to simulate long-term trends of scour and
deposition in a stream channel that might result from modifying the frequency
and duration of the water discharge and stage, or modifying the channel
geometry. This system can be used to evaluate deposition in reservoirs,
design channel contractions required to maintain navigation depths, predict
the influence of dredging on the rate of deposition, estimate maximum
possible scour during large flood events, and evaluate sedimentation in fixed
channels.

Data Storage and Management

Data storage is accomplished through the use of "flat" files (ASCII and
binary), as well as the HEC-DSS. User input data are stored in flat files under
separate categories of project, plan, geometry, steady flow, unsteady flow,
and sediment data. Output data is predominantly stored in separate binary
files. Data can be transferred between HEC-RAS and other programs by
utilizing the HEC-DSS.

Data management is accomplished through the user interface. The modeler is
requested to enter a single filename for the project being developed. Once the
project filename is entered, all other files are automatically created and
named by the interface as needed. The interface provides for renaming,
moving, and deletion of files on a project-by-project basis.

Graphics and Reporting

Graphics include X-Y plots of the river system schematic, cross-sections,
profiles, rating curves, hydrographs, and many other hydraulic variables. A
three-dimensional plot of multiple cross-sections is also provided. Tabular
output is available. Users can select from pre-defined tables or develop their
own customized tables. All graphical and tabular output can be displayed on
the screen, sent directly to a printer (or plotter), or passed through the
Windows Clipboard to other software, such as a word-processor or
spreadsheet.

Reporting facilities allow for printed output of input data as well as output
data. Reports can be customized as to the amount and type of infonnation
desired.
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HEC·RAS Documentation

The HEC-RAS package includes several documents. Each document is
designed to help the modeler learn to use a particular aspect of the modeling
system. The documentation has been broken up into the following three
categories:

Documentation Description

User's Manual This manual is a guide to using HEC-RAS.
The manual provides an introduction and
overview of the modeling system, installation
instructions, how to get started, a simple
example, detailed descriptions of each of the
major modeling components, and how to view
graphical and tabular output.

Hydraulic Reference Manual This manual describes the theory and data
requirements for the hydraulic calculations
performed by HEC-RAS. Equations are
presented along with the assumptions used in
their derivation. Discussions are provided on
how to estimate model parameters, as well as
guidelines on various modeling approaches.

Applications Guide This document contains a series of examples
that demonstrate various aspects of HEC­
RAS. Each example consists of a problem
statement, data requirements, general outline
of solution steps, displays of key input and
output screens, and discussions of important
modeling aspects.

Overview of This Manual

This user's manual is the primary piece of documentation on how to use the
HEC-RAS system. The manual is organized as follows:

•

•

Chapters 1-2 provide an introduction and overview of HEC-RAS, as well
as instructions on how to install the software.

Chapters 3-5 describe how to use the HEC-RAS software in a step-by­
step procedure, including a sample problem that the user can follow along
with. Understanding how this system works with projects is also
discussed.

1-5
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•

•

•

•

•

•

•

•

•

•

•

•

Chapters 6-8 explain in detail how to enter and edit data, and how to
perform the different types of analyses that are available.

Chapter 9 provides detailed discussions on how to view graphical and
tabular output, as well as how to develop user-defined tables.

Chapter 10 describes how to perform a flood way encroachment analysis.

Chapter II provides discussions on "Trouble Shooting" and
understanding the most common Errors, Warnings, and otes.

Chapter 12 describes how to perform bridge scour computations from
within HEC-RAS.

Chapter 13 describes how to perform channel modifications within HEC­
RAS.

Chapter 14 explains how to utilize GIS/CADD data in HEC-RAS, as well
as how to export HEC-RAS results back to the GIS/CADD system.

Chapter 15 describes how to use the Hydraulic Design Functions in HEC­
RAS for performing stable channel deign and analysis, as well as
sediment transport potential calculations, and rip rap sizing.

Chapter 16 contains topics on advanced uses of the unsteady flow
simulation capabilities, including: mixed flow regime for unsteady flow;
dam break analysis; levee overtopping and breaching; modeling pump
stations; and navigation dams.

Appendix A contains a list of references.

Appendix 8 contains a detailed description of the file formats used for
importing and exporting GIS data to and from HEC-RAS.

Appendix C contains a description of all the output variables available
from the HEC-RAS program.
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CHAPTER 2

Installing HEC-RAS

You install HEC-RAS using the program SETUP.EXE. The Setup program
installs the software, sample applications, and the Help system.

This chapter discusses the hardware and system requirements needed to use
HEC-RAS, how to install the software, and how to uninstall the software.

Contents

• Hardware and Software Requirements

• Installation Procedure

• Uninstall Procedure

Important

You cannot simply copy files from the distribution CD to your hard disk and
run HEC-RAS. You must use the Setup program, which decompresses and
installs the files to the appropriate directories.

2-1
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Hardware and Software Requirements

Before you install the HEC-RAS software, make sure that your computer has
at least the minimum required hardware and software. In order to get the
maximum performance from the HEC-RAS software, recommended
hardware and software is shown in parentheses. This version of HEC-RAS
will run on a microcomputer that has the following:

•

•

•

•

•

•

•

Intel Based PC or compatible machine with Pentium processor or higher
(a Pentium III or higher is recommended).

A hard disk with at least 40 megabytes offree space (l00 megabytes or
more is recommended).

A CD Rom drive (or CD-R, CD-RW, DVD).

A minimum of32 megabytes of RAM if using Windows 95, 98, ME or
64 megabytes ifusing Windows NT, 2000 or XP (128 or more is
recommended).

A mouse.

Color Video Display (Recommend running in Super VGA (1024x768) or
higher, and as large a monitor as possible).

MS Windows 95, 98, ME, NT 4.0, 2000, or XP (or later versions).

Installation Procedure

Installation of the HEC-RAS software is accomplished through the use of the
Setup program.

< To install the software onto your hard disk do the fOllowing:

I. Insert the HEC-RAS CD into your CD drive.

2. The setup program should run automatically.

3. If the setup program does not run, use the windows explorer to start
the setup.exe program on the CD.

4. Follow the setup instructions on the screen.

The setup program automatically creates a program group called HEC. This
program group will be listed under the Programs menu, which is under the
Start menu. The HEC-RAS program icon will be contained within the HEC
program group. The user can create a shortcut icon by opening Windows
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Explorer and dragging the HEC-RAS executable onto the desktop. The
HEC-RAS executable can be found in the c:\Program Files\hec\ras directory
with the name "RAS.EXE".

Uninstall Procedure

The HEC-RAS Setup program automatically registers the software with the
Windows operating system. To unistall the software, do the following:

•

•

•

•

From the Start Menu select Settings and then Control Panel.

From within the Control Panel folder select Add/Remove Programs.

From the Tab marked as InstalllUninstall select the HEC-RAS
program from the list of installed software, then press the
Add/Remove button.

Follow the uninstall directions on the screen and the software will be
removed from your hard disk. It is up to the user to remove the HEC­
RAS icon from the desktop.

2-3
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CHAPTER 3

Working With HEC-RAS - An Overview

HEC-RAS is an integrated package of hydraulic analysis programs, in which
the user interacts with the system through the use of a Graphical User
Interface (GUI). The system is capable of performing Steady and Unsteady
Flow water surface profile calculations, and will include Sediment Transport
and several hydraulic design computations in the future.

In HEC-RAS terminology, a Project is a set of data files associated with a
particular river system. The modeler can perform any or all of the various
types of analyses, included in the HEC-RAS package, as part of the project.
The data files for a project are categorized as follows: plan data, geometric
data, steady flow data, unsteady flow data, sediment data, and hydraulic
design data.

During the course of a study the modeler may want to formulate several
different Plans. Each plan represents a specific set of geometric data and
flow data. Once the basic data are entered into the HEC-RAS, the modeler
can easily formulate new plans. After simulations are made for the various
plans, the results can be compared simultaneously in both tabular and
graphical form.

This chapter provides an overview of how a study is performed with the
HEC-RAS software. Special topics on how to import HEC-2 data,
reproducing HEC-2 results, and how to use on-line help are also covered.

Contents

• Starting HEC-RAS

• Steps in Developing a Hydraulic Model With HEC-RAS

• Importing HEC-2 Data

• Reproducing HEC-2 Results

• Getting and Using Help
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Chapter 3 Working With HEC-RAS - An Overview

Starting HEC·RAS

When you run the HEC-RAS Setup program, you automatically get a new
program group called HEC and program icon called HEC-RAS. They
should appear in the start menu under the section called Programs. The user
also has the option of creating a shortcut on the desktop. If a shortcut is
created, the icon for HEC-RAS will look like the following:

I~I
HEC-RAS 31

Figure 3.1 The HEC-RAS Icon in Windows

To Start HEC-RAS from Windows:

• Double-click on tbe HEC-RAS Icon. If you do not have an HEC­
RAS shortcut on the desktop, go to the Start menu and select
Programs, then select HEC, and then HEC-RAS.

When you first start HEC-RAS, you will see the main window as shown in
Figure 3.2 (except you will not have any project files listed on your main
window).

Hydrologic E~gi~~~ri~9 Ct~r~r

US Army Corp~ of E~gj~e~l~

IC:IHECIRas30IDalaIBEAVCREK.prj

IC:IHECIRas30IDalaIBEAVCREK.p01

IC:IHECIRas30IDalaIBEAVCREK.rD1

IC:IHECIRas30IDalaIBEAVCREK.g01

Project ISingle Bridge - Example 2

Plan: IPresslWeil Method

Geometl}1: ISeaver (I. + Bridge - PM

Steady Flow: IBeaver CI.. 3 Flows

Unstead}l Flow: I
Project -------------------------- D IUS CU'
Description: ... ustomary nIts

Figure 3.2 The HEC-RAS Main Window
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o Ius Customaw Unils

About HEC-RAS

Help
Contents
Using HEC-RAS Help

Ie: IH ECIRa,30lDalaIB EAVCR EK. prj

tions
Erogram Setup
Default Parameters
Unit System...
Convert Project

~~~;:;;:-:-"-"""'-------IC:IHECIRas30IDal.IBEAVCRE K.pOl

r-:--\;~;;'7----''"''''--'''''---IC:IHECIRa'30\DalaIBEAVCREK.gOl
r-:----;o:---;;-;o;------"<__- Ic: IHECIRas30IDalaIBEAVCREK.101
r-----''I--------'''''::-Ir ------------

Edit
- Geometric Data...

.steady Flow Data...
Unsteady Flow Data...
S?c/iment Data...

DSS Data

Detailed Output Tables
frofile Swmnary Table...
~urrnnary Err, Warn, Notes...

View
- !Joss Sections...

Water Stuface Profiles...
General Profile Plot
Rating Curves
X-Y-Z Perspective Plots...

Stage and Flow Hydrographs
Hydraulic Property Plots

Run
.steady Flow Analysis...
Unsteady Flow Analysis...
Sgdiment Analysis...
Hydraulic Design Functions...

!mPort HEC-2 Data...
Inport HEC-RAS Data...
Generate Report ..
~xport GIS Data .
Export to HEC-DSS...
Restore Data

FIle
- New Project...

Qpen Project...
Save Project
Save ProjectAs...
Rename Project...
Delete Project...
Project Summary

_~t __

d:\hec\ras\data\buffalo.prj
d:\hec\ras\data\exarnple.pIj
d: \hec\ras\data\onebox.pIj

Figure 3.3 HEC-RAS Main Window Menu Bar Structure
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At the top of the HEC-RAS main window is a Menu bar (Figure 3.3) with the
following options:

File: This option is used for file management. Options available under the
File menu include: New Project; Open Project; Save Project; Save Project As;
Rename Project: Delete Project; Project Summary; Import HEC-2 Data;
Import HEC-RAS data; Generate Report; Export GIS Data; Export to HEC­
DSS; Restore Data; and Exit. In addition, the most recently opened projects
will be listed at the botlom of the File menu, which allows the user to quickly
open a project that was recently worked on.

Edit: This option is used for entering and editing data. Data are categorized
into four types: Geometric Data; Steady Flow Data; Unsteady Flow Data;
and Sediment Data. In the current version, Sediment Data is not active.

Run: This option is used to perform the hydraulic calculations. The options
under this menu item include: Steady Flow Analysis; Unsteady Flow
Analysis; Sediment Analysis; and Hydraulic Design Functions. [n the current
version, Sediment Analysis is not available.

View: This option contains a set of tools that provide for graphical and
tabular displays of the model output. The View menu item currently
includes: Cross Sections; Water Surface Profiles; General Profile Plot; Rating
Curves; X-Y-Z Perspective Plots; Stage and Flow Hydrographs; Hydraulic
Properties Plots; Detailed Output Tables; Profile Summary Tables; and
Summary Err, Warn, Notes.

Options: This menu item allows the user to change Program Setup options;
set Default Parameters; establish the Default Units System (U.S. Customary
or Metric); and Convert Project Units (U.S. Customary to Metric, or Metric to
U.S. Customary).

Help: This option allows the user to get on-line help, as well as display the
current version information about HEC-RAS.

Also on the HEC-RAS main window is a Button bar (Figure 3.4). The Button
bar provides quick access to the most frequently used options under the HEC­
RAS menu bar. A description of each button is shown in Figure 3.4.
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Sum Errs, Warn, Notes:
Summary of Errors,
Warnings, and Notes

Detailed Output Table:
View detailed output at cross­
sections, bridges, culverts, etc ..

Stage and Flow Hydrographs:
Plot stage and flow hydrographs

XYZ Perspective Plot:
View 3D multiple cross
section plot

Hydraulic Properties:
Plots and tables of
hydraulic properties

Profile Summary Table:
View summary output at
multiple locations by profile

View DSS: View
Data stored in DSS

General Profile Plot:
View computed
variables along the
channel

Cross Sections:
View cross
section plots

Unsteady Flow Analysis:
Perform an unsteady flow
simulation

Rating Curve:
View computed
rating curves

Profile Plot:
View water surface
profile plots

Hydraulic Design Functions:
Perform hydraulic design
computations

Unsteady Flow Data:
Edit and/or enter
unsteady flow data

Geometric Data:
Edit andlor enter
geometric Data

PlOiec

Plan:

Geom lrv:

Slead Flow:

Unsle Flow;

6f~~ri lion: ri---I---+-----t--+--------\--'c---:\__ 0 IUS Cuslomarv Units

Save Project:
Save an existing
project

Steady Flow Data:
Edit andlor enter
steady flow data

Steady Flow Analysis:
Perform a steady flow
simulation

Figure 3.4 HEC-RAS Main Window Button Bar
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Steps in Developing a Hydraulic Model with HEC·RAS

There are five main steps in creating a hydraulic model with HEC-RAS:

• Starting a new project

• Entering geometric data

• Entering flow data and boundary conditions

• Performing the hydraulic calculations

• Viewing and printing results

Starting a New Project

The first step in developing a hydraulic model with HEC-RAS is to establish
which directory you wish to work in and to enter a title for the new project.
To start a new project, go to the File menu on the main HEC-RAS window
and select New Project. This will bring up a New Project window as shown
in figure 3.5.

New Project '",,,-

CiI' DemoFlles

Directofies
--',-'------
File Name

Jpri

dendritpfj
K1B1Cl.PRJ
MULT~PE.PRJ

NORMJI.LBT.PRJ
THREE.pri

Dendritic data set
Ml..llliple Opening Data Set
Twin Circulal Pipe Data Sel
Single Bridge Oala Set
Thlee Reo3Ch -W~h Hydlaulic StIuctures

Title

OK Cancel Help Create DiJectory 1--' c:

ISet dfive and path, then enter a new pfoject title and file name.

Figure 3.5 New Project Window

As shown in figure 3.5, you first select the drive and path that they want to
work in (to actually select a path you must double click the directory you
want in the directory box), next enter a project title and file name. The
project filename must have the extension "-prj", the user is not allowed to
change this. Once you have entered all the information, press the "OK"
button to have the information accepted. After the OK button is pressed, a
message box will appear with the title of the project and the directory that the
project is going to be placed in. l.f this information is correct, press the OK
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button. If the information is not correct, press the Cancel button and you will
be placed back into the New Project window.

Note: Before any Geometric data and Flow data are entered, the user
should select the Units System (English or Metric) that they would like to
work in. This step is accomplished by selecting Unit System from the
Options menu of the main HEC-RAS window.

Entering Geometric Data

The next step is to enter the necessary geometric data, which consist of
connectivity information for the stream system (River System Schematic),
cross-section data, and hydraulic structure data (bridges, culverts, weirs, etc.).
Geometric data are entered by selecting Geometric Data from the Edit menu
on the main HEC-RAS window. Once this option is selected, the geometric
data window will appear as show in Figure 3.6 (except yours will be blank
when you first bring this screen up for a new project).

.. ;

J

File Edit View Tables Tools Help

:~
-

Tc.ols Rlvec JSto"'~ LS\..! pump,l r, RS [.IllEditors
Re<lch Are<l Conn. station
-> _ ~ CT' o(TI]ID

Junct. I ~\O.2• ,
-,/(10

Cross /
~ ~~ ) Triblrtary

Brdg/Culv

:;;;'1 ::.\ Upper Reach /01
Infine ~I 9\,

(oJ....

Struoture '\\"9.9 /.,~~

'tIiIiiIJ. r."Lateral . ~~-Structure

IiIIiiIiI "--

'\i;'~(rStorage
A", /,- Sutter \

St<lrage \Are<l Conn,

IPiI' ......'\
~~"_> ." 9.7

Pump '/A" Lower ReachStation
CT' .~~------

i<-__...........\ .... 9.6

HT,b '\Paramo

View
'~"'\

Picture ~~- 9.5
CO)

--I ---I

)

1.0:2:28. 0 5863
._- -----------_._-

Figure 3.6 Geometric Data Window
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The modeler develops the geometric data by first drawing in the river system
schematic. This is accomplished, on a reach-by-reach basis, by pressing the
River Reach button and then drawing in a reach from upstream to
downstream (in the positive flow direction). After the reach is drawn, the
user is prompted to enter a "River" and a "Reach" identifier. The River and
reach identifiers can be up to 16 characters in length. As reaches are
connected together, junctions are automatically formed by the interface. The
modeler is also prompted to enter an identifier for each junction. For more
information on developing the river system schematic, see Chapter 6
"Entering and Editing Geometric Data"

After the river system schematic is drawn, the modeler can start entering
cross-section and hydraulic structure data. Pressing the Cross Section button
causes the cross section editor to pop up. This editor is shown in Figure 3.7.
As shown, each cross section has a River name, Reach name, River Station,
and a Description. The River, Reach and River Station identifiers are used
to describe where the cross section is located in the river system. The "River
Station" identifier does not have to be the actual river station (miles or
kilometers) at which the cross section is located on the stream, but it does
have to be a numeric value (e.g., 1.1,2,3.5, etc.). The numeric value is used
to place cross sections in the appropriate order within a reach. Cross
sections are ordered within a reach from the highest river station
upstream to the lowest river station downstream.

(ross Section Data - Base Geometry

1 ROB
10.05

103

I Expansion

12t48
I Right Bank

10035

I Channel
Manrun 's nValues

Cont\£. Coelhcrenls

Mao> Channel Bank 5tallons

1 LOB

1 Lelt Bank

1006

1,74.8

I Contract""
~ 101

77.1
69.1
70.1
78.1
80.1
901

Cross Section X·Y Coordinates

Et:it ~dit Qptlons elot t:!.elp

Rive!: IFall River 3 1""'1 + COli
Reach: IUpper Reach 3 River 51a. i"19==.8==='=3 [!I.!J
Description IRiver Mile 9.8 of Fall River 0

Del Row I Ins Row I
i"1=::L;;'D8"""'''',i'''';;C"''ha'''n'''nel';=Ii''::::;:R;;'0B:;:=

;="F''''''''5t'''at''''ion='''i''"7.'=:==r='i. 10 10 10

1 110
2 117.2
3 174.8
4 1848
5 2048
6 214.8
7 294
8 301.2
9

10

Enter to move to ne>:t downstream liver -s:tation location

Figure 3.7 Cross Section Data editor
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The basic data required for each cross section are shown on the Cross Section
Data editor in Figure 3.7. Additional cross section features are available
under Options from the menu bar. These options include: adding, copying,
renaming and deleting cross sections; adjusting cross section elevations,
stations, and n or k-values; skew cross section; ineffective flow areas; levees;
blocked obstructions; adding a lid to a cross section; add ice cover; add a
rating curve; horizontal variation of nor k-values; and vertical variation of n
values.

Also, available from the Cross Section Data editor is the ability to plot any
cross section or reach profile. Edit features are available to cut, copy, paste,
insert, and delete data from the Cross Section X-Y Coordinates grid.

Once the cross-section data are entered, the modeler can then add any
hydraulic structures such as bridges, culverts, weirs and spillways. Data
editors, similar to the cross section data editor, are available for the various
types of hydraulic structures. If there are any stream junctions in the river
system, additional data are required for each junction. The Junction data
editor is available from the Geometric Data window.

Once geometric data are entered, the data should be saved to a file on the hard
disk. This is accomplished by selecting the Save Geometric Data As option
from the File menu on the Geometric Data editor. This option allows the user
to enter a title for the geometric data. A filename is automatically established
for the geometric data, and then saved to the disk. Once a title is established,
geometric data can be saved periodically by selecting Save Geometric Data
from the File menu of the Geometric Data editor.

Entering Flow Data and Boundary Conditions

Once the geometric data are entered, the modeler can then enter either steady
flow or unsteady flow data. The type of flow data entered depends upon the
type of analyses to be performed. For the discussion in this chapter, it is
assumed that a steady flow analysis will be performed. The data entry form
for steady flow data is available under the Edit menu bar option on the HEC­
RAS main window.

An example of the steady flow data entry form is shown in Figure 3.8, which
is the Steady Flow Data Editor. As shown in Figure 3.8, steady flow data
consist of: the number of profiles to be computed; the flow data; and the river
system boundary conditions. At least one flow must be entered for every
reach within the system. Additionally, flow can be changed at any location
within the river system. Flow values must be entered for all profiles.

Boundary conditions are required in order to perform the calculations. If a
suberitica! flow analysis is going to be performed, then only the downstream
boundary conditions are required. Jf a supercritical flow analysis is going to
be performed, then only the upstream boundary conditions are required. If
the modeler is going to perfonn a mixed flow regime calculation, then both
upstream and downstream boundary conditions are required. The Boundary
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Conditions data entry form can be brought up by pressing the Reach
Boundary Conditions button from the Steady Flow Data entry form.

Once all of the steady flow data and boundary conditions are entered, the
modeler should save the data to the hard disk. This can be accomplished by
selecting Save Flow Data As from the File option on the Steady Flow Data
menu bar. Flow data is saved in a separate file. The user is only required to
enter a title for the flow data, the filename is automatically assigned.

Steady Flow Data - larger flows ..1". " •

File Options Help

EnterlEdit Number 01 Prolile' (500 max):~ Reach Boundary Conditions I .. .:..ru ;·'.=tl.~i I
Localions of Flow Dal<l Chan e,

River: IFall River 3
Reach: I-Up-p-e-rR-e-a-ch----3 RiverSta.: 110.4 3 .o.dd A Flow Change Location I

FtowCha Location Profile Names and Flow Rates

River Reach RS 10 VI 125 VI 150 VI 1100"r
1 Fall River Upper Reach 10.4 750 1000 1500 2000
2 Fall River Lowe! Reach 9.79 900 1250 2000 2750
3 Fall River LOINer Reach 9.6 975 1300 2100 3000

-

4 Butte Creek Tributary 0.4 150 250 500 750
, ~. - . :

, .__....2.. . ........ _..... ".'....

IEdit Steady flow data lor the prolile, (c1'1

Figure 3.8 Steady Flow Data window

Performing the Hydraulic Computations

Once all of the geometric data and flow data are entered, the modeler can
begin to perfonn the hydraulic calculations. As stated previously, there are
three types of calculations that can be performed in the current version of
HEC-RAS: Steady Flow Analysis, Unsteady Flow Analysis, and Hydraulic
Design Functions. The modeler can select any of the available hydraulic
analyses from the Run menu bar option on the HEC-RAS main window. An
example of the Simulation Manager window is shown in Figure 3.9, which is
the Steady Flow Analysis window.
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Plan: Existing Conditions RlJn

Chapter 3 Workjng With HEC-RAS - An Overview

ShortlD !E:<i'llng

Geometry File: IBQse Geometr}' 0ata 3
Steady Flow File: 1~'-0.-2-5-.5-0-.-ar-,d-'-O-O-yr-F-Io-w-,-------::J

Plan Description:
f Flow Regirne

I r. Subcritical I I D
Irsupercritical
~ Mi:<ed_J

fnterlocompute watersurface profiles--

Figure 3.9 Steady Flow Analysis window

As shown in Figure 3.9, the modeler puts together a Plan by selecting a
specific set of geometric data and flow data. A Plan can be put together by
selecting New Plan from the File menu bar option of the Steady Flow
Analysis window. Once a Plan Title and Short Identifier (Short ID) have
been entered, the modeler can select a Flow Regime for which the model will
perform calculations. Subcritical, Supercritical, or Mixed flow regime
calculations are available.

Additional features are available under the Options menu for: performing a
Floodway Encroachment Analysis; Setting locations for calculating flow
distribution output; conveyance calculation options; friction slope methods;
calculation tolerances; critical depth output; critical depth computation
method; split flow optimization; data checking; setting log file levels; and
viewing the log file output.

Once the modeler has selected a Plan and set all of the calculation options, the
steady flow calculations can be performed by pressing the Compute button at
the bottom of the Steady Flow Analysis window. When this button is
pressed, the HEC-RAS system packages up all the data for the selected plan
and writes it to a run file. The system then runs the steady flow model
(SNET) and passes it the name of the run file. This process is executed in a
separate window. Therefore, the modeler can work on other tasks while it is
executing.
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Viewing and Printing Results

Once the model has finished all of the computations, the modeler can begin
viewing the results. Several output features are available under the View
option from the main window. These options include: cross section plots;
profile plots; rating curve plots; X- Y-Z perspective plots; hydrograph plot (if
unsteady flow simulation was performed); tabular output at specific locations
(Detailed Output Tables); tabular output for many locations (Profile Summary
Tables); and the summary of errors, warnings, and notes.

An example of a cross section plot is shown in Figure 3.10. The user can plot
any cross section by simply selecting the appropriate River, Reach and River
Station from the list boxes at the top of the pia!. The user can also step
through the plots by using the up and down arrow buttons. Several plotting
features are available under the Options menu of the Cross Section plot.
These options include: zoom in; zoom out; full plot; pan; animate; selecting
which plans, profiles and variables to plot; velocity distribution; viewing
interpolated cross-sections; and control over the lines, symbols, labels,
scaling, and grid options.

Hard copy outputs of the graphics can be accomplished in two different ways.
Graphical plots can be sent directly from HEC-RAS to whichever printer or
plotter the user has defined under the Windows Print Manager. Graphical
plots can also be sent to the Windows clipboard. Once the plot is in the
clipboard it can then be pasted into other programs, such as a word processor.
Both of these options are available from the File menu on the various plot
windows.

An example of a profile plot is shown in Figure 3.11. All of the options
available in the cross section plot are also available in the profile pia!.
Additionally, the user can select which specific reaches to plot when a
multiple-reach river system is being modeled.

An example of an X-Y-Z Perspective Plot is shown in Figure 3.12. The user
has the option of defining the starting and ending location for the extent of the
plot. The plot can be rotated left or right, and up or down, in order to get
different perspectives of the river reach. The computed water surface profiles
can be overlaid on top of the cross section data. The graphic can be sent to
the printer or plotter directly, or the plot can be sent through the Windows
Clipboard to other programs.
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Figure 3.11 Profile Plot

3-13



Chapter 3 Working With HEC-RAS . An Overview
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Figure 3.12 X-Y-Z Perspective Plot of River Reach with a Bridge
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Tabular output is available in two different formats. The first type of tabular
output provides detailed hydraulic results at a specific cross section location
(Detailed Output Table). An example of this type of tabular output is shown
in Figure 3.13.

~ [ross Section Output ::--:~ .

File Type Options Help

River: ICritical Cr.

Reach IUpper Reach

iJ Profile: 1100 yr iJ

iJ Ri'! Sia ''-12---iJ [!)[!J
Plan Modified Geo Crilreal Cr U er Reach RS 12 Profde 100 ,

E.G. Elev 1ft) .. 1?16.Q? Element Lell08 Righi 08
Vel Head Iftl 048 Wt. oVal. 0100 0100
W.S. Elev (ItI 1815.54 Reach Len. 1ft) 100.00 . 100.00
C,it W.S. 1ft) 1814.46 Flow Area (sq ft) 2473.60 177.74
E.G. Slope IllIft) 0004567 Area (sq ft) 2473.60 177.74
QTalai (els) 9000.00 Flow (efs) 5748.43 18342
Top Widlh 1ft) 915.30 Top Width (ft) 69971 17059
Vel Talai (ft/sl 3.01 Avg. Vel. Ift/sl 2.32 1.03
Max Chi Dpth (II) 11.94 Hydr. Deplh Iftl 354 7.61 104
Cony. Talai (els) 133182.4 Conv. (efs) 85065.5 45402.7 2714.3
Lenglh Md. (ftl 100.00 Wetted Per. (ft) 702.56 50.80 170.61
Min ChEllft) 180360 Shear Ilb/sq ft) 100 1.92 0.30
Alpha 341 Sireom Power (Ib/II s) 2.33 1722 0.31

)
Frein Loss 1111 0.54 Cum Volume 10e,e·lI) 216.87 42.90 10.36
C&E Loss (ft) 0.04 Cum SA (acres) 79.60 6.44 792

Errors Warrun sand Notes

r--
IEnergy Qladeline for given WSEL

Figure 3.13 Tabular Detailed Output

The second type of tabular output shows a limited number of hydraulic
variables for several cross sections and multiple profiles (Profile Summary
Tables). An example of this type of tabular output is shown in Figure 3.14.
There are several standard tables that are predefined and provided to the user
under the Tables menu from the profile output tables. Users can also define
their own tables by specifying what variables they would like to have in a
table. User specified table headings can be saved and then selected later as
one of the standard tables available to the project.

Tabular output can be sent directly to the printer or passed through the
clipboard in the same manner as the graphical output described previously.
This option is also available under the File menu on each of the table forms.
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f:illptOme Output Table - Standard Table 1'~'

Eile Qptions 2.td. Tables ~ser Tables bocations t:!elp

HEC RAS Plan" Em' Cond River Critical Ci each U e' Reach Plota.: 100 t

Flow Area Top Width Froude UChiReach Rive' Std Q Tola! MinChEI 'viS Elev CliIW.S. E.G. Elev E.G. Slope Vel Chnl
[cI,1 [It) [It) [III (Ill (11/11) [It/s)

Upper Reach 12 9000.00 1803.60 1815.06 1814.46 1815.76 0.006851 10.51
Upper Reach 11 9000.00 1800.70 1810.42 1810.42 1811.87 0.008552 12.03
Upper Reach 10 9000.00 1794.40 180446 1803.69 180498 0.010276 10.48
Upper Reach 9 9000.00 1788.70 1799.31 1799.31 1800.16 0.008851 11.48
Upper Reach 8 9500.00 178430 179389 179389 1795.08 0.008613 12.38
Upper Reach 7 9500.00 1777.20 1789.88 178887 179100 0007410 13.16
Uppel Reach 6 9500.00 1774.50 1784.29 1784.29 1786.35 0.011143 13.38
Upper Reach 5 9500.00 1768.50 1776,81 1776.81 1778.18 0.013216 13.55
Upper Reach 4 950000 176300 177.344 1772.23 177388 0.004991 9.32
Upper Reach 3 9500.00 1759.40 1767.29 1765.75 1769,34 0.019810 16.09
Upper Reach 2 9500.00 1753.60 1761.54 176003 176210 0.009413 10.36
Upper Reach 1 9500.00 1747.40 175671 1755.71 1757.21 0.010002 9.91

Figure 3.14 Profile Output Table

Importing HEC-2 Data

(so II)

255845
1734.74
2478,11
2719.81
252466
2155.56
1266.30
183026
2988.72
1610.99
2323.62
240399

(II)
878.61
562.38
914.50

1216.82
1110.69

526.61
332.38
583.34
760.42
621.76
682.71
728.01

069
0.82 .
0.79 :
0.80.
0.81
0.76
0.93 I

0.97.
0.59 I

1.20
079
079

An important feature of HEC-RAS is the ability to import HEC-2 data. This
feature makes it easy for a user to import existing HEC-2 data sets and start
using HEC-RAS immediately.

What You Should Know First

Before importing HEC-2 data, there are several things that you should be
aware of. First, not all of the options available in HEC-2 have been
incorporated into the current version of HEC-RAS. The following is a list of
HEC-2 options that are not available in the current version of HEC-RAS:

- Compute Manning's n from high water marks (11)
- Archive (AC)
- Free Format (FR)
- Storage Outflow for HEC-I (14)

HEC-2 data sets containing these options can still be imported, but these data
options will be ignored.
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Another important issue to be aware of is how the cross sections are
identified. In HEC-RAS, each cross section is identified with a River name,
Reach name, and a River Station. The river stationing must be in order from
highest river stationing upstream to lowest river stationing downstream.
When the user goes to import HEC-2 data, a pop up window will appear
(Figure 3.15), asking the user to select a method for identifying the river
stationing of the cross sections. If you select "Use HEC-2 Section 1D's," the
program will use the first field of the X I record for the river stationing of the
cross section. If you choose this method, you must be sure that the cross
sections in the HEC-2 file are numbered with highest river stationing
upstream, and that no two cross sections have the same river station identifier.
If these two requirements are not met, the program will not import the data
correctly. An altemative is to select "Use Sequential Counter." This method
simply assigns river stations as I, 2, 3, etc. in the order in which the cross
sections are found in the HEC-2 file (still maintaining highest numbers
upstream and lowest numbers downstream.

r RiverSlation Identifcation Method

1 @ ~Qi~H~r?::$:~~~~i9:6:Ip.:?:
\'i Use Sequential Counter

Import HEC·2 Cancel

Figure 3.15 Method for Identifying River Stations from HEC-2 Data

After the HEC-2 data is imported into HEC-RAS, you may need to make
some modifications to the data. HEC-RAS is a completely new program. As
HEC-RAS was being developed, we tried to improve the hydraulic
computations in every way we could. Some of these improvements have
made it necessary to get more information and/or different information from
the user for a specific type of computation. The following is a list of features
in which the data requirements for HEC-2 and HEC-RAS have changed, and
it may be necessary for the user to modify the data after it is imported:

- Special Bridge (SB)
- Special Culvert (SC)
- Normal Bridge (X2, BT)
- Encroachments and Floodway Determination (X3, ET)
- Ineffective Flow Areas (X3)
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When bridge data are imported, the user must take special care to ensure that
the data are correctly representing the bridge. The bridge routines in HEC­
RAS are more detailed than HEC-2, and therefore you may have to modify
some data and/or enter some additional data. Whenever you import an HEC­
2 data set with bridge data, carefully review all the data for each bridge.
Chapter 6 of this user's manual describes the required data for bridges in
HEC-RAS. Appendix C of the HEC-RAS Hydraulic Reference Manual
contains a detailed discussion of the computational differences between
HEC-RAS and HEC-2. Some key differences between the bridge routines
ofHEC-2 and HEC-RAS are as follows:

1. Special Bridge Data Sets

HEC-RAS does not use a trapezoidal approximation for low flow through the
bridge opening. The actual bridge opening is used in both the Yarnell method
and the momentum method. This could be a problem for HEC-2 special
bridge data sets that do not include low chord information on the BT data. If
you have a data set like this, you will need to modify the bridge deck
information after the data have been imported. This can be done from the
HEC-RAS Deck/Roadway editor.

The pressure flow equations in HEC-RAS use the actual bridge opening,
defined by the ground and the bridge data. In HEC-2, the user was required
to enter an area for pressure flow. If the actual bridge opening produces a
different area than what the user had entered in the HEC-2 data deck, the
program will get different results for pressure flow, and pressure and weir
flow answers.

Pier information from the SB record is incorporated as a single pier in the
HEC-RAS data set (this is how it was treated in HEC-2). Piers are treated as
separate pieces of data in HEC-RAS. For special bridges that have piers, you
may want to change the single pier to multiple piers, depending on what is
actually at the bridge. Pier information can be modified using the Pier editor.

2. Normal Bridge Data Sets

Because piers are treated as a separate piece of data in HEC-RAS, they must
not be included in the cross section data or the bridge deck. Since it is
common to include pier information as part of the cross section or bridge
deck in HEC-2, these data will need to be modified. For data sets that have
piers, you will need to remove the pier information from the cross section or
bridge deck, and then add the information back in using the Pier editor.
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Steps for Importing HEC-2 Data

To import HEC-2 data, do the following:

I. Start a new project by selecting New Project under the File menu
option on the HEC-RAS main window (Figure 3.16). When this
option is selected a window will appear allowing you to select the
drive and directory for the new project, then enter a project title and
filename. Press the OK bulton, and then a pop up window will appear
asking you to confirm the information.

2. Select the Import HEC-2 Dala oplion under the File menu on the
main window (Figure 3.16). A pop up window will appear (Figure
3.17), which will allow you to select a drive, path, and filename for
the HEC-2 data file. In addition to the filenames being listed, the first
line of each HEC-2 data file is shown under the title field on the
window. Once you have selected the file you want, press the OK
bulton.

ill HEC-RAS - River Analysis Syst.em ::. ~:

EHe ~dlt B.un y'iew Qptrons t!elp

New Project".

Open Project".

Save Project

Save Projed As '"
Rename Project."

Delete ProJect",

Project 5u~ry ,,'

_i,ll.I·um.-SII~
Import HEC-RAS Data ...

Generate Report .. ,

Export GIS Data ...

Export to HEC·DSS ,.,

Restore Data

Exit

C:\HEC\Ras30\test2.prj

C:\HEC\Ras30\Data\WAILUPE .prj

C:\HEC\Ras30\Data\eRITCREK.prj

C:\HEC\Ras30\Data\BOGCHIT.prj

C:\HEC\RAS\CLASS\THREE.prj

C:\HEC\RAS\BUGS\THREE.prj

,

!C'IHEC\Ras30\test2.prt

o IUS Customary Units

Figure 3.16 HEC-RAS Main Window With File Menu Options Shown

3. Once you have selected an HEC-2 file and pressed the OK bulton, a
pop up window will appear asking you to select a method for
identifying the river stationing of the cross sections (this was
discussed under the "What You Should Know First" section). Select
a method and press the Import HEC-2 button.
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Import HEC2 data file .,l'

.hee2

Tille

I L

T1 TEST 31NTERPOlJlTED CROSS SECTIO
T1 TEST 4 DIRECT SOLUTION OF MAflNIN
T1 TEST 5 SPECIAL AND NORMAL BRIDGE
T1 TEST 5 SPECIAL AND NORMAL BRIDGE
T1 TEST 6 NORMIAL BRIDGE.SUPERCRITIC
T1 TEST 7NORMIAL BRIDGE .CRITICAL D
T1 TEST BSPECIAL BRIDGE,METRIC UNI
T1 TEST 9 SPECIAL BRIDGE,ClJISS AAN
T1 START AT SECTION
T1

File Name Directories

IA'"'L"""G"'N'"'M'"'NT"'S'""'.D'""'Ac;T'1--- C'IHECIRASlhee~
BOAT • ...:jC:I
T40AT ...:jHEC
T5.0AT ...:jRAS
TSA.OAT
T6.0AT
T7.0AT
TB.OAT
T9.DAT
TJC30AT
YOLO OAT

OK

Iselect HEC·2lileto impOIt

Cancel Help Create Directory I-:Jc

Figure 3.17 Window for Importing HEC-2 Data

4. If the HEC-2 data file contains any bridges or culverts, a note will
appear reminding you to look at the imported data of all of the bridges
and culverts to ensure the data is complete and correct.

The data are automatically saved in HEC-RAS format with default names and
titles. The user can change the titles at any time by using the Rename
feature, which is available from the File menu of the various data editors
(Geometric data, flow data, and plan data).

Reproducing HEC-2 Results

The HEC-RAS program is a completely new piece of software. None of the
hydraulic routines from HEC-2 were used in the HEC-RAS software. When
HEC-RAS was being developed, a significant effort was spent on improving
the computational capabilities over those in the HEC-2 program. Because of
this, there are computational differences between the two programs.

Appendix C, of the HEC-RAS Hydraulic Reference Manual, outlines in
detail the computational differences between the two programs. Please
review this closely!

When importing HEC-2 data, and attempting to reproduce the results of a
previous study, the following is a list of items that should be considered:
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I. First, is the data that you have imported good data? In other words,
did it come from a working HEC-2 model, and was that model
considered as being hydraulically sound. Are there an adequate
number of cross sections? And are there any mistakes in the cross
section data? Review the data closely, before you assume that it is
good!

2. The default method for calculating conveyance in HEC-RAS is
different from HEC-2. However, HEC-RAS has the ability to
compute conveyance with the HEC-2 methodology. Hyou are trying
to reproduce HEC-2 results, you may want to switch HEC-RAS to the
HEC-2 method of computing conveyance. To do this, from the
Steady Flow Analysis window select Options from the menu bar then
select Conveyance Calculations. When this is selected, a pop up
window will appear as shown in Figure 3.18. There are two options
available, the HEC-RAS default method (break in n-value method)
and the HEC-2 style method. Select the HEC-2 style method if you
are trying to reproduce HEC-2 results. For more information on the
differences in conveyance calculations, see Appendix C of the HEC­
RAS Hydraulic Reference manual.

HEG-RAS

Select Method ofCeJDJlating Conveyance

HelpI II I CeneelOK

.. Wb!.~~;;~:M.~
r Between every coordmate point (HEC2 Style)

,-----

Figure 3.18 HEC-RAS Conveyance Calculation Methods

3. The HEC-RAS bridge routines are more comprehensive than the
HEC-2 bridge routines, and therefore differences can occur at bridge
locations. First, review the bridge data closely and make sure it
accurately represents the bridge you are trying to model. If you feel it
is necessary to match the results of a previous study at the bridge,
then your only alternative is to adjust the coefficients that are being
used in the bridge modeling approach (i.e., pressure and weir flow
coefficients, low flow coefficients, contraction and expansion
coefficients, etc...). For detailed information on the differences
between the HEC-RAS and HEC-2 bridge routines, please review
Appendix C of the Hydraulic Reference manual.
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4. Sometimes differences can occur at locations where the programs
have defaulted to a critical depth solution. First you should ask
yourself if critical depth is an appropriate solution for this location. It
is a common problem for both programs to default to critical depth
when the cross sections are spaced too far apart. If you feel critical
depth is an appropriate solution, then in general the HEC-RAS answer
will be beller than HEC-2. The critical depth routines in HEC-RAS
are much more comprehensive than HEC-2. HEC-RAS has tighter
error limits for locating critical depth, as well as the ability to find
multiple critical depths and detect which is the most appropriate.

5. Differences can also occur at locations where flood way
encroachments are being computed. The HEC-RAS floodway
encroachment routines have been improved over those available in
HEC-2. Also, the default at bridges in HEC-RAS is to perform the
encroachment analysis, while the default in HEC-2 was to not
encroach at bridges. For more details on differences between
encroachment routines, please review Appendix C of the HEC-RAS
Hydraulic Reference Manual.

6. After carefully reviewing items one through five above, if you still
have computational differences in the computed profiles, you may
need to modify Manning's n values in order to reproduce the previous
study results. In general, this is not suggested. If you do decide to
modify the n values, try to keep them within a realistic range of what
is appropriate for the stream you are working on.

Getting and Using Help

On-line help is available from within the HEC-RAS software. Help can be
accessed by selecting the Help menu option at the top of each window, or by
pressing the Fl function key.
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CHAPTER 4

Example Application

This chapter provides an example application of how to perform steady flow
water surface profile calculations with !-lEC-RAS. The user is taken through
a step-by-step procedure of how to enter data, perform calculations, and view
the results.

In order to get the most out of this chapter, you should perform each of the
steps on your own computer. Also, before you try the example application,
you should have read the first three chapters in this manual.

Contents

• Starting a New Project

• Entering Geometric Data

• Entering Steady Flow Data

• Performing the Hydraulic Calculations

• Viewing Results

• Printing Graphics and Tables

• Exiting the Program
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Starting a New Project

To begin this example, let's first start the HEC-RAS program. Double click
the HEC-RAS icon in Windows. The main window should appear as shown
in Figure 4.1 (except yours will be blank the first time you start the program).

III HEC-RAS - River Analysis System .. .::~

File Eelt Run I/iew Option> Help

PfOjeet

Plan:

Geomehy.

Steady Flow:

Unsteady Flow: I
PrOject ,..------------------------ 0.. IUS CustomalyUnlls
Description.

Figure 4.1 HEC-RAS Main Window

The first step in developing an HEC-RAS application is to start a new project.
Go to the File menu on the main window and select New Project. The New
Project window should appear as shown in Figure 4.2 (except the title and file
name fields will be blank when it first comes up).

New Project ./tl:' .;-~

C\HEC\Ros30\Dato

Drectolles
:::-;:---,------
File Name

IEX1.prj

Title

ISteady Flow Example from Chapter 4

Stream Junction - Exarnple 10
Looped fletWOlk· E,ample 8
Mixed Flow Project
Mixed Flow - Example 9
Multiple Culverts' Example 4
Multiple Openings - Example 5
Napa Cr. Bridge Project· Example 7
Neil Nelson's Properly
Inline We" and Gated SpiUay' Ex 12
Blidge Seoul' Example 11

JUNCTION.pl;
LOOP.pr;
MIXED.PRJ
MIXFLOW.pl;
MULTCULV.pl;
MULTOPEN.pr;
NAPA.prj
Nelson.prj
NIT .plj
SCOURPRJ

J
~C:\

'.:.:JHEC
~Ros30

• Doto

Isel dJive and path. then enter a new project title and file name

OK Cancel Help Create Directofy I---.J c:

Figure 4.2 New Project Window

First set the drive (e.g., C:) and the directory that you would like to work in.
Next enter the project title and filename as shown in Figure 4.2. Once you
have entered the infon11ation, press the OK button to have the data accepted.
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Entering Geometric Data

The next step in developing a steady flow model with HEC-RAS is to enter
the geometric data. This is accomplished by selecting Geometric Data from
the Edit menu on the HEC-RAS main window. Once this option is selected
the geometric data window will appear, except yours will be blank when you
first bring it up (Figure 4.3).

Drawing the Schematic of the River System

In this example we are going to develop a two-river (three hydraulic reaches)
system as shown in Figure 4.3. Draw the river system schematic by
performing the following steps:

I. Click the River Reach button on the geometric data window.

2. Move the mouse pointer over to the drawing area and place the
pointer at the location in which you would like to start drawing the
first reach.

3. Press the left mouse button once to start drawing the reach. Move the
mouse pointer and continue to press the left mouse button to add
additional points to the line segment. To end the drawing of the
reach, double click the left mouse button and the last point of the
reach will be placed at the current mouse pointer location. All
reaches must be drawn from upstream to downstream (in the positive
flow direction), because the program assumes this to be true.

4. Once the reach is drawn, the interface will prompt you to enter an
identifier for the River name and the Reach name. The River
identifier can be up to 32 characters, while the reach name is limited
to 12 characters. In this example, there is one river named Fall River
and another one named Butte Cr. Fall river contains two hydraulic
reaches, which are labeled Upper Reach and Lower Reach. Butte
Cr. has been entered as a single hydraulic reach, and the reach name
is Tributary.

5. Repeat steps one through four for each reach. After you enter the
identifiers for Butte Cr., you will also be prompted to enter an
identifier for the junction. Junctions in HEC-RAS are locations
where two or more reaches join together or split apart.
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Once you have finished drawing in the river system, there are several options
available for editing the schematic. These options include: change name,
move object (objects are labels, junctions, and points in the reaches), add
points to a reach, remove points from a reach, delete a reach, and delete a
junction. The editing features are located under the Edit menu on the
Geometric Data window. Note: when you first draw your schematic there
will not he any tic marks representing cross sections as shown in Figure
4.3. The tic marks only show up after you have entered cross sections.

Geometric Data - Base Geometry Data

.J

Pump
Station

CP
,

,//"'0.2
/10 /

/\~ /~b~arY
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~: /u

/.~~_ 1/
~, j
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\
" \
y-:.~9.7...

"'P.' _ Lower Reach.. '----
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- \"
\ ... 95
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StorageA,,,-
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Figure 4.3 Geometric Data Window with example river schematic

Entering Cross Section Data

The next step is to enter the cross section data. This is accomplished by
pressing the Cross Section button on the Geometric Data window (Figure
4.3). Once this button is pressed, the Cross Section Data editor will appear as
shown in Figure 4.4 (except yours should be blank). To enter cross section
data do the following:
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1. Select a River and a Reach to work with. For this example start with
the Fall River, Upper Reach.

2. Go to the Options menu and select Add a new Cross Section. An
input box will appear to prompt you to enter a river station identifier

for the new cross section. The identifier does not have to be the
actual river station, but it must be a numeric value. The numeric
value describes where this cross section is located in reference to all
the other cross sections within the reach. Cross sections are located
from upstream (highest river station) to downstream (lowest river
station). For this cross section enter a value of 10.0.

I ROB

I ROB
1005

1550

I Right Bank

103
I Expansion

1500
I Channel

I Channel
10035

Manm" 's nValues

Con(\Ex Coellicrenls

Downstream Reach L hs

Main Channel Bank Statlom
I Left Bank

I LOB
1006

I Contraction

1200

80
78
70
71
73
81

ClOSS Section X-Y Coordinates

Exit Edit Options Plot Help

River: !FaU River 3 1J= I
Reach: jUpper Reach iJ River Sla.: rI1=='0====iJ=iI"[!]==.=;;=[!]:"

Description IUpstream Boundary of Fall River 0
Del Row I Ins Row I

I LOB

F"T'''''':S"'ta'''li'''on''''''''i'''''E''le'''v'''a'''tio'''n''''i'''.'i 1450
1 110 90
2 120
3 200
4 210
5 230
6 240
7 350
8 360
9

10

Edit Station Elevation Data 1ft)

Figure 4.4 Cross Section Data Editor with example data

3. Enter all of the data for this cross section as it is shown in Figure 4.4.

4. Once all the data are entered press the Apply Data button. This
button is used to tell the interface that you want the data to be
accepted into memory. This button does not save the data to your
hard disk, which can only be accomplished from the File menu on the
Geometric Data window.

5. Plot the cross section 10 visually inspect the data. This is
accomplished by pressing the Plot Cross Section option under the
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Plot menu on the Cross Section Data Editor. The cross section
should look the same as that shown in Figure 4.5.

In general, the five steps listed would be repeated for every cross section that
is entered. In order to reduce the amount of data entry for this example, the
current cross section will be copied and adjusted to represent other cross
sections within the river system.

[ross 5ection :~!;~

Eire Qptions t:!elp
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Reach: IUppel Reach

::oJ~~ I + tOll
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Steady Flow Example f'om Chapter 4 Plan: Existing Conditions Run
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Figure 4.5 Cross Section Plot for river mile 10.0 of Fall Creek

The following steps should be followed to copy the current cross section:

1. Go to the Options menu on the Cross Section Data Editor and select
Copy Current Cross Section. An input box will appear to prompt
you to select a river and a reach, and then enter a river station for the
new cross section. For this example, keep the river and reach as Fall
River and Upper Reach, then enter a new river station of 9.9. Press
the OK button and the new cross section will appear in the editor.

2. Change the cross section description to "River Mile 9.9 of Fall River."

3. Adjust all the elevations of the cross section by -0.5 feet. This is
accomplished by selecting the Adjust Elevations feature from the
Options menu on the Cross Section Data Editor.

4. Adjust the cross section stationing to reduce the overbanks by 10%.
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This is accomplished by selecting the Adjust Stations feature from
the Options menu on the Cross Section Data Editor, then select
Multiply by a Factor. When the input box appears for this option,
three data entry fields will be available to adjust the stationing of the
left overbank, channel, and the right overbank separately. Enter
values of 0.90 for the right and left overbanks, but leave the main
channel field blank. This will reduce the stationing of both overbanks
by 10%, but the main channel will not be changed.

5. Downstream reach lengths remain the same for this cross section.

6. Press the Apply Data button.

7. Plot the cross section to visually inspect it.

These seven steps should be repeated to enter all the data for Fall River
(Upper and Lower Reach). The necessary adjustments are listed in Table 4.1.
Perform the cross section duplications in the order that they are listed in the
table. Make sure to change the description of each cross section, and also
press the Apply Data button after making the adjustments for each cross
section.

Table 4.1 Cross Section adjustments for duplicating sections

Cross Section Adjusted Adjusted Stationing Downstream Reach Lengths
Elevation

Reach River Left Channel RightO.B Left O.B. Channel Right O.B
Sta. O.B.

Upper 9.8 -0.4 0.80 - 0.80 0.0 0.0 0.0

Lower 9.79 -0.1 1.20 1.20 1.20 500 500 500

Lower 9.7 -0.5 1.20 1.20 1.20 500 500 500

Lower 9.6 -0.3 - - - 500 500 500

Lower 9.5 -0.2 - - - 0.0 0.0 0.0

This completes all the cross section data for Fall River (upper and Lower
reach). Now let's work on entering the data for the Butte Creek tributary. To
enter the first cross section in the Butte Creek tributary do the following:

I. Go to the River text box on the Cross Section Data Editor and select
the Butte Cr. river. The Reach of "Tributary" will automatically be
selected since it is the only reach in Butte Creek.

2. Select Add a new Cross Section from the Options menu. When the
popup box appears to prompt you to enter a new river station, enter a
value of 0.2.
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3. Enter all the data for this cross section as shown in Figure 4.6.

4. Once all the data are entered for this section, press the Apply Data
button.

5. Plot the cross section to inspect the data.
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Exit Edit Options Plot Help
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Edil Sialion Elevalion Data (II)

Figure 4.6 Cross Section Editor with river mile 0.2 of Butte Creek

There are two other cross sections that need to be developed for the Butte
Creek tributary. These two cross sections will be developed by duplicating
the cross section that you just entered, and then adjusting the elevations and
stationing. The necessary adjustments are listed in Table 4.2. Perform the
cross section adjustments in the order that they are listed in the table. Make
sure to change the description of each cross section and press the Apply Data
button after editing is complete.
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Table 4.2 Cross Section adjustments for Butte Creek sections

Cross Section Adjusted Adjusted Stationing Downstream Reach Lengths
Elevation

Reach River Sta. Left Channel Right O.B. Left O.B. Channel Right O.B.
O.B.

Butte Cr. 0.1 -0.6 - - - 500 500 500

Butte Cr. 0.0 -0.3 - - - 0.0 0.0 0.0

Now that all of the cross section data are entered, save the data to a file before
continuing. Saving the data to a file is accomplished by selecting the "Save
Geometry Data As" option from the File menu on the Geometric Data
window. After selecting this option you will be prompted to enter a Title for
the geometric data. Enter "Base Geometry Data" for this example, then press
the OK button. A file name is automatically assigned to the geometry data
based on what you entered for the project filename.

Entering Junction Data

The next step is to enter the junction data. Junction data consist of a
description, and reach lengths across the junction. In this example there is
only one junction, which is labeled Sutter. To enter Junction data, press the
Junction button on the Geometric Data window. Enter the junction data as
shown in Figure 4.7.

Junction Data - Base Geometry Data~ ,

To: Butte Cr. • TriblJtary

Len th across JunctIon

To: Fall River - Upper Reach

Flom Fall River - Lower Reach

Junction Name [Sutter :::J [!] [!] .J. IComputation Mode

(i Energy
De'Scription !Flm',! Confluence of Fall and Butte Creek 0 ~ M••• \ omentum

_ fl< ;
l;m.Grim. ~ r 1,

l>Q!
50

OK Cancel Help

Figure 4.7 Junction Data Editor, with Sutter junction data
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Reach lengths across the junction are entered in the junction editor, rather
than in the cross section data. This allows for the lengths across very
complicated confluences (i.e., flow splits) to be accommodated. In the cross
section data, the reach lengths for the last cross section of each reach should
be left blank or set to zero.

In this example the energy equation will be used to compute the water surface
profile through the junction. If the momentum equation is selected, then an
angle can be entered for one or more of the reaches flowing into or out of a
junction. The momentum equation is set up to account for the angle of the
flow entering the junction.

Once you have all of the data entered for the junction, apply the data and
close the window by pressing the OK button.

Saving the Geometry Data

At this point in the example, all of the geometric data has been entered.
Before we continue with the example, you should save the geometric data to
the hard disk. Since the data have already been saved once, you simply have
to select Save Geometry Data from the File menu on the Geometric Data
window. We can now go on to enter the Steady Flow data.

Entering Steady Flow Data

The next step in developing the required data to perform steady flow water
surface profile calculations is to enter the steady flow data. To bring up the
steady flow data editor, select Steady Flow Data from the Edit menu on the
HEC-RAS main window. The Steady Flow Data editor should appear as
shown in Figure 4.8.

The first piece of data to enter is the number of profiles to be calculated. For
this example, enter "3" as shown in Figure 4.8. The next step is to enter the
flow data. Flow data are entered from upstream to downstream for each
reach. At least one flow rate must be entered for every reach in the river
system. Once a flow value is entered at the upstream end of a reach, it is
assumed that the flow remains constant until another flow value is
encountered within the reach. Additional flow values can be entered at any
cross section location within a reach.
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Steady Flow Data - 10, 2 and 1llform;me - .
File Options Help

Enter/Edit Number 01 Profiles (500 ma"):~ Reach Boundar}' Conditions I C I I
Locations of Flow Data Chan es

River: IButte Cr.

Reach: IT ributar}'

:::1
3 River Sta.: 10.0 iJ Add A Flow Change Location I

Flow Chanoe LocatIOn Prof,le Names and Flow Rates

River Reach RS 10 vr 150 vr 1100vr
1 SulleCr. Tfibutar}' 0.2 )QQ r 500 1500.................,
2 Fall River Upper Reach 10 500 2000 5000
3 Fall River Lower Reach 9.79 600 2500 6500

I ,,'
4 Fall River Lower Reach 9.6 650 2700 7000 ,:'" I,': .r " .. --, .r ,"':1;

IEdit Steady Ilow data for the profiles (cis)

Figure 4.8 Steady Flow Data Editor, with example prohlem data

In this example, flow data will be entered at the upstream end of each reach.
An additional flow change location will be entered at river mile 9.6 of the Fall
River in the Lower Reach. To add an additional flow change location into the
table, first select the Fall River, Lower Reach from the Reach list box. Next,
select the desired river station location (9.6 in this example) from the River
Sta. list box. Finally, press the Add a Flow Change Location button. The
new flow location should appear in the table. Now enter all of the flow data
into the table as shown in Figure 4.8. Profile labels will automatically default
to "PF#I," "PF#2," etc. You can change these labels to whatever you want.
In this example they have been changed to "10 yr," "50 yr," and "100 yr," to
represent the statistical return period of each of the events being modeled.

The next step is to enter any required boundary conditions. To enter
boundary conditions, press the Enter Boundary Conditions button at the top
of the Steady Flow Data editor. The boundary conditions editor will appear
as shown in Figure 4.9, except yours will be blank the first time you open it.

Boundary conditions are necessary to establish the starting water surface at
the ends of the river system. A starting water surface is necessary in order for
the program to begin the calculations. In a subcritical flow regime, boundary
conditions are only required at the downstream ends of the river system. If a
supercritical flow regime is going to be calculated, boundary conditions are
only necessary at the upstream ends of the river system. If a mixed flow
regime calculation is going to be made, then boundary conditions must be
entered at all open ends of the river system.
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Steady Flow Boundary CondItions ~1','; . ,

a- Set boundary for all profiles r Set boundalY for one profile at a time

Ava~able E.ternal Boundal Condbon T

Known 'VIS. I C,itical Depth Normal Depth I Rating CUlve Delete

Selected Boundar Condition LocatIOns and T es

River
Butte Cr.
Fall River

Fall Rive'

Reach
Tributary
Upper Reach
Lower Reach

all
all
all

Plolile Upstream

Junction=Sutter

Downstream
Junction=Sutter
Junction=Sutter
Normal De th 5 = 0 0004

OK Cancel Help

Select Boundary condition for the downstream side of selected reach.

Figure 4.9 Steady Flow Boundary Conditions

The boundary conditions editor contains a table listing every river and reach.
Each reach has an upstream and a downstream boundary condition.
Connections to junctions are considered internal boundary conditions.
Internal boundary conditions are automatically listed in the table, based on
how the river system is connected in the geometric data editor. The user is
only required to enter the necessary external boundary conditions.

In this example, it is assumed that the flow is subcritical throughout the river
system. Therefore, it is only necessary to enter a boundary condition at the
downstream end of the Fall River, Lower Reach. Boundary conditions are
entered by first selecting the cell in which you wish to enter a boundary
condition. Then the type of boundary condition is selected from the four
available types listed above the table. The four types of boundary conditions
are:

• Known water surface elevations

• Critical depth

• Normal depth

• Rating curve

For this example, use the normal depth boundary condition. Once you have
selected the cell for the downstream end of Fall River, Lower Reach, press
the Normal Depth button. A pop up box will appear requesting you to enter
an average energy slope at the downstream end of the Fall River. Enter a
value of 0.0004 (fl/ft) then press the Enter key. This completes all of the
necessary boundary condition data. Press the OK button on the Boundary
Conditions form to accept the data.
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The last step in developing the steady flow data is to save the data to a file.
To save the data, select the Save Flow Data As option from the File menu on
the Steady Flow Data Editor. A pop up box will prompt you to enter a
description of the flow data. For this example, enter "10, 2, and 1% chance
events." Once the data are saved, you can close the Steady Flow Data Editor.

Performing the Hydraulic Calculations

Now that all of the data have been entered, we can calculate the steady water
surface profiles. To perform the simulations, go to the HEC-RAS main
window and select Steady Flow Analysis from the Run menu. The Steady
Flow Analysis window should appear as shown in Figure 4.10, except yours
will not have any plan titles yet.

aSteady Flow Analysis ... '"

File Options Help

Plan: Existing Conditions Run~ Short ID !Exding

I D

Geometr}l File: IBase Geometry Data iJ
c-----------

Steady Flow File: 110. 2 and 1%chance events iJ
Plan Description:

, Flow Regime
; r.- Subcritical

: (" Supercritical
(" Mixed. -

..... . ·· ···"·COMPUTE'·' , .

Enter to compute watel surface profiles
..- --

Figure 4,10 Steady Flow Analysis Simulation Window

The first step is to put together a Plan. The Plan defines which geometry and
flow data are to be used, as well as providing a title and short identifier for the
run. To establish a plan, select New Plan from the File menu on the Steady
Flow Analysis window. Enter the plan title as "Existing Conditions Run" and
then press the OK button. You will then be prompted to enter a short
identifier. Enter a title of "Existing" in the Short 10 box.

The next step is to select the desired flow regime for which the model will
perform calculations. For this example we will be performing Subcritical
flow calculations only. Make sure that Subcritical is the selected flow
regime. Additional job control features are available from the Options menu
bar, but none are required for this example. Once you have defined a plan
and set all the desired job control information, the plan information should be
saved. Saving the plan information is accomplished by selecting Save Plan
from the File menu of the Steady Flow Analysis window.
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Now that everything has been set, the steady flow computations can be
performed by pressing the Compute button at the bottom of the Steady Flow
Simulation window. Once the compute button has been pressed, a separate
window will appear showing you the progress of the computations. Once the
computations have been completed, the computation window can be closed
by double clicking the upper left comer of the window. At this time the
Steady Flow Simulation window can also be closed.

Viewing Results

Once the model has finished all of the computations successfully, you can
begin viewing the results. Several output options are available from the View
menu bar on the HEC-RAS main window. These options include:

• Cross section plots

• Profile plots

• General Profile Plot

• Rating curves

• X-Y-Z Perspective Plots

• Detailed tabular output at a specific cross section (cross section table)

• Limited tabular output at many cross sections (profile table)

Let's begin by plotting a cross section. Select Cross Sections from the View
menu bar on the HEC-RAS main window. This will automatically bring up a
plot of the first cross section in Butte Cr., as shown in Figure 4.11. Any cross
section can be plotted by selecting the appropriate river, reach, and river
station from the list boxes at the top of the cross section plot window. The
user can also step through the plots by using the up and down arrow buttons.
Several plotting features are available from the Options menu bar on the
cross section plot window. These options include: zoom in; zoom out;
selecting which plans, profiles and variables to plot; and control over lines,
symbols, labels, scaling, and grid options.
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Figure 4.1l Cross Section Plot for Example Application

Select different cross sections to plot and practice using some of the features
available under the Options menu bar

Next let's plot a water surface profile. Select Water Surface Profiles from
the View menu bar on the HEC-RAS main window. This will automatically
bring up a water surface profile plot for the first reach, which is Butte Cr. in
our example. To plot more than one reach, select Reaches from the Options
menu bar on the profile plot. This option brings up a list of available rivers
and reaches from which to choose. Select the Upper and Lower reaches of
the Fall river. This should give you a profile plot as shown in Figure 4.12.
Plot the additional profiles that were computed and practice using the other
features available under the Options menu bar on the profile plot.
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Figure 4.12 Profile Plot for Example Application

Now let's plot a computed rating curve. Select Rating Curves from the View
menu on the HEC-RAS main window. A rating curve based on the computed
water surface profiles will appear for the fIrst cross section in Butte Cr., as
shown in Figure 4.13. You can look at the computed rating curve for any
location by selecting the appropriate river, reach, and river station from the
list boxes at the top of the plot. Plotting options similar to the cross section
and profile plots are available for the rating curve plots. Plot rating curves for
various locations and practice using the available plotting options.
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Figure 4.13 Computed Rating Curve for Example Application

)

Next look at an X-Y-Z Perspective Plot of the river system. From the View
menu bar on the HEC-RAS main window, select X-Y-Z Perspective Plots.
A multiple cross section perspective plot should appear on the screen. From
the Options menu, select Reaches. A pop up window will appear allowing
you to select which rivers and reaches you would like to have on the plot.
Press the Select All button and then the OK button. Also, under the Options
menu, select the Profiles option. Select profile two to be plotted from the
three available profiles. Once you have selected these options, and X-Y-Z
perspective plot should appear on the screen, similar to the one shown in
Figure 4.14. Try rotating the perspective view in different directions, and
select different reaches to look at.

Now let's look at some tabular output. Go to the View menu bar on the HEC­
RAS main window. There are two types of tables available, a detailed output
table and a profile summary table. Select Detailed Output Tables to get the
first table to appear. The table should look like the one shown in Figure 4.15.
This table shows detailed hydraulic information at a single cross section.
Other cross sections can be viewed by selecting the appropriate reach and
river mile from the table.

4-17



Chapter 4 Example AppUcatioo

Now bring up the profile summary table. This table shows a limited number
of hydraulic variables for several cross sections. There are several types of
profile tables listed under the Std. Tables menu bar of the profile table
window. Some of the tables are designed to provide specific infonnation at
hydraulic structures (e.g., bridges and culverts), while others provide generic
information at all cross sections. An example of this type of table is shown in
Figure 4.16.

File Options

., ~- - J
Ro~ation Angle

Azimuth Angle

Steady Flow Example from Chapter 4 Plan: Existing Conditions Run
Geom: Base Geometry Data Flow: 10, 2 and 1% chance events

legend, ,
WS 50 \'r

Grounej.
Bank sta

Figure 4.14 X-Y-Z Perspective Plot of All Three River Reaches
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Figure 4.15 Detailed Tabular Output at a Cross Section
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Figure 4.16 Tabular Output in Profile Format
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Printing Graphics and Tables

All of the plots and tables can be sent directly to a printer/plotter or passed
through the Windows clipboard to another program (e.g., a word processor).
The printer or plotter that gets used is based on what you currently have
selected as the default printer for Windows. The user has the ability to
change many of the default printer settings (e.g., portrait to landscape) before
printing occurs.

Sending Graphics Directly to the Printer

To send a graphic to the printer/plotter, do the following:

1. Display the graphic of interest (cross section, profile, rating curve, or
river system schematic) on the screen.

2. Using the available options (scaling, labels, grid, etc.), modifY the
plot to be what you would like printed out.

3. Select Print from the File menu ofthe displayed graphic. Once Print
is selected, a Printer Options window will appear, giving the user
the opportunity to change any of the default printer settings. Once
you have the print settings the way you want them, press the Print
button on the Printer Options window and the plot will
automatically be sent to the Windows Print Manager. From that point
the Windows Print Manager will control the printing.

Sending Graphics to the Windows Clipboard

To pass a graphic to the Windows clipboard and then to another program, do
the following:

I. Display the graphic of interest on the screen.

2. Using the available options, modify the plot to be what you want it to
look like.

3. Select Copy to Clipboard from the File menu of the displayed
graphic. The plot will automatically be sent to the Windows
clipboard.

4. Bring up the program that you want to pass the graphic into (e.g.,
word processor). Select Paste from the Edit menu ofthe receiving
program. Once the graphic is pasted in, it can be resized to the
desired dimensions.
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Sending Tables Directly to the Printer

To send a table to the printer, do the following:

I. Bring up the desired table from the tabular output section of the
program.

2. Select Print from the File menu of the displayed table. Once the
Print option is selected, a Printer Options window will appear. Set
any print options that are desired then press the Print button. This
will send the entire table to the Windows Print Manager. From this
point the Windows Print Manager will control the printing of the
table.

The profile type of table allows you to print a specific portion of the table,
rather than the whole thing. If you desire to only print a portion of the table,
do the following:

I. Display the desired profile type table on the screen.

2. Using the mouse, press down on the left mouse button and highlight
the area of the table that you would like to print. To get an entire row
or column, press down on the left mouse button while moving the
pointer across the desired row or column headings.

3. Select Print from the File menu of the displayed table. Only the
highlighted portion of the table and the row and column headings will
be sent to the Windows Print Manager.

Sending Tables to the Windows Clipboard

To pass a table to the Windows clipboard and then to another program, do the
following:

I. Display the desired table on the screen.

2. Select Copy to Clipboard from the File menu of the displayed table.

3. Bring up the program that you want to pass the table into. Select
Paste from the Edit menu of the receiving program.

Portions of the profile table can be sent to the clipboard in the same manner
as sending them to the printer.

Practice sending graphics and tables to the printer and the clipboard with the
example data set that you currently have open.
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Exiting the Program

Before you exit the HEC-RAS software, make sure you have saved all the
data. This can be accomplished easily by selecting Save Project from the
File menu on the HEC-RAS main window. Any data (geometric, flow, and
plan data) that have not been saved will automatically be saved for you.

To exit the HEC-RAS software, select Exit from the File menu of the HEC­
RAS main window. The program will prompt you to save the project if the
data have not been saved previously.
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CHAPTER 5

Working With Projects

To create a river hydraulics application with HEC-RAS, you work with
projects. A project is a collection offiles that are used to build a model.
This chapter describes projects and how you build and manage them.

Contents

• Understanding Projects

• Elements of a Project

• Creating, Opening, Saving, Renaming, and Deleting Projects

• Project Options

Understanding Projects

As you develop an application, the management of all the files that get
created is accomplished through the user interface. When a new project is
started, the user is requested to enter a title and filename for the project. All
other data are automatically stored by the user interface using the same name
as the project file, except for the three character extension. A project consists
of:

• One Project file (.PRJ)

• One file for each Plan (.POI to .P99)

• One Run file for each steady flow plan (.ROI to .R99)

• One Output file for each plan (.001 to .099)

• One file for each set ofGeomelry data (.GOI to .G99)

• One file for each set ofSleady Flow data (.FOI to .F99)

• One file for each set of Unsteady Flow data (.UOI to .U99)

• One r,le for each set of Sediment data (.SO I to .S99)

• One file for each set of Hydraulic Design data (.HOI to .H99)
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The Project File contains: the title of the project; the units system of the
project; a list of all the files that are associated with the project; and a list of
default variables that can be set from the interface. Also included in the
project file is a reference to the last plan that the user was working with. This
information is updated every time you save the project.

Elements of a Project

The following sections describe the various types of files that can be included
in a project. All of these files are either created by the user interface or the
various computation engines. The modeler interacts with the data through the
user interface, and is not required to create or edit any of these files directly.

Plan Files

Plan files have the extension .PO I to .P99. The "P" indicates a Plan file,
while the number represents the plan number. As plans are created, they are
numbered from 0 I to 99. The plan file contains: a description and short
identifier for the plan; a list of files that are associated with the plan (e.g.,
geometry file and steady flow file); and a description of all the simulation
options that were set for the plan. The plan file is created automatically by
the interface each time the user selects New Plan or Save Plan As from the
simulation windows.

Run Files

Run files have the extension .ROI to .R99. The "R" indicates a Run file,
while the number represents an association to a particular plan file. A file
with an extension of .RO I is the run file that corresponds to the plan file with
the extension .PO 1. The run file contains all of the necessary data to perform
the computations that are requested by the associated plan file. For example,
if a steady flow analysis is requested, the run file will contain geometry data,
steady flow data, and all the necessary computational options that are
associated with the plan file. The run file contains the input to any of the
computational engines available in the HEC-RAS system. The run file is
automatically generated by the interface whenever the user presses the
Compute button on the Simulation windows. The run file is in an ASCII
format, but it is not self explanatory.
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Output Files

Output files have the extension .001 to .099. The "0" indicates an Output
file, while the numher represents an association to a particular plan file. A
file with the extension .012 is the output file that corresponds to the plan file
with an extension .P12. The output file contains all of the computed results
from the requested computational engine. For example, if a steady flow
analysis is requested, the output file will contain results from the steady flow
computational engine. The output files are in a binary file format and can
only be read from the user interface.

Geometry Files

Geometry files have the extension .GOI to .G99. The "G" indicates a
Geometry file, while the number corresponds to the order in which they were
saved for that particular project. Geometry files contain all of the geometric
data for the river system being analyzed. The geometric data consist of: cross
section information; hydraulic structures data (e.g., bridges and culverts);
coefficients; and modeling approach information. The geometry data are
stored in an ASCII format. The file contains key words to describe each
piece of data, and is for-the-most-part self explanatory. A geometry file is
created by the user interface whenever the modeler selects New Geometry
Data or Save Geometry Data As from the Geometric Data window.

Steady Flow Data Files

Steady flow data files have the extension .FOI to .F99. The "F" represents
that it is a steady Flow data file, while the number corresponds to the order in
which they were saved for that particular project. Steady flow data files
contain: the number of profiles to be computed; flow data; and boundary
conditions for each reach. The steady flow data files are stored in an ASCII
format. The file contains key words to describe each piece of data, and is for­
the-most-part self explanatory. Steady flow data files are automatically
created by the user interface when the modeler selects New Flow Data or
Save Flow Data As from the Steady Flow Data window.

Unsteady Flow Data Files

Unsteady flow data files have the extension .UO 1 to .U99. The "U"
represents that it is an Unsteady flow data file, while the number corresponds
to the order in which they were saved for that particular project. Unsteady
flow data files contain: flow hydrographs at the upstream boundaries; starting
flow conditions; and downstream boundary conditions. The unsteady flow
data files are stored in an ASCli format. The file contains key words to
describe each piece of data, and is for-the-most-part self explanatory.
Unsteady flow data files are automatically created by the user interface when
the modeler selects New Flow Data or Save Flow Data As from the
Unsteady Flow Data window.
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Sediment Data Files

Sediment data files have the extension .SOI to .S99. The "S" represents that it
is a Sediment data file, while the number corresponds to the order in which
they were saved for that particular project. Sediment data files contain: flow
data; boundary conditions for each reach; and sediment data. The sediment
data files are stored in an ASCII format. The file contains key words to
describe each piece of data, and is for-the- most-part self explanatory.
Sediment data files are automatically created by the user interface when the
modeler selects New Sediment Data or Save Sediment Data As from the
Sediment Data window. Currently, the sediment option is not available in
HEC-RAS. This option will be included in a future version.

Hydraulic Design Data Files

Hydraulic design data files have the extension .HOI to .H99. The "H"
represents that it is a Hydraulic design data file, while the number
corresponds to the order in which they were saved for that particular project.
Hydraulic design data files contain information corresponding to the type of
hydraulic design calculation that is requested. The Hydraulic design data
files are stored in an ASCII format. The file contains key words to describe
each piece of data, and is for-the most-part self explanatory. Hydraulic
Design data files are automatically created by the user interface when the
modeler selects New Hydraulic Design Data or Save Hydraulic Design
Data As from the File menu of the Hydraulic Design Functions window.

A schematic diagram of how the data files fit together is shown in Figure 5.1
on the next page. In this example there are three plans in the project. Each
plan represents a specific set of steady flow data and geometry data. In this
example there are three geometry files and one steady flow file. The first
geometry file could represent the existing conditions of the stream. The
second and third geometry file could represent some modification of that base
geometry file, such as adding a bridge or culvert crossing; a channel
modification; different roughness coefficients; or any other change to the base
geometry file. A plan is formulated by selecting a steady flow file and a
geometry file, and then saving that plan with a specific title and short
identifier. For more information about formulating plans, see Chapter 7 of
the HEC-RAS User's Manual and Chapter 7 of the HEC-RAS Applications
Guide.
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Figure 5.1 Schematic of Project Data Files.
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Creating, Opening, Saving, Renaming, and Deleting
Projects

The following commands from the File menu of the HEC-RAS main window
allow you to create, open, save, rename, and delete projects.

File menu command

New Project

Open Project

Save Project

Save Project As

Rename Project

Delete Project

Description

Closes the current project, prompting you to
save the data if anything has been changed.
The user is then prompted to enter a title and
filename for the new project.

Closes the current project, prompting you to
save the data if anything has been changed.
Opens an existing project and all ofthe
associated files.

Updates the project file and all other files in
which data have been modified.

Updates the project file and all other
associated data, saving all the information to a
new filename that you specify.

Allows the user to rename the title of the
currently opened project.

Deletes the project file and all other files
associated with the selected project. The user
is prompted to make sure that they really want
to delete all of the files.

These commands are the same for all of the other data types that get created
by the user interface (Plan data, geometry data, steady flow data, unsteady
flow data, sediment data, and hydraulic design data).

Project Options

From the Options menu of the main HEC-RAS window, the user can set
several default project options. These options include: setting default margins
and color control for printing; setting default hydraulic variables; establishing
the default units system (English or Metric); and converting existmg projects
to a different units system (English to Metric or Metric to English). The
following four options are available from the Options menu:
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Program Setup

Description
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- Default File Viewer This option allows the user to change which
program is used for viewing the report
generator and logfile output. The default is
the Windows Write program. The user can
change this to any file viewer on their system.

- AVI Bin Directory This option allows the user to set the default
directory for where HEC-RAS will store
bitmap files that it makes when creating an
AVI movie file.

- Open last project When this option is selected, the program will
automatically open the last project worked on,
during startup.

- Automatically backup
data When this option is checked, the program will

automatically make a backup of the currently
opened project, plan, geometry, and flow files.
The backup files are updated at specific timed
intervals, which is user controlled. The
backup files are stored in the \HEC\RAS
directory, with the titles RasBackup.prj,
RasBackup.pO I, RasBackup.gO I, and
RasBackup. ill I .

- Set time for
automatic backup This option allows the user to control the time

interval between updating the backup files.
The default value is 20 minutes.
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Options menu command

Default Parameters

Unit System

Convert Project Units
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Description

This option allows the user to set defaults for
some of the hydraulic variables.

This option allows the user to set the default
units system to either English or Metric. Once
the units system is set, the program assumes
that all input data are entered in that units
system. Likewise, the display of all output
data will be done in the default units system.

This option allows the user 10 convert an
existing project from one units system to
another. Projects can be converted from
English to Metric or from Metric to English.
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CHAPTER 5

Working With Projects

To create a river hydraulics application with HEC-RAS, you work with
projects. A project is a collection of files that are used to build a model.
This chapter describes projects and how you build and manage them.

Contents

• Understanding Projects

• Elements of a Project

• Creating, Opening, Saving, Renaming, and Deleting Projects

• Project Options

Understanding Projects

As you develop an application, the management of all the files that get
created is accomplished through the user interface. When a new project is
started, the user is requested to enter a title and filename for the project. All
other data are automatically stored by the user interface using the same name
as the project file, except for the three character extension. A project consists
of:

• One Project file (.PRJ)

• One file for each Plan (.POI to .P99)

• One Run file for each steady flow plan (.RO 1 to .R99)

• One Output file for each plan (.001 to .099)

• One file for each set of Geometry data (GO 1 to .G99)

• One file for each set of Steady Flow data (.FO I to .F99)

• One file for each set of Unsteady Flow data (.UOI to .U99)

• One file for each set of Sediment data (.SO I to .S99)

• One file for each set of Hydraulic Design data (.1-10 I to .H99)
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The Project File contains: the title of the project; the units system of the
project; a list of all the files that are associated with the project; and a list of
default variables that can be set from the interface. Also included in the
project file is a reference to the last plan that the user was working with. This
information is updated every time you save the project.

Elements of a Project

The following sections describe tbe various types of files that can be included
in a project. All of these files are either created by the user interface or the
various computation engines. The modeler interacts with the data through the
user interface, and is not required to create or edit any of these files directly.

Plan Files

Plan files have the extension .POI to .P99. The "P" indicates a Plan file,
while the number represents the plan number. As plans are created, they are
numbered from 0 I to 99. The plan file contains: a description and short
identifier for the plan; a list of files that are associated with the plan (e.g.,
geometry file and steady flow file); and a description of all the simulation
options that were set for the plan. The plan file is created automatically by
the interface each time the user selects New Plan or Save Plan As from the
simulation windows.

Run Files

Run files have the extension .ROI to .R99. The "R" indicates a Run file,
while the number represents an association to a particular plan file. A file
with an extension of .ROI is the run file that corresponds to the plan file with
the extension .POI. The run file contains all of the necessary data to perform
the computations that are requested by the associated plan file. For example,
if a steady flow analysis is requested, the run file will contain geometry data,
steady flow data, and all the necessary computational options that are
associated with the plan file. The run file contains the input to any of the
computational engines available in the HEC-RAS system. The run file is
automatically generated by tbe interface whenever the user presses the
Compute bulton on the Simulation windows. The run file is in an ASCII
format, but it is not self explanatory.
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Output Files

Output files have the extension .001 to .099. The "0" indicates an Output
file, while the number represents an association to a particular plan file. A
file with the extension .012 is the output file that corresponds to the plan file
with an extension .P12. The output file contains all of the computed results
from the requested computational engine. For example, if a steady flow
analysis is requested, the output file will contain results from the steady flow
computational engine. The output files are in a binary file format and can
only be read from the user interface.

Geometry Files

Geometry files have the extension .GOI to .G99. The "G" indicates a
Geometry file, while the number corresponds to the order in which they were
saved for that particular project. Geometry files contain all of the geometric
data for the river system being analyzed. The geometric data consist of: cross
section information; hydraulic structures data (e.g., bridges and culverts);
coefficients; and modeling approach information. The geometry data are
stored in an ASCII format. The file contains key words to describe each
piece of data, and is for-the-most-part self explanatory. A geometry file is
created by the user interface whenever the modeler selects New Geometry
Data or Save Geometry Data As from the Geometric Data window.

Steady Flow Data Files

Steady flow data files have the extension .FOI to .F99. The "F" represents
that it is a steady Flow data file, while the number corresponds to the order in
which they were saved for that particular project. Steady flow data files
contain: the number of profiles to be computed; flow data; and boundary
conditions for each reach. The steady flow data files are stored in an ASCII
format. The file contains key words to describe each piece of data, and is for­
the-most-part self explanatory. Steady flow data files are automatically
created by the user interface when the modeler selects New Flow Data or
Save Flow Data As from the Steady Flow Data window.

Unsteady Flow Data Files

Unsteady flow data files have the extension .UOI to .U99. The "U"
represents that it is an Unsteady flow data file, while the number corresponds
to the order in which they were saved for that particular project. Unsteady
flow data files contain: flow hydrographs at the upstream boundaries; starting
flow conditions; and downstream boundary conditions. The unsteady flow
data files are stored in an ASCII format. The file contains key words to
describe each piece of data, and is for-the-most-part self explanatory.
Unsteady flow data files are automatically created by the user interface when
the modeler selects New Flow Data or Save Flow Data As from the
Unsteady Flow Data window.
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Sediment Data Files

Sediment data files have the extension .SOI to .S99. The "S" represents that it
is a Sediment data tile, while the number corresponds to the order in which
they were saved for that particular project. Sediment data files contain: flow
data; boundary conditions for each reach; and sediment data. The sediment
data files are stored in an ASCll format. The file contains key words to
describe each piece of data, and is for-the- most-part self explanatory.
Sediment data files are automatically created by the user interface when the
modeler selects New Sediment Data or Save Sediment Data As from the
Sediment Data window. Currently, the sediment option is not available in
HEC-RAS. This option will be included in a future version.

Hydraulic Design Data Files

Hydraulic design data files have the extension .HOI to .H99. The "H"
represents that it is a Hydraulic design data file, while the number
corresponds to the order in which they were saved for that particular project.
Hydraulic design data files contain information corresponding to the type of
hydraulic design calculation that is requested. The Hydraulic design data
files are stored in an ASCII format. The file contains key words to describe
each piece of data, and is for-the most-part self explanatory. Hydraulic
Design data files are automatically created by the user interface when the
modeler selects New Hydraulic Design Data or Save Hydraulic Design
Data As from the File menu of the Hydraulic Design Functions window.

A schematic diagram of how the data files fit together is shown in Figure 5.1
on the next page. In this example there are three plans in the project. Each
plan represents a specific set of steady flow data and geometry data. In this
example there are three geometry files and one steady flow file. The first
geometry file could represent the existing conditions of the stream. The
second and third geometry file could represent some modification of that base
geometry file, such as adding a bridge or culvert crossing; a channel
modification; different roughness coefficients; or any other change to the base
geometry file. A plan is formulated by selecting a steady flow file and a
geometry file, and then saving that plan with a specific title and short
identifier. For more information about formulating plans, see Chapter 7 of
the HEC-RAS User's Manual and Chapter 7 of the HEC-RAS Applications
Guide.
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Figure 5.1 Schematic of Project Data Files.
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Creating, Opening, Saving, Renaming, and Deleting
Projects

The following commands from the File menu of the HEC-RAS main window
allow you to create, open, save, rename, and delete projects.

File menu command

New Project

Open Project

Save Project

Save Project As

Rename Project

Delete Project

Description

Closes the current project, prompting you to
save the data if anything has been changed.
The user is then prompted to enter a title and
filename for the new project.

Closes the current project, prompting you to
save the data if anything has been changed.
Opens an existing project and all of the
associated files.

Updates the project file and all other files in
which data have been modified.

Updates the project file and all other
associated data, saving all the information to a
new filename that you specify.

Allows the user to rename the title of the
currently opened project.

Deletes the project file and all other files
associated with the selected project. The user
is prompted to make sure that they really want
to delete all of the files.

These commands are the same for all of the other data types that get created
by the user interface (Plan data, geometry data, steady flow data, unsteady
flow data, sediment data, and hydraulic design data).

Project Options

From the Options menu of the main HEC-RAS window, the user can set
several default project options. These options include: setting default margins
and color control for printing; setting default hydraulic variables; establishing
the default units system (English or Metric); and converting existing projects
to a different units system (English to Metric or Metric to English). The
following four options are available from the Options menu:
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Program Setup

Description
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- Default File Viewer This option allows the user to change which
program is used for viewing the report
generator and logfile output. The default is
the Windows Write program. The user can
change this to any file viewer on their system.

- AVI Bin Directory This option allows the user to set the default
directory for where HEC-RAS will store
bitmap files that it makes when creating an
AVI movie file.

- Open last project When this option is selected, the program will
automatically open the last project worked on,
during startup.

- Automatically backup
data When this option is checked, the program will

automatically make a backup of the currently
opened project, plan, geometry, and flow files.
The backup files are updated at specific timed
intervals, which is user controlled. The
backup files are stored in the \HEC\RAS
directory, with the titles RasBackup.prj,
RasBackup.pO I, RasBackup.gO I, and
RasBackup.illl.

- Set time for
automatic backup This option allows the user to control the time

interval between updating the backup files.
The default value is 20 minutes.
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Options menu command

Default Parameters

Unit System

Convert Project Units
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Description

This option allows the user to set defaults for
some of the hydraulic variables.

This option allows the user to set the default
units system to either English or Metric. Once
the units system is set, the program assumes
that all input data are entered in that units
system. Likewise, the display of all output
data will be done in the default units system.

This option allows the user to convert an
existing project from one units system to
another. Projects can be converted from
English to Metric or from Metric to English.
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CHAPTER 6

Entering and Editing Geometric Data
Geometric data consist of establishing the connectivity of the river system
(River System Schematic), entering cross-section data, defining all the
necessary junction infonnation, adding hydraulic structure data (bridges,
culverts, weirs, etc.) and cross section interpolation. The geometric data is
entered by selecting Geometric Data from the Edit menu on the HEC-RAS
main window. Once this option is selected, the Geometric Data window will
appear as shown in Figure 6.1. The drawing area will be blank on your
screen, until you have drawn in your own river system schematic.

This chapter describes how to enter and edit all of the necessary geometric
data for a river system.

Contents

• Developing the River System Schematic
• Cross Section Data
• Stream Junctions
• Bridges and Culverts
• Multiple Bridge and/or Culvert Openings
• Inline Structures (Weirs and Gated Spillways)
• Lateral Structures (Weirs, Gated Spillways, Culverts, and Rating Curves)
• Storage Areas
• Storage Area Connections
• Pump Stations
• Cross Section Interpolation
• River Ice
• Viewing and Editing Data Through Tables
• Importing Geometric Data
• Geometric Data Tools
• Attaching and Viewing Pictures
• Saving the Geometric Data
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Developing the River System Schematic

Building The Schematic

The modeler develops the geometric data by first drawing in the river system
schematic on the Geometric Data window (Figure 6.1). The River System
Schematic is a diagram of how the stream system is connected together. The
river system is drawn on a reach-by-reach basis, by pressing the River Reach
button and then drawing in a reach from upstream to downstream (in the
positive flow direction). Each reach is identified with a River Name and a
Reach Name. The River Name should be the actual name of the stream,
while the reach name is an additional qualifier for each hydraulic reach within
that river. A river can be comprised of one or more reaches. Reaches start or
end at locations where two or more streams join together or spilt apart.
Reaches can also start or end at the open ends of the river system being
modeled. In other words, the first and last cross section that will be modeled
in a particular river will be the start or end of a particular reach.
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Figure 6.1 Geometric Data Editnr Window
6-2



Cha,oter 6 Entering and Editing GeometriC Data

Reaches are drawn as multi-segmented lines. Each reach must have at least
two points, defining the start and end of the reach. However, it is more
typical to draw a reach with several points that would follow along the main
channel invert of the stream. To draw a reach, first press the River Reach
button at the top of the Geometric Data editor, on the tools button bar. Move
the mouse pointer to the location on the drawing area that you would like to
have the reach begin (upstream end of the reach). Click the left mouse button
once to define the first point of the reach. Move the mouse and continue to
click the left mouse button to add additional points to the reach. To end a
reach, move the mouse pointer to the location in which you would like the
last point of the reach to be located, then double click the left mouse button.
After the reach is drawn, the user is prompted to enter the River Name and
the Reach Name to identify the reach. The river and reach identifiers are
limited to sixteen characters in length. If a particular River Name has already
been entered for a previously defined reach of the same river, the user should
simply select that river name from the list of available rivers in the river name
text box. As reaches are connected together, junctions are automatically
formed by the interface. The modeler is also prompted to enter an identifier
for each junction. Junctions are locations where two or more streams join
together or split apart. Junction identifiers are also limited to sixteen
characters. An example of a simple stream system schematic is shown in
Figure 6.1.

In addition to river reaches, the user can draw Storage Areas, Storage Area
Connections, and Pump Stations. A storage area is used to define an area in
which water can flow into and out of. The water surface in a storage area is
assumed to be a level pool. Storage areas can be connected to river reaches
as well as other storage areas. The user connects a storage area to a reach by
using the lateral structure option. Storage areas can be connected to other
storage areas by using a storage area connection between the storage areas.
Storage area connections consist of culverts, gated spi.llways and a weir. The
user can set up a storage area connection as just a weir, a weir and culverts, or
a weir and gated spillways. For connections between a storage area and a
river reach, the lateral structure option is the only means of doing this in
HEC-RAS.

To draw a Storage Area, select the storage area button at the top of the
geometric editor window. Storage areas are drawn as polygons. Move the
mouse pointer to the location in which you would like to start drawing the
storage area. Press the left mouse button one time to start adding points to
define the storage area. Continue using single left mouse clicks to define the
points of the storage area. To end the storage area use a double left mouse
click. The storage area will automatically be closed into a polygon. Once
you have finished drawing the storage area, a window will appear asking you
to enter a name for the storage area. To enter and edit the data for a storage
area, use the storage area editor button on the left panel of the geometric data
window.
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To enter a Storage Area Connection, select the storage area connection
button at the top of the Geometric data editor. Move the mouse pointer to the
storage area that you want to connect from. Then click the left mouse pointer
one time to start the drawing of the connection. You can continue to use
single mouse clicks to add as many points as you want into the line that
represents the storage area connection. When you want to end the
connection, place the mouse pointer over the storage area that you want to
connect to, and then double click the mouse pointer. A window will pop up
asking you to enter a name for the storage area connection. The direction in
which you draw the storage area connection is important for establishing the
positive flow direction for the flow. If you want the program to output
positive flow when the flow is going from one storage area to another storage
area, then you must draw the connection in that order. This is establishing the
positive flow direction for the storage area connection. If flow happens to go
in the other direction during the calculations, that flow will be output as
negative numbers. To enter and edit the data for a storage area connection
use the Storage Area Connection data editor on the left panel of the
geometric data window.

Pump stations can be connected between two storage areas, between a storage
area and a river reach, or between two river reaches. To add a pump station
to the schematic, click the Pump Station button at the top, under the tools
button bar, and then left click on the schematic at the location where you want
to place the pump station. To connect the pump station, either left click over
top of the pump station and select edit, or just click on the pump station editor
from the edit tool bar. Connecting pumps is accomplished by picking from
and to locations from the pump data editor.

Adding Tributaries into an Existing Reach

If you would like to add a tributary or bifurcation into the middle of an
existing reach, this can be accomplished by simply drawing the new reach,
and connecting it graphically to the existing reach at the location where you
would like the new junction to be formed. Once the new reach is connected
into the middle of an existing reach, you will first be prompted to enter a
River and Reach identifier for the new reach. After entering the river and
reach identifiers, you will be asked if you want to "Split" the existing reach
into two reaches. [I' you answer "yes", you will be prompted to enter a Reach
identifier for the lower portion of the existing reach and a Junction name for
the newly formed stream junction.

Editing The Schematic

There are several options available for editing the river system schematic.
These options include: changing labels, moving objects (such as labels,
junctions, and points in a reach), adding points to a reach or storage area,
deleting points in a reach or storage area, deleting entire reaches, deleting
junctions, numerically editing the reach schematic lines, and numerically
editing the cross section schematic lines. Editing fUllctions for the schematic
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are found under the Edit menu of the geometric data window. When a
specific editing function is selected, the interaction of the user with the
schematic is restricted to performing that type of operation. When the user is
finished performing that editing function they should turn off that editing
function by selecting it again from the Edit menu. When none of the editing
functions are turned on, the schematic goes back to the default mode of
interaction. The default interaction mode for the schematic is described in the
"Interacting with the Schematic" section of this document. A description of
each editing function follows:

Change Name: This option allows the user to change the identifiers of any
reach or junction. To change an identifier, you must be in the Change Name
edit mode. This is accomplished by selecting the Change Name option from
the Edit menu. Once you are in the Change Name edit mode, you then select
the particular label that you would like to change by clicking the left mouse
button over that label. When a label is selected, a pop up window will appear
allowing you to enter a new label. The user can continue to change names by
simply selecting the next label to be changed. The Change Name option can
only be turned offby re-selecting it from the edit menu or by selecting any
other edit option.

Move Object: This option allows you to move any label, junction, or point
in a reach. This is accomplished by first selecting Move Object from the
Edit menu, then selecting the particular object that you would like to move.
To select an object and then move it, simply place the mouse pointer over the
object, then press the left mouse button down. Move the object to the desired
location and then release the left mouse button. The Move Object option
will remain in effect until the user either turns it off (which is accomplished
by re-selecting it) or selects any other edit option.

Add Points to a Reach od SA: This option allows the user to add additional
points to the line that defines a reach or a storage area. This allows the user
to make the schematic look more like the actual river system. To add
additional points, first select Add Points to a Reach or SA from the Edit
menu. Move the mouse pointer to the location in which you would like to
add an additional point on the reach line, then click the left mouse button.
After you have finished adding points to a reach, you can move them around
by selecting the Move Object option from the Edit menu. To turn the "Add
Points to a Reach or SA" mode off, simply re-select it from the Edit menu, or
select any other edit function.

Remove Points in a Reach or SA: This option allows the user to remove
points from a reach line or a storage area. To use this option, first select
Remove Points in a Reach or SA from the Edit menu. Move the mouse
pointer over the point that you would like to delete and then click the left
mouse button. This option can only be turned offby either re-selecting the
option from the Edit menu or by selecting another edit function.

Delete Reach: This option is used to delete a reach. This is accomplished by
selecting the Delete Reach option from the Edit menu. A list box containing
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all the available reaches will appear allowing you to select those reaches that
you would like to delete. Warning - Be careful when you delete reaches.
When you delete a reach, all of its associated data will be deleted also.

Delete Junction: This option is used to delete a junction. This is
accomplished by selecting the Delete Junction option from the Edit menu. A
list box containing all the available junctions will appear allowing you to
select those junctions that you would like to delete.

Delete Storage Area: This option is used to delete a storage area. This is
accomplished by selecting Delete Storage Area from the Edit menu. A
selection box will appear allowing you to pick the storage areas that you
would like to delete.

Delete Storage Connection: This option is used to delete a storage area
connection. This is accomplished by selecting the Delete Storage Conn
option from the Edit menu. A list box containing all the available storage
area connections will appear allowing you to select the ones that you would
like to delete.

Delete Pump Station: This option allows the user to select one or more
pump stations to be deleted from the schematic. This is accomplished by
selecting Delete Pump Station from the Edit menu. A list box containing all
the available pump stations will appear allowing you to select the ones that
you would like to delete.

Delete Nodes (XS, Bridges, Culverts, ... ): This option allows the user to
delete multiple locations at one time. For example, you can delete multiple
cross sections at one time with this option. When this option is selected, a
window will appear allowing you to select all of the nodes (cross sections,
bridges, culverts, etc.) that you would like to delete.

Reach Schematic Lines: This option allows the user to numerically edit the
coordinates of the river reach schematic lines. When the river system
schematic is hand drawn on the screen, the coordinates of the river reach lines
are put into a simple coordinate system that ranges from 0.0 to 1.0 in both the
X and Y direction. However, the user has the option of taking real world
coordinates (such as UTM or State Plane coordinates) off of a map and
entering them into this table. If the user decides to use real world
coordinates, real world coordinates must be added for all of the reaches of the
schematic. If this is not done, the schematic will still be displayed in the
simple 0.0 to 1.0 coordinate system (the hand drawn coordinates). Once real
world coordinates have been entered for all of the river reaches, then the
schematic will be drawn in that coordinate system. To enter/edit the reach
schematic lines, select the Reach Schematic Lines option from the Edit
menu. Once this option is selected, a window will appear allowing the user to
enter/edit the coordinates of any of the reaches defined in the schematic.

XS Schematic Lilies: This option allows the user to numerically edit the
coordinates of the cross sectIOn schematic Jines. When the river system is
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hand drawn on the screen, the default coordinate system is a simple 0.0 to 1.0
range for both the X and Y direction. As cross sections are entered, they are
automatically scaled based on the coordinates of the river reach line and the
main channel distance between cross sections. Each cross section is drawn as
a straight line perpendicular to the river reach schematic line. The user has
the option of entering the real world coordinates (UTM or State Plane) of the
cross section schematic lines. Each cross section schematic line must have at
least two points, a start and an end, but additional points can be added if the
cross section was taken as a multi segmented line. In order for the cross
section schematic lines to be plotted in the real world coordinate system, the
user must enter real world coordinates for all of the cross sections in the
reach. To enterledit the cross section schematic lines, select the XS
Schematic Lines option from the Edit menu. Once this option is selected, a
window will appear allowing the user to enterledit the coordinates of any of
the cross section schematic lines.

Storage Area Outlines: This option allows the user to enterledit the X and Y
coordinates that define the outline of a storage area. If you are using GIS
data, these coordinates may be in the UTM or State Plane coordinate system.
If you are not using GIS data, the coordinate system for the storage areas will
just be in a ato 1.0 system. The coordinates ofa storage area can also be
edited graphically by using the Move Object option from the edit menu.

GIS Levee: This option allows the user to editlenter the coordinates for a
user specified levee. Levees can be defined in the GIS system and imported
into HEC-RAS. The coordinates will consist of X, Y, and Z (elevation).

GIS Ineffective Flow Area: This option allows the user to edit/enter the
coordinates for a user specified ineffective flow areas. Ineffective flow areas
can be defined in the GIS system and imported into HEC-RAS. The
coordinates will consist of X, Y, and Z (trigger elevation for when it will be
turned off).

Hydraulic Connection Lines: This option allows the user to edit/enter
coordinates for the line used to show a connection between two storage areas,
between a storage area and a river reach, and between two river reaches.
These lines cal also be edited graphically by using the Move Object option
from the Edit menu.

Interacting With The Schematic

In addition to modifying the river schematic, there are options available to
zoom in, zoom out, display the cross section river stationing, and reset the
viewing extent of river system schematic. Additionally, the user has the
ability to use the mouse to interact with the schematic. This is accomplished
by moving the mouse pointer over an object (river reach line, junction.
bridge, culvert, etc.) on the schematic and pressing down the left mouse
button. Once the left mouse button is pressed down, a pop up menu will
appear with options that are specific to that type of object. For example,
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when the left mouse button is pressed down over a cross section, a menu will
appear allowing the user to select options to: edit the cross section, plot the
cross section, plot the profile for the reach that the cross section is in, display
tabular output for the cross section, and plot the computed rating curve for
that cross section. Another way of interacting with the schematic is to press
the right mouse button while the mouse pointer is located any where over the
schematic drawing area. This will bring up a pop up menu that is exactly the
same as the View menu at the top of the drawing. This option is providing
for convenience in getting to the View menu options. The options available
from the View menu are as follows:

Zoom In: This option allows the user to zoom in on a piece of the schematic.
This is accomplisbed by selecting Zoom In from the View menu, then
specifying the area to zoom in on with the mouse. Defining the zoom area is
accomplished by placing the mouse pointer in the upper left corner of tbe
desired area. Then press down on tbe left mouse button and drag the mouse
to define a box containing the desired zoom area. Finally, release the left
mouse button and the viewing area will display the zoomed in schematic.
Also displayed will be a small box in tbe upper right corner of the viewing
area. This box will contain a picture of tbe entire schematic, with a rectangle
defining the area that is zoomed in. In addition to showing you where you are
at on the schematic, this zoom box allows you to move around the schematic
without zooming out and then back in. To move the zoomed viewing area,
simply hold down the left mouse button over the rectangle in the zoom box
and move it around the schematic. The zoom box can also be resized.
Resizing the zoom box is just like resizing a window.

Zoom Out: This option zooms out to an area that is twice the size of the
currently zoomed in window. Zooming out is accomplished by selecting
Zoom Out from the View menu on the geometric data window.

Full Plot: This option re-draws the plot to its full original size. The Full Plot
option is accomplished by selecting Full Plot from the View menu on the
geometric data window.

Pan: This option allows the user to move around when in a zoomed in mode.
The pan option is accomplished by selecting Pan from the View menu of the
geometric data window. When this option is selected, the mouse pointer will
turn into a hand. Press the left mouse button and hold it down, then move the
mouse. This will allow the user to move the zoomed in graphic. To turn the
pan mode off, re-select the pan option from the view menu.

Set Schematic Plot Extents: This option allows the user to set the extents of
the viewing area for the river system schematic. The user can enter a specific
coordinate system, or utilize the default data system. The default data plot
extents are from 0 to I for both the X and Y axis.

Find: This option allows the nser to have the interface locate a specific
feature on the schematic. This is especially useful when very large and
complex river systems are being modeled.
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Display River Stationing: This option allows you to display river station
identifiers on the schematic. This is accomplished by selecting Display
River Stationing from the View menu on the geometric data window.

Display Bank Stations: This option allows the user to display the main
channel bank stations on the cross section lines of the schematic. This is
accomplished by selecting Display Bank Stations from the View menu of
the geometric data window.

Display Ineffective Areas: This option allows the user to display the
location of ineffective flow areas on top of the cross section lines of the
schematic. This is accomplished by selecting Display Ineffective Areas
from the View menu of the geometric data window.

Display Levees: This option allows the user to display the location ofIevees
on the cross section lines of the schematic. This is accomplished by selecting
Display Levees from the View menu of the geometric data window.

Display XS Direction Arrows: This option allows the user to display arrows
along the cross sections in the direction in which they were extracted. This
option is useful when you have coordinates defined for the cross section, such
that the software can detect the direction that the cross section was extracted.
Cross-sections are suppose to be entered from left to right while looking
downstream. If a cross section has not been entered in this manner, it should
be reversed. I-IEC-RAS has an option to reverse the cross section stationing.
This option can be found under the Tools menu bar of the geometric data
editor. To display the cross section direction arrows, select Display XS
Direction Arrows from the View menu of the geometric data window.

Fill in Storage Areas: This option allows the user to tum on and off the fill
in color for the storage areas. Turning this off is very useful when a
background picture is loaded.

Background Pictures.

Another option available to users is the ability to add background images for
displayed behind the river system schematic. One or more pictures can be
added. To enter a background picture, press the background picture button on
the Tools menu bar (far right button). Select the add button to find a picture
file to use as a background image. The software will automatically look for a
companion file to the image, called a world file. This file contains
information about the image, including the coordinate system and the extents
of the image. The user has the option of rectifying the picture by entering
coordinates for the left, right, top, and bottom sides of the picture, with
respect to the coordinates of the river system schematic. If coordinates are
not entered for the extent of the picture, the size of the picture will be based
on its resolution and the resolution of your screen. Several graphical formats
are supported for background maps, including: ESRI shape files (.shp); Cad
files (.dgn, .dxf, .dwg); Windows bitmap (bmp, .dip); Tiff and GeoTiff(.tif,
.tff, .tiff); JFIF (jpg, jpeg); MrSID (.sid), and others.
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Cross Section Data

After the river system schematic is completed, the next step for the modeler is
to enter the cross section data. Cross section data represent the geometric
boundary of the stream. Cross sections are located at relatively short intervals
along the stream to characterize the flow carrying capacity of the stream and
its adjacent floodplain. Cross sections are required at representative locations
throughout the stream and at locations where changes occur in discharge,
slope, shape, roughness, at locations where levees begin and end, and at
hydraulic struclures (bridges, culverts, inline weirs/spillways, and lateral
weirs/spillways).

Entering Cross Section Data

To enter cross section data, the user presses the Cross Section button on the
Geometric Data window (Figure 6.1). Once the cross section button is
pressed, the Cross Section Data Editor will appear as shown in Figure 6.2
(except yours will be blank until you have added some data). To add a cross
section to the model, the user must do the following:

1. From the Cross Section Editor, select the river and the reach that you
would like to place the cross section in. This is accomplished by
pressing the down arrow on the River and Reach boxes, and then
selecting the river and reach of choice.

2. Go to the Options menu and select Add a new Cross Section from
the list. An input box will appear prompting you to enler a river
station identifier for the new cross section.

3. Enter all of the required data for the new cross section. Required data
is the data that is openly displayed in the cross section editor window.

4. Enter any desired optional information (i.e., ineffective flow areas,
levees, blocked obstructions, etc.). Optional cross section information
is found under the Options menu.

5. Press the Apply Data button in order for the interface to accept the
data. The apply data button does not save the data to the hard disk, il
is used as a mechanism for telling the interface to use the information
that was just entered. If you want the data to be saved to the hard disk
you must do that from the File menu on the geometric data window.

The required information for a cross section consists of: the river, reach and
river station identifiers; a description; X & Y coordinates (station and
elevation points); downstream reach lengths; Manning's roughness
coefficients; main channel bank stations; and contraction and expansion
coefficients. All of the required information is displayed openly on the Cross
Section Data editor (Figure 6.2). A description of this information follows:
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Figure 6.2 Cross Section Data Editor

River, Reach, and River Station. The River and Reach boxes allow the user
to select a specific hydraulic reach from the available reaches in the
schematic diagram. The river and reach labels define which reach the cross
section will be located in. The River Station tag defines where the cross
section will be located within the specified reach. The river station tag does
not have to be the actual river station of the cross section, but it must be a
numeric value. Cross sections are ordered in the reach from highest river
station upstream to lowest river station downstream. The up and down arrow
buttons next to the river station box can be used to sequentially move through
the river stations.

Description. The description hox is used to describe the cross section
location in more detail than just the river, reach, and river station. This box
has a limit of 512 characters. The first line of infonnation is displayed, unless
the button to the right of the box is pressed. Also, the first 40 characters of
the description are used as a label for cross section plots and tables.

Cross Section X & Y Coordinates. This table is used to enter the station
and elevation information of the cross section. Station and elevation
information is entered in feet (meters for metric). The cross section
stationing (x-coordinates) are entered from left to right looking in the
downstream direction. Cross section stationing must be in increasing order.
However, two or more stations can have the same value to represent vertical
walls.
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Downstream Reach Lengths. The downstream cross section reach lengths
describe the distance between the current cross section and the next cross
section downstream. Cross section reach lengths are defined for the left
overbank, main channel, and the right overbank. Cross section reach lengths
are entered in feet (meters for metric).

Manning's n Values. At a minimum, the user must specify Manning's n
values for the left overbank, main channel, and the right overbank.
Alternative roughness options are available from the Options menu.

Main Channel Bank Stations. The main channel bank stations are used to
define what portion of the cross section is considered the main channel and
what is considered left and right overbank area. The bank stations must
correspond to stations entered on the cross section X & Y coordinates table.
If the user enters a value that does not correspond to the station points of the
cross section, the interface will ask the user if they would like the value to be
automatically interpolated and added to the cross section data.

Contraction & Expansion Coefficients. Contraction and expansion
coefficients are use to evaluate the amount of energy loss that occurs because
of a flow contraction or expansion. The coefficients are multiplied by the
change in velocity head from the current cross section to the next downstream
cross section. In other words, the values entered at a particular cross section
are used to compute losses that occur between that cross section and the next
downstream cross section.

Once all of the required data for the cross section are entered, make sure you
press the Apply data button to ensure that the interface accepts the data that
was just entered.

Editing Cross Section Data

The bulk of the cross section data is the station and elevation information.
There are several features available under the Edit menu to assist the user in
modifying this information. These features include the following:

Undo Editing. This editing feature applies to all of the information on the
cross section data editor. Once data has been entered and the Apply Data
button has been pressed, the Undo Editing feature is activated. If any
changes are made from this point, the user can get the original information
back by selecting the Undo Edit option from the Edit menu. Once the Apply
Data button is pressed, the new information is considered good and the Undo
Edit feature is reset to the new data.

Cut, Copy, and Paste. Cut, Copy, and Paste features are available for the
station and elevation information on the cross section editor. These features
allow the user to pass cross section station and elevation data to and from the
Windows Clipboard. To use this feature, first highlight a cell or multiple
cells on the station and elevation table. Cells are highlighted by pressing
down on the left mOllse button and moving it over the cells that you would
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like to be highlighted. Next select either the Cut or Copy feature from the
Edit menu. If Cut is selected, the information is placed in the Windows
Clipboard and then it is deleted from the table. If Copy is selected, the
information is placed in the Windows Clipboard, but it also remains in the
table. Once the information is in the Windows Clipboard it can be pasted into
the station and elevation table of any cross section. To paste data into another
cross section, first go to the cross section in which you would like the data to
be placed. Highlight the area of the table in which you want the data to be
placed. Then select the Paste option from the Edit menu. The cut, copy, and
paste features can also be used to pass station and elevation information
between HEC- RAS and other programs.

Delete. This option allows the user to delete a single cell or multiple cells in
the station/elevation table. Once the cells are deleted, everything below those
cells is automatically moved up. To use this option, first highlight the cells
that you would like to delete, then select the Delete option from the Edit
menu. If you would like to clear cells, without moving the data below those
cells, simply highlight the cells and press the delete key.

Insert. This option allows the user to insert one or several rows in the middle
of existing data in the station/elevation table. To use this option, first
highlight the area in the table that you would like to be inserted. Then select
Insert from the Edit menu. The rows will be inserted and all of the data will
be moved down the appropriate number of rows. The user can also insert a
single row by placing the curser in the row just below where you would like
the new row to be inserted. Then select Insert from the Edit menu. The row
will be inserted and all of the data below the current row will be moved down
one row.

Cross Section Options

Information that is not required, but is optional, is available from the Options
menu at the top of the cross section data editor window (Figure 6.2). Options
consist of the following:

Add a new Cross Section. This option initiates the process of adding a cross
section to the data set. The user is prompted to enter a river station tag for the
new cross section. The river station tag locates the cross section within the
selected reach. Once the river station is entered, the cross section data editor
is cleared (except for some default values that get set) and the user can begin
entering the data for the cross section. Whenever a new cross section is
added to the data set, default values will appear for the contraction and
expansion coefficients (0.1 and 0.3 respectively). Also, if the new cross
section is not the first or most upstream cross section of the reach, the
program will set default Manning's n values equal to the n values of the cross
section just upstream of the new cross section. If the user does not want these
default values, they can simply change them to whatever values they would
like.
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Copy Current Cross Section. This option allows the user to make a copy of
the cross section that is currently displayed in the editor. When this option is
selected, the user is prompted to select a river and reach for the new section,
and then enter the a river station. Once the information is entered, the new
cross section is displayed in the editor. At this point it is up to the user to
change the description and any other information about the cross section.
This option is normally used to make interpolated cross sections between two
surveyed cross sections. Once the section is copied, the user can adjust the
elevations and stationing of the cross section to adequately depict the
geometry between the two surveyed sections.

Rename River Station. This option allows the user to change the River
Station of the currently displayed cross section.

Delete Cross Section. This option will delete the currently displayed cross
section. The user is prompted with a message stating specifically which cross
section is going to be deleted, and requesting the user to press the OK button
or the Cancel button. Once the OK button is pressed, the user will be
prompted with a question of whether or not they would like the cross section
reach lengths to be automatically adjusted to account for the removal of the
cross section. If the user answers YES then the reach lengths of the current
cross section, that is being deleted, will be added to the reach lengths of the
next upstream cross section. If the user answers NO, then the cross section
will be deleted with out adjusting any reach lengths.

Adjust Elevations. This option allows the user to adjust all of the elevations
of the currently displayed cross section. Positive or negative elevation
changes can be entered. Once the value is entered, the interface automatically
adjusts all the elevations in the table.

Adjust Stations. This option allows the user to adjust the stationing of the
currently displayed cross section. Two options are available. The first
option (Multiply by a Factor) allows the user to separately expand and/or
contract the left overbank, main channel, and the right overbank. When this
option is selected, the user is prompted to enter a multiplier for each of the
three flow elements (left overbank, main channel, and right overbank). If the
multiplier is less than one, the flow element is contracted. If the multiplier is
greater than one, the flow element is expanded. Once the information is
entered, and the user hits the OK button, the interface automatically performs
the contraction and/or expansions. The cross section should be reviewed to
ensure that the desired adjustments were performed. The second option (Add
a Constant) allows the user to add or subtract a constant value from all the
stations in the cross section. This would allow the entire cross section to be
shifted to the right or the left.

Adjust nor k Values. This option allows the user to either increase or
decrease all the n or k values of the current cross section. The user is
prompted for a single value. This value is then used as the multiplier for all
of the n or k \ialues of the current cross section.
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Skew Cross Section. This option allows the user to adjust the stationing of a
cross section based on a user entered skew angle. Cross-sections are suppose
to be taken perpendicular to the flow lines. This may not always be the case,
such as at bridges. In order for the program to use the correct flow area, the
cross section stationing must be adjusted by taking the cosine of the skew
angle times the stationing. When this option is selected, a window will
appear allowing the user to enter a skew angle. Once the angle is entered, the
software will automatically adjust the cross section stationing. The user can
get back to the original stationing by putting a zero skew into the field.

Ineffective Flow Areas. This option allows the user to define areas of the
cross section that will contain water that is not actively being conveyed
(ineffective flow). Ineffective flow areas are often used to describe portions
of a cross section in which water will pond, but the velocity of that water, in
the downstream direction, is close to or equal to zero. This water is included
in the storage calculations and other wetted cross section parameters, but it is
not included as part of the active flow area. When using ineffective flow
areas, no additional wetted perimeter is added to the active flow area. An
example of an ineffective flow area is shown in Figure 6.3. The cross­
hatched area on the left of the plot represents the ineffective flow area.

Two alternatives are available for setting ineffective flow areas. The first
option allows the user to define a left station and elevation and a right station
and elevation (normal ineffective areas). When this option is used, and if
the water surface is below the established ineffective elevations, the areas to
the left of the left station and to the right of the right station are considered
ineffective. Once the water surface goes above either of the established
elevations, then that specific area is no longer considered ineffective. In other
words, the program now assumes that the area will be conveying water in the
downstream direction, such that it now uses that area in the conveyance
calculations of the active flow area. However, the user has the option to set
the ineffective flow areas to pennanent, which will prevent them from turning
off. When this option is used, water is allowed to go over top of the
ineffective flow area.

The second option allows for the establishment of blocked ineffective flow
areas. Blocked ineffective flow areas require the user to enter an elevation, a
left station, and a right station for each ineffective block. Up to ten blocked
ineffective flow areas can be entered at each cross section. Once the water
surface goes above the elevation of the blocked ineffective flow area, the
blocked area is no longer considered ineffective. However, the user has the
option to set the blocked ineffective flow areas to permanent, which will
prevent them from turning off. When this option is used, water is allowed to
go over top of the ineffective flow area.
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Figure 6.3 Cross section with ineffective flow areas

Levees. This option allows the user to establish a left and/or right levee
station and elevation on any cross section. When levees are established, no
water can go to the left of the left levee station or to the right of the right
levee station until either of the levee elevations are exceeded. Levee stations
must be defined explicitly, or the program assumes that water can go
anywhere within the cross section. An example of a cross section with a
levee on the left side is shown in Figure 6.4. In this example the levee station
and elevation is associated with an existing point on the cross section.

The user may want to add levees into a data set in order to see what effect a
levee will have on the water surface. A simple way to do this is to set a levee
station and elevation that is above the existing ground. If a levee elevation is
placed above the existing geometry of the cross section, then a vertical wall is
placed at that station up to the established levee height. Additional wetted
perimeter is included when water comes into contact with the levee wall. An
example of this is shown in Figure 6.S.
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Obstructions. This option allows the user to define areas of the cross section
that will be permanently blocked out. Obstructions decrease flow area and
add wetted perimeter when the water comes in contact with the obstruction.
An obstruction does not prevent water from going outside of the obstruction.

Two alternatives are available for entering obstructions. The first option
allows the user to define a left station and elevation and a right station and
elevation (normal obstructions). When this option is used, the area to the
left of the left station and to the right of the right station will be completely
blocked out. An example of this type of obstruction is shown in Figure 6.6.
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Figure 6.6 Example of Normal Obstructions

Tbe second option, for obstructions, allows the user to enter up to 20
individual blocks (blocked obstructions). With this option the user enters a
left station, a right station, and an elevation for each of the blocks. An
example of a cross section with blocked obstructions is shown in Figure 6.7.
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Figure 6.7 Example of a Cross Section With Blocked Obstruction

Add a Lid to XS. This option allows the user to add a lid (similar to a bridge
deck/roadway) to any cross section. This is commonly used when trying to
model a long tunneL The ground geometry can be used to describe the
bottom half of the tunnel, while the lid can describe the top half. A lid can be
added to any number of cross sections in a row. The program treats cross
sections with lids just like any other cross section. The energy equation is
used to balance a water surface, with the assumption of open channel flow.
The only difference is that the program will subtract out area and add wetted
perimeter when the water surface comes into contact with the lid.

Add Ice Cover. This option allows the user to enter ice cover for the
currently opened cross section. For a detailed discussion of ice cover, and ice
modeling, please review the section called Modeling Ice Cover later in this
chapter.

Add a Rating Curve. This option allows the user to add a rating curve to a
cross section as an alternative to the program computing the water surface.
The user is required to enter flow versus elevation information for the rating
curve. When the program is executed in a steady flow mode, the program
will interpolate a water surface elevation from the rating curve for the given
flow of a particular profile.

Horizontal Variation in n Values. This option allows the user to enter more
than three Manning's n values for the current cross section. When this option
is selected, an additional column for n values is added to the cross section
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coordinates table as shown in Figure 6.8. A Manning's n value must be
placed in tbe first row of the table. This n value is good for all cross section
stations until a new n value shows up in the table. The user does not have to
enter an n value for every station, only at the locations where the n value is
changing.
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Figure 6.8 Cross section with horizontal variation of n values selected

Horizontal Variation in k Values. This option allows the user to enter k
values (roughness heights) instead of n values. The k values are entered in
the same manner as the horizontal variation ofn values. To learn more about
k values and how they are used in the program, see Chapter 3 of the
Hydraulic Reference manual.

Vertical Variation in n Values. This option allows the user to enter
Manning's n values that vary both horizontally as well as vertically. The user
can vary the n value either by elevation or by flow. When this option is
selected a window will appear as shown in Figure 6,9. The user enters the
stationing for horizontal changes in n values across the top in row 0 (these
stations are entered in the same manner as the horizontal variation of
Manning's n value option). The elevations in which changes occur are
entered in the tirst column. Then the actual Manning's n values are entered in
rows 1-20 (columns 2-21). The program will interpolate Manning's n values
whenever the actual water surface is between the entered elevations. 1f the
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water surface is below the first elevation entered, then the values from that
elevation will be used. Likewise, if the water surface is above the last
elevation entered, the program will use the n values from the last elevation
specified. No extrapolation is done on either side of the user entered values.

,..
r.- Vertical n based on Watef Surface r Vertical n based on Flow

RowO'Start StalJon. Row. 1·20 Mannrn .nValue.
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Cancel 1
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Clear I
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Figure 6.9 Vertical Variation of Manning's n Values Window

Plotting Cross Section Data

Once all the data have been entered for a cross section, you should plot the
cross section to inspect it for possible data errors. To plot the current cross
section from the cross section editor, select Plot Cross Section from the Plot
menu.

Stream Junctions

Entering Junction Data

Stream junctions are defined as locations where two or more streams come
together or split apa11. Junction data consist of a description, reach lengths
across the junction, tributary angles, and modeling approach. To enter
junction data the user presses the Junction button on the Geometric Data
window (Figure 6.1). Once the junction button is pressed, the junction editor
will appear as shown in Figure 6.10.
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Figure 6.10 Junction Data Editor

The junction editor will come up with one of the junctions loaded. Fill out the
description and reach lengths for the junction. Reach lengths across the
junction are entered here instead of the cross section data editor. This allows
for the lengths across very complicated confluences (i.e., flow splits) to be
accommodated. In the cross section data, the reach lengths for the
downstream cross section of each reach should be left blank or set to zero.

Selecting A Modeling Approach

In HEC-RAS a junction can be modeled by either the energy equation or the
momentum equation. The energy equation does not take into account the
angle of a tributary coming in or leaving, while the momentum equation does.
In most cases the amount of energy loss due to the angle of the tributary flow
is not significant, and using the energy equation to model the junction is more
than adequate. However, there are situations where the angle of the tributary
can cause significant energy losses. In these situations it would be more
appropriate to use the momentum approach. When the momentum approach
is selected, an additional column is added to the table next to the junction
lengths. This column is used to enter an angle for any river reach that is
coming into or exiting the main river. For the reaches that are considered to
be the main river. the angle should be left blank or set to zero. Also, the user
has the option to turn friction and weight forces on or off during the
momentum calculations. The default is to have the weight force turned off.

If there is more than one junction in the river schematic, the other junctions
can be selected from the Junction Name box at the upper left corner of the
window. Enter all the data for each junction in the river system, then close
the window by pressing the OK button in the lower left corner of the window.
When the junction data editor is closed the data are automatically applied.
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Bridges and Culverts

Once all of the necessary cross-section data have been entered, the modeler
can then add any bridges or cnlverts that are required. HEC-RAS computes
energy losses caused by structures such as bridges and culverts in three parts.
One part consists oflosses that occur in the reach immediately downstream
from the structure where an expansion of flow takes place. The second part is
the losses at the structure itself, which can be modeled with several different
methods. The third part consists of losses that occur in the reach immediately
upstream of the structure where the flow is contracting to get through the
opemng.

The bridge routines in HEC-RAS allow the modeler to analyze a bridge with
several different methods without changing the bridge geometry. The bridge
routines have the ability to model low flow (Class A, B, and C), low flow and
weir flow (with adjustments for submergence), pressure flow (orifice and
sluice gate equations), pressure and weir flow, and high flows with the energy
equation only. The model allows for multiple bridge and/or culvert openings
at a single location.

The culvert hydraulics in HEC-RAS are based on the Federal Highway
Administrations (FHWA) standard equations from the publication Hydraulic
Design of Highway Culverts (FHWA, 1985). The culvert routines include the
ability to model circular, box, elliptical, arch, pipe arch, low profile arch, high
profile arch, and semi circular culverts. The HEC-RAS program has the
ability to model multiple culverts at a single location. The culverts can have
different shapes, sizes, elevations, and loss coefficients. The user can also
specify the number of identical barrels for each culvert type.

Cross Section Locations

The bridge and culvert routines utilize four user defined cross sections in the
computations of energy losses due to the structure. A plan view of the basic
cross section layout is shown in Figure 6.11.

Cross section 1 is located sufficiently downstream from the structure so that
the flow is not affected by the structure (i.e., the flow has fully expanded).
This distance should generally be determined by field investigation during
high flows. Generally, field investigation during high flows is not possible.
The expansion distance will vary depending upon the degree of constriction,
the shape of the constriction, the magnitude of the !low, and the velocity of
the flow. Table 6.1 offers ranges of expansion ratios, which can be used for
different degrees of constriction, different slopes, and different ratios ofthe
overbank roughness to main channel roughness. Once an expansion ratio is
selected, the distance to the downstream end of the expansion reach (the
distance L, on Figure 6.11) is found by multiplying the expansion ratio by the
average obstruction length (the average of the distances A to Band C to D
from Figure 6.1 I).
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Figure 6.11 Cross Section Locations at a Bridge or Culvert

The average obstruction length is half of the total reduction in floodplain
width caused by the two bridge approach embankments, In Table 6, I, biB is
the ratio of the bridge opening width to the total floodplain width, nob is the
Manning n value for the overbank, n, is the n value for the main channel, and
S is the longitudinal slope, The values in the interior of the table are the
ranges of the expansion ratio, For each range, the higher value is typically
associated with a higher discharge,

Table 6.1
Ranges of Expansion Ratios

nob I nc-l nob /nc=2 n ob/ n c=4

b/B=O,IO S ~ 1 ft/mile 1.4 - 3,6 L3 - 3,0 L2 - 2,1
5 ft/mile 1.0 - 2,5 0,8 - 2,0 08-20

10 ft/mile 1.0 - 2,2 08 - 2,0 08 - 2,0

biB ~ 0,25 S = I ft/mile 1.6 - 3,0 14 - 2,5 L2 -2,0
5 ft/mile 15 - 2,5 L3 -20 1.3 -2,0

10 ft/mile 1.5 - 2,0 L3 - 20 13 - 2,0

biB ~ 050 S = I ttlmile 1.4 - 2,6 L3 - 1.9 L2 - 1.4
5 ttlmile L3 - 2, I 12 - 1.6 1.0 - 1A

I() ftlmile L3 - 2,0 12-1.5 1.0-1.4
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A detailed study of flow contraction and expansions at bridges was
undertaken by the Hydrologic Engineering Center. The results of this study
have been published as a research document entitled "Flow Transitions in
Bridge Backwater Analysis" (RD-42 HEC, 1995). The purpose of this study
was to provide better guidance to hydraulic engineers performing water
surface profile computations through bridges. Specifically the study focused
on determining the expansion reach length, L,; the contraction reach length,
L,; the expansion energy loss coefficient, Co; and the contraction energy loss
coefficient, Co. A summary of this research, and the final recommendations,
can be found in Appendix B of the HEC-RAS Hydraulic Reference manual.

The user should not allow the distance between cross section I and 2 to
become so great that friction losses will not be adequately modeled. If the
modeler feels that the expansion reach will require a long distance, then
intermediate cross sections should be placed within the expansion reach in
order to adequately model friction losses. The user will need to estimate
ineffective flow areas for these intermediate cross sections.

Cross section 2 is located immediately downstream from the bridge (i.e.,
within a short distance). This cross section should represent the natural
ground just outside the bridge. This section is normally located at the toe of
the downstream bridge embankment.

Cross section 3 should be located just upstream from the bridge. The
distance between cross section 3 and the bridge should be relatively short.
This distance should only reflect the length required for the abrupt
acceleration and contraction of the flow that occurs in the immediate area of
the opening. Cross section 3 represents the natural ground just upstream of
the bridge. This section is normally located at the toe of the upstream bridge
embankment.

Both cross sections 2 and 3 will have ineffective flow areas to either side of
the bridge opening during low flow and pressure flow. In order to model only
the effective flow areas at these two sections, the modeler should use the
ineffective flow area option. This option is selected from the cross section
data editor. For a detailed discussion of how to set the ineffective flow area
stations and elevations, see Chapter 5 of the Hydraulic Reference manual.

Cross section 4 is an upstream cross section where the flow lines are
approximately parallel and the cross section is fully effective. In general,
flow contractions occur over a shorter distance than flow expansions. The
distance between cross section 3 and 4 (the contraction reach length, Lcl
should generally be determined by field investigation during high flows.
Traditionally, the Corps of Engineers recommends locating the upstream
cross section a distance equal to one times the average length of the side
constriction caused by the structure abutments. The contraction distance will
vary depending upon the degree of constriction, the shape of the constriction,
the magnitude of the tlow, and the velocity of the flow. As mentioned
previously, the detailed study "Flow Transitions in Bridge Backwater
Analysis" (RD-42. HEC, 1995) was performed to provide better guidance to
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hydraulic engineers performing water surface profile computations through
bridges. A summary of this research, and the final recommendations, can be
found in Appendix B of the HEC-RAS Hydraulic Reference manual.

When the user adds a bridge at a particular river station, the program
automatically fonmulates two additional cross sections inside ofthe bridge
structure. The geometry inside of the bridge is a combination of the bounding
cross sections (2 and 3) and the bridge geometry. The bridge geometry
consists of the bridge deck, abutments if necessary, and any piers that may
exist. The user can specify different bridge geometry for the upstream and
downstream sides of the structure if necessary. Cross section 2 and the
structure information on the downstream side are used as the geometry just
inside the structure at the downstream end. Cross section 3 and the upstream
structure infonnation are used as the bridge geometry just inside the structure
at the upstream end. The user has the option to edit these internal bridge
cross sections, in order to make adjustments to the geometry.

For a more detailed discussion on laying out cross sections around bridges,
the user is referred to chapter 5 of the Hydraulic Reference Manual.

Contraction and Expansion Losses

Losses due to the contraction and expansion of flow between cross sections
are determined during the standard step profile calculations. Contraction and
Expansion losses are described in terms of coefficient times the absolute
value of the change in velocity head between adjacent cross sections. When
the velocity head increases in the downstream direction a contraction
coefficient is used; and when the velocity head decreases in the downstream
direction, an expansion coefficient is used. For a detailed discussion on
selecting contraction and expansion coefficients at bridges, the user is
referred to chapter 5 of the HEC-RAS Hydraulic Reference Manual.

Bridge Hydraulic Computations

Low Flow Computations. For low flow computations the program first uses
the momentum equation to identify the class of flow. This is accomplished
by first calculating the momentum at critical depth inside the bridge at the
upstream and downstream ends. The end with the higher momentum
(therefore most constricted section) will be the controlling section in the
bridge. The momentum at critical depth in the controlling section is then
compared to the momentum of the flow downstream of the bridge when
performing a subcritical profile (upstream of the bridge for a supercritical
profile). If the momentum downstream is greater than the critical depth
momentum inside the bridge, the class of flow is considered to be completely
subcritical (i.e., class A low flow). If the momentum downstream is less than
the momentum at critical depth in the bridge, then it is assumed that the
constriction will cause the flow to pass through critical depth and a hydraulic
jump will occur at some distance downstream (i.e., class B low flow). If the
profile is completely supercritical through the bridge then this is class Claw
flow. Depending on the class of flow the program will do the following:
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Class A low jlow Class A low flow exists when the water surface through
the bridge is completely subcritical (i.e., above critical depth). Energy losses
through the expansion (sections 2 to I) are calculated as friction losses and
expansion losses. Friction losses are based on a weighted friction slope times
a weighted reach length between sections I and 2. The average friction slope
is based on one of the four available alternatives in HEC-RAS, with the
average-conveyance method being the default. This option is user selectable.
The average length used in the calculation is based on a discharge-weighted
reach length.

There are four methods for computing losses through the bridge (from 2 to 3):

- Energy equation (standard step method)

- Momentum balance

- Yamell equation

- FHWA WSPRO method

The user can select any or all of these methods in the computations. If more
than one method is selected, the user must choose either a single method as
the final solution or tell the program to use the method that computes the
greatest energy loss through the bridge as the answer at section 3. This
allows the modeler to compare the answers from several techniques all in a
single execution of the program. Minimal results are available for all the
methods computed, but detailed results are available for the method that is
selected as the final answer.

Energy losses through the contraction (sections 3 to 4) are calculated as
friction losses and contraction losses. Friction and contraction losses between
sections 3 and 4 are calculated the same as friction and expansion losses
between sections 1 and 2.

Class Blow jlow. Class B low flow can exist for either subcritical or
supercritical profiles. For either profile, class B flow occurs when the profile
passes through critical depth in the bridge constriction. For a subcritical
profile, the momentum equation is used to compute an upstream water
surface above critical depth and a downstream water surface below critical
depth, using a momentum balance through the bridge. For a supercritical
profile, the bridge is acting as a control and is causing the upstream water
surface elevation to be above critical depth. Momentum is used again to
calculate an upstream water surface above critical depth and a downstream
water surface below critical depth. The program will proceed with forewater
calculations downstream from the bridge.

Class C loWfiow. Class C low flow exists when the water surface through
the bridge is completely supercritical. The program can use either the energy
or the momentum equation to compute the water surface through the bridge.
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Pressure Flow Computations. Pressure flow occurs when the flow comes
into contact with the low chord of the bridge. Once the flow comes into
contact with the upstream side of the bridge, a backwater occurs and oritlce
flow is established. The program will handle two cases of oritlce flow: the
t1rst is when only the upstream side of the bridge is in contact with the water;
and the second is when the bridge constriction is flowing completely full. For
the t1rst case, a sluice gate type of equation is used, as described in
"Hydraulics of Bridge Waterways" (FHWA, 1978). In the second case, the
standard full flowing orifice equation is used. The program will begin
checking for the possibility of pressure flow when the energy grade line goes
above the maximum low chord elevation. Once pressure flow is computed,
the pressure flow answer is compared to the low flow answer and the higher
of the two is used. The user has the option to tell the program to use the
water surface, instead of energy, to trigger the pressure flow calculation.

Weir Flow Computations. Flow over the bridge and the roadway
approaching the bridge will be calculated using the standard weir equation.
For high tailwater elevations the program will automatically reduce the
amount of weir flow to account for submergence on the weir. This is
accomplished by reducing the weir coefficient based on the amount of
submergence. When the weir becomes highly submerged, the program will
automatically switch to calculating losses based on the energy equation
(standard step backwater). The criteria for when the program switches to
energy based calculations is user controllable.

Combination Flow. Sometimes combinations of low flow or pressure flow
occur with weir flow. In these cases an iterative procedure is used to
determine the amount of each type of flow.

Entering and Editing Bridge Data

To enter bridge data the user presses the Bridge/Culvert button on the
geometric data window (Figure 6.1). Once the bridge/culvert button is
pressed, the Bridge/Culvert Data Editor will appear as shown in Figure 6.12
(your bridge/culvert editor will come up with a blank window until you have
entered the bridge data). To add a bridge to the model, do the following:

1. Select the river and reach that you would like to place the bridge in.
Selecting a reach is accomplished by pressing the down arrow on the
river and reach box, then selecting the river and reach of choice.

2. Go to the Options menu and select Add a Bridge and/or Culvert
from the list. An input box will appear prompting you to enter a river
station identifier for the new bridge.

3. Enter all of the required data for the new bridge. This includes:
- Bridge Deck
- Sloping Abutments (optional)
- Piers (optional)
- Bridge modeling approach information
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4. Enter any desired optional information. Optional bridge information
is found under the Options menu at the top of the window.

5. Press the Apply Data button for the interface to accept the data.
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Figure 6.12 Bridge/Culvert Data Editor

The required information for a bridge consists of: the river, reach, and river
station identifiers; a short description of the bridge; the bridge deck; bridge
abutments (if they exist); bridge piers (if the bridge has piers); and specifying
the bridge modeling approach. A description of this information follows:

River, Reach and River Station. The River and Reach boxes allow the user
to select a river and reach from the available reaches that are defined in the
schematic diagram. The reach label defines which reach the bridge will be
located in. The River Station tag defines where the bridge will be located
within the specified reach. The river station tag does not have to be the actual
river station of the bridge, but it must be a numeric value. The river station
tag for the bridge should be numerically between the two cross sections that
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bound the bridge. Once the user selects Add a Bridge andlor Culvert from
the options menu, an input box will appear prompting you to enter a river
station tag for the new bridge. After the river station tag is entered, the two
cross sectIOns that bound the bridge will be displayed on the editor.

Description. The description box is used to describe the bridge location in
more detail than just the reach and river station. This box has a limit of 256
characters. Only the first line of information is displayed, unless the button to
the right of the box is pressed. Also, the first 40 characters ofthe description
are used as a label for bridge plots and tables.

Bridge Deck/Roadway. The bridge deck editor is used to describe the area
that will be blocked out due to the bridge deck, road embankment and vertical
abutments. To enter bridge deck information the user presses the Deck
button on the Bridge/Culvert Data Editor. Once the deck button is pressed,
the Deck Editor will appear as in Figure 6.13 (except yours will be blank).
The information entered in the deck editor consists of the following:
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r- D.S Embankment 55 12
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Figure 6.13 Bridge Deck/Roadway Data Editor

Distance - The distance field is used to enter the distance between the
upstream side of the bridge deck and the cross section immediately upstream
of the bridge (see Figure 6. J4, "Upstream Distance"). This distance is
entered in feet (or meters for metric).
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Width - The width field is used to enter the width of the bridge deck along the
stream (Figure 6.14, "Bridge Width"). The distance between the bridge deck
and the downstream bounding cross section will equal the main channel reach
length minus the sum of the bridge "width" and the "distance" between the
bridge and the upstream section. The width ofthe bridge deck should be
entered in feet (meters for metric).

BOBU
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, '
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~.rJstance.. : ..

Bridge
Width

Q)
, '
: DJN nstream
I Distance I

.:~ .:

Figure 6.14 Bridge Profile With Upstream Distance, Bridge Width, and
Downstream Distance.

Weir Coefficient- Coefficient that will be used for weir flow over the bridge
deck in the standard weir equation.

Upstream Stationing, High Chord, and Low Chord - This table is used to
define the geometry of the bridge deck on the upstream side of the bridge.
The information is entered from left to right in cross section stationing. The
deck is the area between the high and low chord elevation information. The
stationing of the deck does not have to equal the stations in the bounding
cross section, but it must be based on the same origin. The Del Rowand Ins
Row buttons allow the user to delete and insert rows.

Downstream Stationing, High Chord, and Low Chord - This portion of the
table is used to define the geometry of the bridge deck on the downstream
side ofthe bridge. If the geometry of the downstream side is the same as the
upstream side, then the user only needs to press the Copy Up to Down
button. When this button is pressed, all of the upstream bridge deck
information is copied to the downstream side. If the bridge deck information
on the downstream side is different than the upstream side, then the user must
enter the infomlation into the table.

u.s. Embankment 55 - This field is used to enter the slope of the road
embankment on the upstream side of the bridge. The slope should be entered
as the horizontal to vertical distance ratio of the embankment. This variable
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is generally not used in the computations, but is used for display purposes in
the profile plot. However, if the user has selected the FHWA WSPRO bridge
method for low flow, this field will be used in the computation of the bridge
discharge coefficient.

D.S. Embankment SS - This field is used to enter the slope of the road
embankment on the downstream side of the bridge. The slope should be
entered as the horizontal to vertical distance ratio of the embankment. This
variable is generally not used in the computations, but is used for display
purposes in the profile plot. However, if the user has selected the FHWA
WSPRO bridge method for low flow, this field will be used in the
computation of the bridge discharge coefficient.

Max Allowable Submergence - The maximum allowable submergence ratio
that can occur during weir flow calculations over the bridge deck. If this ratio
is exceeded, the program automatically switches to energy based calculations
rather than pressure and weir flow. The default value is 0.95 (95 percent
submerged).

Submergence Criteria - When submergence occurs there are two choices
available to figure out how much the weir coefficient should be reduced due
to the submergence. The first method is based on work that was done on a
trapezoidal shaped broad crested weir (FHWA, 1978). The second criterion
was developed for an agee spillway shape (COE,I965). The user should
pick the criterion that best matches their problem.

Min Weir Flow El - This field is used to set the minimum elevation for which
weir flow will begin to be evaluated. Once the computed upstream energy
becomes higher than this elevation, the program begins to calculate weir flow.
However, the weir flow calculations are still based on the actual geometry of
the deck/roadway, and are not effected by this elevation. If this field is left
blank, the elevation that triggers weir flow is based on the lowest high chord
elevation on the upstream side of the bridge deck. Also, weir flow is based
on the elevation of the energy grade line and not the water surface.

Once all of the bridge deck information is entered, the user should press the
OK button at the bottom of the window. Pressing the OK button tells the
interface to accept the data and close the window. Once the deck editor
closes, the graphic of the bridge deck will appear on the Bridge/Culvert Data
window. An example of this is shown in Figure 6.15. Note! The data are
not saved to the hard disk at this point. Geometric data can only be saved
to the hard disk from the File menu of the Geometric Data window.
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Figure 6.15 Example Bridge Deck Plotted on Bounding Cross Sections

Sloping Bridge Abutments. The sloping bridge abutments editor is used to
supplement the bridge deck information. Whenever bridge abutments are
protruding towards the main channel (sloping inward abutments), it will be
necessary to block out additional area that cannot be accounted for in the
bridge deck/roadway editor. If the bridge has vertical wall abutments, then it
is not necessary to use this editor. Vertical wall abutments can be included as
part of the bridge deck/roadway data. To add sloping abutments, the user
presses the Sloping Abutment button on the Bridge/Culvert Data editor.
Once this button is pressed the Abutment data editor will appear as in Figure
6.16.

Sloping abutments are entered in a similar manner to the bridge
deck/roadway. When the editor is open, it has already established an
abutment # of 1. Generally a left and right abutment are entered for each
bridge opening. Sloping abutment data are entered from left to right, looking
in the downstream direction. In general it is usually only necessary to enter
two points to describe each abutment.
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The data for each abutment consist of a skew angle (this is optional) and lhe
station and elevation information. The station and elevation information
represents the high chord information of the abutment. The low chord
information of the abutment is assumed to be below the ground, and it is
therefore not necessary to enter it. The geometric information for each
abutment can vary from upstream to downstream. If this information is the
same, then the user only needs to enter the upstream geometry and then press
the Copy Up to Down button.

To add additional sloping abutments, the user can either press the ADD or the
Copy button. To delete an abutment, press the Delete button. Once all of the
abutment data are entered, the user should press the 0 K button. When the
OK button is pressed, the abutment information is accepted and the editor is
closed. The abutments are then added to the bridge graphic on the
Bridge/Culvert Data editor. An example of a sloping bridge abutment is
shown in Figure 6.17. This graphic is zoomed in on the left abutment of the
bridge.

6-34



Chapter 6 Enten"ng and Editing Geometric Data

... '" .
File View Options Help

J

River: ~~~~iJ c I
Reach: IJohn'ton Sia iJ River Sta.: ;=15=2.=37===iJ=;r[!]=.=U=lIJ=i

Description lCo~jnt,y Road Bridge tt341 D
BoundingXS',· 52 0 8 I 5236 IDi,tance between 84 (ft)

Select theriver for Bridge/Culveft Editing

.0

Deckl RS 52.37 Upstream (Bridge) .
Roadwa!ll

1~ J.,J
~

legend
•

Pier GrOlmd

i
, •Ineff
I •

SLoping Bank Sta
Abutment

~ 335'-I e
c

Bridge 0

~
fvlodeling >
Approach -"w 330

Culvert

9:1
_~tMultiple

325Opening
Analysis

HTab 2440 2460 2480 2500
Paramo Station (ft) .

i~ - - - J- -
- •Bridge .

Design

-

Figure 6.17 Example of a Sloping Abutment

Bridge Piers. The bridge pier editor is used to describe any piers that exist in
the bridge opening. Note! All piers must be entered through the Pier
Editor, they should not be included as part of the ground or bridge deck.
Several of the low flow bridge computations require that the piers be defined
separately in order to determine that amount of area under the water surface
that is blocked by the piers. If the piers are included with the ground or the
bridge deck, several of the methods will not compute the correct amount of
energy loss for the piers.
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To enter pier infomlation, the user presses the Pier button on the
Bridge/Culvert Data editor. Once the pier button is pressed, the pier data
editor will appear as in Figure 6.18 (except yours will not have any data in it
yet).

Pier Data Editor .....
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Figure 6.18 Pier Data Editor

When the pier data editor appears it will have already defined the first pier as
pier # I. The user is required to enter a centerline station for both the
upstream and downstream side of the pier. The skew angle is entered in
degrees that the pier is skewed from a line parallel to the flow. The skew
angle is an optional item. The pier geometry is entered as pier widths and
elevations. The elevations must start at the lowest value and go to the highest
value. Generally the elevations should start below the ground level. Any pier
area below the ground will be clipped off automatically. Pier widths that
change at a single elevation are handled by entering two widths at the same
elevation. The order of the widths in the table is very important. Keep in
mind that the pier is defined from the grouod up to the deck. [fthe pier
geometry on the downstream side is the same as the upstream side, simply
press the Copy Up to Down button after the upstream side data are entered.
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The user also has the option of defining floating pier debris. Ifthe Floating
Debris option is selected, the user will need to enter a width and a height for
the debris. The user can set a different height and width of debris for each
pier, or there is a button that will allow the user to enter a single height and
width that will be used for all of the piers.

Additional piers can be added by pressing either the Add or the Copy button.
If the piers are the same shape, it is easier to use the copy button and simply
change the centerline stations of the new pier. To delete a pier, simply press
the Delete button and the currently displayed pier will be deleted. Once all of
the pier data are entered, press the OK button. When the OK button is
pressed, the data will be accepted and the pier editor will be closed. The
graphic ofthe bridge will then be updated to include the piers. An example
bridge with piers is shown in Figure 6.19. This graphic is only the upstream
side of the bridge with a zoomed in view.
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Figure 6.19 Bridge with Piers, zoomed in view
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Bridge Modeling Approach. The Bridge Modeling Approach editor is used
to define how the bridge will be modeled and to enter any coefficients tbat are
necessary. To bring up the Bridge Modeling Approach editor press the
Bridge Modeling Approach button on the Bridge/Culvert Data editor. Once
this button is pressed, the editor will appear as shown in Figure 6.20 (except
yours will only have the default methods selected).

~~ Delete IBridge # ~.:::J [!] [!]
Low Flow Methods
Use~

r W Enelgy IStandard Slep)

r W Momentum Coel Drag Cd 12

r W YarneH (Class A on~) Pier Shape K 1;"1"".2-=5--

r I WSPRO Melhod (Class A only) WSPRO Variables I
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I r Energy Only ISlandard Slepl
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Submerged Inlel Cd IBlank lor lable) I

;.,....,.--
Submerged Inlel + Oullel Cd 103

Max Low Chord (Blank 101 defaull) ;"'1---

OK Cancel Help

Select set of bridge coelficients to Edit

Figure 6.20 Bridge Modeling Approach Editor

When the Bridge Modeling Approach editor comes up it will be ready to
enter data for the first bridge opening (coefficient set # 1). If there is more
than one bridge opening at the current location, the user can either use a
single set of modeling approaches and coefficients, or establish a different set
for each bridge opening.

Establishing a bridge modeling approach consists of defining which methods
the program will use for low flow computations and high flow (flow at or
above the maximum low chord) computations. The user can instruct the
program to use any or all of the low flow methods during the computations by
clicking the bultons under the Compute column. If either the Momentum or
Yarnell method are selected, the user must enter a value for the pier loss
coefficient that corresponds to that method. If the WSPRO method is
selected, the user must press the "WSPRO Variables" bulton and enter
additional information that is required for the method. Once the WSPRO
Variables bulton is pressed. a data editor as shown in Figure 6.21 will
appear.
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As shown in Figure 6.21, there are several variables that must be entered as
well as some options that are available to the user. All of the required
variables shown on the WSPRO data editor are used in the computation of the
discharge coefficient, C, which is used in the WSPRO expansion loss
equation. A detailed discussion of how the discharge coefficient is computed
can be found in appendix D of the HEC-RAS Hydraulic Reference manual.
The following is a description of each of the variables on the WSPRO Data
Editor:

EI ojthe top oj the Embankment - These fields are used for entering the
elevation of the top of the embankment (top of road) at the edges of the
bridge opening. An elevation must be entered for both the left and right side
of the bridge opening.

E/ ojthe toe ojthe Abutment - These fields are used for entering the elevation
of the abutment toe (elevation at the station in which the abutment toe
intersects with the natural ground inside the bridge opening) on both the left
and right side of the bridge opening.

Abutment Type - This field is used for selecting the type of abutments. There
are four abutment types available from this selection box.
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Slope of the Abutments - This field is used for entering the slope of the
abutments. This slope is taken as the horizontal distance divided by the
vertical distance. If the abutments are vertical walls, then this field should be
left blank or set to zero. Ifthe left and right abutments do not have the same
slope, take an average of the two and enter that into this field.

Top Width ofEmbankment - This field is used for entering the width ofthe
top of the road embankment, in the area of the bridge opening. If the
topwidth of the embankment varies from one end of the bridge opening to the
other, use an average of the two widths.

Centroid stationing of the projected bridge opening at the approach cross
section - For the WSPRO bridge method, it is necessary to calculate the water
surface topwidth inside of the bridge opening, and then project that width
onto the approach cross section. The program calculates the conveyance
within this projected width at the approach cross section. This conveyance is
used in calculating a channel contraction ratio, which is an integral part in the
calculation of the discharge coefficient. Ifthis field is left blank, the program
will automatically center the computed topwidth, such that the center of the
topwidth will be at the center of conveyance at the approach cross-section.
The user can override this by entering their own centroid stationing value for
the approach cross section.

Wing Walls - This field is used for selecting the type of wing walls. There are
three choices available in the selection box: No wing walls present; Angular
wing walls; and Rounded wing walls. Ifthe user selects "Angular wing
walls", then the fields labeled "Angle of Wing Wall" and "Length of Wing
Wall" become active and must be filled out. If the user selects "Rounded
wing walls", then the fields "Length of wing walls" and "Radius of entrance
rounding" become active and must be filled out. If the user selects "No wing
walls present" then no other information on wing walls is necessary. For
more infonnation on wing walls see appendix 0 of the HEC-RAS Hydraulic
Reference manual.

Guide Banks Type - This field is used for selecting the type of guide banks if
any exist. There are three choices available from the selection box: No guide
bank present; Straight; and Elliptical. If the user selects "Straight" then the
fields labeled "Length of guide banks", "Offset of Guide Banks", and "Skew
of Guide Banks" become active and must be filled out. If the use selects
"Elliptical" then only the fields "Length of Guide Banks" and "Offset of
Guide Banks" become active. If the user selects "No Guide Bank present"
then no other information about guide banks is necessary. For more
information on Guide Banks see appendix D ofthe HEC-RAS Hydraulic
Reference manual.
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Optional Contraction and Expansion Losses - This box allows the user to tum
on contraction and expansion losses at locations that are traditionally not in
the WSPRO methodology. The basic WSPRO bridge method only computes
expansion losses in the expansion reach (between the exit cross section and
the section just downstream of the bridge). This option allows the user to turn
on contraction and expansion losses individually at the following locations:
downstream inside of the bridge; upstream inside of the bridge; upstream
outside of the bridge; at the end of a guide bank (if guide banks exist); and at
the approach cross section. The default for the WSPRO method is that
contraction and expansion losses will not be calculated at these locations.
Users should not turn these options on unless they feel that the standard
WSPRO bridge approach is not producing enough energy loss through the
bridge.

Two other options that the user has control over are: specifying that the piers
are continuous the whole way through the bridge or not, and using the
Geometric Mean friction slope averaging technique through the bridge
computations (from exit to approach section). The default for the WSPRO
methodology is to assume that the piers are continuous through the bridge,
and to use the Geometric Mean friction slope method.

After all of the variables have been entered, the user must press the OK
button for the WSPRO variables to be accepted. For more information about
the computation of the discharge coefficient, and these data variable, see
appendix D of the HEC-RAS Hydraulic Reference manual.

Once the user has selected which low flow bridge methods will be computed,
they must also specify which of those methods will be used as the final
answer to continue the computations on upstream with. Only one of the
methods can be selected as the answer to "Use" in order to continue the
computations upstream. An alternative to selecting a single method to use is
to instruct the program to use the answer with the highest computed upstream
energy elevation. This is accomplished by pressing the button under the
"Use" column that corresponds to the Highest Energy Answer text field.

For high flows, the modeler can choose between Energy based calculations or
pressure and weir flow calculations. If pressure and weir flow is the selected
high flow method, the user must enter coefficients for the pressure flow
equations. The first coefficient applies to the equation that is used when only
the upstream side (inlet) of the bridge is submerged. If this coefficient is left
blank, the program selects a coefficient based on the amount of submergence.
If the user enters a coefficient, then that value is used for all degrees of
submergence. The second coefficient applies to the equation that is used
when both the upstream and downstream end of the bridge is sub-merged.
Generally this coefficient is around 0.8. For more information on pressure
flow coefficients see Hydraulics of Bridge Waterways (FHWA, 1978).

Max LolV Chord - This field is used to set the maximum elevation of the deck
low chord, and therefore the elevation at which pressure flow begins to be
calculated. Jf this field is left blank, then the elevation that triggers pressure
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flow calculations is based on the highest low chord elevation on the upstream
side of the bridge deck. If the user enters a value in this field, then the value
set will be used to trigger when pressure flow calculations begin. Pressure
flow is triggered when the energy elevation exceeds the maximum low chord.
When pressure flow is calculated, the answer is compared to the low flow
answer and the higher of the two is selected. Altematively, the user can tell
the program to use the water surface instead of the energy elevation to trigger
pressure flow calculations. This option can be found under the Bridge and
Culvert Options section of this manual.

Once all of the bridge modeling approach information is entered, the user
should press the OK button. When the OK button is pressed the information
will be accepted and the editor will close. Remember! The data are not
saved to disk at this point, it is only accepted as being valid. To save the
geometric data, use the File menu from the Geometric Data Editor window.

Bridge Design Editor

The bridge design editor allows the user to enter or modify bridge data
quickly and conveniently. With this editor the user can enter the
deck/roadway data, sloping abutments, and pier information. To put together
a bridge with this editor, the user would do the following:

1. From the Geometric Data window, open the Bridge/Culvert data
editor. Select the River and Reach in which you would like to place
the bridge.

2. Go to the Options menu and select Add a Bridge and/or Culvert
from the list. An input box will appear prompting you to enter a river
station identifier for the new bridge.

3. Open the Bridge Design editor by pressing the Bridge Design button
on the lower left side of the Bridge/Culvert Data editor.

4. Enter the required data for the bridge deck/roadway, sloping
abutments (optional), and piers (optional).

When the Bridge Design button is pressed, a window will appear as shown in
Figure 6.22. The user only has to enter a minimal amount of information to
build or edit the bridge. To create the bridge deck/roadway, the user must
enter a high cord elevation (top of road) and a low cord elevation (maximum
elevation inside of the bridge opening).
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Figure 6.22 Bridge Design Editor

The user has the option to limit the width of the bridge opening by selecting
the Add Vertical Walls in Deck option. When this option is selected, the
bridge opening will be limited to either the main channel bank stations (this is
the default) or a user specified width (this is optional). Everything left and
right of the bridge opening will be completely filled in all the way to the
ground elevations. If the user enters a bridge opening width, the opening will
be centered between the main channel bank stations.

The nser also has the option to enter sloping abntments. Sloping abutments
should only be entered after selecting to limit the width of the bridge opening
with the vertical walls option. To enter sloping abutments, the user only has
to enter a slope in units of horizontal to vertical. The program will
automatically build a left and right sloping abutment that starts in the upper
left and right corners of the bridge opening.

Once all of the bridge deck/roadway information is entered, the user can have
the program build the deck/roadway by pressing the Make Deck/Roadway
button.

The last option available in the Bridge Design editor is to enter pier
information. The user enters the number of piers, the upstream and
downstream stationing of the left most pier, the spacing between the
centerline of the piers, and the width of the piers. The user then presses the
Make Piers button to have the interface build the piers.
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After all of the bridge data are entered, the user presses the Close button to
get out of the editor. The bridge data can be changed at any time by either
going back into the Bridge Design editor and entering new values, or by
going to the more detailed editors for the bridge deck/roadway, sloping
abutments, and piers.

Culvert Hydraulic Computations

The culvert hydraulic computations in HEC-RAS are similar to the bridge
hydraulic computations, except the Federal Highway Administration's
(FHWA) standard equations for culvert hydraulics under inlet control are
used to compute the losses through the structure. Because of the similarities
between culverts and other types of bridges, the cross section layout, the use
of ineffective areas, the selection of contraction and expansion coefficients,
and many other aspects of bridge analysis apply to culverts as well.

The culvert routines in HEC-RAS have the ability to model nine different
types of culvert shapes. These shapes include box (rectangular), circular,
elliptical, arch, pipe arch, semi circular, low profile arch, high profile arch,
and Can Span culverts.

The analysis of flow in culverts is complicated. It is common to use the
concepts of "Inlet" control and "Outlet" control to simplify the analysis. Inlet
control flow occurs when the flow carrying capacity of the culvert entrance is
less than the flow capacity of the culvert barrel. Outlet control flow occurs
when the culvert carrying capacity is limited by downstream conditions or by
the flow capacity of the culvert barrel. The HEC-RAS culvert routines
compute the headwater required to produce a given flow rate through the
culvert for inlet control conditions and for outlet control conditions. [n
general, the higher headwater "controls," and an upstream water surface is
computed to correspond to that energy elevation.

Inlet Control Computations. For inlet control, the required headwater is
computed by assuming that the culvert inlet acts as an orifice or a weir.
Therefore, the inlet control capacity depends primarily on the geometry of the
culvert entrance. Extensive laboratory tests by the National Bureau of
Standards, and the Bureau of Public Roads (now, FHWA), and other entities
resulted in a series of equations which describe the inlet control headwater
under various conditions. These equations are used by HEC-RAS in
computing the headwater associated with inlet control.

Outlet Control Computations. For outlet control flow, the required
headwater must be computed considering several conditions within the
culvert and the downstream tailwater. For culverts flowing full, the total
energy loss through the culvert is computed as the sum of friction losses,
entrance losses, and exit losses. Friction losses are based on Manning's
equation. Entrance losses are computed as a coefficient times the velocity
head in the culvert at the upstream end. Exit losses are computed as a
coefficient times the change in velocity head from just inside the culvert (at
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the downstream end) to outside the culvert.

When the culvert is not flowing full, the direct step backwater procedure is
used to calculate the profile through the culvert up to the culvert inlet. An
entrance loss is then computed and added to the energy inside the culvert (at
the upstream end) to obtain the upstream energy (headwater). For more
information on the hydraulics of culverts, the reader is referred to Chapter 6
of the HEC-RAS Hydraulics Reference manual.

Entering and Editing Culvert Data

Culvert data are entered in the same manner as bridge data. To enter culvert
data the user presses the Bridge/Culvert button on the Geometric Data
window (Figure 6.1). Once this button is pressed, the Bridge/Culvert Data
Editor will appear (Figure 6.12). To add a culvert group to the model the user
must then do the following:

I. Select the river and reach that you would like to place the culvert in.
This selection is accomplished by pressing the down arrow on the
river and reach boxes and then selecting the river and reach of choice.

)

2. Go to the Options menu of the Bridge/Culvert editor and select Add
a Bridge and/or Culvert from the list. An input box will appear
prompting you to enter a river station identifier for the new culvert
group. After entering the river station, press the OK button and the
cross sections that bound the new culvert group will appear in the
editor.

3. Enter all of the required data for the culvert group. This includes the
road embankment information and the culvert specific data. The
roadway information is entered in the same manner as a bridge (using
the deck/roadway editor). To enter culvert specific data, press the
Culvert button on the Bridge/Culvert Data editor.

4. Once all of the culvert data are entered, press the OK button in order
for the interface to accept the information.

River, Reach and River Station. The River and Reach boxes allow the user
to select a river and reach from the available reaches that were put together in
the schematic diagram. The reach label defines which reach the culvert will
be located in. The River Station tag defines where the culvert will be located
within the speci fied reach. The River Station tag does not have to be the
actual river station of the culvert, but it must be a numeric value. The River
Station tag for the culvert should be numerically between the two cross
sections that bound the culvert. Once the user selects Add a Bridge and/or
Culvert from the options menu, an input box will appear prompting you to
enter a River Station tag for the new culvert. After the River Station tag is
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entered, the two cross sections that bound the culvert will be displayed on the
editor.

Description. The description box is used to describe the culvert location in
more detail than just the river, reach and river station. This box has a limit of
256 characters. Only the first line of information is displayed, unless the
button to the right of the box is pressed. Also, the first 40 characters of the
description are used as a label for culvert plots and tables.

Culvert Road Embankment. The culvert road embankment is virtually the
same as the bridge deck/roadway information. The road embankment is used
to describe the area blocking the stream and the roadway profile. The only
difference in the infonnation for culverts is that the low chord elevations
should be left blank or set to elevations below the ground data. This will
cause the road embankment to completely fill the channel up to the roadway
elevations (high chord data). Therefore, the· only opening below the roadway
will be whatever culvert openings are entered.

To enter the culvert roadway information, press the Deck/Roadway button on
the Bridge/Culvert Data Editor window. For an explanation of the deck
information, please review the section entitled Bridge Deck/Roadway found
earlier in this chapter.

Culvert Data. To enter culvert specific information, press the Culvert
button on the Bridge/Culvert Data Editor window. When this button is
pressed, the Culvert Data Editor will appear as shown in Figure 6.23 (except
yours will be blank). The information entered in the Culvert Data Editor
consists of the following:
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Figure 6.23 Culvert Data Editor

Culvert fD# - The culvert identifier (ID#) is automatically assigned to
"Culvert # I" the first time you open the editor. The user can enter up to ten
culvert types if they are working on a multiple culvert, opening problem. If
all of the culvert barrels are exactly the same, then only one culvert type
(CulvertID#) should be entered. The number of barrels is an input parameter
in the culvert data. If the user has culverts that are different in shape, size,
elevation, or loss coefficients, then additional culverts types (Culvert ID#'s)
must be added for each culvert type. To add an additional culvert type you
can either use the Add or Copy buttons. The Add button increments the
culvert ID# and clears the culvert editor. The Copy button increments the
culvert ID# and makes a copy of the original culvert data. Once a copy is
made of a culvert, the user can change any of the existing culvert information.
Culverts can be deleted by pressing the Delete button.

Solution Criteria - This option allows the user to select between taking the
higher of the inlet control and outlet control answers (Highest U.S. EO), or
specifically selecting the Inlet conlrol or Outlet control answer. The default is
to let the program compute both and take the higher of the two. In general
this should be left this way. The only time a user should specifically select
Inlet control or Outlet control, is when they feel the program is in error by
selecting the higher of the two answers.
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Rename - This button allows the user to put in their own identifier for each of
the culvert types. By default the culvert types will be labeled "Culvert #1,"
"Culvert #2," and so on. The user can enter up to twelve characters for each
culvert type.

Shape - The shape selection box allows the user to select from one of the nine
available shapes. This selection is accomplished by pressing the down arrow
on the side of the box, then selecting one of the nine available shapes.

Span - The span field is used to define the maximum width inside of the
culvert. The span is left blank for circular culverts.

Rise - The rise field describes the maximum height inside of the culvert.

Chart #. - This field is used to select the Federal Highway Administration
Chart number that corresponds to the type and shape of culvert being
modeled. Once the user has selected a culvert shape, the corresponding
FHWA chart numbers will show up in the chart # selection box. More
information on FHWA chart numbers can be found in the Hydraulics
Reference manual.

Scale. - This field is used to select the Federal Highway Administration Scale
number that corresponds to the type of culvert entrance. Once the user has
selected a culvert shape and chart #, the corresponding FHW A scale numbers
will show up in the scale selection box. More information on FHWA scale
numbers can be found in the Hydraulics Reference manual.

Distance to Upstream XS - This field is used to locate the culvert in space,
relative to the two cross sections that bound the culvert crossing. The user
should enter the distance between the upstream cross section and the
upstream end of the culvert barrel.

Culvert Length - The culvert length field describes the length of the culvert
along the centerline of the barrel.

Entrance Loss Coefficient - The coefficient entered in this field will be
multiplied by the velocity head inside of the culvert at the upstream end. This
value represents the amount of energy loss that occurs as now transitions
from the upstream cross section to inside the culvert barrel. This coefficient
is used in the outlet control computations.

Exit Loss Coefficient - The coefficient entered in this field will be multiplied
by the change in velocity head from inside the culvert to outside the culvert at
the downstream end. This value represents the energy loss that occurs as
water exits the culvert. This coefficient is used in the outlet control
computations.

Manning's nfol' Top - The n-value fields are used for entering the Manning's
n values of the culvert barrel. This version of HEC-RAS allows the user to
enter a separate n value for the top (which includes top and sides) of the
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culvert, as well as for the bottom. If the culvert has the same roughness for
the top and bottom, the user can enter the value for the top. The Manning's n
value for the bottom will automatically be copied from the top field.

Manning's njar Bottom - This field is used to enter a Manning's n value for
the bottom of the culvert. This n value will be used up to a user specified
depth inside of the culvert. When the water surface gets higher than that
depth, a composite Manning's n value is computed based on the bottom and
top n values and their corresponding wetted perimeters.

Depth to use Bottom n - This field is used to specify the depth that the
"Bottom n value" is applied inside of the culvert. The surface of the culvert
below this depth is given the n value for the bottom of the culvert, while the
surface of the culvert above this depth is given the n value for the top of the
culvert.

Depth Blocked - This field is used to block off a portion of the bottom of the
culvert. When a value is entered into this field, the culvert is completely
blocked up to the depth specified. This blocked out area persists the whole
way through the culvert.

Upstream invert Elevation - This field is used to describe the elevation of the
culvert invert at the upstream end.

Downstream invert Elevation - This field is used to describe the elevation of
the culvert invert at the downstream end.

# identical Barrels - This field is used to display the number of identical
barrels. The number of identical barrels is limited to 25. To enter more than
one identical barrel, the user must provide different centerline stationing
information for each barrel. As the centerline stationing information is added,
the number of identical barrels will automatically change to reflect the
number of centerline stations. The user does not enter anything into this field,
it is just used to display the number of identical barrels.

Centerline Stations - This table is used to enter the stationing of each culvert
barrel. Centerline stations must be provided for both the upstream and
downstream side of each culvert barrel.

Once all of the culvert infonnation is entered, the user should press the OK
button at the bottom of the window. Pressing the 0 K button tells the
interface to accept the data and close the window. Once the culvert editor is
closed, the graphic of the culvert will appear on the Bridge/Culvert Data
editor window. An example culvert with two culvert types and two identical
barrels for each culvert type is shown in Figure 6.24. Note! The data are
not saved to the hard disk at this point. Geometric data can only be saved
from the File menu on the Geometric Data window.
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Figure 6.24 Bridge/Culvert Data Editor with example culvert

Bridge and Culvert Options

Some additional options that are available, but not required, are found under
the Options menu from the Bridge/Culvert Data Editor. These include the
following:

Add a Bridge and/or Culvert. This option initiates the process of adding a
bridge or culvert to the data set. The user is prompted to enter a river station
tag for the new bridge or culvert. The river station tag locates the bridge or
culvert within the selected reach. Once the river station is entered, the
Bridge/Culvert Data editor is cleared and tbe user can begin entering the data
for that new bridge or culvert.

Copy Bridge and/or Culvert. This option allows the user to make a copy of
the bridge and/or culvert crossing and place it in another reach and/or river
station within the current project.
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Rename River Station. This option allows the user to change the river
station of the currently opened Bridge and/or Culvert crossing.

Delete Bridge and/or Culvert. This option will delete the currently
displayed bridge or culvert. The user is prompted with a message stating
specifically which bridge or culvert is going to be deleted, and requesting
them to press the OK button or the Cancel button.

Internal Bridge Cross-Sections. This option allows the user to edit the two
cross sections inside of a bridge. These two cross seclions are a copy of the
cross sections just upstream and downstream of the bridge. If the ground
elevations inside of the bridge are different than just outside of the bridge,
then the internal bridge cross sections should be modified to reflect the
changing elevations. This option allows the user to change the station and
elevation data, roughness coefficients, and main channel bank stations for
each of the two internal bridge cross sections.

Momentum Equation. This option allows the user to change the
components of the momentum equation. The momentum equation is one of
the optional low flow methods in the bridge roulines. The default momentum
equation includes terms in the equation to account for friction losses and the
weight of water component. The user can tum either or both of these
components off from this option.

Momentum Class B Defaults. If the program computes that the flow must
pass through critical depth inside the bridge (Class B flow), critical depth will
automatically be located inside the bridge at the most constricted cross
section. If both cross sections are identical, the program will locate critical
depth at the upstream inside cross section. This option allows the user to
control where the program sets critical depth for class B flow. If the user
feels that it would be better to set critical depth inside the bridge at the
downstream end, then this can be selected.

Pressure Flow Criteria. This option allows the user to select either the
energy grade line or the water surface, to be used as the criterion for when the
program begins checking for the possibility of pressure flow. By default the
program uses the energy grade line. This does not change how pressure flow
is calculated, only when the program will begin checking for pressure flow.

Ice Option. This option allows the user to select how ice will be handled
inside of the bridge during ice computations. This option is only pertinent if
the user is performing a profile computation with the effects of ice included.
When this option is selected, a window will appear asking the user to select
one of three available options. These options include: no ice inside of the
bridge; a constant amount of ice through the bridge; dynamic ice effects are to
be computed through the bridge.
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Skew Bridge/Culvert. This option allows the user to make adjustments to
bridge/culvert data that is skewed (i.e. not perpendicular to the flow lines
going through the bridge/culvert. When this option is selected, a window will
appear allowing the user to enter a skew angle for the deck/roadway, as well
as the piers. The stationing of the deck/roadway is reduced, by multiplying it
by the cosine of the user entered skew angle. Additionally, the user has the
option to adjust the upstream and downstream cross sections bounding the
bridge by the same skew angle. A separate skew angle is entered for bridge
piers. The piers are assumed to go the whole way through the bridge as a
single continuous pier.

Bridge and Culvert View Features

Several options are available for viewing the bridge/culvert geometric data.
These options include: Zoom In; Zoom Out; Display Upstream XS; Display
Downstream XS; Display Both; Highlight Weir, Opening Lid and Ground;
Highlight Piers; and Grid. These options are available from the View menu
on the bridge/culvert data editor.

Zoom In. This option allows the user to zoom in on a piece of the bridge or
culvert. This is accomplished by selecting Zoom In from the View menu,
then specifying the area to zoom in on with the mouse. Defining the zoom
area is accomplished by placing the mouse pointer in the upper left comer of
the desired area. Then press down on the left mouse button and drag the
mouse to define a box containing the desired zoom area. Finally, release the
left mouse button and the viewing area will display the zoomed in area of the
bridge or culvert.

Zoom Out. This option displays the bridge or culvert back into its original
size before you zoomed in. Zooming out is accomplished by selecting Zoom
Out from the View menu bar on the bridge/culvert data editor.

Full Plot. When this option is selected, the graphic is automatically redrawn
back to its full extent, showing the entire bridge/culvert.

Pan. When this option is selected, the user can move the zoomed in portion
of the graphic. This is accomplished by first selecting the Pan option, then
pressing and holding down the left mouse button while over the graphic.
Next, move the graphic in the desired direction, and then release the left
mouse button. The graphic will be redrawn with a new portion ofthe graphic
shown in the zoomed in area.

Display Upstream XS. When this option is selected, only the upstream side
ofthe bridge or culvert will be displayed.

Display Downstream XS. When this option is selected, only the
downstream side of the bridge or culvert will be displayed.

Display Both. When this option is selected, both the downstream and
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upstream sides of the bridge will be displayed in the viewing area.

Highlight Weir, Opening Lid and Ground. When this option is selected,
various portions of the bridge/culvert graphic will be highlighted. The
program will highlight in red the combination of the deck/roadway high cord
and any ground to the left and right of this data. The red color shows what
the program will use for weir flow if the Pressure and Weir option is selected
for high flows.

The program will also highlight any bridge openings. Within the bridge
opening, the ground information will be highlighted in blue and the lid of the
opening (deck/roadway low cord data) will be highlighted in green. If the
any of these three colors show up in an area where they should not be, then
there must be a geometric mistake in the data. This option is very useful for
detecting any data entry errors that may otherwise go unnoticed.

Highlight Piers. When this option is turned on the interface will highlight
what it thinks is the extent of the pier information. This option allows the
user to see exactly what the program thinks piers are, and to see how the pier
information has been clipped. Piers are clipped below the ground and above
the low chord of the bridge.

Grid. This option allows the user to have a grid overlaid on top of the bridge
or culvert graphic.

Multiple Bridge and/or Culvert Openings

HEC-RAS has the ability to model multiple bridge and/or culvert openings at
any individual river crossing. Types of openings can consist of bridges,
culvert groups (a group of culverts is considered to be a single opening), and
conveyance areas (an area where water will flow as open channel flow, other
than a bridge or culvert opening). Up to seven openings can be modeled at a
given location, and any combination of bridges and culvert groups can be
used. Conveyance type openings can range from zero to a maximum of two,
and the conveyance areas must be located on the far left and far right of the
river crossing.

An example multiple opening is shown in Figure 6.25. As shown in this
example, there are three types of openings: a conveyance area (left side,
labeled as opening #1), a bridge (labeled as opening #2), and a culvert group
(labeled as opening #3). During low flow conditions, flow will be limited to
the bridge opening. As flow increases, the culverts will begin to take some of
the flow away from the bridge opening. The conveyance area was defined as
ineffective flow (no conveyance) until the water surface goes above the top of
the bridge. This was accomplished by setting blocked ineffective flow areas.
In this example, three blocked ineffective flow areas were established: one to
the left of the bridge (which encompasses the whole conveyance area). one
between the bridge and the culvert group, and one to the right of the culvert
group.
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Figure 6.25 Example Multiple Opening River Crossing

Entering Multiple Opening Data

Multiple opening data are entered in the same manner as any other bridge or
culvert crossing. In general, the user should perform the following steps to
enter multiple opening data:

1. Press the Bridge/Culvert button on the Geometric Data window.

2. Select the river and reach in which you would like to place the
multiple opening river crossing. This is accomplished from the River
and Reach boxes near the top of the window.

3. Select Add a Bridge and/or Culvert from the Options menu of the
bridge and culvert editor. Enter the river station at which you want to
place the multiple opening crossing. Once you have done this, the
two cross sections that bound this river station will appear in the
window. These two cross sections, along with the bridge and culvert
information, will be used to formulate the (wo cross sections inside
the multiple opening river crossing.

4. Enter the deck and road embankment data by using the
Deck/Roadway editor.
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5. Enter any piers or sloping abutments that are required.

6. Select the Bridge Modeling Approach button and enter a set of
coefficients and modeling approaches for each bridge opening.

7. Enter Culvert data for any culvert openings.

8. Select the Multiple Opening Analysis button on the bridge and
culvert editor. Enter the types of openings and their station limits.
Start at the left most station of the crossing and work your way to the
right end. This is explained in greater detail under the section entitled
"Defining the Openings".

Deck/Road Embankment Data. There can only be one deck and road
embankment entered for any bridge and/or culvert crossing. The deck editor
is used to describe the area that will be blocked out due to the bridge deck and
road embankment. As shown by the gray shaded area in Figure 6.25, the
deck and roadway data are used to block out area around the bridge as well as
around the culverts. In the area of the bridge, high and low chord information
is entered in order to define the top of road as well as the bridge opening. In
the area of the culverts, the high chord information is entered to define the
rest of the top of the road embankment. However, the low chord information
can be left blank, or set to elevations below the ground, because the culvert
data define the culvert openings.

Piers and abutments. All piers are entered from the pier editor, which was
described previously under bridge data. The number of bridge openings has
no impact on how pier data are entered. Piers are treated as separate
information. Once the user establishes that there is more than one bridge
opening, the program is smart enough to figure out which piers go with which
opening. If any sloping abutment data are required for a bridge opening, it
can be entered as described previously under the bridge data section.

Bridge Modeling Approach. A bridge modeling approach and coefficient
set must be established for at least one bridge opening. If there is more than
one bridge opening, and the user has only established a single coefficient set
and bridge modeling approach, those data will be used for all of the bridge
openings. The user can establish a different set of coefficients and modeling
approaches for each bridge opening.
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Figure 6.26 Bridge Modeling Approach Editor

As shown in Figure 6.26, the user must enter information under the Bridge
Modeling Approach editor for at least one bridge Opening. Bridge openings
are referred to as Bridge # I, Bridge # 2, etc., up to the number of bridge
openings. Bridge # 1 represents the left most bridge opening while looking in
the downstream direction. Bridge # 2 represents the next bridge opening to
the right of Bridge # I, and so on. The user can enter additional coefficient
sets and modeling approaches by selecting either the Add or Copy button. If
either of these buttons is selected, the Bridge # will automatically be
incremented by one. The user can then enter or change any of the
information on the editor for the second bridge opening. Any bridge opening
that does not have a corresponding coefficient set and modeling approach,
will automatically default to what is set for Bridge # I.

)

Culvert Data. Culvert information is added in the same manner as described
in the previous section called "Entering and Editing Culvert Data." Culverts
will automatically be grouped based on their stationing.
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Defining The Openings

Once all of the bridge and/or culvert data are entered for a multiple opening
river crossing, the last step is to define the number and type of openings that
are being modeled. This is accomplished by pressing the Multiple Opening
Analysis button on the Bridge/Culvert Data editor. Once this button is
pressed, an editor will appear as shown in Figure 6.27 (except yours will be
blank the first time you bring it up).
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Figure 6.27 Multiple Opening Analysis window

The user selects from the three available opening types: Conveyance; Culvert
Group; and Bridge. Openings must be established in order from left to right,
while looking in the downstream direction. In addition to establishing the
number and types of openings, the user must also enter a Station Left and a
Station Right for each opening. These stations are used to establish limits for
each opening as well as stagnation points. Stagnation points are the locations
at which flow separates (on the upstream side) from one opening to the next
adjacent opening. Stagnation points can either be set to fixed locations or
they can be allowed to migrate within limits.

As shown in Figure 6.27 (numerical representation) and Figure 6.25
(graphical representation), there are three openings established in this
example. The first opening is defined as a conveyance area, and it ranges
from station 98 (the left most station of the section) to station 260. That
means that any water in this area will be treated as normal open channel flow,
and the water surface will be calculated by performing standard step
calculations with the energy equation. The second opening is the bridge
opening. This opening has a left station of260 and a right station of740.
This bridge will be modeled by using the cross section data, bridge deck. and
pier information that lie within these two stations (260 and 740). The bridge
coefficients and modeling approach for this opening will be based on the data

6-57



Chapter 6 Entering and Editing Geometric Data

entered for bridge opening #1, since it is the first bridge opening. The third
opening is a culvert group. This opening has a left station of 650 and a right
station of 940. Any culverts that lie within these stations will be considered
as being in the same culvert group.

Notice that the right station of the bridge opening overlaps with the left
station of the culvert group. This is done on purpose. By overlapping these
stations, the user is allowing the program to calculate the location of the
stagnation point between these two openings. This allows the stagnation
point to vary from one profile to the next. In the current version of the HEC­
RAS software, stagnation points are allowed to migrate between any bridge
and culvert group openings. However, stagnation points must be set to a
fixed location for any conveyance opening type. A more detailed explanation
of stagnation points, and how the program uses them, can be found in the
HEC-RAS Hydraulics Reference manual, under the section on Multiple
Openings (Chapter 7).

Once the user has entered all of the information into the Multiple Opening
Analysis window, simply press the OK button to accept the data.

Multiple Opening Calculations

Multiple opening calculations are computationally intensive. An iterative
solution approach is used, by which the amount of flow through each opening
is adjusted until the computed upstream energies of each opening are
balanced within a predefined tolerance. The general approach of the solution
scheme is as follows:

1. The program makes a first guess at the upstream water surface by
setting it to the computed energy of the cross section just downstream
of the bridge.

2. The program sets an initial flow distribution. This is accomplished by
first calculating the amount of active flow area in each opening, based
on the water surface from step one. The program then apportions the
flow by using an area weighting (i.e., if an opening has 40 percent of
the active flow area, then it will receive 40 percent of the flow).

3. Once a flow distribution is established, the program then calculates
the water surface and energy profiles for each opening, using the
estimated flow.

4. Once the program has computed the upstream energy for each
opening, a comparison is made between the energies to see if a
balance has been achieved (i.e., all energies are within the predefined
tolerance). If the energies are not within the set tolerance, the
program re-distributes the flow based on the computed energies.
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5. The program continues this process until either the computed energies
are within the tolerance or the number of iterations reaches a pre­
defined maximum. The energy balance tolerance is set as 3 times the
user entered water surface calculation tolerance (The default is 0.03
feet or 0.009 meters). The maximum number of iterations for
multiple opening analysis is set to 1.5 times the user entered
maximum number of iterations from the normal water surface
calculations (the default is 30 for multiple openings).

A more detailed discussion of how the program performs the multiple
opening analyses can be found in Chapter 7 of the HEC-RAS Hydraulic
Reference manual.

In line Structures (Weirs and Gated Spillways)

HEC-RAS has the ability to model inline weirs and gated structures with
radial gates (often called tainter gates) or vertical lift gates (sluice gates). The
spillway crest of the gates can be modeled as either an ogee shape or a broad
crested weir shape.

This section of the User's manual will describe how to enter the data for
inline structures. For information on general modeling guidelines and the
hydraulic computations of inline weirs and gated spillways, please see
Chapter 8 of the HEC-RAS Hydraulic Reference manual. To find out how to
view specific results for an inline structure, see Chapter 9 of this User's
manual.

Entering and Editing Inline Structure Data

jnline structure data are entered in a similar manner as bridge and culvert
data. To enter an inline weir and/or gated spillway press the Inline Structure
button from the Geometric Data window. Once this button is pressed, the
jnline Structure Data editor will appear as shown in Figure 6.28 (except yours
will be blank until you have entered some data).
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Figure 6.28 lnline Structure Data Editor

To add an inline structure to a model, the user must do the following:

1. Select the river and reach that you would like to place this inline
structure into. This is accomplished by first selecting a River, then
selecting a specific reach within that river. The River and Reach
seJection buttons are at the top of the [nline Structure Data editor.

2. Go to the Options menu at the top of the window and select Add an
lnline Structure from the list. An input box will appear asking you
to enter a river station identifier for locating this structure within the
reach. After entering the river station, press the OK button and a
copy of the cross section just upstream of this river station will appear
on the screen. This cross section is used in formulating the inline
structure crossing.

3. Enter all of the data for the Inline structure. This data will include a
Weir/Embankment profile, and any gated spillways that you may be
modeling. Gated spillways are optional. If the user does not enter
any gated spillways, then the program assumes that there is only an
inline weir.
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4. Once all of the lnline Structure data are entered, press the Apply
Data button in order for the interface to accept the data. The editor
can then be closed by selecting Exit from the File menu at the top of
the window.

River, Reach, and River Station. The River and Reach boxes allow the user
to select a river and reach from the available reaches that were put together in
the schematic diagram. The river and reach labels define which river and
reach the inline structure will be located in. The River Station tag defines
where the structure will be located within the specified reach. The River
Station tag does not have to be the actual river station of the structure, but it
must be a numeric value. The River Station tag for the inline structure should
be numerically between the two cross sections that bound the structure. Once
the user selects Add an Inline Structure from the options menu, an input
box will appear prompting you to enter a River Station tag for the new
structure. After the River Station tag is entered, the cross section just
upstream of the Inline Structure will be displayed on the editor.

Description. The description box is used to describe the Inline Structure
location in more detail than just the river, reach and river station. This box
has a limit of 256 characters. Only the first line of information is displayed,
unless the button to the right of the box is pressed. Also, the first 40
characters of the description are used as a label for the lnline Structure plots
and tables.

Pilot Flow. This option allows the user to put in a flow rate that will be used
as a minimum flow release from the stmcture. If you have an inline stmcture
in HEC-RAS, there must be flow coming out of the structure at all times. The
pilot flow option is a simple way to ensure that there is always some flow
going through the structure.

Breach (Plan Data). This button allows the user to define information for
evaluating the breaching of this inline structure. The data is actually stored in
the currently opened plan file. The editor can also be brought up from the
plan editor. This option is only for unsteady flow modeling. To learn more
about this option, see Chapter 8 "Performing an Unsteady Flow Analysis."

Weir/Emhankment. The Embankment and Weir data are entered together,
and are used to describe the embankment blocking the stream as well as any
uncontrolled weirs. To enter the weir and embankment data, press the
Weir/Embankment button and the editor will appear (Figure 6-29). The
Weir/Embankment Data editor is similar to the Deck/Roadway editor for
bridges and culverts. The data on the Weir/Embankment editor is the
following:

Distance - The distance field is used to enter the distance between the
upstream side of the Weir/Embankment (the top of the embankment) and the
cross section immediately upstream of the structure. This distance is entered
in feet (or meters for metric).
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Figure 6.29 Weir and Embankment Data Editor

Width· The width field is used to enter the width of the top of the
embankment along the stream. The distance between the top of the
downstream side of the embankment and the downstream bounding cross
section will equal the main channel reach length of the upstream cross section
minus the sum of the weir/embankment "width" and the "distance" between
the embankment and the upstream section. The width of the embankment
should be entered in feet (meters for metric).

Weir Coefficient - Coefficient that will be used for weir flow over the
embankment in the standard weir equation.

Station and Elevation Coordinates - This table is used to define the geometry
of the Weir and the Embankment. The infonnation is entered from left to
right in cross section stationing. The user enters stations and elevations of the
top of the embankment and weir. The stationing does not have to equal the
stations in the bounding cross section, but it must be based on the same
origin. Everything below these elevations will be filled in down to the
ground. The Del Rowand Ins Row buttons allow the user to delete and
insert rows.

U.S Embankment SS - This field is used to enter the slope of lhe road
embankment on the upstream side of the structure. The slope should be
entered as the horizontal to vertical distance ratio of the embankment.
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D.S. Embankment SS - This field is used to enter the slope of the road
embankment on the downstream side of the structure. The slope should be
entered as the horizontal to vertical distance ratio of the embankment.

Weir Crest Shape - When submergence occurs over the weir there are two
choices available to figure out how much the weir coefficient should be
reduced due to the submergence. These two criteria are based on the shape of
the weir. The first method is based on work that was done on a trapezoidal
shaped broad crested weir (FHWA, 1978). The second criterion was
developed for an Ogee spillway shape (COE, 1965). The user should pick the
criterion that best matches their problem. If the user selects the Ogee
Spillway shape, then some additional information is required. For an Ogee
shaped weir the user must enter the "Spillway Approach Height" and the
"Design Energy Head". The spillway approach height is equal to the
elevation of the spillway crest minus the mean elevation of the ground just
upstream of the spillway. The design energy head is equal to the energy
grade line elevation (at the design discharge) minus the elevation of the
spillway crest. In addition to these two parameters, the user has the option to
have the program calculate the weir coefficient at the design discharge. This
is accomplished by pressing the Cd button. Once this button is pressed, the
program will compute a weir coefficient for the Ogee spillway based on the
design head. During the weir calculations, this coefficient will fluctuate
based on the actual head going over the spillway. The curves used for
calculating the Ogee spillway coefficient at design head, and discharges other
than design head, were taken from the Bureau of Reclamation publication
"Design of Small Dams", Figures 249 and 250 on page 378 (Bureau of
Reclamation, 1977).

Gated Spillway Data. In addition to uncontrolled overflow weirs, the user
can add gated spillways (this is optional). To add gated spillways to the
structure, press the Gate button on the Inline Structure data editor. Once this
button is pressed, the gated editor will appear as shown in Figure 6.30 (except
yours will be blank until you have entered some data).
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Figure 6.30 Gated Spillway Editor

The Gated Spillway editor is similar to the Culvert editor in concept. The
user enters the physical description of the gates, as well as the required
coefficients, in the Gated Spillway editor. The functionality of the gates is
defined as part of the Steady Flow data, on a per profile basis. The following
is a list ofthe data contained on this editor:

Gate Group - The Gale Group is automatically assigned to "Gate # I" the first
time you open the editor. The user can enter up to I0 different Gate Groups
at each particular river crossing, and each gate group can have up to 25
identical gate openings. If all of the gate openings are exactly the same, then
only one gate group needs to be entered. If the user has gate openings that are
different in shape, size, elevation, or have different coefficients, then
additional Gate Groups must be added for each Gate type. To add an
additional gate group you can either use the Add or Copy buttons. The Add
button increments the Gate # and clears the culvert editor. The Copy button
increments the Gate # and makes a copy of the original Gate group data.
Once a copy is made of a gate data, the user can change any of the existing
gate information. Gate groups can be deleted by pressing the Delete button.
Also, if the gates are identical, but the lIser wants to be able to open the gates
to different elevations, then the user must have a separate gate group for each
set of gates that will be opened to different elevations.
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Height - This field is used to enter the maximum possible height that the gate
can be opened in feet (meters for metric).

Width - This field is used for entering the width of the gate in feet (meters).

Invert - This field is used for entering the elevation of the gate invert (sill
elevation of the spillway inside of the gate) in feet (meters for metric).

Discharge Coefjicient - This field is used for entering the coefficient of
discharge for the gate opening. This coefficient ranges from 0.6 to 0.8 for
Radial gates and 0.5 to 0.7 for sluice gates.

Gate Type - This field is used for selecting the type of gate. Two gate types
are available, radial (tainter gate) or sluice (vertical lift gate).

Trunnion Exponent - This field is used to enter the trunnion height exponent,
which is used in the radial gate equation. The default value for this field is
0.0

Opening Exponent - This field is used to enter the gate opening exponent,
which is used in the radial gate equation. A default value of 1.0 is
automatically set for this field.

Head Exponent - This field is used to enter the upstream energy head
exponent, which is used in the radial gate equation. A default value of 0.5 is
automatically set for this field.

Trunnion Height - This field is used for entering the height from the spillway
crest to the trunnion pivot point. See Chapter 8 of the Hydraulic Reference
manual for more details on this variable.

Orifice Coefficient - This field is used to enter an orifice coefficient, which
will be used for the gate opening when the gate becomes more than 80
percent submerged. Between 67 percent and 80 percent submerged, the
program uses a transition between the fully submerged orifice equation and
the free flow equations. When the flow is less than 67 percent submerged,
the program uses the free flow gate equations.

Head Reference ~ This field is used to select the reference point for which the
upstream energy head will be computed from. The default is the gate sill
(invert), which is normally used when the flow through the gate goes out into
a channel. If the gate causes the flow to jet out freely into the atmosphere,
then the head reference should be selected as the centerline elevation of the
gate opening. If the gate crest is an ogee spillway crest, then the center of the
gate opening should be used. Ogee spillway crests are normally designed to
follow the shape of water jetting freely into the atmosphere.

Centerlme Stations - This table is used for entering the centerline stationing
of the identical gate openings. The user should enter a different centerline
stationing for each gate opening that is part oftbe current gate group. All
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gate openings within the same gate group are exactly identical in every way,
except their centerline stationing. As a user adds new centerline stationing
values, the number of identical gates in the group is automatically
incremented and displayed in the field labeled "# Openings".

Weir Coefficient - This field is used for entering a weir coefficient that will be
used for the gate opening. This coefficient will only be used when the gate is
opened to an elevation higher than the upstream water surface elevation.
When this occurs, the flow through the gate is calculated as weir flow.

Weir Crest Shape - This parameter allows the user to select between a Broad
Crested shape weir and an agee shaped weir. Depending on which shape is
selected, the program will use a different submergence criteria during the
calculation. In addition to the submergence criteria, if the user selects the
agee shape, the program will bring up two additional data eutry fields that
must be entered by the user. These fields are used for the Spillway Approach
Height and the Design Energy Head, which are explained below. Once these
fields are entered, the user should press the button labeled Cd. When this
button is pressed, the program will compute a weir coefficient for the agee
spillway based on the design head. During the weir calculations, this
coefficient will fluctuate based on the actual head going over the gated
spillway. The curves used for calculating the agee spillway coefficient at
design head, and discharges other than design head, work taken from the
Bureau of Reclamation publication "Design of Small Dams", Figures 249 and
250 on page 378 (Bureau of Reclamation, 1977).

Spillway Approach Height - The spillway approach height is equal to the
elevation of the spillway crest minus the mean elevation of the ground just
upstream of the spillway.

Design Energy Head - The design energy head is equal to the energy grade
line elevation (at the design discharge) minus the elevation of the spillway.

Once all of the data for the gates has been entered, the user needs to press the
OK button for the data to be accepted. If the user does not want to use the
new data, and would like to go back to the original data they had before
entering the Gate Editor, press the Cancel button. If the user presses the OK
button, this does not mean that the data is saved to the hard disk, it is only
stored in memory and accepted as being good data. This data is part of the
geometry data, and is stored in the geometric data file. The data can be stored
to the hard disk by selecting one of the save options from the File menu of the
Geometric Data window.
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Lateral Structures (Weirs, Gated Spillways, Culverts,
and Diversion Rating Curves)

HEC-RAS has the ability to model lateral weirs, gated spillways, culverts,
and diversion rating curves. The user can set up a single lateral weir, a weir
and separate set of gates, a weir and group of culverts, or any combination of
weir, gates, culverts, and a rating curve. The gated spillways can have either
radial gates (often called tainter gates) or vertical lift gates (sluice gates). The
spillway crest of the gates can be modeled as either an ogee shape or a broad
crested weir shape. The culverts can be any of the available shapes from the
standard HEC-RAS culvert capability. The diversion rating curve can be
used alone, or in conjunction with the other hydraulic outlet types. The rating
curve can be used to represent a structure or a particular outlet that could not
be modeled with HEC-RAS. Lateral structures can be connected to storage
areas or another river reach.

The lateral structure option can also be used to model a levee. In general, the
user should end their cross sections at the levee, and then use the later
structure option to represent the top of the levee along the stream. The area
behind the levee could be represented with either a storage area or another
river reach. Water that goes above the levee will be modeled as weir flow.
The user also has the option to evaluate levee breaching.

This section of the User's manual will describe how to enter the data for
lateral weirs, gated spillways, culverts, and lateral rating curves. For
information on general modeling guidelines and the hydraulic computations
of lateral weirs, gated spillways, and culverts, please see Chapter 8 of the
HEC-RAS Hydraulic Reference manual. To find out how to view specific
results for a lateral structure, see Chapter 9 of this User's manual.

Entering and Editing Lateral Structure Data

Lateral weir, gated spillway, and culvert data are entered in a similar manner
as bridge and culvert data. To enter a lateral structure, press the Lateral
Structure button from the Geometric Data window. Once this button is
pressed, the Lateral Structure Data editor will appear as shown in Figure 6.31
(except yours will be blank until you have entered some data).

To add a lateral structure to a model, the user must do the following:

I. Select the river and reach that you would like to place this lateral
structure into. This is accomplished by first selecting a River, then
selecting a specific reach within that river. The River and Reach
selection buttons are at the top of the Lateral Structure Data editor.

2. Go to the Options menu at the top of the window and select Add a
Lateral Structure from the list. An input box will appear asking you
to enter a river station identifier for locating this structure within the
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reach. The river station you enter will represent the location of the
upstream end of the lateral structure. The river station must be unique,
and should be numerical between the river station values of the
upstream cross section and the next section downstream. After
entering the river station, press the OK button and a profile plot of the
channel invert and cross sections in the vicinity of the lateral
weir/spillway will be displayed.
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Figure 6.31 Lateral Weir, Gated Spillway, and Culvert Editor

3. Enter all of the data for the Lateral Weir, Gated Spillways, Culverts
and Diversion Rating Curves. Gated spillways, culverts, and rating
curves are optional. If the user does not enter any gated spillways,
culverts, or rating curves, then the program asswnes that there is only
a lateral weir. If the user wants to enter only gated spillways,
culverts, or a rating curve, and no lateral weir, they must still enter a
weir embankment.

4. Once all of the data are entered, press the Apply Data button in order
for the interface to accept the data. The editor can then be closed by
selecting Exit fr0111 the File menu at the top of the window.
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5. If any gated spillways were entered, the user must go to the Steady or
Unsteady Flow Data Editor to control the gate settings for each
individual event.

The user can have up to two lateral structures defined between any two given
cross sections. However, the lateral structure must be placed on opposite
sides of the channel (i.e. one on the left and one on the right), and the river
stations of each lateral structure must be different (though still contained
within the two cross section river station values). Also, any lateral structure
can be longer than the distance between cross sections. The user can have a
lateral structure that extends downstream, encompassing up to 100 cross
sections. If you have a lateral structure that is longer than that, you must
break it up into separate lateral structure.

River, Reach, and River Station. The River and Reach boxes allow the user
to select a river and reach from the available reaches that were defined in the
schematic diagram. The river and reach labels define which river and reach
the lateral weir andlor gate spillway will be located in. The River Station tag
defines where the structure will be located within the specified reach. The
River Station tag does not have to be the actual river station of the structure,
but it must be a numeric value. The River Station tag for the lateral structure
should be numerically between the two cross sections that bound the
upstream end of the structure. Once the user selects Add a Lateral
Structure from the options menu, an input box will appear prompting you to
enter a River Station tag for the new structure. After the River Station tag is
entered, a profile plot of the reach thalweg will be displayed for the bounding
cross sections in the graphic window.

Description. The description box is used to describe the Lateral Structure
location in more detail than just the river, reach and river station. This box
has a limit of 256 characters. Only the first line of information is displayed,
unless the button to the right of the box is pressed. Also, the first 40
characters of the description are used as a label for the Lateral Structure plots
and tables.

Position. The position box is used to define where the lateral structure is
located spatially within the cross section. The user can select one of the
following: Left overbank; Next to left bank station; Next to right bank station;
and Right overbank. When the user selects "Left overbank", the weir is
assumed to be located at the left end (beginning cross section station) of the
cross section data, looking in the downstream direction. When the lIser
selects "Next to left bank station", the weir is assumed to be located on the
left edge of the main channel. When the user selects "Next to right bank
station", the weir is assumed to be located on the right edge of the main
channel. When the lIser selects "Right overbank", the weir is assumed to be
located at the right end of the cross section data.

Connected To. This field will display what the lateral structure is connected
to (i.e. where the water leaving from the main river will be going). If the
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structure is not connected to anything, this field will be blank. A lateral
structure can be connected to a storage area, another river reach, or nothing at
all. The buttons below this field are used to connect the lateral structure, as
well as remove a connection. Whatever the lateral structure is connected to is
where the water will be sent, and will also be used as the tailwater elevation
for submerged hydraulic calculations. Water can also flow in the reverse
direction through a lateral structure if the connected to location has a higher
water surface than the from location.

Structure Type. This field is used to select the type of routing that will be
used for this structure. There are two options, Weir!Gates!Culverts!
Diversion Rating Curves (the default) and Linear Routing. The default
option is where the program calculated the flow across the structure by
performing detailed hydraulic calculations for the weir, gated spillways,
culverts, and any rating curve. The second option, Linear Routing, is a
simplified method in which the user just puts in a linear routing coefficient.
This coefficient can vary between 0.0 and 1.0, with 1.0 representing sending
the maximum flow over the structure and 0.0 representing no flow. The
linear routing method is a simple storage accounting method. This method
can be very useful when the user has many lateral structures connected to
storage areas, and a detailed flow calculation over each structure is not
necessary. Also, the linear routing method is computationally faster and more
stable. Typical values for the linear routing coefficient are from 0.05 to 0.2.
However, this coefficient needs to be calibrated.

Culvert Flap Gates. The drop down box right above the Structure Type
pertains to having flap gates on culverts. This option only affects the flow
through the culverts, not the weir or the gated structures. The options are no
flap gates (default), no negative flow flap, and no positive flow flap. No flap
gates means that flow is allowed to go in both directions through the culvert.
The no negative flow flap option means that flow can only go in the positive
flow direction through the culverts. Positive flow is assumed to be taking
flow away from the river for a lateral structure. Therefore, the no negative
flow flap option would allow water to go away from the main river through
the culverts, but not back into the river. The final option, no positive flow
flap, would only allow water to come into the main river through the culverts,
but not away from the main river.

Optimization. This option is for steady flow modeling only. When
modeling in a steady flow mode, the user can have the software figure out
how much flow will leave through the lateral structure, and how much will
continue on downstream. This calculation requires an iterative solution.
Pressing the Optimization button brings up an editor that allows the user to
turn the optimization option on. When optimization is not turned on, the
program will assume all of the water is still going downstream, though it will
calculate what could have gone out the lateral weir based on the computed
water surface. When optimization is turned on, the software calculates the
flow out of the lateral structure, reduces the flow in the main river, and then
recalculates the profile in the main river. This operation continues until there
is a balance between the calculated and assumed flows for the main river.
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Breach. This button allows the user to define information for evaluating the
breaching of this lateral structure. The data is actually stored in the currently
opened plan file. The editor can also be brought up from the plan editor.
This option is only for unsteady flow modeling. To learn more about this
option, see Chapter 16 "Advanced Features For Unsteady Flow Routing."

Weir/Embankment. The Embankment and Weir data are entered together,
and are used to describe the embankment in which the outlels will be placed,
as well as any uncontrolled weirs. To enter the weir and embankment data,
press the Weir/Embankment button and the editor will appear as shown in
Figure 6-32
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Figure 6.32 Lateral Weir/Embankment editor

The Lateral Weir/Embankment Data editor is similar to the Deck/Roadway
editor for bridges and culverts. The data on the Weir/Embankment editor is
the following:

Distance - The distance field is used to enter the distance between the
upstream end of the Weir/Embankment (based on where the user will start to
enter the embankment data) and the cross section immediately upstream of
the structure. This distance is entered in feet (or meters for metric).

Weir Width - The width field is used to enter the width of the top of the
embankment. This value will only be used for graphical plotting, and does
not have any effect on the computations. The width of the embankment
should be entered in feet (meters for metric).

Weirflow reference - This value is used to select whether weir flow is
computed by using the energy gradeline or the water surface from the cross
sections. The default is to use the energy gradeline.
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Weir Coefficient - Coefficient tbat will be used for weir flow over the
embankment in the standard weir equation.

Weir Crest Shape - When submergence occurs over the weir there are two
choices available to figure out how much the weir coefficient should be
reduced due to the submergence. These two criteria are based on the shape of
the weir. The first method is based on work that was done on a trapezoidal
shaped broad crested weir (FHWA, 1978). The second criterion was
developed for an Ogee spillway shape (COE, 1965). The user should pick the
criterion that best matches their problem. If the user selects the Ogee
Spillway shape, then some additional information is required. For an Ogee
shaped weir the user must enter the "Spillway Approach Height" and the
"Design Energy Head". The spillway approach height is equal to the
elevation of the spillway crest minus the mean elevation of the ground just
upstream of the spillway. The design energy head is equal to the energy
grade line elevation (at the design discharge) minus the elevation of the
spillway crest. In addition to these two parameters, the user has the option to
have the program calculate the weir coefficient at the design discharge. This
is accomplished by pressing the Cd button. Once this button is pressed, the
program will compute a weir coefficient for the Ogee spillway based on the
design head. During the weir calculations, this coefficient will fluctuate
based on the actual head going over the spillway. The curves used for
calculating the Ogee spillway coefficient at design head, and discharges other
than design head, were taken from the Bureau of Reclamation publication
"Design of Small Dams", Figures 249 and 250 on page 378 (Bureau of
Reclamation, 1977).

Station and Elevation Coordinates - This table is used to define the geometry
of the Weir and the Embankment. The infonnation is entered from upstream
to downstream in stationing. The user enters stations and elevations of the
top of the embankment and weir. The stationing does not have to equal the
stations in the river reach. Everything below these elevations will be filled in
to the ground. The Del Rowand Ins Row buttons allow the user to delete
and insert rows.

Gated Spillway Data. In addition to uncontrolled overflow weirs, the user
can add gated spillways (this is optional). To add gated spillways to the
structure, press the Gate button on the Lateral Weir and Gated Spillway data
editor. Once this button is pressed, the lateral gated editor will appear as
shown in Figure 6.33 (except yours will be blank until you have entered some
data).
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Figure 6.33 Lateral Gated Spillway Editor.

The Gated Spillway editor is similar to the Culvert editor in concept. The
user enters the physical description of the gates, as well as the required
coefficients, in the Gated Spillway editor. The functionality of the gates is
defined as part of the Steady Flow data, on a per profile basis. The following
is a list of the data contained on this editor:

Gale Group - The Gate Group is automatically assigned to "Gate #1" the first
time you open the editor. The user can enter up to I0 different Gate Groups
at each particular structure, and each gate group can have up to 25 identical
gate openings. If all of the gate openings are exactly the same, then only one
gate group needs to be entered. If the user has gate openings that are different
in shape, size, elevation, or have different coefficients, then additional Gate
Groups must be added for each Gate type. To add an additional gate group,
you can either use the Add or Copy buttons. The Add button increments the
Gate # and clears the gate editor. The Copy button increments the Gate # and
makes a copy ofthe original Gate group data. Once a copy is made of the
gate data, the user can change any of the existing gate information. Gate
groups can be deleted by pressing the Delete button. Also, if the gates are
identical, but the lIser wants to be able to open the gates to different
elevations, then the user must have a separate gate group for each sct of gates
that will be opened to different elevations.
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Height - This field is used to enter the maximum possible height that the gate
can be opened in feet (meters for metric).

Width - This field is used for entering the width of the gate in feet (meters).

Invert - This field is used for entering the elevation of the gate invert (sill
elevation of the spillway inside of the gate) in feet (meters for metric).

Discharge Coefficient - This field is used for entering the coefficient of
discharge for the gate opening. This coefficient ranges from 0.6 to 0.8 for
Radial gates and 0.5 to 0.7 for sluice gates.

Gate Type - This field is used for selecting the type of gate. Two gate types
are available, radial (tainter gate) or sluice (vertical lift gate).

Trunnion Exponent - This field is used to enter the trunnion height exponent,
which is used in the radial gate equation. The default value for this field is
0.0.

Opening Exponent - This field is used to enter the gate opening exponent,
which is used in the radial gate equation. A default value of 1.0 is
automatically set for this field.

Heod Exponent - This field is used to enter the upstream energy head
exponent, which is used in the radial gate equation. A default value of 0.5 is
automatically set for this field.

Trunnion Height - This field is used for entering the height from the spillway
crest to the trunnion pivot point. See Chapter 8 of the Hydraulic Reference
manual for more details on this variable.

Orifice Coefficient - This field is used to enter an orifice coefficient, which
will be used for the gate opening when the gate becomes more than 80
percent submerged. Between 67 percent and 80 percent submerged, the
program uses a transition between the fully submerged orifice equation and
the free flow equations. When the flow is less than 67 percent submerged,
the program uses the free flow gate equations.

Head Reference - This field is used to select the reference point for which the
upstream energy head will be computed from. The default is the gate sill
(invert), which is normally used when the flow through the gate goes out into
a channel. If the gate causes the flow to jet out freely into the atmosphere,
then the head reference should be selected as the centerline elevation of the
gate opening. If the gate crest is an ogee spillway crest, then the center of the
gate opening should be used. Ogee spillway crests are normally designed to
follow the shape of water jetting freely into the atmosphere.

Centerline Stations - This table is used for entering the centerline stationing
of the identical gate openings. The user should enter a different centerline
stationing for each gate opening that is part of the current gate group. All
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gate openings within the same gate group are exactly identical in every way,
except their centerline stationing. As a user adds new centerline stationing
values, the number of identical gates in the group is automatically
incremented and displayed in the field labeled "# Openings".

Weir Coefficient - This field is used for entering a weir coefficient that will be
used for the gate opening. This coefficient will only be used when the gate is
opened to an elevation higher than the upstream water surface elevation.
When this occurs, the flow through the gate is calculated as weir flow.

Weir Crest Shape - This parameter allows the user to select between a Broad
Crested shape weir and an agee shaped weir. Depending on which shape is
selected, the program will use a different submergence criteria during the
calculation. In addition to the submergence criteria, if the user selects the
agee shape, the program will bring up two additional data entry fields that
must be entered by the user. These fields are used for the Spillway Approach
Height and the Design Energy Head, which are explained below. Once these
fields are entered, the user should press the button labeled Cd. When this
button is pressed, the program will compute a weir coefficient for the agee
spillway based on the design head. During the weir calculations, this
coefficient will fluctuate based on the actual head over the gated spillway.
The curves used for calculating the agee spillway coefficient at design head,
and discharges other than design head, were taken from the Bureau of
Reclamation publication "Design of Small Dams", Figures 249 and 250 on
page 378 (Bureau of Reclamation, 1977).

Spillway Approach Height - The spillway approach height is equal to the
elevation of the spillway crest minus the mean elevation of the ground just
upstream of the spillway.

Design Energy Head - The design energy head is equal to the energy grade
line elevation (at the design discharge) minus the elevation of the spillway.

Once all of the data for the gates have been entered, the user needs to press
the OK button for the data to be accepted. If the user does not want to use the
new data, and would like to go back to the original data they had before
entering the Gate Editor, press the Cancel button. If the user presses the OK
button, this does not mean that the data is saved to the hard disk, it is only
stored in memory and accepted as being good data. This data is part of the
geometry data, and is stored in the geometric data fi Ie. The data can be stored
to the hard disk by selecting one of the save options from the File menu of the
Geometric Data window.
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Culvert Data. In addition to the lateral weir and gates, the user can also
enter lateral culverts. To add culverts to the structure, press the Culvert
bulton on the lower left side of the editor. When this option is selected the
following window will appear.

~ Copy I~ CulverliD ICulvert #1 :.:J
Solution Cr.eria IHighest U.S. EG :.:J Rename I[!] [!]

~=-=---
Shape IC'cular:.:J Diam 15

:.:J
:.:J

104

Chart # 11· Concrete Pipe Culvert

Scale ** 11. Square edge enhance with headwall

Upstream Invert Elev: 1205
~-­

Downstream Invert Elev: 1205
~--

tt: identical barrels: h
Culvert Length:

Entrance loss Coeff:

E,I Loss Coelf:

Manning's n lor Top:

Manning's n for Bottom:

Depth to use Bottom n:

Depth Blocked:

10013

10.013

10

10

OK

Centerline StatIOns

Upstream IDownstream \ ...... 1
-.l 35. 35. --.l
~

~ ~
Cancel Help I

Enler the lenglh 01 the culvert 1111

Figure 6.34 Culvert Editor for Lateral Culverts.

The required culvert data is the same as for an inline culvert. To see an
explanation of each field on the editor, review the information on culverts
found earlier in this chapter. The only difference is that the centerline
stationing of each culvert is based on the stationing entered in the
WeirlEmbankment editor.
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Diversion Rating Curve. Diversion rating curves are used to remove flow
from a main river. The diversion, rating curve can be used in conjunction
with a lateral weir, gated structures, and culverts, or it can be used alone.

To add a diversion, rating curve to the system, press the "Diversion Rating
Curve" button on the left hand side of the Lateral Structure editor. When this
button is pressed, the following editor will appear:

r.- Diversion based on water surface in channel

r Diversion based on flow in the channel

Distance to Diversion: 1100

DiverSion Rat! Curve
ChanWS Elev I Div Flow .&1

I---.!. 205 oU
1...1 206 100

-

1...1 208 500

I---.'! 210 1000

I~ 215 2000

1---2 220 5000

1-.-2 225 5000

I~ :
~n

Plot Curve .. OK Cancel I

Figure 6.35 Lateral Rating Curve Editor

The user first selects the type of rating to be used: channel water surface
versus diverted flow or channel flow versus diverted flow. Next, the distance
between the location of the diversion and the cross section just upstream of
the structure must be entered in order to locate the diversion. Finally, the user
enters the actual rating curve. The curve is entered as the amount of flow
leaving, verses the elevation of the water in the main river or flow in the main
rIver.

Linear Routing Option

The user can choose to use a linear routing option instead of entering
structure information and having the program compute the flow from the
structures. The linear routing option is selected by going to the Structure
Type pull down and selecting "Linear Routing" from the list. This option
uses a coefficient times the difference in available storage between the too
and from connection. When this option is selected, a linear routing button
will appear on the left side of the window. Selecting the linear routing button
will bring up the following window:
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Lateral Weir Linear RouLinv Editor

Lineal Rotting Coef fO( flo.. from Beaver Cleek Kenlwood at 10.05
RS: 5.4 to Storage area: ST0 **1

Linear Routing Coef tor flow hom Storage area: STo *1:1 to 10.05
Beaver Creek Kentwood at RS: 5.4

Elevation of sprllwa~ cfesl 1212
IL_J1L_!1 Cancel

Figure 6.43 Simple Spillway Data Editor

As shown in the Linear Routing editor, the user must enter a linear routing
coefficient for both the positive and negative flow directions. Additionally,
the minimum elevation of the spillway crest must be entered. [fboth water
surfaces go below the spillway crest, no flow is passed over the structure.
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Storage Areas

Storage Areas are lake like regions in which water can be diverted into or
from. Storage areas can be located at the beginning of a reach, at the end of a
reach, or they can be located laterally to a reach. Storage areas can be
connected to a river reach by using a lateral structure connection. Storage
areas can be connected to another storage area by using a storage area
connection. Storage area connections consist of a weir, gated spillways and a
weir, culverts and a weir, or a linear routing option. An example river system
with storage areas is shown in Figure 6.36.
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Figure 6.36 Example Schematic With Storage Areas.

To add a storage area to the river system, first use the storage area drawing
tool at the top of the geometric editor. Once the storage area, drawing tool is
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selected, the user single clicks the left mouse button to begin drawing the
storage area. Additional points are added by moving the mouse and single
clicking. The storage area will be represented as a polygon. To finish
drawing the storage area, double click the left mouse button. The first and
last point will then be connected, and the storage area will be filled in with a
blue color.

After the storage area is drawn, the user must enter data to describe the
storage area. This is accomplished with the storage area editor, which is one
of the buttons on the left side of the geometric editor. Press the storage area
editor button and the following editor will appear:

r Area times depth method Area (aclest.

Min Elev:

I .1' I

Storage PJea: lea29 ii El [!][I]
I

a Elevation velSus Volume Curve

Elevation Volume Curve
Fust elevation must have Z810 volume

Elevation I Volume (acle·1I1 AI

~ 43831 o. U
..1. 4385.8 1.53 ,
.2 4388.1 39.92

~ 43904 28508

-2 4392.6 90338

-! 43949 1812.4

-.2 4397.2 281195

J! 4399.4 382709
..:J~ 4401 7 4R44 n4

OK

Figure 6.37 Storage Area Editor

Cancel

As shown in the figure above, the user has two options for entering
information about the volume of the storage area. The first option is a simple
area times a depth option. The user enters the area of the storage, and a
minimum elevation. The storage area is assumed to have the same area at all
elevations, therefore the volume is dimply the depth times the area. The
second option is to enter and elevation versus volume relationship for the
storage area. This option provides more detail and accuracy, and is the
recommended method whenever possible.
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Storage Area Connections

Storage Area connections are used to link two storage areas together with a
hydraulic structure. Storage area connections can consist of a weir; culverts
and a weir; gated spillways and a weir; or a linear routing option. To
establish a hydraulic connection between two storage areas, press the
"Storage Area Conn" button at the top of the geometric data window. Once
the storage area connection drawing tool is invoked, the user simple presses
the left mouse button one time while over the from storage area, then daub Ie
click the left mouse button while over the too storage area. This establishes
the connection between the storage areas, as well as what is considered to be
the positive flow direction.

Once a connection is made between two storage areas, the user must enter
information describing the hydraulics of the connection. This is
accomplished by pressing the Storage Area Conn editor button on the left
hand side of the geometric data editor. When this button is pressed, the
following window will appear:
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,)1'1 I I
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:.::J
--l
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Figure 6.38 Storage Area Connection Editor

As shown in the figure above, the user should first enter a description for the
storage area connection. Next the type of routing connection must be selected
from the drop down box. As mentioned previously, the user has the choice of
a weir only; weir and gates: weir and culverts; or linear coefficient routing
between storage areas. Once a routing type is selected. the window will place
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editor buttons specific to that type of routing onto the left side of the editor.
In this example, because a weir and culverts was selected, the weir, culverts,
and hydraulic table parameters buttons show up on the window. The user
must enter data for each of the buttons shown on the window. In this
example it is required to enter a weir/embankment, culvert information, and
hydraulic table parameters. When the weir/embankment editor is selected,
the following window will appear:

..
Weir SI.bon and Elevation-Weir Data I

Weir Widlh 1"',0=---1
IWeir Ilow ,elerence:IEne,g9 Grade :.:oJ I
i Weir Coellieienl (Cdl 12.6 I

Weir Crest Shape
(i Broad Crested
n Ogee

Enter width-of the weir in-the diredion o(lIow.~

Station
1 0
2 500
3
4
5
6
7
8
9

10

11

OK

Elevation A

16.5
16.5

~

Cancel I

Figure 6.39 Weir/Embankment Editor for Storage Area Connections

To complete the data for the weir/embankment between two storage areas, the
user enters a Weir Width (used only for drawing the schematic); a Weir
Coefficient (used in the weir flow calculations); a Weir Crest Shape (used
to assist in the calculation of the weir coefficient, as well as defining
submergence criteria); and the Station/Elevation Points that describe the top
of the weir/embankment profile. The weir/embankment can have up to 500
points to describe the profile. The program will use all of the information
entered by the user for calculating weir flow between the two storage areas.
After all ofthe data is entered, simply press the OK button to have the data
accepted by the program.

If the user has selected the weir and culverts routing type, then culvert
information must be entered also. When the culvert editor button is selected,
the following window will appear:
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Figure 6.40 Culvert Editor for Storage Area Connections

The culvert editor shown above has exactly the same information as the
nonnal culvert editor used at a river crossing. For detailed information about
this editor, please review the section on culverts found earlier in this chapter.

Whenever the user selects a weir, or a weir and culvert routing type, and
additional button will appear on the editor labeled "Htab Param". This
editor is used to define the limits of the family of rating curves that will be
developed for the storage area connection. When this button is pressed, the
following editor will appear:

Number of points on free flow curve: 140
~-

Number of submerged curves: 140
-,-­

Numbel of points on each submerged curves: 110
.6.ppJy number of points to all Connections

Head water maximum elevation: ]25
~--

Tail water rna:-:imum elevation (Optional): ]25
---

Ma:<imum Sl/~ell Head (Optional):

f..,ja:-:lmum Flow (Optional):

OK Cancel II
Figure 6.41 Hydraulic Properties Table Editor
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As shown in Figure 6.41, the user must enter a number of points for the free
flow curve (default is 40, max 50); number of submerged curves (default is
40, max 50); number of points on the submerged curves (default is 10, max
20); and head water maximum elevation. Additionally, the user can enter a
tailwater maximum elevation; maximum swell head (difference between
headwater and tailwater); and a maximum flow rate. All of these parameters
are used to define the limits of the family of rating curves that get created
when the geometric pre-processor runs.

Ifthe user has selected the Weir and Gates option, an editor for gated
spillways will show up on the left hand side of the window. Pressing this
button will bring up the window shown in Figure 6.42. As shown in the
figure, this editor is the same gate editor that is used for inline and lateral
gated spillways. For information about this editor, please review the sections
on inline and lateral gated spillways found earlier in this chapter.

Connection Gate Editor ..

Height: 110 Width: 110
Gale Data

I Discharge Coefficient: 1.6
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Opening Exponent

Head Exponent:
-.
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1 J I'
i--I_-
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Invert: 1'99
nOpenings: 1"",---
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, 60.... - .
2
3
4
5
6
7
R ~

Weil Data
Weir Coefficient: 13
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r Ogee

DK eareel Help

Enter the identical 9dte's center6ne stations (It)

Figure 6.42 Gated Spillway Editor for Storage Area Connections

The final option for Storage Area Connections is to model the connection as a
Linear Routing Method. This option lIses a coefficient times the difference
in available storage between the two storage areas, divided by the time step.
When this option is pressed, the following window will appear:
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SImple Spillway ., .

Linear Rouling Coef fOf flow from Storage afea: pyramid Lake 10.05
to Storage afea: Eagle Lake

Linear Routing Coef for flow from Storage alea: Eagle Lake to 10.05
Storage area: Pyramid Lake

Elevation of spillway crest 12504

I::::0r,;:::;1 Cancel I

Figure 6.43 Simple Spillway Data Editor

As shown in the Linear Routing editor, the user must enter a linear routing
coefficient for both the positive and negative flow directions. Additionally,
the minimum elevation of the spillway crest must be entered. If both water
surfaces go below the spillway crest, no flow is passed between the storage
areas.

Pump Stations

A pump station can be used to pump water between two storage areas, a
storage area and a river reach, or between two river reaches. Each pump
station can have up to ten different pump groups, and each pump group can
have up to twenty identical pumps. To add a pump station to the system,
select the Pump Station drawing tool at the top of the geometric data editor.
When this button is pressed, the mouse icon will change to a set of cross hairs
with a pump. Move the mouse to the location that represents where the pump
station will be pumping from, press the left mouse button to start the
connection. Next, move the mouse to the location where the pump station
will be pumping too, then press the left mouse button again. This will
establish a pump station connection between two elements.

Once a pump station is added to the system, the user must edit the pump
station and fill in the required data. To bring up the pump station editor,
select the pump station editor button on the left hand side of the geometric
data editor, or move the mouse over the pump station icon on the schematic,
press down on the left mouse button, then select Edit Pump Station. When
the Pump Station editor is selected, the following window will appear:

6-85



Chanter 6 Entering and FdWng Geometric Dara

Pum 1
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Figure 6.44 Pump Station Editor with Pump Connection Data

As shown in Figure 6.44, there are two tabs on the pump station editor, one is
for the pump connection data, and the other is for the pump group data. The
pump connection data contains the following data:

Rename Pump Station: This option allows the user to rename the pump
station to something other than the default.

Pump From: This is the location of where the pump station is pumping from.
This can be either a storage area or a river station from a river reach.

Pump To: This is the location of where the pump station is pumping to. This
can be either a storage area or a river station from a river reach.

On-OffReference: By default the program uses the "Pump From" location to
determine when the pump should tum on or off. However, the user has the
option to set a different location to be used as the monitor point for
determining whether lhe pump should be turned on or off. This optional
monitor location can be a storage area or a river station within a river reach.

Highest elevation in pump line: This option allows the user to enter an
elevation to be used as the highest elevation in the pump line. One example
of where this may be useful is if a pump station was being used to pump
water over top of a levee. In this situation, the to and from waler surface
elevations does not complelely quantify the required head to pump the water
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over the levee. So it is necessary to enter the elevation of the highest point in
the pump line (top of the levee) in order to accurately compute the flow going
through the pump.

Steady Flow Optimization: This option is for steady flow modeling only. [f
water is being pumped from or to a river reach, the amount of flow going into
or out of the reach should be accounted for when computing the water surface
profiles. However, the water surface profiles will affect the computation of
the amount of flow through the pumps. Therefore, to calculate this
accurately, the pump flow and water surface profiles must be calculated
iteratively until a balance is found between the river flows and the pump
flows. This optimization feature is not done automatically by the steady flow
program, however, the user can have the program do this by selecting Steady
flow optimization. When this option is selected, a window will appear
allowing the user to tum the pump flow optimization on.

In addition to the pump connection data the user must fill out the pump group
data. Select the Pump Group Data tab and the editor will look like the
following:

Pump Station Data Editor ,r"' ~,.'

ii Iii I iii iii iG [!][I] Rename PLJmp 5lotion IPumplPump 510lion Name: I i 1i
Pumo Connection Data Pump Group Data I

o 1OO'-.j
10 9IJ
15 80
18 60
20 30
21 0

Head(lI) I Flow(cls) ~ I
Pum EfflClet1C Cwve

208.5 208
208 208.5

209.2 209

Pu aerations

WS D,. On (II) Vl5 Elev Off (ItIPump Name
1 Pump #1
2 Pump#2
3 Pump#3

Group Name: 1Group tn 3 Add Group I Delete Group .. I Rename Group ···1
Pump Groups ---- --- ----

NumbelofPumpsinGroup: 13 o::J
r Bias group operations to on (steady flow onl}t]
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Figure 6.45 Pump Station Editor With Pump Group Data.

As shown in Figure 6.45, the pump group data consists of the following:

Group Name: By default the first pump group is called "Group #1", and the
second would be "Pump Group #2", etc. The user has the option to rename
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any pump group to whatever they would like. This is done by pressing the
"Rename Group" button.

Add Group: This button is used to add another pump group. If you have
pumps that have different flow capacities and use different pump efficiency
curves, they must be entered as a separate pump group.

Delete Group: This button is used to delete the current pump group.

Number ofPumps in Group: This field is used to enter the number of
identical pumps in the current pump group. Identical pumps must use the
same pump efficiency curve but can have different on and off trigger
elevations.

Bias group operations to on (Steady Flow Only): This option is only relevant
for a steady flow run. When this option is selected, and a particular water
surface profile is between the on and off elevation for a pump, the program
will assume the pump is turned on. If this option is not checked, then the
program will assume the pump is off when the water surface is between the
on and off elevations.

Pump Efficiency Curve: This table is used to enter the pump efficiency curve,
which is a table of pump head versus flow rate. The head represents the total
head in the system, which is normally the difference in the water surface
elevations between the from and the to location, plus any friction losses and
minor losses in the pump line. The flow is the pump rate capacity at that
particular head. The pump efficiency curve can be plotted for visual
iuspection by pressing the Plot Pump Curves button at the bottom of the
window.

Pump Operations: This table is used to define the trigger elevations for when
the pumps will turn on and off. The monitor location for triggering a pump
on or offis by default the from location, unless otherwise specified in the
Optional On-Off Reference field. In general, the pump on elevation must be
higher than the pump off elevation. Trigger elevations must be specified for
all of the pumps.

After all of the pump data are entered, press the OK button to have the data
excepted by the program. This does not save the data to the hard disk, it only
allows it to be used in the current execution of the program. To save the data
permanently, you must save the geometry data from the File menu of the
Geometric Data Editor.
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Cross Section Interpolation

Occasionally it is necessary to supplement surveyed cross section data by
interpolating cross sections in between two surveyed sections. Interpolated
cross sections are often required when the change in velocity head is too large
to accurately determine the energy gradient. An adequate depiction of the
change in energy gradient is necessary to accurately model friction losses as
well as contraction and expansion losses.

Cross section interpolation can be accomplished in three ways from within
the HEC-RAS interface. The first method is to simply copy one of the
bounding cross sections and then adjust the station and elevation data. The
cross section editor allows the user to raise or lower elevations and to shrink
or expand various portions of any cross section. The second and third options
allow for automatic interpolation of cross section data. From the Geometric
Data editor, automatic interpolation options are found under the Tools menu
bar as shown in Figure 6.46.
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Figure 6.46 Automatic Cross Section Interpolation Options
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The first cross section interpolation option, Within a Reach, allows for
automatic interpolation over a specified range of cross sections within a
single reach. When this option is selected, a window will pop up as shown in
Figure 6.47. The user must first select the River and Reach that they would
like to perfonn the interpolation in. Next the user must select a starting River
Station and an ending River Station for which interpolation will be
performed. The user must also provide the maximum allowable distance
between cross sections. If the main channel distance between two sections is
greater than the user defined maximum allowable, then the program will
interpolate cross sections between these two sections. The program will
interpolate as many cross sections as necessary in order to get the distance
between cross sections below the maximum allowable. Additionally the user
can specify the number of decimal places used for the stationing and
elevations of the interpolated cross sections.

X5 Interpolation by Reat\l

River: jCritical Cr. ~
Reach: IUpper Reach ~
Upstream Riv Sta: 112 ~
Downstream Riv Sta: 11 ~
Maximum Distance betweenXS's: 1100

12 Decirnal places ~
Delete Intelpolated XS's I Intelpolate XS's

Close I Help

Enler max distance betweenlnterpXSs.

Figure 6.47 Automatic Cross Sectiou Interpolating Within a Reach

Once the user has selected the cross section range and entered the maximum
allowable distance, cross section interpolation is performed by pressing the
Interpolate XS's button. When the program has finished interpolating the
cross sections, the user can close the window by pressing the Close button.
Once this window is closed, the interpolated cross sections will show up on
the river schematic as light green tic marks. The lighter color is used to
distinguish interpolated cross sections from user-entered data. Interpolated
cross sections can be plotted and edited like any other cross section. The only
difference between interpolated sections and user-defined sections is that
interpolated sections will have an asterisk (*) attached to the end of their river
station identifier. This asterisk will show up on all inpnt and ontput forms,
enabling the nser to easily recognize which cross sections are interpolated and
which are user defined.
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The second type of automatic cross section interpolation, Between 2 XS's,
allows the user to have much greater control over how the interpolation is
performed. When this option is selected, a Cross Section Interpolation
window will appear as shown in Figure 6.48.
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Figure 6.48 Detailed Cross Section Interpolation Window

This cross section interpolation window displays only two cross sections at a
time. The user can get to any two cross sections from the River, Reach and
River Station boxes at the top of the window. Interpolated cross section
geometry is based on a string model as graphically depicted in Figure 6.46.
The string model consists of chords that connect the coordinates of the
upstream and downstream cross sections. The cords are classified as master
and minor cords. As shown in Figure 6.48, five master cords are
automatically attached between the two cross sections. These master cords
are attached at the ends of the cross sections, the main channel bank stations,
and the main channel inverts. Minor cords are generated automatically by the
interpolation routines. A minor cord is generated by taking an existing
coordinate in either the upstream or downstream section and establishing a
corresponding coordinate at the opposite cross section by either matching an
existing coordinate or interpolating one. The station value at the opposite
cross section is determined by computing the decimal percent that the known
coordinate represents of the distance between master cords and then applying
that percentage to the opposite cross section master cords. The number of
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minor cords will be equal to the sum of all the coordinates of the upstream
and downstream sections minus the number of master cords. Interpolation at
any point in between the two sections is then based on linear interpolation of
the elevations at the ends of the master and minor cords. Interpolated cross
sections will have station and elevation points equal to the number of major
and minor cords.

This interpolation scheme is used in both of the automated interpolation
options ("Within a Reach" and "Between 2 XS's"). The difference is that the
Between 2 XS's option allows the user to define additional master cords.
This can provide for a better interpolation, especially when the default of five
major cords produces an inadequate interpolation. An example of an
inadequate interpolation when using the default cords is shown below.

..:..lQIB
River: ICrilical Cr: iJ Upper Riv 51a: 1.,-11,.----iJ---,T [!][!]
Reach: IUpper Reach iJ Lower Riv 51a: 110
Distance Between XS's "'110""0"-- 12 Decimal places ::::oJ

IMaximum Dislance (ft) iJ 1100 GLI~ Delete Interp Ilro["'1i=.~"t~=ii'''.~=I~''[e=••."'!1

Close

.1 nte;p 4 xs's between "'0" and "1 , "

Help

Figure 6.49 Cross Section Interpolation Based on Default Master Cords

As shown in Figure 6.49, the interpolation was adequate for the main channel
and the left overbank area. The interpolation in the right overbank area failed
to connect two geometric features that could be representing a levee or some
other type of high ground. If it is known that these two areas of high ground
should be connected, then the interpolation between these two sections should
be deleted, and additional master cords can be added to connect the two
features. To delete the interpolated sections, press the Dellnterp button.

6-92



Chanter 6 Entering and Editing Geometric Data

Master cords are added by pressing the Master Cord button that is located to
the right of the Maximum Distance field above the graphic. Once this button
is pressed, any number of master cords can be drawn in. Master cords are
drawn by placing the mouse pointer over the desired location (on the upper
cross section), then while holding the left mouse button down, drag the mouse
pointer to the desired location of the lower cross section. When the left
mouse button is released, a cord is automatically attached to the closest point
near the pointer. An example of how to connect master cords is shown in
Figure 6.50.

•

Interpolate

-~,,

XS Interpolation - Base Geometry 0 a ~~

Aiver: 1C,ilical Cr. 3 Upper Aiv 51a: 111 3 [!][!]
Aeach: IUppe,Aeach ::oJ Lowe,Aiv5ta: 1""10".----
Distance BelweenXS's "'15"'00"""-- 12 Decimal places

IMaximum Dislance (II) 31100 llJE81 Deletelntelp I

Close Help

Create additional i1terpolatooCOlds

Figure 6.50 Adding Additional Master Cords for Interpolation

User defined master cords can also be deleted. To delete user defined master
cords, press the scissors button to the right of the master cords button. When
this button is pressed, simply move the mouse pointer over a user defined
cord and click the left mouse button to delete the cord.

Once you have drawn in all the master cords that you feel are required, and
entered the maximum distance desired between sections, press the
interpolate button. When the interpolation has finished, the interpolated
cross sections will automatically be drawn onto the graphic for visual
inspection. An example of this is shown in Figure 6.51.
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Figure 6.51 Final Interpolation With Additional Master Cords

As shown in Figure 6.5 I, the interpolation with the addition of user defined
master cords is very reasonable.

In general, the best approach for cross section interpolation is to first
interpolate sections using the "Within a Reach" method. This provides for
fast interpolation at all locations within a reach. The "Within a Reach"
method uses the five default master cords, and is usually very reasonable for
most cross sections. Once this is accomplished, all ofthe interpolated
sections should be viewed to ensure that a reasonable interpolation was
accomplished in between each of the cross sections. This can be done from
the "Between 2 XS's" window. Whenever the user finds interpolated cross
sections that are not adequate, they should be deleted. A new set of
interpolated cross sections can be developed by adding additional master
cords. This will improve the interpolation.

CAUTION: Automatic geometric cross section interpolation should not be
used as a replacement for required cross section data. If water surface profile
information is required at a specific location, surveyed cross section data
should be provided at that location. It is very easy to use the automatic cross
section interpolation to generate cross sections. But if these cross sections are
not an adequate depiction of the actual geometry, you may be introducing
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error into the calculation of the water surface profile. Whenever possible, use
topographic maps to assist you in evaluating whether or not the interpolated
cross sections are adequate. Also, once the cross sections are interpolated,
they can be modified just like any other cross section.

If the geometry between two surveyed cross sections does not change
linearly, then the interpolated cross sections will not adequately depict what is
in the field. When this occurs, the modeler should either get additional
surveyed cross sections, or adjust the interpolated sections to better depict the
information from the topographic map.

The current version of HEC-RAS allows the user to model ice-covered
channels. This section of the users manual will describe how to enter the data
describing the ice cover and the ice cover properties. If the ice cover
geometry is known, that is, if the ice cover thickness and roughness are
known throughout the reaches of interest, the user can supply these data and
describe the ice cover directly. If the ice cover results from a wide-river type
jam, HEC-RAS will estimate the jam thickness in reaches where the ice jam
occurs. [n this case, the user can supply the material properties of the jam or
use the default values. To find out how to view specific results for a channel
with an ice cover, see Chapter 9 of this User's manual.

Entering and Editing Ice Data

River ice data can be entered in two ways: by using the Add lee Cover
option under the Options Menu found at the top of the Cross Section Data
Editor (Figure 6.2), or by using Tables Menu found at the top of the
Geometric Data window (Figure 6.1). Both ways of entering data will be
described below. It is important to remember that at least two cross sections
are required to define the ice cover. A cross section should be placed at the
upstream and downstream ends of each ice-covered reach.

Entering Ice Data at a Cross Section

To enter river ice data the user presses the Cross Section button on the
Geometric Data window (Figure 6.1). Once the cross section button is pressed
the Cross Section Data Editor will appear as shown in Figure 6.2. See the
CROSS SECTION DATA section of the User's Manual, for infonnation on
selecting the appropriate river, reach, and cross section in the Cross Section
Data Editor. Once a cross section with an ice cover has been selected, choose
the "Add ice cover..." option under the Options Menu found at the top of the
Cross Section Data Editor (Figure 6.2). This will open the Ice Cover Editor
(Figure 6.52). All ice data for this cross section can be entered with this
editor.
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Figure 6.52 Ice Cover Editor

Ice Cover Thickness. The ice cover thickness in the left overbank (LOB),
main channel (Channel), and right overbank (ROB), are entered here. If there
is no ice in any of these areas, a thickness of zero should be entered.

Ice Cover Manning's n Values. The Manning's n value of the ice cover in
the left overbank (LOB). main channel (Channel), and right overbank (ROB),
are entered here. If any part of a cross section has a non-zero ice thickness, a
Manning's n value must be supplied.

Ice Cover Specific Gravity. The default value is 0.916. The user can supply
an alternative value here.

Wide River Ice Jam. The boxes under this option are checked if this section
is to be treated as a wide river ice jam. In this case, HEC-RAS will estimate
the jam thickness using the complete ice jam force balance as described in the
Hydraulic Reference Manual. The user can confine the jam to the main
channel or allow the jam to be in the channel and overbank areas by checking
the proper boxes. If the ice cover is confined to the channel, the overbanks
can have a known ice thickness (including an ice thickness of zero) assigned
to them in the Ice Cover Thickness option. If the Wide River lee Jam option
is selected, an ice cover thickness must be supplied for the main channel
using the Ice Cover Thickness Option or through the Ice Tables (see below).
This ice cover thickness will be used as the initial estimate of the ice jam
thickness and will also serve as the minimum thickness allowed for the ice
jam at that section. If the jam is allowed in the overbank areas, the channel
and overbanks hydraulic properties will be combined to calculate a single jam
thickness for the channel and overbanks. NOTE: A wide river jam cannot be
selected for an entire river channel. A cross section with fixed ice cover
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geometry must be included at the upstream end and the downstream end of
the wide river ice jam to serve as the boundary conditions for the jam. There
is no limit to the number of separate wide river jams that can exist in a river
network. However, every ice jam must hav~ a cross section with fixed ice
geometry at its upstream and downstream limit. Ice jams can extend through
any number of junctions. However, the jam will only be extended between
reaches that have identical reach names.

Internal Friction Angle of the Jam (degrees). This describes the "strength"
of the ice jam as a granular materiaL The default value is 45_degrees.

Ice Jam Porosity (fraction water filled). This describes the fraction of the
ice jam that is filled with liquid water. The default value is 0.4.

Coefficient Kl (longitudinal to lateral stress in jam). This describes the
ratio of the lateral stress and the longitudinal stress in the jam. It is the
efficiency of the jam in transferring longitudinal stress into lateral stress
against the channel banks. The default value is 0.33

Maximum mean velocity under ice cover. This option limits the maximum
mean velocity under a wide river ice jam. The default value is 5 fps. If the
maximum mean velocity is greater than this, the ice cover will be thinned
until the maximum velocity is attained, or the minimum ice thickness
supplied by the user is reached. In any case, the jam thickness will not be
allowed to be thinner than the user supplied thickness. This option prevents
the jam from thickening to such an extent that the entire cross sectional area
of the channel would become blocked.

Ice Cohesion. At present, the ice jam cohesion is set to the default value of
zero. This cannot be changed by the user. A value of zero is appropriate for
breakup ice jams.

Fixed Manning's n Value (or Nezhikovsky's data will be used). The
Manning's n value of the ice jam can be specified by the user or estimated
using the empirical relationships developed from Nezhikovsky's data (1964).
The empirical relationships estimate the Manning's n value on the basis of the
jam thickness and the total water depth. The default is the user supplied
Manning's n value.

Once all the ice data have been entered and edited, click the OK button. At
the bottom of the Cross Section Data Editor, in the space entitled "List of
special notes for cross section," the words "Ice cover" will now appear. The
user can now click on the words "lee cover" to return to the ice cover editor
for that cross section.
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Entering Ice Data Through a Table

Ice cover infonnation can also be entered using the Tables Menu found at the
top of the Geometric Data Window (Figure 6.1). To enter data the user selects
the Ice Cover Option under the Tables Menu. All the infonnation that can be
entered under the Ice Cover Editor can also be entered using the Ice Cover
table. It is often very convenient to enter and view data for more than one
cross section at a time (Figure 6.53).
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Figure 6.53 Entering ice information using a Table

The user has the option of entering the ice thickness in the left overbank
(LOB ice Thickness), the main channel (Chan ice Thickness), and the right
overbank (ROB ice Thickness); the Manning's n value of the left overbank
ice cover (LOB ice Mann n), the main channel ice cover (Chan ice Mann n),
and the right overbank ice cover (ROB ice Mann n); and the specific gravity
of the ice cover (Ice gravity). The user can also choose if the ice cover in the
main channel is the result of a wide river ice jam (Ice Jam Chan. Note: only y
or n can be entered here), and choose if the overbanks are also included in
the wide river ice jam (Ice Jam OB. Note: only y or n can be entered here).
The user can further select the internal friction angle of the ice jam (Friction
Angle); the porosity of the ice jam (Porosity); the longitudinal to lateral stress
ratio of the ice jam (Stress KI ratio); the maximum allowable under ice flow
velocity (Max Velocity); and if the Manning's n value ofthc ice jam is fixed,
that is selected by the user. or if the Manning's n value will be determined by
HEC-RAS (Note: only y or n can be entered here).

As in all instances where a Table is used to enter data, in each column the
user has the option of entering one or more values, adding a constant to one
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or more of the values, multiplying a group of values by a factor, or changing a
group of values to a specific value. Additionally, cut, copy, and paste buttons
are provided to pass data to and from the Windows Clipboard.

Entering Ice Data at Bridges

The influence of ice on the hydraulics of bridges is a relatively unstudied
area. Little is known about the ways in which a wide river ice jam interacts
with the various components of a bridge. The important components of a
bridge that may interact with an ice jam include the piers, low chord,
approaches, and deck. Previous investigations of ice jams in rivers with
bridges have largely ignored their presence, arguing that observed ice jams
did not contact the low steel significantly. Removing the bridge information
for an ice jam study still remains an option. However to allow a user to
efficiently use HEC-RAS with ice and with bridges, three separate options
are provided. These options allow the user to selectively decide at each bridge
whether or not the ice cover can interact with the structure. When modeling
ice at bridges, users should carefully evaluate the results for consistency and
accuracy.

Ice information at bridges is entered using the Bridge/Culvert editor found
under the Geometry editor. Use the options menu in the Bridge/Culvert editor
to select the ice option. This will open a window as shown in Figure 6.54.

Select Ice Jam Computation Option

r No ice computed in the blidge

r Ice remains constant thlOught the bridge

r; lQ?~~~!~!s.~.I~~i~~~·~~_~~!~~~Ei.~~.~!~~.~

OK Cancel Help

Figure 6.54 Entering ice information at bridges

No ice computed in the bridge. In this case no ice calculations will be
preformed at the bridge itself and the ice thickness at the bridge will be
assumed to be zero.

Ice remains constant through the bridge. In this case, the ice thickness at
the cross section immediately upstream of the bridge will be used. If the ice
thickness is calculated as a wide river jam, this thickness will be used.

Dynamic ice jam computed through the bridge. In this case, the wide river
ice jam calculations will be preformed at the bridge cross section. The user
must check for inconsistent results, especially if any part of the ice jam is
above the low chord of the bridge.
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Setting Tolerances for the Ice Jam Calculations

The user can override the default settings for the ice jam calculation
tolerances which are used in the solution of the ice jam force balance
equation. The tolerances are set as multiples of the water surface calculation
tolerance used in the solution of the energy equation, described in the
Simulation Options section of Chapter 7. The user can change the values of
these tolerances by changing the water surface calculation tolerance. The
tolerances are as follows:

lee thickness calculation tolerance. This tolerance is compared with the
difference between the computed and assumed ice thickness at a cross
section. It is set to ten times the water surface calculation tolerance. Its
default value is 0.1 ft.

Global ice thickness calculation tolerance. This tolerance is compared with
the difference between the computed ice thickness at each cross section
between successive solutions of the ice jam force balance equation and tbe
energy equation. It is set to ten times the water surface calculation tolerance.
Its default value is 0.1 ft.

Global water level calculation tolerance. This tolerance is compared with
the difference between the computed water surface elevations at each cross
section between successive solutions of the ice jam force balance equation
and the energy equation. It is set to six times the water surface calculation
tolerance. Its default value is 0.06 ft.

Maximum number of ice jam iterations. This variable defines the
maximum number of times for successive solutions of the ice jam force
balance equation and the energy equation. It is set to 2.5 times the maximum
number of iterations. Its default value is 50.
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Viewing and Editing Data Through Tables

Once cross-section data are entered, the user can view and edit certain types
of data in a tabular format. The current version of HEC-RAS allows the user
to view and edit Manning's nor k values, cross-section reach lengths,
contract' and expansion coefficients, ice cover, cross-section river stationing,
and node names. These options are available from the Tables menu option
on the Geometric Data editor. The following is a description of each option.

Manning's n or k values

It is often desirable to view and edit the Manning's n values or roughness
heights (k values) for several cross sections all at the same time. From the
Geometric Data editor, the user can select Manning's n or k values from
the Tables menu item. Once this option is selected, a window will appear as
shown in Figure 6.55.

As shown in Figure 6.55, the user has the options of selecting either n or k
values to be used as the roughness coefficient, add a constant to one or more
of the n or k values, multiply a group ofn or k values by a factor, or change a
group ofn or k values to a specific value. Additionally, cut, copy, and paste
buttons are provided to pass data to and from the Windows Clipboard.

To add a constant to a group of n or k values, the user must first high light the
values that they would like to change. Highlighting is accomplished by
placing the mouse in the upper left cell of the desired cells to highlight, then
press the left mouse button and drag the cursor to the lower left comer of the
desired cells to highlight. When the left mouse button is released, the cells
that are selected will be highlighted (except the first cell). Once the user has
highlighted the desired cells to be modified, press the Add Constant button.
This will bring up a pop up window, which will allow the user to enter a
constant value that will be added to all cells that are highlighted.
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Figure 6.55 Manning's n Data View and Editing Table

To multiply a group of n or k values by a factor, the user first highlights the
desired cells. Once the cells are highlighted, pressing the Multiply by a
Factor button will bring up a pop up window. This window allows the user
to enter a value that will be multiplied by each ofthe highlighted cells.

To set a group ofn or k values to the same number, the user must first
highlight the values that they would like to change. Once the cells are
highlighted, pressing the Set Values button will bring up a pop up window.
This window will allow the user to enter a specific n or k value, which will
replace all of the highlighted values.

The user can also go directly into the table and change any individual values.
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Reach Lengths

The user has the ability to view and edit cross section reach lengths in a
tabular fonnat. This is accomplished by selecting Reach Lengths from the
Tables menu of the Geometric Data editor. Once this option is selected, a
window will appear as shown in Figure 6.56. The user has the same editing
features as described previously for the n values table. See the discussion
under Manning's n or k values, in the previous section, for details on how to
edit the data.

Edit Downstream Reach Lengths t',

Multiply FactOi I Set Values

::J 00~~ '"' EdillnlerpolatedXS's

::J

~ - -
River Sta LOB I Channel r ROB

1 5.99 440 L~L ... _.. ....._._...-' 400
2 5.B75" 440 600 400
35.76 225 400 275
4 5.685" 225 400 275
5 5.61 240 460 190
6 5.525~ 240 460 190
7 5.44 270 170 500
B 541 100 100 100
9 5.4 Bridge

10 5.39 320 500 580
11 5.29 410 416.5 410
12 5.21" 410 416.5 410
13 5.13 310 355 340
14 5.065" 310 355 340
15 5.0 0 0 0

River: IBeavel Creek

Reach: IKentwood

1- Selected Area Global Edils
Add Conslant I

OK Cancel Help

Figure 6.56 Reach Lengths View and Editing Table

Contraction and Expansion Coefficients

The user has the ability to view and edit contraction and expansion
coefficients in a tabular format. This is accomplished by selecting
Coefficients from the Tables menu of the Geometric Data editor. Once this
option is selected, a window will appear as shown in Figure 6.57. The user
has the same editing features as described previously for the n values table.
See the discussion under Manning's n values, in the previous section, for
details on how to edit the data.
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River: IBeaver Creek
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Figure 6.57 Contraction and Expansion Coefficients Table

Bank Stations

This table allows the user to set or move the main channel bank stations. If
the main channel bank stations have not been set, and the user brings up this
table, the bank stations will be set to the ends of the cross section. If the bank
stations are already set the user can adjust the bank stations by adding a
constant, multiplying them by a factor, or setting them to a specific value. If
the new bank stations do not exist in the cross section, the program will
automatically interpolate them.

Levees

This table allows the user to easily enter and edit levee stations and
elevations. The editor allows the user to quickly move levee stations and/or
elevations. This can be very useful when trying to decide on a location for
levee setbacks and their corresponding elevations.

Ice Cover

This option allows the user to enter ice cover data in a tabular form. A
detailed discussion of ice cover information was presented earlier in this
chapter.
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River Stationing

This option allows the user to view and edit the cross section river stationing
in a tabular fonn. This is accomplished by selecting River Stations from the
Tables menu of the Geometric Data editor. Once this option is selected, a
window will appear as shown in Figure 6.58. This table allows the user to
change the river stationing of individual cross sections, add a constant value
to the river stationing of selected cross sections (those cross sections
highlighted by the user), multiply the selected cross sections river stationing
by a factor, or to renumber the cross section river stationing based on the
main channel reach lengths

- - - _.
RS NewRS ·1

1 5.99 ?.~~.- .............•..•.- .._._. .-1
2 5.875' 5875'
3 5.76 5.76
4 5.685' 5.685'
5 5.61 5.61
6 5.525' 5.525'
7 5.44 5.44
8 5.41 541
9 5.4 SR 5.4

10 5.39 539 ~

River. lBeaver C,eek 3
Reoch: IKentwood ::oJ

Selected Area Global Ed~s

Add Canstont I Multiply by FactOl

Genelate RS based on main channellength--
I Starling RS Value: 10
LCreate RS in miles I Create RS in feel II

OK Cancel Help

Figure 6.58 Cross Section River Stationing View and Editing Table

Node Names

This option allows the user to add an additional name to a node (a node is a
cross section, bridge, culvert, inline structure, etc ... ). The name can be up to
16 characters long. The user can request that the name be displayed on a
profile plot or on a cross-section plot. To use this feature, select Node
Names from the Tables menu. When this option is selected a window will
appear as shown in Figure 6-59. Enter any text name that you want at a
desired location within the model.
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Node Names ~~

Set ValuesMulliply Factor I

:o::J 00~ IjJ W Ed~ InlerpolatedXS's

:o::J

-- - -
River Sta Node Name (16 char max) &1

1 5.99 W
2 5.875"
3 5.76 !E~§~_G.~~,,::::::=:::~::::::::::::=:-
4 5.685"
5 5.61
6 5.525"
7 5.44
8 541
9 5.4 Highway 1049

10 5.39
11 5.29
12 5.21"

l.:J13 5.13

Ri·..er: IBeaver Creek

Reach: IKentwood

,- Selected AIea Global Edits ­
Add Constant I

OK Cancel Help

Figure 6.59 Node Name Table Editor

Node Descriptions

This table allows the user to enter a description for any node (cross section,
bridge, culvert, inline structure, lateral structure, and pump stations). The
description can be up to six rows of text. The table allows the user to display
any number of the rows at one time. The user can request that the description
be displayed on a profile plot or on a cross-section plot. To use this feature,
select Node Descriptions from the Tables menu. Enter any text description
that you want at a desired location within the model.

Picture File Associations

This table allows the user to see and edit the directories that pictures are
attached to for the project. For example, ifall of the pictures for a project
were in a directory separate from the project, and these pictures were then
moved to another directory, this table would allow you to easily change the
associated directory for the pictures.

Bridge Width Table

This option allows the user to view and/or modify bridge width and distance
data. Previous versions of HEC-RAS (versions 2.21 and earlier) allowed the
user to enter a zero length between the cross sections inside of a bridge and
the cross sections just outside of the bridge. This creates and unrealistic
water surface profile in the vicinity of the bridge. Current versions require
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the user to maintain some distance between the outside cross sections and the
bridge structure. This table was added to make the process of modifying old
data sets less painful. When this option is selected, a window will appear as
shown in Figure 6-60. As shown in Figure 6-60, the user is given the length
between the cross sections that bound the bridge, the distance between the
upstream cross section and the bridge, the bridge width, and the distance
between the downstream cross section and the bridge. The user must ensure
that the upstream and downstream distances are greater than zero. This will
require entering an upstream distance, and then changing the bridge width to
allow for a positive downstream distance.

; 11-

River: I8ald Eagle

Reach: ILoc Hav

Selected Alea Global Edls
Add Constant I

...

Multiply Factor I Set Values

River Sta D~tAvai Upsbeam Dis! I Width I
1 103245 24745 ]QQ ..__._-_.._•.......__.., 42
2 75960 85.15 30 30
3 58780 1277 40 20
4 36713 106.12 35 30
5 23828 88.41 20 50
6 21241 83.41 30 20
7 15100 593.53 240 210
8 11985 169.43 50 50
9 2920 316.24 50 160

10 2436 129.19 15 100

OK Cancel Help

Figure 6.60 Bridge Width and Distance Table

Weir and Gate Coefficient Table

This table allows the user to see and edit all of the weir and gate coefficients
for all of the inhne and lateral structures within the model.

Importing Geometric Data

HEC-RAS has the ability to import geometric data in several different
formats. These formats include: a GIS format (developed at HEC); the
USACE Standard Surveyor format; HEC-2 data format; HEC-RAS data
format; UNET geometric data format; and the MIKEll cross section data
format. Data can be imported into an existing HEC-RAS geometry file or for
a completely new geometry file. Multiple data files can be imported into the
same geometric data file on a reach-by-reach basis.
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To import data into a HEC-RAS geometric data file, the user selects the
Import Geometric Data option from the File menu of the Geometric Data
window. Once this option is selected, the user then selects one of the three
available formats from the list. After a format is selected, the user will be
asked if they want to add the data to the current geometry file, or if they want
to clear the current geometry file before importing the data. Once this choice
is made, the user will be prompted to enter the name of the file containing the
data. The following is a discussion of each of the three file formats.

GIS Format

A file format for interfacing HEC-RAS with GIS/CADD systems has been
developed at HEC. A detailed description of the file format is contained in
Appendix B of this manual. Chapter 14 of this manual provides detailed
discussions on how to import GIS/CADD data into HEC-RAS, as well as
how to export computed water surface profiles back to GIS/CADD systems.

USACE Survey Data Format

The U.S. Army Corps of Engineers (USACE) has developed a standard file
format for survey data. This format is documented in Chapter 6 of
Engineering Manual (EM) 1110-1-1005. The USACE survey format
encompasses a wide range of data types. The current version of HEC- RAS
has the capability to read this file format, but only cross section data are
extracted from the file. At this time all other data are ignored.

HEC-2 Data Format

The HEC-2 program was the predecessor to the HEC-RAS software package.
The HEC-2 program was used for many years to compute steady flow water
surface profiles. Consequently, thousands of data sets exist in the HEC-2
data format. HEC-RAS has two ways of importing HEC-2 data. The first
way is accomplished through the use of the Import HEC-2 Data option from
the File menu on the main HEC-RAS window. When this method is used, it
is assumed that the user has started a new project; and therefore all of the
HEC-2 data is imported (geometric data, flow data, and plan information). A
second way of importing HEC-2 data is provided from the geometric data
editor. This way of importing HEC-2 data allows the user to bring the data
into existing HEC-RAS geometric data files. This method also allows the
user to import multiple HEC-2 data files into the same HEC-RAS geometric
data file. However, when importing HEC-2 data from the geometric data
window, only the geometric data contained in the HEC-2 files will be
imported. All of the other data (flow data and plan information) will be
ignored.

HEC-RAS Data Format

This option allows the user to combine several HEC-RAS geometry files into
a single geometry tile. For example, if severa] pieces of a river system were
developed as separate HEC-RAS models, this option could be used to put
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them together into one model.

UNET Geometric Data Format

This option allows the user to import a UNET geometric data file (CSECT
geometry file). UNET is an unsteady flow program developed by Dr. Robert
Barkau. The Corps, as well as many other agencies, has used this software
for many years. UNET models are often very complex, consisting of many
river reaches that can be connected in numerous ways. The HEC-RAS UNET
importer does not have enough information to draw the schematic in the
proper manner. The river reaches and storage areas will be connected
correctly, but the user will need to edit the schematic to make it look like the
actual ri ver system.

MIKE11 Cross-Section Data

This option allows the user to import cross section data from the MIKEll
program. MIKE II is a one-dimensional river hydraulics model developed by
the Danish Hydraulic Institute. Users must first export the MIKE I I data to a
raw text file. This is an available option from MIKEll. Once the data is in
the text file format, it can be imported into HEC-RAS.

Geometric Data T0015

Several tools are available from the Geometric Data editor to assist you in the
development and editing of data. These tolls consist of: cross section
interpolation; channel modification; graphical cross section editor; reverse
stationing data; set ineffective flow areas to permanent mode; cross section
points filter; fixed sediment elevation; pilot channels; and GIS cut line check.
The cross section interpolation tool has been described previously in this
chapter. Channel modification is described separately in Chapter 13 of this
manual. The following is a short description of each of the tools.

Graphical Cross Section Editor

A graphical cross section editor is available from the Tools menu of the
Geometric Data Editor window. When this option is selected, a window will
appear as shown in Figure 6.61.

The user has the option to move objects (objects are ground points, main
channel bank stations, ineffective flow areas, levees, and blocked
obstructions), delete objects, or add new objects. To move an object, the user
first selects Move Objects from the Options menu. Then move the mouse
pointer over the object that you want to move, press down the left mouse
button, and then move the object. When you are finished moving the object,
simply release the left mouse button and the object will be moved. To delete
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CHAPTER 7

Performing a Steady Flow Analysis

This chapter discusses how to calculate steady flow water surface profiles.
The chapter is divided into two parts. The first part discusses how to enter
steady flow data and boundary conditions. The second part discusses how to
develop a plan and perform the calculations.

Contents

• Entering and Editing Steady Flow Data

• Performing Steady Flow Calculations

Entering and Editing Steady Flow Data

Once all of the geometric data are entered, the modeler can then enter any
steady flow data that are required. To bring up the steady flow data editor,
select Steady Flow Data from the Edit menu on the HEC-RAS main
window. The steady flow data editor should appear as shown in Figure 7.1

Steady Flow Data

The user is required to enter the following information: the number of profiles
to be calculated; the peak flow data (at least one flow for every river reach
and every profile); and any required boundary conditions. The user should
enter the number of profiles first. The next step is to enter the flow data.
Flow data are entered directly into the table. Use the mouse pointer to select
the box in which to enter the flow then type in the desired value.

Flow data are entered from upstream to downstream for each reach. At least
one flow value must be entered for each reach in the river system. Once a
flow value is entered at the upstream end of a reach, it is assumed that the
flow remains constant until another flow value is encountered within the
reach. The flow data can be changed at any cross section within a reach. To
add a flow change location to the table, first select the reach in which you
would like to change the flow (from the river and reach boxes above the
table). Next, select the River Station location for which you want to enter a
flow change. Then press the Add Flow Change Location button. The new
flow change location will appear in the table.
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5teady Flow Data - 10,2 and 1% chant JiY
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IEdit Sleady flow dala for Ihe proliles (cis)

Figure 7.1 Steady Flow Data Editor

Each profile is aUlomatically assigned a title based on the profile number,
such as profile #1 is assigned a title of"Prof#I," profde #2 is assigned a title
of "Prof#2," etc. The user can rename the title for each profile by simply
going into the options menu and selecting Edit Profile Names. Once this
option is selected, a dialog will appear allowing you to rename each of the
profile titles.

Boundary Conditions

After all of the flow data have been entered into the table, the next step is to
enter any boundary conditions that may be required. To enter boundary
conditions data, press the Boundary Conditions button at the top right of the
steady flow data editor. The boundary conditions editor should appear as
shown in Figure 7.2.

Boundary conditions are necessary to establish the starting water surface at
the ends of the river system (upstream and downstream). A starting water
surface is necessary in order for the program to begin the calculations. In a
subcritical flow regime, boundary conditions are only necessary at the
downstream ends of the river system. If a supercritical flow regime is going
to be calculated, boundary conditions are only necessary al the upstream ends
of the river system. If a mixed flow regime calculation is going to be made,
then boundary conditions must be entered at all ends of the river system.
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Figure 7.2 Steady Flow Boundary Conditions Editor

The boundary conditions editor contains a table listing every reach. Each
reach has an upstream and a downstream boundary condition. Connections to
junctions are considered internal boundary conditions. Internal boundary
conditions are automatically listed in the table, based on how the river system
was defined in the geometric data editor. The user is only required to enter
the necessary external boundary conditions.

To enter a boundary condition, first use the mouse pointer to select the celJ
location in which you would like to enter a boundary condition. Then select
the type of boundary condition from the four available types listed above the
table. The four types of boundary conditions consist of

Known Water Surface Elevations - For this boundary condition the user
must enter a known water surface for each of the profiles to be computed.

Critical Depth - When this type of boundary condition is selected, the user is
not required to enter any further information. The program wilJ calculate
critical depth for each of the profiles and use that as the boundary condition.

Normal Depth - For this type of boundary condition, the user is required to
enter an energy slope that will be used in calculating normal depth
(Manning's equation) at that location. A normal depth wilJ be calculated for
each profile based on the user-entered slope. If the energy slope is unknown,
the user could approximate it by entering either the slope of the water surface
of the slope of the channel bottom.

Rating Curve - When this type of boundary condition is selected, a pop up
window appears alJowing the user to enter an elevation versus flow rating
curve. For each profile. the elevation is interpolated from the rating curve
given the flow.
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An additional feature of the boundary condition editor is that the user can
specify a different type of boundary condition for each profile at the same
location. This is accomplished by first selecting the option that says "Set
boundary for one profile at a time" at the top of the window. When this
option is selected, the table will expand out to provide a row for each profile,
at every location. The user can then select the location and profile for which
they would like to change the boundary condition type.

Once all the boundary conditions data are entered, press the OK button to
return to the steady flow data editor. Press the Apply Data button to have the
data accepted.

Steady Flow Data Options

Several options are available from the steady flow data editor to assist users
in entering the data. These features can be found under the Options menu at
the top of the window. The following options are available:

Undo Editing. This option allows the user to retrieve the data back to the
form that it was in the last time the Apply Data button was pressed. Each
time the Apply Data button is pressed, the Undo Editing feature is reset to the
current infomnation.

Delete Row From Table. This option allows the user to delete a row from
the flow data table. To use this option, first select the row to be deleted with
the mouse pointer. Then select Delete Row From Table from the options
menu. The row will be deleted and all rows below it will move up one.

Delete All Rows From Table. This option allows the user to delete all of the
rows from the table. To use this option, select Delete All Rows From Table
from the Options menu. When this option is selected a window will appear
with a question to make sure that deleting all of the row is what you really
want to do.

Delete Column (Profile) From Table. This option allows the user to delete
a specific column (profile) of data from the table. To use this option, first
select the column that you want to delete by placing the mouse over any cell
of that column and clicking the left mouse button. Then select Delete
Column (Profile) From Table from the Options menus. The desired
column will then be deleted.

Ratio Selected Flows. This option allows the user to multiply selected
values in the table by a factor. Using the mouse pointer, hold down the left
mouse button and highlight the cells that you would like to change by a
factor. Next, select Ratio Selected Flows from the options menu. A pop up
window will appear allowing you to enter a factor to multiply the flows by.
Once you press the OK button, the highlighted cells will be updated with the
new values.
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Edit Profile Names. This option allows the user to change the profile names
from the defaults of PF# I, PF#2, etc.

)

Set Changes in WS and EG. This option allows the user to set specific
cbanges in the water surface and energy between any two cross sections in the
model. The changes in water surface and energy can be set for a specific
profile in a multiple profile model. When this option is selected, a window
will appear as shown in Figure 7.3. As shown, there are four options that the
user can select from: Additional EG, Change in EG, Known WS, and
Change in WS. The Additional EG option allows the user to add an
additional energy loss between two cross sections. Tbis energy loss will be
used in the energy balance equation in addition to the normal friction and
contraction and expansion losses. The Change in EG option allows the user
to set a specific amount of energy loss between two cross sections. When this
option is selected, the program does not perform an energy balance, it simply
adds the specified energy loss to the energy of the downstream section and
computes a corresponding water surface. The Known WS option allows the
user to set a water surface at a specific cross section for a specific profile.
During the computations, the program will not compute a water surface
elevation for any cross section where a known water surface elevation has
been entered. The program will use the known water surface elevation and
then move to the next section. The Change in WS option allows the user to
force a specific change in the water surface elevation between two cross
sections. When this option is selected, the program adds the user specified
change in water surface to the downstream cross section, and then calculates a
corresponding energy to match the new water surface.

Set Internal Changes in WS and EG ". Ji·t

Select Localion and Profile, then Select Method

Delete

Prof
10 J'f

Reach
Tributary

Rive,
Bulle Cr.

Rives: IButte Cr. 3 Profile '110 y' :::J
Reach: I-=T""ribut-a-ry-----3 River Sla. 1-0"".2------::1

Additional EG I Change in EG Known VIS Change in VIS I

OK Cancel Help Clear Ai

Figure 7.3 Setting Changes in Water Surface and Energy

As shown in Figure 7.3, to use the "Set Internal Changes in WS and EG"
option, the user first selects the river, reach, river station, and profile that they
would like to add an internal change too. Once the user has established a
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location and profile, the next step is to select one of the four available options
by pressing the appropriate button. Once one of the four buttons are pressed,
a row will be added to the table at the bottom, and the user can then enter a
number in the value column, which represents the magnitude of the internal
change.

Observed WS. This option allows the user to enter observed water surfaces
at any cross section for any of the computed profiles. The observed water
surfaces can be displayed on the profile plots and in the summary output
tables.

Gate Openings. This option allows the user to control gate openings for any
inline or lateral gated spillways that have been added to the geometric data.
When this option is selected, a window will appear as shown in Figure 7.4.

Spillway Gate Openings ," 'r~s

Gate: INittany River Weir Reach 41.75

Dese. hnline We, and Gated Spillway

iJ[!J[!]
nGale groups: 13

Gate GrouD n DDenino, GateHt PFn1 I IPFn2 I IPFn3 I I
fill n Open IOpen HI In Open IOpen HI I n Open IOpen HI I

Left Group 5 10 0 0 L? .. :3 3 6
Center Group 5 10 5 '5 5 5 5 6
Right Group 5 10 0 0 2 3 3 6

L!.LJ ~

OK

1 riter thenumberoTgates opened for profile 2

Cancel Help

Figure 7.4 Inline Spillway Gated Openings Editor

As shown in Figure 7.4, for each profile the user can specify how many gates
are opened per gate group, and at what elevation they are opened too. For the
example shown in Figure 7.4, there are three gate groups labeled "Left
Group," "Center Group," and "Right Group." Each gate group has five
identical gate openings. All of the gate openings have a maximum opening
height often feet. For profile number 1, only the middle gate group is
opened, with all five gates opened to a height of five feet. For the second
profile, all three gate groups are opened. The Left gate group has two gates
opened to seven feet, the Center gate group has five gates opened to four feet,
and the Right gate group has two gates opened for seven feet. This type of
information must be entered for all of the profiles being computed.

Optimize Gate Openings. This option allows the user to have the program
compute a gate setting at a structure in order to obtain a user specified water
surface upstream of the structure. Given a user entered flow and upstream
stage for each profile, the program will iterate with different gate settings
until the desired upstream water surface is obtained. This option is very
handy when modeling dams and reservoirs.
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Initial Lateral Split FlolV Values. This option allows the user to enter initial
estimates of the flow that is leaving the main river through a lateral
weir/spillway. Flow values can be entered for each profile. When a value is
entered for this option, that amount of flow is subtracted from lhe main river
before the first profile is computed. This option can be useful in reducing the
required computation time, or allowing the program to reach a solution that
may not otherwise been obtainable.

Storage Area Elevations. This option allows the user to enter water surface
elevations for storage areas that have been entered into the geometric data.
Storage areas are most often used in unsteady flow modeling, but they may
also be part of a steady flow model. When using storage areas within a
steady flow analysis, the user is requires to enter a water surface elevation for
each profile.

Saving The Steady Flow Data

The last step in developing the steady flow data is to save the information to a
file. To save the data, select the Save FlolV Data As from the File menu on
the steady flow data editor. A pop up window will appear prompting you to
enter a title for the data.

Importing Data From The HEC Data Storage System
(HEC-DSS)

HEC-DSS is a data base system that was specifically designed to store data
for applications in waler resources. The HEC-DSS system can store almost
any type of data, but it is most efficient at storing large blocks of data (e.g.,
time-series data). These blocks of data are stored as records in HEC-DSS,
and each record is given a unique name called a "pathname." A pathname
can be up to 391 characters long and, by convention, is separated inlo six
parts. The parts are referenced by the letters A, B, C, 0, E, and F, and are
delimited by a slash "I" as follows:

/NB/C/DIEIF/

The pathname is used to describe the data in enough detail that various
application programs can write to and read data from HEC-DSS by simply
knowing the pathname. For more information about HEC-DSS, the user is
referred to the "HEC-DSS, User's Guide and Utility Manuals" (HEC, 1995).

Many of the HEC application programs have the ability to read from and
write to the HEC-DSS. This capability facilitates the use of observed data as
well as passing information between software programs. The ability to read
data from HEC-DSS has been added to HEC-RAS in order to extract flow
and stage data for use in water surface profile calculations. It is a common
practice to use a hydrologic model (i.e., HEC-HMS) to compute the runoff
from a watershed and then use HEC-RAS to compute the resulting water
surface profiles.
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Reading data from HEC-DSS into HEC-RAS is a two-step process. First, the
user must establish connections between HEC-RAS cross-section locations
and pathnames contained in the HEC-DSS file. These connections are
established by selecting the "Set Locations for DSS Connections" option
from the File menu of the Steady Flow Data editor. When this option is
selected, a window will appear as shown in Figure 7.5. The user selects
cross-section locations for DSS connections by selecting a River, Reach, and
River Station, then pressing the "Add selected location to table" button.
When this button is pressed, a new row will be added to the table at the top of
the window. The user should do this for all the locations where they want to
establish connections to HEC-DSS data.

The next step is to open a particular HEC-DSS file. The user has the option
of either typing the filename in directly, or using the open button, which is
right next to the filename field. Once a DSS file is selected, a listing of the
pathnames for all of the data contained in that file will appear in the table at
the bottom of the window. The user can establish connections to more than
one DSS file if desired.

IiilSet locations for OSS Connections ...1.';1 •

River: IBald Eagle Creek =:]
Reach: jlake to Lock Hav 3 RiveISta.: 1138154.4 3

River Reach AS DSS File
Bald Easje C,eek Lake 10 Lock Hay 13B154.4 C:IHECIRASIBal,
Bald Easje C,eek Lake to Lock Hay 82607.89 C:IHECIRASIBal,
Bald Eagle C,eek Lake to Lock Hay B1 B49.41 C:IHECIRASIBal,
Bald Eagle C,eek Lake to Lock Hay 7600296 C:IHECIRASlBal,
Bald Eagle C,eek Lake to Lock Hay 6732678 C:IHECIRASIBa/,

Delete row from table

SAYER IN
BLANC
MARSHJCT
MAR·BEE

FLOW
FLOW
FLOW
FLOW

•

BALDEAGLE NOV9
BALDEAGLE NOV9
BALDEAGLE NOV9 -l
BALDEAGLE NOV9
BALD EAGLE NOV9
BALD EAGLE NOV9
l:t.]'.I:r.!ij"~I"IJ:1

~AL~:~~L: ~~~ .:J
I

1HOUR
1HOUR01 NOVl993

Select DSS Pathname

FLOW 01110'11993
FLOWMILES JCT

IC:\HEC\RAS\8C11dE agle\fofecasl.dss ::J~ Upda'e Calalog I
Part A Pari B PartC Pelfl D P",tE

FLOW OlNOVl993
HOW·SPR FLOW 01NOV1993 1HOUR
M.AR·BEE FLOW 01 N0V1993 lHOUR
MARSH HW FLOW 01NOV1993 1HOUR
MARSHJCT FLOW 01 NOVl993 1HOUR
MIL·SAY FLOW 01 N0V1993 1HOUR
MILES HW FLOW 01 NOVl993 lHOUR

10
11
12
13
14
15

16•••••1

17 SAYER

Frlt..

DSS Frle:

Plot Selected Pathname OK Cancel I

Figure 7.5 Editor for selling connections to HEC-DSS pathnames.
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To establish the connection between an HEC-RAS cross section and a
particular pathname in the DSS file, the user selects the row in the upper table
that contains the river station that they want to connect data to. Next, they
select the path name that they want to connect to that river station from the
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lower table. Finally, they press the button labeled "Select DSS Pathname,"
and the pathname is added to the table at the top of the window.

To make it easier to find the desired pathnames, a set of pathname part filters
were added to the top row of the lower table. These filters contain a list of all
the DSS pathname parts contained within the currently opened DSS file. If
the user selects a particular item within the list of one of the pathname parts,
then only the pathnames that contain that particular pathname part will be
displayed. These filters can be used in combination to further reduce the list
of pathnames displayed in the table. When a particular filter is left blank, that
means that pathname part is not being filtered.

Another featnre on the editor to assist in selecting the appropriate pathnames
is the "Plot Selected Pathname" button. This button allows the user to get a
plot or a table of the data contained within any record in the DSS file. The
user simply selects a DSS pathname, and then presses the Plot Selected
Pathname button, and a new window will appear with a graphic of the data
contained within that record.

Once all of the pathname connections are set, the user presses the 0 K button
to close the editor. The next step is to import the data. This is accomplished
by selecting "DSS Import" from the File menu ofthe Steady Flow Data
editor. When this option is selected, a window will appear as shown in
Figure 7.6

""
• 2>.1.. , I

r Time Window

Staring Date: IZ7flov1993 Staring Time: 10000

Ending Dale: 105Dec1993 Ending Time: !JZOO

w [~.~~'f~·~·~.~·~.~9.!ij.~.~·.·.~.\·jF~.·t~Ji.9.~16g.·.r~I~·i.~.~U Is Hour 3
~ Get Peak Flows at all Locations for Final Profile

Interpolation Options for Locations With No DSS Data-
r No Interpolation (Leave Blankl
(+ Linear Interpolation
r Use existing flow profiles as ratios

\ -

Import Data OK Cancel Help

Figure 7.6 DSS Data Import Window

First the user sets a time window, which consists of a starting date and time
and an ending date and time. When data are extracted from DSS, the
program will only look at the data that is contained within the user specilled
time window.
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Below the time window there are two options for selecting flow data to be
extracted from the DSS file. The first option allows the user to pick off flow
data at a specified time interval, starting with the beginning of the time
window for the first profile. The second and subsequent profiles would be
based on adding the user specified time interval to the start time of the time
window. Flow data is extracted from the hydrographs at each of the locations
being read from DSS. The second option listed on the window allows the
user to get an overall peak flow for a profile computation. When this option
is selected, the peak flow will be extracted from each hydrograph, within the
time window specified. These peak flows will be made into the final profile
in the flow data editor.

The bottom portion of the window contains options for interpolating flow
data at locations that do not have hydrographs in the DSS file. After the flow
data are read in, it will be necessary to interpolate flow data at all of the
locations listed in the flow data editor that do not have values in the DSS file.
Three options are available: no interpolation, linear interpolation, or using the
flow data from an existing profile to calculated ratios for interpolating
between points that have data. Once all the options are set, the user presses
the "Import Data" button, to have the data imported and fill out the flow data
editor.

Performing Steady Flow Calculations

Once all of the geometry and steady flow data have been entered, the user can
begin calculating the steady flow water surface profiles. To perform the
simulations, go to the HEC-RAS main window and select Steady Flow
Analysis from the Run menu. The Steady Flow Analysis window will
appear as in Figure 7.7 (except yours may not have a Plan title and short 10).

IISteady flow Analysis '., <

File Options Help

Plan: Existing Conditions Run ShoriiD IExistlng

Flow Regime
I r.- Subcritical
r Supercritical
(" Mi:<ed

I:•....

Geometry File: IBase Geometry Data 3
Sleady Flow File: 1-:-'O:-.-::2-a-n-c-:-dn:-.-ch:-a-n-ce--ev-e-nl-s------~:.:J

Plan Description:1--'---------0
Enter to compute water surface profiles

Figure 7.7 Steady Flow Analysis window

7-10



)

Chapter 7 performjng a Steady Bow Analvsjs

Defining A Plan

The first step in performing a simulation is to put together a Plan. The Plan
defines which geometry and flow data are to be used, as well as provide a
description and short identifier for the run. Also included in the plan
information are the selected flow regime and the simulation options.

Before a Plan is defined, the user should select which geometry and flow data
will be used in the plan. To select a geometry or flow file, press the down
arrow button next to the desired data type. When this button is pressed, a list
will appear displaying all of the available files of that type that are currently
available for the project. Select the geometry and flow files that you want to
use for the current plan.

To establish a Plan, select New Plan from the File menu on the steady flow
analysis window. When New Plan is selected, a window will appear
prompting you to enter a title for the plan. After you enter the title, press the
OK button to close the window and accept the title. The user will also be
prompted to enter a short identifier for the plan. The short identifier is limited
to 12 characters. It is very important to enter a short identifier that is
descriptive of the plan. When viewing multiple plan output from the graphics
and tables, the Short ro will be used to identify each plan.

The last step is to select the desired flow regime for which the model will
perform calculations. The user can select between subcritical, supercritical,
or mixed flow regime calculations.

Saving The Plan Information

To save Plan information to the hard disk, select Save Plan from the File
menu of the simulation window. Whenever options are changed or modified
on the Steady Flow Analysis window, the user should Save the Plan.

Simulation Options

The following is a list of the available simulation options under the Options
menu of the Steady Flow Analysis window:

Encroachments. This option allows the user to perform a floodway
encroachment analysis. For a detailed description of how to use the floodway
encroachment capabilities ofHEC-RAS, see Chapter 9 of the User's Manual
(this manual). For a description of how the encroachment calculations are
performed for the various encroachment methods, see Chapter 9 of the
Hydraulic Reference Manual.

Flow Distribution Locations. This option allows the user to specify
locations in which they would like the program to calculate flow distribution
output. The flow distribution option allows the user to subdivide the left
overbank, main channel, and right overbank, for the purpose of computing
additional hydraulic information.
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As shown in Figure 7.8, the user can specify to compute flow distribution
information for all the cross sections (this is done by using the Global option)
or at specific locations in the modeL The number of slices for the flow
distribution computations must be defined for the left overbank, main
channel, and the right overbank. The user can define up to 45 total slices.
Each flow element (left overbank, main channel, and right overbank) must
have at least one slice. The flow distribution output will be calculated for all
profiles in the plan during the computations.

Set Locations for flow Distribution ;..}t

rSet Global Subsection Distribution --- - - -- - -- -_. -1
,SeIGlobaISubSec~o:, •__ . LOB [103 Channel~~~B 11O::oJ.

I
~-set Specific Location Subsection Distribution-- '---l
River: IButte Cr. il

i I
.Reach: IT ributary ::::J
ISlarlingRiVSla: 102 ::oJ LOB n Channel n ROB n I
IEnding Riv Sla: 10.2::oJ Sel Selected Range II

II
I

Cancel Help Clear All

Figure 7.8 Window for Specifying the Locations of Flow Distribution

To set the flow distribution option for all the cross sections, simply select the
number of slices for the left overbank, main channel, and right overbank from
the Set Global Subsections portion of the window. To set flow distribution
output at specific locations, use the Set Specific Location Subsection
Distribution option.

During the normal profile computations, at each cross section where flow
distribution is requested, the program will calculate the flow, area, wetted
perimeter, percentage of conveyance, and average velocity for each of the
user defined slices. For details on how the flow distribution output is
actually calculated, see Chapter 4 of the HEC-RAS Hydraulic Reference
ManuaL For information on viewing the flow distribution output, see Chapter
9 of the User's Manual (this manual).
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Conveyance Calculations. This option allows the user to tell the program
how to calculate conveyance in the overbanks. Two options are available.
The first option, At breaks in n values only, instructs the program to sum
wetted perimeter and area between breaks in n values, and then to calculate
conveyance at these locations. If n varies in the overbank the conveyance
values are then summed to get the total overbank conveyance. The second
option, Between every coordinate point (HEC-2 style), calculates wetted
perimeter, area, and conveyance between every coordinate point in the
overbanks. The conveyance values are then summed to get the total left
overbank and right overbank conveyance. These two methods can provide
different answers for conveyance, and therefore different computed water
surfaces. The At breaks in n values only method is the default.

Friction Slope Methods. This option allows the user to select one of four
available friction slope equations, or to allow the program to select the
method based on the flow regime and profile type. The four equations are:

- Average Conveyance (Default)

- Average Friction Slope

- Geometric Mean Friction Slope

- Harmonic Mean Friction Slope

Set Calculation Tolerances. This option allows the user to override the
default settings for the calculation tolerances. These tolerances are used in
the solution of the energy equation. Warning !!! - Increasing the default
calculation tolerances could result in computational errors in the water
surface profile. The tolerances are as follows:

Water surface calculation tolerance: This tolerance is used to compare
against the difference between the computed and assumed water surface
elevations. When the difference is less than the tolerance, the program
assumes that it has a valid numerical solution.

Critical depth calculation tolerance: This tolerance is used during the critical
depth solution algorithm.

Maximum number of iterations: This variable defines the maximum number
of iterations that the program will make when attempting to balance a water
surface.

Maximum difference tolerance: This tolerance is used during the balance of
the energy equation. As the program attempts to balance the energy equation,
the solution with the minimum error (assumed minus computed water
surface) is saved. If the program goes to the maximum number of iterations
without meeting the specified calculation tolerance, the minimum error
solution is checked against the maximum difference tolerance. If the solution
at minimum error is less than this value, then the program uses the minimum
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error solution as the answer, issues a warning statement, and then proceeds
with the calculations. If the solution at minimum error is greater than the
maximum difference tolerance, then the program issues a warning and
defaults the solution to critical depth. The computations then proceed from
there.

Flow Tolerance Factor: This factor is only used in the bridge and culvert
routines. The factor is used when the program is attempting to balance
between weir flow and flow through the structure. The factor is multiplied by
the total flow. The resultant is then used as a flow tolerance for the balance
of weir flow and flow through the structure.

Maximum Iteration in Split Flow: This variable defines the maximum
number of iterations that the program will use during the split flow
optimization calculations.

Flow Tolerance Factor in Weir Split Flow: This tolerance is used when
running a split flow optimization with a lateral weir/gated spillway. The split
flow optimization continues to run until the guess of the lateral flow and the
computed value are within a percentage of the total flow. The default value
for this is 2 percent (.02).

Maximum Difference in Junction Split Flow: This tolerance is used during a
split flow optimization at a stream junction. The program continues to
attempt to balance flow splitting from one reach into two until the energy
gradelines of the receiving streams are within the specified tolerance.

Each of these variables has an allowable range and a default value. The user
is not allowed to enter a value outside of the allowable range.

Critical Depth Output Option. This option allows the user to instruct the
computational program to calculate critical depth at all locations.

Critical Depth Computation Method. This option allows the user to select
between two methods for calculating critical depth. The default method is the
Parabolic Method. This method utilizes a parabolic searching technique to
find the minimum specific energy. This method is very fast, but it is only
capable of finding a single minimum on the energy curve. A second method,
Multiple Critical Depth Search, is capable of finding up to three minimums
on the energy curve. Ifmore than one minimum is found the program selects
the answer with the lowest energy. Very often the program will find
minimum energies at levee breaks and breaks due to ineffective flow settings.
When this occurs, the program will not select these answers as valid critical
depth solutions, unless there is no other answer available. The Multiple
Critical Depth Search routine takes a lot of computation time. Since critical
depth is calculated often. using this method will slow down the computations.
This method should only be used when you feel the program is finding an
incorrect answer for critical depth.
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Split Flow Optimizations. This option allows the user to have the program
optimize the split of flow at lateral structures, lateral diversions, stream
junctions, and pump stations. When this option is selected, a window will
appear as shown in Figure 7.9. As shown in Figure 7.9, there are four tabs to
choose from. One tab is for each of the following: Junctions; Lateral
Weirs/Diversions; Reach-Storage Areas; and Pump Stations.

When the Lateral Weir/Diversion tab is selected, a table with all of the
lateral weirs/spillways and rating curves defined in the model will be
displayed. To have the program optimize the split of flow between the main
stream and a lateral weir/spillway (or rating curve), the user simply checks
the column labeled "Optimize." If you do not want a particular lateral
weir/spillway to be optimized, the user should not check the box. For the first
iteration of the flow split optimization, the program assumes that zero flow is
going out of the lateral structure. Once a profile is computed, the program
will then compute flow over the lateral structure. The program then
iteratively reduces the flow in the main channel, until a balance is reached
between the main river and the lateral structure. The user has the option to
enter an initial estimate of the flow going out the lateral structure. This can
speed up the computations, and may allow the program to get to a solution
that may not have otherwise been possible. This option is available by
selecting "Initial Split Flow Values" from the "Options" menu of the Steady
Flow Data editor.

Steady Flow Analysis - Flow Optiinizaliolr Opt .•.

r}uncilon~:n La!eralWeir/Diversions I r. ... ,
Optimize

OK Cancel

Figure 7.9 Split Flow Optimization Window

When the Junction tab is selected, the table will show all of the junctions in
the model that have flow splits. To have the program optimize the split of
flow at a junction, check the optimize column, otherwise leave it unchecked.
Flow optimizations at junctions are performed by computing the water
surface profiles for all of the reaches. then comparing the computed energy
grade lines for the cross sections just downstream of the junction. If the
energy in all the reaches below a junction is not within a specified tolerance
(0.02 feet), then the flow going to each reach is redistributed and the profiles
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are recalculated. This methodology continues until a balance is reached.

When the Reach - Storage Areas tab is selected, a window will appear
displaying all of the storage areas that are upstream boundaries to river
reaches. If optimization is set on the program will automatically compute the
stage in the storage area based in the flow in the river reach.

The final tab is for Pumps. When this tab is pressed a table will appear
showing all of the locations where pump stations are connected to the main
rivers. The user can then tum on optimization for the split of flow between
the main river and the pump station.

Check Data Before Execution. This option provides for comprehensive data
input checking. When this option is turned on, data input checking will be
performed when the user presses the compute button. If all of the data are
complete, then the program allows the steady flow computations to proceed.
If the data are not complete, or some other problem is detected, the program
will not perform the steady flow analysis, and a list of all the problems in the
data will be displayed on the screen. If this option is turned off, data
checking is not perfonned before the steady flow execution. The default is
that the data checking is turned on.

Set Log File Output Level. This option allows the user to set the level of the
Log file. The Log file is a file that is created by the computational program.
This file contains information tracing the program process. Log levels can
range between 0 and 10, with 0 resulting in no Log output and 10 resulting in
the maximum Log output. In general, the Log file output level should not be
set unless the user gets an error during the computations. If an error occurs in
the computations, set the log file level to an appropriate value. Re-run the
computations and then review the log output, try to determine why the
program got an error.

When the user selects Set Log File Output Level, a window will appear as
shown in Figure 7.10. The user can set a "Global Log Level," which will be
used for all cross sections and every profile. The user can also set log levels
at specific locations for specific profiles. In general, it is better to only set the
log level at the locations where problems are occurring in the computations.
To set the specific location log level, first select the desired reach and river
station. Next select the log level and the profile number (the log level can be
turned on for all profiles). Once you have everything set, press the Set button
and the log level will show up in the window below. Log levels can be set at
several locations individually. Once all of the Log Levels are set, press the
OK button to close the window.

Warning !!! - Setting the log output level to 4 or 5 can result in very large log
file output. Log level values of 6 or larger can result in extremely large log
files.

View Log File. This option allows the user to view the contents of the log
file. The interface uses the Windows Write program to accomplish this. It is
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up to the user to set an appropriate font in the Write program. If the user sets
a font that uses proportional spacing, the information in the log file will not
line up correctly. Some fonls that work well are: Line Printer; Courier (8 pt.);
and Helvetica (8 pt.). Consult your Windows user's manual for information
on how to use the Write program.

Output Log Level -'

Sel Global Log Level

Global Log Level:

Log Level for Selecled Range

Reach=Uppel River
Reach"'Upper River

Starting Riv Sta:

Ending Riv 510:

Spruce Creek
Spruce Creek

Set Spec{1C Log Level Locations

River: ISpruce Creek iJ Profile:

Reach: IUpper River P:J
,..---
11278. 3 Log Level 110 3 .
1'11-88-.----=3 IL..w... m_~_<;t S~l<;£\ii.qF\iii!i<;: __:--;1 '

I
RS=1278. profile= 1 LL=10
RS=1188. profile= 1 LL=10

OK Cancel Help

I

_J

CleO! All I
) Set specific log level lor selected location

Figure 7.10 Log File Output Level Window

Starting the Computations

Once all of the data have been entered, and a Plan has been defined, the
steady flow computations can be performed by pressing the Compute button
at the bottom of the steady flow simulation window. Once the compute
button is pressed, a separate window will appear showing you the progress of
the computations. The information that appears in the window is only there
as an indicator of the programs progress during the computations. This
window is not intended to be used for viewing any output. When the
computations have been completed, the user can close the computations
window by clicking the close button at the bottom of the window. If the
computations ended with a message stating "Finished Steady Flow
Simulation," the user can then begin to review the output.
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CHAPTER 8

Performing an Unsteady Flow Analysis

This chapter shows how to calculate unsteady flow water surface profiles.
The chapter is divided into two parts. The first part explains how to enter
unsteady flow data and boundary conditions. The second part describes how
to develop a plan and perfonn the calculations.

Contents

• Entering and Editing Unsteady Flow Data

• Perfonning Unsteady Flow Calculations

• Calibration of Unsteady Flow Models

• Model Accuracy, Stability, and Sensitivity

Entering and Editing Unsteady Flow Data

Once all of the geometric data are entered, the modeler can then enter any
unsteady flow data that are required. To bring up the unsteady flow data
editor, select Unsteady Flow Data from the Edit menu on the HEC-RAS
main window. The Unsteady flow data editor should appear as shown in
Figure 8.1.

Unsteady Flow Data

The user is required to enter boundary conditions at all of the external
boundaries of the system, as well as any desired intemal locations, and set the
initial flow and storage area conditions at the beginning of the simulation.

Boundary conditions are entered by first selecting the Boundary Conditions
tab from the Unsteady Flow Data editor. River, Reach, and River Station
locations of the external bounds of the system will automatically be entered
into the table. Boundary conditions are entered by first selecting a cell in the
table for a particular location, then selecting the boundary condition type that
is desired at that location. Not all boundary condition types are available for
use at all locations. The program will automatically gray-out the boundary
condition types that are not relevant when the user highlights a particular
location in the table. Users can also add locations for entering internal
boundary conditions. To add an additional boundary condition location,
select the desired River, Reach, and River Station, then press the Add a
Boundary Condition Location button.
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IIUnsleady Flow Data .:,?,:~

Eile Qptions t::!elp

Boundary Condilions I Initial Conditions 1

Select Location tOf Boundar Condition

River: JNittany River

Reach: IWeir Reach

::oJ
::oJ RiveISta.: 160.1 3 Add a Boundary Condition Location I

Boundal Condition T es

Stage/Flow Hydl.

Boundar\' Condition T eRS

Flow Hydroglaph

ReachRiver

Nut; J[~pli

Stage Hydroglaph

1 Nittany River Weir Reach 60.1 Flow H dro la h
2 Nittany River Weir Reach 41.75 IS Elev Controlled Gates

Storage Area or SA Connection

:::oJ Add a Boundary Condition Location I

Rating Curve

Boundarv Condition T e

36.85Wei! Reach3 Nittany River

Storage Area and SA Connections:

Figure 8.1 Unsteady Flow Data Editor

Boundary Conditions

There are several different types of boundary conditions available to the user.
The following is a short discussion of each type:

Flow Hydrograph:

A flow hydrograph can be used as either an upstream boundary or
downstream boundary condition, but is most commonly used as an upstream
boundary condition. When the flow hydrograph button is pressed, the
window shown in Figure 8.2 will appear. As shown, the user can either read
the data from a HEC-DSS (HEC Data Storage System) file, or they can enter
the hydrograph ordinates into a table. If the user selects the option to read the
data from DSS, they must press the "Select DSS File and Path" button.
When this button is pressed a DSS file and pathllame selection screen will
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appear as shown in Figure 8.3. The user first selects the desired DSS file by
using the browser button at the top. Once a DSS file is selected, a list of all of
the DSS palhnames within that file will show up in the table. The user can
use the pathname filters to reduce the number of pathnames shown in the
table. The last step is to select the desired DSS Pathname and to close the
window.

Flow Hydrograph ,~~

River Bald Ea Ie Reach Loe Hav RS 13B1544

r Read flam DSS before simulation

File: I
Palh: rl------------------

r.- Enter Table Data time interval. 11 Hour 3
Select/Enter the Data's Starting Time Referen",ee~==

,CO UseSimulalion Time: Dale' 102/18/1999 Time ooסס1

r Fixed Slarl Time: Date: I Time: r-,
No. Ordinates I InteJpoIale Missing Values: Del Row I Ins Row I

Hydro ra h Dala
Date Simulation Time Flow IAI

(hoursl (cis) I I
1 17Feb19992400 00:00 1000.
2 18Feb1999 0100 01:00 1040.
3 lBFebl999 0200 0200 1080.
4 lBFeb1999 0300 03:00 1120
5 18Feb1999 0400 04:00 1160. ~

r Time SteDAdiustment Ootions f"Criticar' boundary contlliionsl
r Marner this hydlogaph for adjustments to computational time step

'I'---

Min Flow: MuRip~er: I
Plot Dala I OK Cancel

Figure 8.2 Example Flow Hydrograph Boundary Condition

The user also has the option of entering a flow hydrograph directly into a
table, as shown in Figure 8.2. The first step is to enter a "Data time
interval." Currently the program only supports regular interval time series
data. A list of allowable time intervals is shown in the drop down window of
the data interval list box. To enter data into the table, the user is required to
select either "Use Simulation Time" or "Fixed Start Time." If the user
selects "Use Simulation Time", then the hydrograph that they enter will
always start al the beginning of the simulation time window. The simulation
starting dale and time is shown next to this box, but is grayed out. If the user
selects "Fixed Start Time" then the hydrograph is entered starting at a user
specified time and date. Once a starting date and time is selected, the user can
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then begin entering the data.

Illll pick 055 Path . . •

DSS File: IC: IHECIRas30IUnsteadylbeaver.d" :::J @j Update Calalog I
Part A

Filler
109 BEAVER CREEK KENTWDOD 5.951
110 BEAVER CREEK KENTWOOD 5.951
111 BEAVER CREEK KENTWOOD 5.97
112 BEAVER CREEK KENTWOOD 5.97
113 BEAVER CREEK KEflTWOOD 5.99

Part C

FLOW
FLOW
FLOW
FLOW
FLOW
FLOW

PartE

01FEB199: lHOUR
01FEB199: lHOUR
01FEB199: lHOUR
01FEB199: 1HOUR
01FEB199: lHOUR

Part F

:10YEAR EVfIT

1oYEAR EVNT

BEAvER CREEK KENTWOOD 599 FLOW 01FEB199' 1HOUR

Selecl entire fillered lisl Select highlighted DSS Palhnamels)

/BEAVER CREEK KENTWOOO/599IFLOWI01FEB199911 HOURll0YEAR EVNTI

Plot Selected Pathnamelsl I Cleal List Close

Figure 8.3 HEC-DSS File and Pathname Selection Screen

An option listed at the bottom of the flow hydrograph boundary condition is
to make this boundary a "Critical Boundary Condition." When you select
this option, the program will monitor the inflow hydrograph to see if a change
in flow rate from one time step to the next is exceeded. If the change in flow
rate does exceed the user entered maximum, the program will automatically
cut the time step in half until the change in flow rate does not exceed the user
specified max. Large changes in flow can cause instabilities. The use of this
feature can help to keep the solution of the program stable. This feature can
be used at multiple hydrographs simultaneously. The software will evaluate
all of the hydrographs, then calculate a time slice based on the hydrograph
with the largest percentage increase over the user specified maximum flow
change.

Two other options at the bottom of this editor are "Min Flow" and
"Multiplier." Both of these options apply to user entered hydrographs or
hydrographs read from HEC-DSS. The "Min Flow" option allows the user to
specify a minimum flow to be used in the hydrograph. This option is very
useful when too low of a flow is causing stability problems. Rather than edit
the user entered hydrograph or the DSS file (depending upon where the
hydrograph is coming from), the user can enter a single value, and all values
below this magnitude will be changed to that value. The "Multiplier" option
allows the user to multiply every ordinate of the hydrograph by a user
specified factor. This factor will be applied to the user-entered hydrograph or
a hydrograph read from HEC-DSS.
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Stage Hydrograph:

A stage hydrograph can be used as either an upstream or downstream
boundary condition. The editor for a stage hydrograph is similar to the flow
hydrograph editor (Figure 8.2). The user has the choice of either attaching a
HEC-DSS file and pathname or entering the data directly into a table.

Stage and Flow Hydrograph:

The stage and flow hydrograph option can be used together as either an
upstream or downstream boundary condition. The upstream stage and flow
hydrograph is a mixed boundary condition where the stage hydrograph is
inserted as the upstream boundary until the stage hydrograph runs out of data;
at this point the program automatically switches to using the flow hydrograph
as the boundary condition. The end of the stage data is identified by the
HEC-DSS missing data code of "-901.0". This type of boundary condition is
primarily used for forecast models where the stage is observed data up to the
time of forecast, and the flow data is a forecasted hydrograph.

Rating Curve:

The rating curve option can be used as a downstream boundary condition.
The user can either read the rating curve from HEC-DSS or enter it by hand
into the editor. Shown in Figure 8.4 is the editor with data entered into the
table. The downstream rating curve is a single valued relationship, and does
not reflect a loop in the rating, which may occur during an event. This
assumption may cause errors in the vicinity of the rating curve. The errors
become a problem for streams with mild gradients where the slope of the
water surface is not steep enough to dampen the errors over a relatively short
distance. When using a rating curve, make sure that the rating curve is a
sufficient distance downstream of the study area, such that any errors
introduced by the rating curve do not affect the study reach.
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Rating Curve ~,-

RIVer. Truckee Reach. Lower RS.123156 .

C Read from DSS belore simulation

File: I
Path rl------------------

(.' Enter Table

Del Row 1 Ins Row I

H dro ra h Data

Siagelitl I Flow Icls) j,-.2 43665 0

:~ 4373.63 1000

..1 437432 2000

--4 4374.88 3000

~ 4375.37 ·4000.

~ 4375.8 5000

-1 4376.75 7500.

~ 437756 10000.
9 4378.32 12500

10 4379.01 15000.
11 4379.66 17500t 438028 20000. ..:oJ

ICJ'leijpa.i~ j OK Cancel I
Figure 8.4 Example Rating Curve Boundary Condition Editor

Normal Depth:

The Normal Depth option can only be used as a downstream boundary
condition for an open-ended reach. This option uses Manning's equation to
estimate a stage for each computed flow. To use this method the user is
required to enter a friction slope for the reach in the vicinity of the boundary
condition. The slope of the water surface is often a good estimate of the
friction slope.

As recommended with the rating curve option, when applying this type of
boundary condition it should placed far enough downstream, such that any
errors it produces will not affect the results at the study reach.

Lateral Inflow Hydrograph:

The Lateral Inflow Hydrograph is used as an internal boundary condition.
This option allows the user to bring in flow at a specific point along the
stream. The user attaches this boundary condition to the river station of the
cross section just upstream of where the lateral inflow will come in. The
actual change in flow will not show up until the next cross section
downstream from this inflow hydrograph. The user can either read the
hydrograph from DSS or enter it by hand.
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Uniform Lateral Inflow Hydrograph:

The Uniform Lateral Inflow Hydrograph is used as an internal boundary
condition. This option allows the user to bring in a flow hydrograph and
distribute it unifonnly along the river reach between two specified cross
sections. The hydrograph for this boundary condition type can be either read
in from DSS, or entered by hand into a table.

Groundwater Interflow:

The Groundwater lnterflow option allows the user to identify a reach of river
that will exchange water with a groundwater reservoir. The stage of the
groundwater reservoir is assumed to be independent of the interflow from the
river, and must be entered manually or read from DSS. The groundwater
interflow is similar to a unifonn lateral inflow in that the user enters an
upstream and a downstream river station, in which the flow passes back and
forth. The computed flow is proportional to the head between the river and
the groundwater reservoir. The computation of the interflow is based on
Darcy's equation. The user is required to enter Darcy's groundwater loss
coefficient (hydraulic conductivity), a time series of stages for the
groundwater aquifer, and the distance between the river and the location of
the user entered groundwater aquifer stages (this is used to obtain a gradient
for Darcy's equation).

Time Series of Gate Openings:

This option allows the user to enter a time series of gate openings for an
inline gated spillway, lateral gated spillway, or a gated spillway connecting
two storage areas. The user has the option of reading the data from a DSS file
or entering the data into a table from within the editor. Figure 8.5 shows an
example of the Times Series of Gate Openings editor. As shown in Figure
8.5, the user first selects a gate group, then either attaches a DSS pathname to
that group or enters the data into the table. This is done for each of the gate
groups contained within the particular hydraulic structure.
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Gate Openings . "

River N,u River Reach Well Reach RS 41 75 IW

Gate G,Oup:

r Read flom DSS before simulation

IliMij@ji. i .:J [!)[!]
Select 055 file and Path I

Fle. 1
Path' r"1-----------------

a EnterTabie Data time rnellr'a1: 11 Hour :::J
SelectlEnler the Data's St..t;'g Time Reference -

r. UseSimJlation Tme: Date: 1410811999 Time' 10000

r Fixed Start Time: Date: I Time: r-
No. Ordinates I Interpolate Missing Values I Del Row I Ins Row I

H dro ra hData

Date Simulation Time Gate Openilg Heightl.1
Ihoursl (ft) I I

1 07Apr1999 2400 0000 1
2 OBApr1999 0100 01:00 3.23
3 OBApl1999 0200 02:00 147
4 OBApr1999 0300 0100 17
5 OBApl1999 0400 04:00 193
6 OBApr1999 0500 05:00 4.17

~, .......... ~ __1 ...."0"1 ""'-'/"0'" nr-.nn ,.
Plot Data I OK Cancel

Figure 8.5 Example Time Series of Gate Openings Editor

Warning: Opening and closing gates to quickly can cause instabilities in
the solution of the unsteady now equations. If instabilities occur near
gated locations, the user should either reduce the computational time step
and/or reduce the rate at which gates are opened or closed.

Elevation Controlled Gate:

This option allows the user to control the opening and closing of gates based
on the elevation of the water surface upstream of the structure. A gate begins
to open when a user specified elevation is exceeded. The gate opens at a rate
specified by the user. As the water surface goes down, the gate will begin to
close at a user specified elevation. The closing of the gate is at a user
specified rate (feet/min.). The user must also enter a maximum and minimum
gate opening, as well as the initial gate opening. Figure 8.6 shows and
example of this editor.
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Rlver.SaldEa Ie ReacnLocHavRS 81500 1\;/

Upstream WS Elevation at which gate begins to close:

Upstream WS Elevation at which gale begins to open:

Gate Group:

Gale Opening Rale:lll/min):

Gale Closing Rale:lfllminl:

Maximum gate opening:

MinimLlm Gale Opening:

Miiliil

)10
105

Initial Gate Opening: 105

OK __C~~

)

Figure 8.6 Elevation Controlled Gate Editor

Navigation Dam:

This option allows the user to define an inline gated structure as a hinge pool
operated navigation dam. The user specifies stage and flow monitoring
locations, as well as a range of stages and flow factors. This data is used by
the software to make decisions about gate operations in order to maintain
water surface elevations at the monitor locations. A detailed discussion about
Navigation Dams can be found in Chapter 16 ofthe user's manual.

Internal Observed Stage and Flow Hydrograph:

This option allows the user to enter an observed stage hydrograph or a stage
and flow hydrograph, to be used as an internal boundary condition just
upstream of an inline structure (inline weir/spillway, bridge, or culvert). If
only an observed stage hydrograph is entered, the user must have values to
cover the complete simulation range. If a stage and flow hydrpograph is
entered, the stage hydrograph is used as the observed boundary until the stage
hydrograph runs out of data; afterward the flow hydrograph is used. The end
of data in the stage hydrograph is identified by the HEC-DSS missing data
code, -901.0. The stage and flow hydrographs can either be entered into a
table or from HEC-DSS. The mixed boundary condition is primarily used for
forecast models where the stage data is observed up to the forecast time and
the flow hydrograph is the flow forecast.

Initial Conditions

In addition to the boundary conditions, the user must establish the initial
conditions of the system at the beginning of the unsteady flow simulation.
Initial conditions consist of flow and stage information at each of the cross
sections, as well as elevations for any storage areas defined in the system.
Initial conditions are established frolll within the Unsteady Flow Data editor
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by selecting the Initial Conditions tab. After the Initial Conditions tab is
selected, the Unsteady Flow Data editor will appear as shown in Figure 8.7.

As shown in Figure 8.7, the user has two options for establishing the initial
conditions of the system. The first option is to enter flow data for each reach
and have the program perform a steady flow backwater run to compute the
corresponding stages at each cross section. This option also requires the user
to enter a starting elevation for any storage areas that are part of the system.
This is the most common method for establishing initial conditions. Flow
data can be changed at any cross section, but at a minimum the user must
enter a flow at the upper end of each reach.

IIUnsteady flow Data ~ ,~,~~, '

Filename:

Eile Qptions t:!elp

Boundafll Conditions Lilli~aCtQndltions::n

Initial Flow Distribution Method

r Use a Restarl File

{.' Enter Intia] flow distribution

ppplvD.,;!-=s I

River: IBO}lntonSlough

Reach' ITributalY

Locations of Flow Data Chan es

::oJ
::oJ River Sla' 11975867 Add.l!l. Flow Change Location I

Rivel Reach RS Initial Flow
1 BoynlonSlough Tlibutary 1975867 80
2 NT ruckeeDlain Tlibutary 1332854 60
3 SteamS aater Upper 22976.87 200
4 SleamBoalCr Lower 13579.42 280
5 Truckee Upper 41611.80 5300
6 Truckee Middle 13313.60 5340
7 Truckee Lower 12674.60 5620
B TruckeeOverbank Overland 14235.67 100

. ',: " . "J' -.', ,
"

:,,' '.;,. ,.X·.' if: .'

Inilial Elevatron 01 SIma e Cells

Storage Cell Inita! Elevation ~I

1 AreaO 4403 -.J
2 Areal 4416
3 Area2 4406 ..:J" ~ --_ ... A ...'.....

Figure 8.7 Initial Conditions Editor

A second method is to read in a file of stages and flows that were written
from a previous run, which is called a "Restart File." This option is often
used when running a long simulation time that must be divided into shorter
periods. The output from the first period is used as the initial conditions for
the next period, and so on. Additionally, this option may be used when the
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software is having stability problems at the very beginning of a run.
Occasionally the model may go unstable at the beginning of a simulation
because of bad initial conditions. When this happens, one way to fix the
problem is to run the model with all the inflow hydrographs set to a constant
flow, and set the downstream boundaries to a high tailwater condition. Then
run the model and decrease the tailwater down to a normal stage over time
(use a stage hydrograph downstream boundary to do this). Once the tailwater
is decreased to a reasonable value, those conditions can be written out to a
file, and then used as the starting conditions for the unsteady flow run.

Unsteady Flow Data Options

Several options are available from the Unsteady Flow Data editor to assist
users in entering and viewing the data. These features can be found under the
Options menu at the top of the window. The following options are available:

Delete Boundary Condition. This option allows the user to delete a
boundary condition from the table. To use this option, first select the row to
be deleted with the mouse pointer. Then select Delete Boundary Condition
from the options menu. The row will be deleted and all rows below it will
move up one. Only user inserted boundary conditions can be deleted from the
table. If the boundary condition is an open end of the system, the system will
not allow that boundary to be deleted. There must always be some type of
boundary condition at all the open ends of the system.

Internal RS Initial Stages. This option allows the user to specify starting
water surface elevations for any internal cross section within the system. A
common application ofthis would be to specify the starting pool elevation for
the first cross section upstream of a dam (modeled with the inline
weir/spillway option). The user specifies locations and water surface
elevations, which are then used to establish the initial conditions of the system
at the beginning of a run.

Observed Data In DSS. This option allows the user to attach observed data
pathnames from a HEC-DSS file to specific river stations within the model.
When an observed data pathname is attached to a specific river station
location, the user can get a plot of the observed flow or stage hydrograph on
the same plot as the computed flow and stage hydrographs. Additionally the
observed data will show up on profile and cross section plots.

To use this option, the user selects Observed Data In DSS from the Options
menu of the Unsteady Flow Data editor. When this option is selected a
window will appear as shown in Figure 8.8. As shown in the figure below,
the user first selects a river, reach, and river station. Then the user presses the
Add selected location to table button in order to select a location to attach
observed data. This should be done for all the locations in which you have
observed data. The next step is to open up the DSS file that contains the
observed data. This is accomplished by pressing the open file button, wbich
is next to the DSS filename field. When a DSS file is selected, a list of the
available pathnames contained in that DSS file will show up in the lower

8-11



Chapter 8 Performing a Unsteady Flow Analysis

table. To attach a DSS pathname to a particular river station, first select the
river station row from the upper table. Then select the DSS pathname row
from the lower table. Finally, press the button labeled Select DSS Pathname.
Repeat this process for every location in which you wish to attach observed
data. If you are going to have more than one data type (such as stage and
flow) at a particular river station, you must have two entries in the upper table
for that river station.

1m Set Locations and Paths ror Observed Dat., in DSS .._1..
River: IMississippi Ri" ::oJ Delete row 110m table

Re3ch, IUpper o:J River Sla: 1437 ::oJ Add selected Ioc~llor) to table I
River Reach RS DSS File Pari A Pdft B Parle Part 0 PallE Part F

1 Misslss -RI... Upper 43.7 C:\HEC\RdS30\f,lU~!.2.?,I.?,~!efL_.! THEBES STAGE 01JANl924 lDAY OBS
2 M1SShtippi Ai'll U " 20.2 C:\HEC\R<lS30\M MISSISSIPPI THOMPSON LAN STAGE 01JANl982 1DAY OBS
3 I-hnissippi Ai" U " 1.4 C\HEC\Ras30\M MJ~SISSIPPI BIRDS POINT STA§E Q~~Nl~82 1DAY DBS
4 Mlmss' pi AI'" lower 953.03 C:\HEC\R-3s30\M MISSISSIPPI RIVI CAIRO ST~E O1JAN1982 WAY OBS
5 MisSISSippi AIV Lower 922 C\HEC\Ras30\M MISSISSIPPI RIVI HICKMAN .STAGE 01JANl982 1DAY OBS

DSS Fie. IC:\HE C\A asJ(N~ issOhioRiv\MissOhioRiv.D SS ::oJ~ UpdaleC'3laIo9!

Part A ParIS PartC Pari 0 PartE Part F

Filter STAGE DSS
1 MISSISSIPPI BIRDS POINT STAGE 01JAN1992 10AY OSS
2 MISSISSIPPI BI~DS POINT STAGE °blANl9B3 lDAY OSS
3 MISSISSIPPI BIROS POINT STAGE 01JAN1S84 lDAY OBS
4 MISSISSIPPI BIROS POINT STAGE O1JAN1985 ,WAY OBS
5 MISSIS·S1PP1 THEB-ES· STAGE O1JAN1984 1DAY DSS
6 MISSISSIPPI THEBES STAGE 01J.6.N1985 1DAY OBS
7 MISSISSIPPI THOMPSON LANDING STAGE 01JANl982 lO.6.Y OSS
8 MISSISSIPPI THOMPSON LANDING STAGE 01JAN19B3 WAY DBS

~- ... ~_._-,-_.
Select DS$ Palhnarne I

Plot Selected P.!I!hMme OK Canc.el I

Figure 8.8 Editor for Establishing Locations of Observed Data

Minimum Flow and Flow Ratio Table. This option brings up a global
editor that will show all the locations in which flow hydrographs have been
attached as boundary conditions. The editor allows the user to enter a
minimum flow or a flow factor for each flow hydrograph boundary condition.
The minimum flow option will prevent any flow read from either HEC-DSS
or a user entered hydrograph from going lower than the user specified
minimum. Values that are lower than the minimum specified are
automatically changed to the minimum value. The flow factor option allows
the user to specify a factor to be multiplied by all ordinates of the flow
hydrograph. This option is commonly used in planning type studies for
performing sensitivity analysis (i.e. what if the flow were 20% higher?).

Saving The Unsteady Flow Data

The last step in developing the unsteady flow data is to save the information
to a file. To save the data, select the Save Unsteady Flow Data As from the
File menu on the Unsteady Flow Data editor. A pop-up window will appear
prompting you to enter a title for the data.
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Performing Unsteady Flow Calculations

Once all of the geometry and unsteady flow data have been entered, the user
can begin performing the unsteady flow calculations. To run the simulation,
go to the HEC-RAS main window and select Unsteady Flow Analysis from
the Run menu. The Unsteady Flow Analysis window will appear as in Figure
8.9 (except yours may not have a Plan title and short 10).

'"unsteady flow Analysis ',: ".

E.i1e Qptions Help

Plan: Unsteady With Bridges and Dam ShorliD IUnSleadyFlow

10500

10000Starting Time:

Ending Time:

Geomelry Fie: IExislng Cond'''ns - GIS Data 3
Unsleady Flow File: IFlow Hydrograph 2 3

P,ograms 10 Run -- Plan Description:

W Geometry Preplocessor I1----'-----------0
p Unstea~ Flow SiTUation .••
~ Post Processol '

._ __...I

- Sinulatlon Time 'Window - -- -
Slarling Dale: 102/18/1999

Ending Dale: 102/24/1999

lOSS Oulpul Filename: IC\HEC\Ras30\Unsleady\BaldEagle.dss

r Mixed Flow Regime [see menu: "Options/mixed flow options ... ")

r Computation Settings----- -c'
I Computalionlnterval: 12 Minule 3
r

Hydrograph Oulputlnlerval:

Detailed Outpullnterval:

Figure 8.9 Unsteady Flow Analysis Window

Defining A Plan

The first step in performing a simulation is to put together a Plan. The Plan
defines which geometry and unsteady flow data are 10 be used, as well as
provides a description and short identifier for the run. Also included in the
Plan information are the selected programs to be mn; simulation time
window; computation settings; and the simulation options.

Before a Plan is defined, the user should select which geometry and unsleady
flow data will be used in the Plan. To select a geometry or unsteady flow file,
press the down arrow button next to the desired data type. When this button
is pressed, a list will appear displaying all of the available files of that type
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that are currently available for the project. Select the geometry and unsteady
flow file that you want to use for the current Plan.

To establish a Plan, select Save Plan As from the File menu on the Unsteady
Flow Analysis window. When Save Plan As is selected, a window will
appear prompting you to enter a title for the Plan. After you enter the title,
press the OK button to close the window and accept the title. The user will
also be prompted to enter a short identifier for the Plan. The short identifier is
limited to 12 characters. It is very important to enter a short identifier that is
descriptive of the Plan. When viewing multiple plan output from the graphics
and tables. the Short ID will be used to identitY each Plan.

Selecting Programs to Run

There are three components used in performing an unsteady flow analysis
within HEC-RAS. These components are: a geometric data pre-processor; the
unsteady flow simulator; and an output post-processor.

Geometric Pre-Processor

The pre-processor is used to process the geometric data into a series of
hydraulic properties tables. rating curves. and family of rating curves. This is
done in order to speed up the unsteady flow calculations. Instead of
calculating hydraulic variables for each cross-section, during each iteration.
the program interpolates the hydraulic variables from the tables. The pre­
processor must be executed at least once, but then only needs to be re­
executed if sometbing in the geometric data has changed.

Cross sections are processed into tables of elevation versus hydraulic
properties of areas, conveyances. and storage. Each table contains a
minimum of21 points (a zero point at the invert and 20 computed values).
and can have up to a maximum of 100 points. The user is required to set an
interval to be used for spacing the points in the cross section tables. The
interval can be the same for all cross sections or it can vary from cross section
to cross section. This interval is very important. in that it will define the
limits of the table that is built for each cross section. On one hand, the
interval must be large enough to encompass the full range of stages that may
be incurred during the unsteady flow simulations. On the other hand, if the
interval is to large, the tables will not have enough detail to accurately depict
changes in area. conveyance, and storage with respect to elevation.

The interval for the cross section tables is defined as part of the geometric
data. To set this interval, the user selects the HTab Parameters (Hydraulic
Table Parameters) button from the Geometric Data editor. When this option
is selected. a window will appear as shown in Figure 8.10.
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(ross SectIOn Table Parameters 7•• T
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8 5.855 207.04 208.04 .5 20
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10 5.81 206.23 207.23 .5 20
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OK Cancel Help

Figure 8.10 Hydraulic Table Parameters for Cross Sections

As shown in Figure 8.10, the table contains three columns in which the user
can enter a Starting Elevation, Increment, and Number of Points. The first
time the user opens this editor all of the columns are automatically filled. The
starting elevation columns are automatically filled to an elevation one foot
higher than the invert, however, the user can change these values to whatever
they want. The second and third columns are used for the table increment and
the number of points. These two variables will describe the extent to which
the table encompasses the cross section data. A default value will be set for
the increment and the number of points. Normally the increment will be set
to one foot, and the number of points will be set to a value that will allow the
table to extend to the top of the cross section. If this combination would end
up with less than 20 points, then the number of points is set to 20 and the
increment is reduced to get the table to the top of the cross section. The user
can set these values individually for each cross section, or they can highlight a
series of cross sections and use the Set Values button to enter the value for all
of the highlighted sections. Other options are available to multiply
highlighted fields by a factor or add a constant to all of them. Additionally,
cut, copy, and paste buttons are available for manipulating the data.

Hydraulic structures, such as bridges and culverts, are converted into families
of rating curves that describe the structure as a function of tailwater, flow, and
headwater. The user can set several parameters that can be used in defining
the curves. To set the parameters for the family of rating curves, the user can
select the "HTab Parameters" button from the Bridge and Culvert editor or
from the Hydraulic connection editor. When this button is pressed, the
window in Figure 8.ll will appear:
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Number of points on free flow curve. )40

Number of submerged curves: 14'"'0'---
Numbef of points on each submerged curves: 110
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Malcimum Flow [Recommendedl

OK

1225

150000

Cancel

Figure 8.11 Hydraulic Properties Table for Bridges/Culverts

As shown in Figure 8.11, the user can set the number of points to be
computed on the free-flow rating curve (maximum of 50 points); the number
of submerged curves to be computed (maximum of 50); and the number of
points on the submerged curves (maximum of 20). The default values for
these parameters are 40, 40, and 10 respectively. Additionally, the user can
refine the curves by setting limits on the extent of the curves. This can be
accomplished by entering the head water maximum elevation (reguired), tail
water maximum elevation, maximum swell head (difference between the head
water and tailwater), and the maximum possible flow (recommended). In
general, the curves will come out better if the user enters a headwater
maximum elevation and a maximum flow rate.

Structures that are gated, such as gated spillways, are not converted into
curves because it would require a new family of curves for each possible gate
setting. The hydraulics through gated structures is calculated on the fly
during the unsteady flow calculations. No hydraulic table parameters are
required for gated structures.
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Unsteady Flow Simulation

The unsteady flow computations within HEC-RAS are perfonned by a
modified version of the UNET (Unsteady NETwork model) program,
developed by Dr. Robert Barkau (Barkau, 1992) and modified by HEC. The
unsteady flow simulation is actually a three-step process. First a program
called RDSS (Read DSS data) runs. This software reads data from a HEC­
DSS file and then converts all of the boundary condition time series data into
the user specified computation interval. Next, the UNET program runs. This
software reads the hydraulic properties tables computed by the pre-processor,
as well as the boundary conditions and flow data from the interface and the
ROSS program. The program then perfonns the unsteady flow calculations.
The final step is a program called TABLE. This software takes the results
from the UNET unsteady flow run and writes them to a HEC-DSS file.

Post-Processor

The Post-Processor is used to compute detailed hydraulic infonnation for a set
of user specified time lines during the unsteady flow simulation period. In
general, the unsteady flow computations only compute stage and flow at all of
the computation nodes, as well as stage and flow hydrographs at user
specified locations. If the Post Processor is not run, then the user will only
be able to view the stage and flow hydrographs and no other output from
HEC-RAS. By running the Post Processor, the user will have all of the
available plots and tables for unsteady flow that HEC-RAS normally
produces for steady flow.

By default, the Post-Processor will compute detailed output for a maximum
stage water surface profile. This profile does not represent any specific
instance in time, but rather represents a profile of the maximum stage that
occurred at each cross section during the entire simulation. This profile is
often useful for getting a quick view of the maximum extent of flooding
during a specific event.

In addition to the maximum water surface profile, the user can request the
software to write out a series of instantaneous profiles at a specific time
interval. This is accomplished from the Computation Settings section of the
Unsteady Flow Analysis window. The user turns on this option by selecting
an interval from the box labeled Detailed Output Interval. The Post­
Processor will then compute detailed output for each of the instantaneous
profiles requested (Note: the Post-Processor is limited to 500 profiles). When
the unsteady flow program runs, flow and stage water surface profiles are
written to DSS for the entire system, starting with the beginning of the
simulation and then at the user specified time interval for the entire
simulation.
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When the Post-Processor runs, the program reads from HEC-DSS the
maximum water surface profile (stages and flows) and the instantaneous
profiles. These computed stages and flow are sent to the HEC-RAS steady
flow computation program SNET. Because the stages are already computed,
the SNET program does not need to calculate a stage, but it does calculate all
of the hydraulic variables that are normally computed. This consists of over
two hundred hydraulic variables that are computed at each cross section for
each flow and stage.

At hydraulic structures such as bridges and culverts, the unsteady flow
program only reports the stage just upstream and downstream of the structure.
During the Post-Processing of the results, the SNET program calculates the
hydraulics of the structures by using the computed tailwater and flow, and
then performing detailed hydraulic structure calculations. This is done so that
the user can see detailed hydraulic information inside of the hydraulic
structures for each of the profiles that are being post processed. However,
this process can produce slightly different results for the upstream headwater
elevation. Occasionally, you may notice a headwater elevation computed
from the Post-Processor that is higher than the next upstream sections water
surface. This difference is due to the fact that the unsteady flow simulation
uses a pre-computed family of rating curves for the structure during the
unsteady flow calculations. The program uses linear interpolation between
the points of the rating curves to get the upstream headwater for a given flow
and tailwater. The Post-Process performs the calculations through the
structure and does not use rating curves (it solves the actual structure
equations).

Once the Post-Processor is finished running, the user can view output from all
of the HEC-RAS plots and tables. The maximum water surface profile and
user specified instantaneous profiles can be viewed by selecting Profiles from
the Options menu on each of the output windows (tables or plots). The
overall maximum water surface profile will be labeled "Max W.S.", while the
instantaneous profiles are labeled by the date and time. For example, a profile
from January 5, 1999 at I :00 p.m. would be labeled "OSJan1999 1300".

WARNING: Specifying a detailed output interval for post processing
that is small can lead to long computational times and huge output files.
Select this interval wisely, in that you only get detailed output when you
really need it.

Simulation Time Window

The user is required to enter a time window that defines the start and end of
the simulation period. The time window requires a starting date and time and
an ending date and time. The date must have a four digit year and can be
entered in either of the two following formats: OSJan2000 or 01/05/2000.
The time field is entered in military style format (i.e. I pm. is entered as
1300).
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Computation Settings

The Computation Settings area of the Unsteady Flow Analysis window
contains: the computational interval; hydrograph output interval; detailed
output interval; the name and path of the output DSS file, and whether or not
the program is run in a mixed flow regime mode.

The computation interval is used in the unsteady flow calculations. This is
probably one of the most important parameters entered into the model.
Choosing this value should be done with care and consideration as to how it
will affect the simulation. The computation interval should be based on
several factors. First, the interval should be small enough to accurately
describe the rise and fall of the hydrographs being routed. A general rule of
thumb is to use a computation interval that is equal to or less than the time of
rise of the hydrograph divided by 24. In other words, if the flood wave goes
from its base flow to its peak flow in 24 hours, then the computation interval
should be equal to or less than I hour.

Additional considerations must be made for hydraulic structures, such as
bridges, culverts, weirs, and gated spillways. Within bridges and culverts,
when the flow transitions from unsubmerged to submerged flow, the water
surface upstream of the structure can rise abruptly. This quick change in
water surface elevation can cause the solution of the unsteady flow equations
to go unstable. One solution to this problem is to use a very small time step,
on the order of 1 to 5 minutes. This allows the module to handle the changes
in stage in a more gradual manner. Additionally, when gates are opened or
when flow just begins to go over a lateral weir, the change in stage and flow
can be dramatic. Again, these types of quick changes in stage and flow can
cause the solution of the unsteady flow equations to go unstable. The only
solution to this problem is to shorten the computational time step to a very
short interval. This may require the user to set the value as low as I to 5
minutes. The time step should be adjusted to find the largest value that will
still solve the equations accurately. Additional variables that affect stability
are the number of iterations and the Theta weighting factor. These two
variables are discussed under the calculation tolerances section below.

The Hydrograph Output Interval is used to define at what interval the
computed stage and flow hydrographs will be written to HEC-DSS. This
interval should be selected to give an adequate number of points to defme the
shape of the computed hydrographs without losing information about the peak
or volume of the hydrographs. This interval must be equal to or larger than
the selected computation interval.

The Detailed Output Interval field allows the user to write out profiles of
water surface elevation and flow at a user specified interval during the
simulation. Profiles are not written for every computational time step because
it would require too much space to store all of the infonnation for most jobs.
Also, when the Post-Processor is nm, the program will compute detailed
hydraulic information for each one of the instantaneous profiles that are
written. This option is turned on by selecting an interval from the drop-down
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box next to the detailed hydrograph output label. The selected interval must
be equal to or greater than the computation interval. However, it is suggested
that you make this interval fairly large, in order to reduce the amount of post­
processing and storage required for a detailed hydraulic output. One example
for selecting this variable would be, if the time window of the simulation was
set at 72 hours, then one might want to set the instantaneous profiles to an
interval of every 6 hours. This would equate to 13 profiles being written out
and having detailed hydraulic information computed for them.

The field labeled DSS Output Filename is required before an execution can
be made. The program will always write some results to a HEC-DSS file, so
the user is required to select a path and filename to be used for this
information.

Mixed Flow Regime. When this option is selected, the program will run in a
mode such that it will allow subcritical flow, supercritical flow, hydraulic
jumps, and draw downs (sub to supercritical transitions). This option should
only be selected if you actually have a mixed flow regime situation. The
methodology used for mixed flow regime analysis is called the Local Partial
Inertia (LPI) solution technique (Fread, 1996). When this option is turned
on, the program monitors the Froude number at all cross section locations for
each time step. As the Froude number gets close to 1.0, the program will
automatically reduce the magnitude of the inertial terms in the momentum
equation. Reducing the inertial terms increases the models stability. When
the Froude number is equal to or greater than 1.0, the inertial terms are
completely zeroed out and the model is essentially reduced to a diffusion
wave routing procedure. For Froude numbers close to 1.0, the program will
use partial inertial effects, and when the Froude number is low, the complete
inertial effects are used.

Note: more information about mixed flow regime calculations can be found in
Chapter 16 of the HEC-RAS User's manual.

Simulation Options

From the Options menu of the Unsteady Flow Analysis window, the
following options are available: stage and flow output locations; flow
distribution locations; flow roughness factors; seasonal roughness factors;
calculation options and tolerances; output options; checking data before
execution, and viewing the computation log.

Stage and Flow Output Locations. This option allows the user to specify
locations where they want to have hydrographs computed and available for
display. By default, the program sets locations of the first and last cross
section of every reach. To set the locations, the user selects Stage and Flow
Output Locations from the Options menu of the Unsteady Flow Analysis
window. When this option is selected a window will appear as shown in
Figure 8.12.
As shown in Figure 8.12, the user can select individual locations, groups of
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cross sections, or entire reaches. Setting these locations is important, in that,
after a simulation is performed, the user will only be able to view stage and
flow hydrographs at the selected locations.

Flow Distribution Locations. This option allows the user to specify
locations in which they would like the program to calculate flow distribution
output. The flow distribution option allows the user to subdivide the left
overbank, main channel, and right overbank, for the purpose of computing
additional hydraulic information.

The user can specify to compute flow distribution information for all the cross
sections (this is done by using the Global option) or at specific locations in
the model. The number of slices for the flow distribution computations must
be defined for the left overbank, main channel, and the right overbank. The
user can define up to 45 total slices. Each flow element (left overbank, main
channel, and right overbank) must have at least one slice. The flow
distribution output will be calculated for all profiles in the plan during the
computations.

)

... Stage and flow Output Locations~

Selected Locations
3 Beaver Creek Kentwood

~
:==::: Beaver Creek Kentwood1IIIIII::oJ Beaver Creek Kentwood

River Sta.: Beaver Creek Kentwood
Beaver Creek Kentwood

5,99 ...... 1 Beaver Creek Kentwood
5.97 ---=.J Beaver Creek Kentwood
5.951 Beaver Creek Kentwood
5.93 Beaver Creek Kentwood
5_913 Beaver Creek Kent~\lood
5.894 Beaver Creek Kentwood
5.875 Beaver Creek Kentwood
5.855 _ I Beaver Creek Kentwood
5. 836 ~ Beaver Creek Kentwood

.=J.gJ~

-. (57 selectedl!
5.99 &

5.97
5.951
5.93
5913
5894
5.875
5.855
5836
5.81
5.798
5779
5.76 _I'
5.741 ..:.J

I

Clear Selected List I OK Cancel

Figure 8.12 Stage and Flow Hydrograph Output Window

Flow Roughness Factors. This option allows the user to adjust roughness
coefficients with changes in flow. This feature is very useful for calibrating
an unsteady flow model for flows that range from low to high. Roughness
generally decreases with increases flow and depth. This is especially true on
larger river systems. This feature allows the user to adjust the roughness
coefficients up or down in order to get a better match of observed data. To
use this option, select Flow Roughness Factors from the Options menu of
the Unsteady Flow Simulation manager. When this option is selected, a
window will appear as shown in Figure 8.13.
As shown in Figure 8.13, the user first selects a river, reach, and a range of
cross sections to apply Ihe factors to.' Next a starting flow, flow increment,
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and a number of increments is entered. Finally, a roughness factor is entered
into the table for each of the flows. The user can create several sets of these
factors to cover a range of locations within the model. However, one set of
factors cannot overlap with another set of factors. Hence, you can only apply
one set of roughness change factors to any given cross section.

Roughness Change Factors:;'

Flow Roughness Fador '.1
1 10000 0.8 ......., ..................... W
2 60000 08
3 110000 0.85
4 160000 0.85
5 210000 0.9
6 260000 0.9
7 310000 095
8 360000 0.95
9 410000 1.

10 460000 1
I~

" t:'~1"\...nn , 0<

Roughness FactOi Data -I
Set: I,iv: Mississippi Riv fch:Lower Is:953.03 to 922 3

I
I Add I~ ~ [!] m;

River: IMississippi Riv :::oJ

I
Reach: ILower 3
Upstream Riv Sta: 1953.03 3

IDownstream Riv Sla: 1922 3 I
: Starting Flow: 110000 Flow Inc[150000 125 incremen31

I
,

OK Cancel I

Figure 8.13 Flow versus Roughness Change Factors Editor

Seasonal Roughness Change Factors. This option allows the user to change
roughness with time of year. This feature is most commonly used on larger
river systems, in which temperature changes can cause changes in bed forms,
which in turn causes changes in roughness. This factor can be applied in
conjunction with the flow roughness change factors. When applying both, the
seasonal roughness factor gets applied last.

To use this option, select Seasonal Roughness Factors trom the Options
menu of the Unsteady Flow Simulation manager. When this option is
selected a window will appear as shown in Figure 8.14.

As shown in Figure 8.14, the user first selects a river, reach, and range of
river station to apply the factors to. Next the user enters the day and month in
the Day column, for each time that a new roughness factor will be entered.
By default the program will automatically list the first of each month in this
column. However, the user can change the day to whatever they would like.
The tinal step is to then enter the roughness change factors.
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Seasonal Roughness OJange.f t

...-Roughness Factor Data-- - - -----

Set Iriv: Mississippi Riv Ich:Lower Is:953.03 to 922 iJ
~ Copy I ~ W[n

,River: IMississippi Riv 3
i Re.eh: ILower ::oJ
I Upstream Riv Sla: 1953.03 :::J
I Downstre.m Riv St.: 1922 ::oJ

Day (ex 15MAYl [Roughness FaetOl ·1
I...! 01JAN JJ.~._ .....,...~.. -- --- i.-J I

1.1 01FEB 1.15

I1.1 01 MAR 1.1
-

I~ 01 APR 1.1 I
•

I~ 01 MAY '.05

,~ 01JUN 1.05

:~ 01JUL 1
01AUG 1

.,
J! ,

.J! 01SEP 1.05

IlQ 010CT 1.05

l! 01NDV 1.1
12 010EC 1.1 ~I-- --_._-

OK Cancel I

Figure 8.14 Seasonal Roughness Factors Editor

Unsteady Flow Encroachments. This option allows the user to perform an
encroachment analysis using the unsteady flow simulation option. Currently,
encroachments are limited to method I within the unsteady flow analysis
module. In general the user should first perfonn the encroachment analysis
with the steady flow computations module, as documented in Chapter 10 of
this manual. Once a good steady flow encroachment analysis is completed,
the final encroachments can be imported into the unsteady flow plan for
further analysis and refinement. The user will need to have two unsteady
flow plans, one without encroachments (representing the base flood) and one
with encroachments (representing the encroached floodplain).

To add encroachments to an unsteady flow plan, the user selects Unsteady
Encroachments from the Options menu of the Unsteady Flow Simulation
editor. When this option is selected the following window will appear:
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~
o:J Get EnclOachmenl:s flom Stead,.; Flow Plan _."

Unsteady Encroachments

Rive,: I(All Riversl

Reach: I
Selected Area Global Edits

Add Conslant I MUR,,~ Factor I Set Values

Unstead Encroachments Method 1 5 Ie Encroachments

River Reach RS Left Station I Right Slalion

ICJ1 Beaver Creek Kenlwood 5.99 ___§L~~j 1731.07
2 Beaver Creek Kentwood 5.97 495 1763.97
3 Beaver Creek Kentwood 5.951 3623 1784.01
4 Beaver C,eek Kentwood 5.93 11822 1607.87
5 Beaver Creek Kentwood 5.913 15361 153337
6 Beaver Creek Kentwood 5.894 178.02 1479.7
7 Beaver Creek Kentwood 5.875 189.82 1450.95
8 Beaver Creek Kentwood 5.855 30553 1296.01
9 Beaver Cleek Kentwood 5.836 20289 140607

10 Beaver Creek Kentwood 5.81 945 1564.15
11 Beaver Cleek Kentwood 5.798 93.36 1543.71
12 Beaver Creek Kentwood 5.779 9043 152364
13 Beavel Creek Kentwood 5.76 79.29 1520.94
14 Beaver Creek Kentwood 5.741 13134 1481.37
15 Beave, Creek Kentwood 5.72 18016 145026 '-:..I

OK Cancel

Figure 8.15 Unsteady Flow Encroachment Data Editor.

As shown in Figure 8.15, the user can enter a left station and a right station
for the encroachments at each cross section. Additionally, the user has the
option to import the encroachments calculated from a steady flow plan. This
is accomplished by pressing the bulton labeled Get Encroachments from
Steady Flow Plan, which is shown in the upper right part of the editor.
When this bulton is pressed the user is asked to select a previously computed
steady flow plan, and a specific profile from that plan. When the user presses
the OK button, the program will go and get the final computed
encroachments from that particular steady flow plan and profile.

Once all of the encroachments are entered, the user presses the OK bulton to
have the interface accept the data. However, this information is not stored to
the hard disk, the user must save the currently opened plan file for that to
happen. The next step is to run the unsteady flow analysis with the
encroachment data. The user should have two unsleady flow plans, one
without encroachments and one with encroachments. Once both plans have
been successfully executed, then comparisons between the plans can be made
both graphically and in a tabular format.

Dam (lnline Structure) Breach. This option allows the user 10 perform a
Dam Break analysis. The breach data is stored as "Plan" information. This is
done so the user can try different breach locations. sizes. elc, without having
to re-run the geometric pre-processor. Storing the data as Plan data is not that
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important in a planning study, but it is very important when doing real time
river forecasting. However, the user can get to the breach data in two different
ways. First there is a button on the Inline Structure editor that is labeled
Breach (Plan Data). Second, from the Unsteady Flow Simulation Manager,
the user can select Dam (In line Weir) Breach from the Options menu.
When either option is selected, the following window will appear.

,.Dam (Inhne Weir) Breach Data -:; ~.

•
Ground

•Bank Sta

,......,-~I 'legend
I

Delete this Breach I Delete all Breaches I

680

700

600

B:ald Eagle Cr.- Dam Break Run Plan: Unsteady with Piping F3ilure

580'h~~~~~~~~~~~~~~~~
o "1000 2000 3000 4000 5000 6000

station (ft)

81500

8reach Plot 1Breach ProQlession I

660 Final Breach I!'.
c

3 .Q 6400;
>

"w 620

Inline Weil IBald Eagle Loc Hav

r;; Breach This Strudure=---Center Station: j4200
~--

Final Bollom Width: 1400
---

Final Bottom Elevation: 1592
~--

Lelt Side Slope: 12
---

Right Side Slope: [2
;--­

Full FO/mation Time {hrsJ: 14
--:._-

Failure Mode: !Piping
---

Piping Coefficient: 10.6
---

Initial Piping Elev: 1620

Trigger Fa~ure at lws Elev 3
Siaiting WS: 1664

~ t It [ t~, 1""2-.i~-'-'.-i-~;:l-'-

~,d I'

)

OK Cancel

Figure 8.16 Dam Breach Editor.

As shown in Figure 8.16. the user selects a particular Inline Structure to
perform the breach on. The following data must be entered for a breach:

Breach This Structure - This check box is used to decide if the program will
perform the breach or not. In order for the breach to occur this box must be
checked. This box was added to allow the user to turn certain breaches on or
off, without loosing the user entered breach information.

Center Station - This field is used for entering the centerline stationing of the
final breach.

Final Bottom Width - This field is used to enter the bottom width of the
breach at its maximum size.

Final Bottom Elevation - This field is used to enter the elevation of the
bottom of the breach after it has been fully developed.
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Left Side Slope - This is the left side slope of the trapezoidal breach.

Right Side Slope - This is the right side slope of the trapezoidal breach.

Full Formation Time (hrs) - This field is used to enter the breach
development time in hours. This time represents the duration from when the
breach begins to have some significant erosion, to the full development of the
breach.

Failure Mode - This option allows the user to choose between two different
failure modes, an Overtopping failure and a Piping failure.

Piping Coefficient - If a piping failure mode is selected, the user must enter a
piping coefficient. This coefficient is an Orifice coefficient, which is used
while flow is coming out of the dam in a piping mode. Typical Orifice
coefficients for a true designed orifice are around 0.8. However, for a piping
breach, the coefficient should be lower to represent all of the additional
energy losses occurring.

Initial Piping Elev. - If a piping failure mode is selected the user must enter
an initial piping elevation. This elevation should be entered as the center of
the piping flow while the breach develops.

Trigger Failure At - This field is used to select one of two trigger methods for
initiating the breach. The two trigger methods are a water surface elevation
or a specific time and date.

Starting WS - [f the user selects water surface elevation for the failure trigger
mode, then this field must be entered. This field represents the water surface
elevation at which the breach should begin to occur.

Start Date - If the user selects a starting date and time as the failure trigger
mode, then this field must be entered. This field is used to enter the date at
which the breach will begin to occur.

Start Time - If the user selects a starting date and time as the failure trigger
mode, then this field must be entered. This field is used to enter the time at
which the breach will begin to occur.

In addition to all of the main breach infonnation, the user also has the option
to enter a user specified Breach Progression curve. By default the breach
progression is assumed to be linear between the breach initiation and the full
breach size (Full Formation Time). The user enters their breach progression
curve by selecting the Breach Progression tab. When this tab is selected, the
editor will now look like the following:
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Figure 8.17 Dam Breach Editor with User Specified Breach Progression.

As shown in Figure 8.17, the user enters a Time Fraction (from zero to 1.0)
and a Breach Fraction (from zero to 1.0). The user-entered data is plotted in
the graphic next to the table. The breach progression curve is then used
during the breach formation time to adjust the growth rate of the breach.

Note: More detailed infonnation on perfonning a breach analysis can be
found in the HEC-RAS User's Manual, chapter 16.

Levee (Lateral Structure) Breach. This option is very similar to the Dam
Break option described previously. The only difference is that the breaching
is perfonned on a levee. The options and data entered to describe the breach
is the same as a Dam Break.

In order to use this option, the user must first define the levee as a lateral
structure within HEC-RAS. The lateral weir profile is used to describe the
top of the levee along the stream both at and between the cross sections.
Second, a weir coefficient is entered for calculating the flow that may go
overtop of the levee if the water surface gets high enough. Entering breach
data for the levee can be accomplished from the lateral weir editor or from the
Levee (lateral structure) Breach option from the Unsteady Flow Simulation
window. The levee breaching data is stored as part of the unsteady flow plan
file, just as it is for a dam break. When the levee breach option is selected, a
breach editor will appear as shown in Figure 8. j 8.
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Figure 8.18 Levee Breaching Editor.

As shown in Figure 8.18, this editor contains the same information as the
Dam Breach editor. For a description of the variables please review the
section on Dam Breaching above. More detailed information about levee
breaching can be found in Chapter 16 of this manual.

Mixed Flow Options. This option allows the user to change the parameters
that control the computations of mixed flow regime within the unsteady flow
simulation. This option was described previously in this chapter, under the
section titled Computational Settings. Please review that section of this
chapter for the details of how to use the mixed flow regime option and
controlling the parameters.

Calculation Options and Tolerances. This option allows the user to set
some computation options and to override the default senings for the
calculation tolerances. These tolerances are used in the solution of the
momentum equation. Warning !!! - Increasing the default calculation
tolerances could result in computational errors in the water s",face profile.
The tolerances are as follows:

Theta implicit weighting factor: This factor is used in the finite difference
solution of the unsteady flow equations. The factor ranges between 0.6 and
1.0. A value of 0.6 will give the most accurate solution oflhe equations, but
is more susceptible to instabilities. A value of 1.0 provides the most stability
in the solulion, but may not be as accurate for some data sets. The default
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value is set to 1.0. Once the user has the model up and running the way they
want it, they should then experiment with changing theta towards a value of
0.6. If the model remains stable, then a value of 0.6 should be used. In many
cases, you may not see an appreciable difference in the results when changing
theta from 1.0 to 0.6. However, every simulation is different, so you must
experiment with your model to find the most appropriate value.

Water surface calculation tolerance: This tolerance is used to compare the
difference between the computed and assumed water surface elevations at
cross sections. If the difference is greater than the tolerance, the program
continues to iterate for the current time step. When the difference is less than
the tolerance, the program assumes that it has a valid numerical solution. The
default value is set to 0.02 feet.

Storage area elevation tolerance: This tolerance is used to compare the
difference between computed and assumed water surface elevations at storage
areas. If the difference is greater than the tolerance, the program continues to
iterate for the current time step. When the difference is less than the
tolerance, the program can go on to the next time step. The default tolerance
for storage areas is set to 0.1 feet.

Maximum number ofiterations: This variable defines the maximum number
of iterations that the program will make when attempting to solve the
unsteady flow equations using the specified tolerances, The default value is
set to 20, and the allowable range is from 0 to 40,

Maximum number ofworm-up time steps: Before the dynamic simulation, the
program runs a series of time steps with constant inflows, This is called a
warm-up period. This is done in order to smooth the profile before allowing
the inflow hydrographs to progress, This helps to make a more stable
solution at the beginning of the simulation. The default number of warm-up
time steps is set to 20. This value ranges from 0 to 40,

Time step during warm-up period: During the warm-up period described in
the previous paragraph, it is sometimes necessary to use a smaller time step
than what will be used during the unsteady flow calculations. The initial
conditions from the backwater analysis uses a flow distribution in the reaches
which is often different than that computed by unsteady flow. This can cause
some instabilities at the beginning of the simulation. The use of a smaller
time step during the warm-up period helps to get through these instabilities,
The default is to leave this field blank, which means to use a time step that is
the same as for the unsteady flow simulation period.

Minimum time step for interpolation: The program has an option to
interpolate between time steps when it finds a very steep rise in an inflow
hydrograph, or a rapid change in stage at any cross section, This option
allows the user to set a minimum time step to use during interpolation. This
prevents the program from using to small of a time step during time slicing.

Moximum number of interpololed lime steps: This option defines the
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maximum number of interpolated time steps that the program can use during
time slicing, as described in the previous paragraph.

Weir jlow stability factor: This factor is used to increase the stability of the
numerical solution in and around a weir. This factor varies from 1.0 to 3.0.
As the value is increased, the solution is more stable but less accurate. A
value of 1.0 is the most accurate, but is susceptible to oscillations in the
computed weir flow. The default value is 1.0. If you observe oscillations in
the computed flow over the weir, you should first check to see if you are
using a small enough computation interval. If the computation interval is
sufficiently small, you should then try increasing this coefficient to see if it
solves the problem.

Spillway jlow stability factor: This factor is used to increase the stability of
the numerical solution in and around a gated spillway. This factor varies
from 1.0 to 3.0. As the value is increased, the solution is more stable but less
accurate. A value of 1.0 is the most accurate, but is susceptible to oscillations
in the computed spillway flow. The default value is 1.0. If you observe
oscillations in the computed flow over the spillway, you should first check to
see if you are using a small enough computation interval. If the computation
interval is sufficiently small, you should then try increasing this coefficient to
see if it solves the problem.

Weir jlow submergence decay exponent: This coefficient is used to stabilize
the solution of flow over a weir for highly submerged weirs. This factor
varies from 1.0 to 3.0. As the headwater and tailwater stages become closer
together, occasionally oscillations in the solution can occur. This exponent
will prevent this from happening. The default value of one has no effect. As
you increase the coefficient, dampening of the oscillations will occur. See the
section called Model Accuracy, Stability, and Sensitivity later in this chapter
for greater detail on this factor.

Spillway jlaw submergence decay exponent: This coefficient is used to
stabilize the solution of flow over a gated spillway for highly submerged
flows. This factor varies from 1.0 to 3.0. As the headwater and tailwater
stages become closer together, occasionally oscillations in the solution can
occur. This exponent will prevent this from happening. The default value of
1.0 has no effect. As you increase the coefficient, dampening of the
oscillations will occur. See the section called Model Accuracy, Stability, and
Sensitivity later in this chapter for greater detail on this factor.

Convert energy method bridges to cross-sections with lids: This option is
used to convert bridges to nonnal cross sections, instead of being processed
as a family of rating curves. If you have a bridge in which you are using the
energy solution method for high and low flow solutions, there is no need to
process this as a family of rating curves. Instead, you can have the program
treat the two internal bridge cross sections as any other normal cross section.
If you turn this option on, the program will create a separate table of elevation
versus area and conveyance for each of the two bridge sections.
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Output Options. This option allows the user to set some additional output
flags. The following is a list of the available options:

Write Initial Conditions file: This option allows the user to write out a "Hot
Start" file. A hot start file can be used to set the initial conditions of the
system for a subsequent run. This is commonly done in real time forecasting,
where you want to use the results at a specific time from a previous run to be
the initial conditions of the next run. The user is require to enter a time in
hours from the beginning of the current simulation, which represents the time
at which the conditions of the system will be written to the "Hot Start" file.

Write Detailed Output for Debugging: This option allows the user to tum on
detailed output that is written to a log file. The user has the option to set a
specific time window in which the program will only output information
within this time. This option is used when there is a problem with the
unsteady flow solution, in that it may be oscillating or going completely
unstable. When this occurs, the user should turn this option on and re-run the
program. After the run has either finished or blown up, you can view the log
file output by selecting View Computation Log File from the Options menu
of the Unsteady Flow Simulation window. This log file will show what is
happening on a time step by time step basis. It will also show which cross
section locations the program is having trouble balancing the unsteady flow
equations, as well as the magnitude of the errors.

Check Data Before Execution. This option provides for comprehensive
input data checking. When this option is turned on, data checking will be
performed when the user presses the compute button. If all of the data are
complete, then the program allows the unsteady flow computations to
proceed. If the data are not complete, or some other problem is detected, the
program will not perform the unsteady flow analysis, and a list of all the
problems in the data will be displayed on the screen. If this option is turned
off, data checking is not performed before the unsteady flow execution. The
default is that the data checking is turned on.

View Computation Log File. This option allows the user to view the
contents of the unsteady flow computation log file. The interface uses the
Windows Notepad program to accomplish this. The log file contains detailed
information of what the unsteady flow computations are doing on a time step
by time step basis. This file is very useful for debugging problems with your
unsteady flow model.

Saving The Plan Information

To save the Plan information to the hard disk, select Save Plan from the File
menu of the simulation window. Whenever any option is changed or
modified on the Unsteady Flow Analysis window. the user should Save the
Plan.
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Starting the Computations

Once all of the data have been entered, and a Plan has been defined, the
unsteady flow computations can be performed by pressing the Compute
button at the bottom of the Unsteady Flow Simulation window. When the
compute button is pressed, a separate window will appear showing you the
progress of the computations (Figure 8.19). The information that appears in
the window is there as an indicator of the programs progress during the
computations, and to display any computational messages. When the
computations have been completed, the user can close the computations
window by clicking the upper right comer of the window, or the close button
at the bottom. If Ihe computations ended normally (i.e. all of the processes
ran with no error messages), then the user can begin to look at the output. If
the program does not finish normally, then the user should tum on the
detailed log file output option and fe-run the program. Then view the log file
output to begin debugging the problem.
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Figure 8.19 Unsteady Flow Computations Window
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Calibration of Unsteady Flow Models

Calibration is the adjustment of a model's parameters so that it reproduces
observed data to an acceptable accuracy. The following is a list of cornmon
problems and factors to consider when calibrating an unsteady flow model.

Observed Hydrologic Data

Stage Records. In general, measured stage data is our most accurate
hydrologic data. Measured stage data is normally well within +/- 1.0 feet of
accuracy. However, errors can be found in measured stage data. Some
conunon problems are:

1. The gages float gets stuck at a certain elevation during the rise or fall
of the flood wave.

2. The recorder may systematically accumulate error over time.

3. The gage reader of a daily gage misses several days and guesses at the
stage recordings.

4. There is an error in the datum of the gage.

Flow Records. Flow records are generally computed from observed stages
using single valued rating curves. These rating curves are a best fit of the
measured data. The USGS classifies good flow measurements from Price
current meters to be within ±5% of the true value. Some believe that this
assumed error is optimistic. In any case, ±5%, on many river systems,
translates into a stage error of ±l foot. Acoustic velocity meters (AVM)
provide a continuous record, but the current USGS technique calibrates these
meters to reproduce measurements from Price current meters, so the AVM is
as accurate as the current meter. Boat measurements are almost always
suspect. In general it is very difficult to get accurate velocity measurements
using a price current meter from a boat. Newer techniques using acoustic
velocity meters with three beams mounted on boats are thought to be much
better.

Published discharge records should also be scrutinized. Continuous discharge
is computed from discharge measurements, usually taken at bi-weekly or
monthly intervals and the continuous stage record. The measurements are
compiled into a rating curve and the departures of subsequent measurements
from the rating curve are used to define shifts. The shifts are temporary
changes in the rating curve due to unsteady flow effects (looped rating curve)
and short term geomorphic changes. The quality of the record depends on the
frequency of discharge measurements and the skill of the hydrologist. The
only way to depict the quality of the published flow data is to compare the
measured flow values to the currently published rating curve. However, if the
flow measurements are infrequent, one can only apply the flow record to the
model and see how well the stage record is reproduced. Remember' Most
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published flow records for large streams are in mean daily flow. The modeler
must somehow assign time values to these records.

High Water Marks. High water marks are estimated from the upper limit of
stains and debris deposits found on buildings, bridges, trees, and other
structures. Wind and wave actions can cause the debris lines to be higher
than the actual water surface. Capillary action can cause stains on buildings
to migrate upward, depending on the material used for the building walls.
High water marks in the overbank area are often higher than in the channel.
The overbank water is moving slower and may be closer to the energy
gradeline. High water marks on bridge piers are often equal to the energy
gradeline, not the average water surface. This is due to the fact that the water
will run up the front of the pier to an elevation close to the energy gradeline.

Shown in the Figure 8.20 below is a comparison between high water marks
and the computed maximum water surface profile. Note the scatter in the
high water marks, particularly around river station 230. Which mark is
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Ungaged Drainage Area. For an unsteady flow model to be accurate, it must
have flow input from all of the contributing area. In many studies a
significant portion of the area is ungaged. Discharge from ungaged areas can
be estimated from either hydrologic models or by taking flow from a gaged
watershed with similar hydrologic characteristics and multiplying it by a
simple drainage area ratio.

An example of accounting for ungaged drainage area is shown below for the
Red River of the North.

River
Gaged

Stream Station
Mile

Drainage

(Sq. Miles)

Red River Grand Forks 296 30,100

Turtle River Manvel 272.9 613
Forest River Minto 242.5 740
Snake River Alvarado 229.9 309
Middle River Argyle 9.72 265
Park River Grafton 221.9 695

Total of Gaged Tributaries 2,622

Red River Drayton 206.7 34,800

Total Ungaged 2,078

River
Ungaged

Pattern Drainage
Stream

Mile
Drainage

Hydrograph Area Ratio
(Sq. Miles)

Grand Marais Creek 288.6 298 Middle River 1.12
Tamarac River 218.5 320 Middle River 1.21

Remaining 1,460 Middle River 5.51

Figure 8.21 Example Drainage Area Accounting for Red River of the
North.

As shown in Figure 8.21, ungaged areas can be accounted for by using a
pattern hydrograph of a similar watershed (Middle River), then calculating a
drainage area ratio of contributing areas (Ungaged area divided by pattern
hydrograph area).

River and Floodplain Geometry

It is essential to have an adequate number of cross sections that accurately
depict the channel and overbank geometry. This can be a great source of
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error when trying to calibrate. Additionally, all hydraulic structures must be
accurately depicted. Errors in bridge and culvert geometry can be significant
sources of error in computed water surface profiles. Another important factor
is correctly depicting the geometry at stream junctions (flow combining and
splitting locations). This is especially important at flow splits, and areas in
which flow reversals will occur (i.e. flow from a main stem backing up a
tributary).

Also, a one-dimensional model assumes a constant water surface in each cross
section. For some river systems, the water surface may vary substantially
between the channel and the floodplain. lfthis is the case in your model, it
may be necessary to separate the channel and the floodplain into there own
reaches or model the overbank area as a series of storage areas.

Roughness Coefficients

Roughness coefficients are one of the main variables used in calibrating a
hydraulic model. Generally, for a free flowing river, roughness decreases
with increased stage and flow (Figure 8.22). However, if the banks ofa river
are rougher than the channel bottom (do to trees and brush), then the
composite n value will increase with increased stage. Sediment and debris
can also play an important role in changing the roughness. More sediment
and debris in a river will require the modeler to use higher n values in order to
match observed water surfaces.
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Looped Rating Curves. Excluding cataclysmic events such as 'meander
cutoffs or a new channel, the river will pass any given flow within a range of
stages. The shift in stage is a result of the following: shifts in channel
bedforms; the dynamics ofthe hydrograph (how fast the flood wave rises and
falls); backwater (backwater can significantly change the stage at a given
cross section for a given flow); and finally, the slope of the river (flatter
streams tend to have greater loops in the rating curve). Figure 8.23 below
shows a looped rating for a single event. Generally, the lower stages are
associated with the rising side of a flood wave, and the higher stages are
associated with the falling side of the flood wave.

Plan: UnsteadyFlow River: Bald Eagle Reach: Loc Hav RS: 50720.68
576J

574

572

570-

Flow(cfs)

Figure 8.23 Looped Rating Curve Example
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Alluvial Rivers. In an alluvial stream the channel boundary, as well as the
meandering pattern of the stream, are continuously being re-worked by the
flow of water. Alluvium is unconsolidated granular material, which is
deposited by flowing water. An alluvial river is incised into these alluvial
deposits. The flow characteristics ofthe stream are defined by the geometry
and roughness of the cross-section below the water surface. The reworking of
the cross section geometry and meander pattern is greatest during high flow,
when the velocity, depth of water, and sediment transport capacity are the
greatest. For some streams, which approach an equilibrium condition, the
change in morphology (landforms) is small. For other streams, the change in
morphology is much larger. The change can be manifest as changes in
roughness or a more dynamic change such as the cut-off of a meander loop,
which shortens the stream and starts a process which completely redefines the
bed.

A typical meandering river is shown in Figure 8.24 below. Pools are at the
outside of bends, and a typical pool cross-section is very deep. On the inside
ofthe bend is a point bar. Crossings are between the meander bends. A
typical crossing cross-section is much shallower and more rectangular than a
pool cross-section.

Pool

,
e

Meandering

Crossing

Figure 8.24 Morphology of a Meandering River

An invert profile for the Mississippi River is shown in the Figure 8.25. Note
the pools and crossings. The water surface profile is controlled by the
crossing cross-sections, particularly at low flow. The conveyance properties
of pool cross-sections are only remotely related to the water surface. This
poses a significant problem when calibrating a large river.
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Figure 8.25 Invert Profile for Lower Mississippi River

As stage and flow increase you have an increase in stream power (stream
power is a function of hydraulic radius, slope, and velocity). The bed forms
in an alluvial stream tend to go through the following transitions:

1. Plane hed without sediment movement.
2. Ripples.
3. Dunes.
4. Plane bed with sediment movement.
5. Anti-dunes.
6. Chutes and pools.

Generally, anti-dunes and chutes and pools are associated with high velocity
streams approaching supercritical flow. The bed form process is shown
graphically in Figure 8.26.
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Figure 8.26 Transitions of Bed Forms in an Alluvial Stream

Typical Manning's roughness coefficients for the different bed forms
presented above are shown in the following table:

Table 8-1 Roughness Variations for Alluvial Streams

Bed Forms Range of Manning's n
Ripples 0.018 - 0.030
Dunes 0.020 - 0.035
Washed Out Dunes 0.014 - 0.025
Plane Bed 0.012 - 0.022
Standing Waves 0.014 - 0.025
Antidunes 0.015 - 0.031
Note: ThIS table IS from the book "EngIneering AnalysIs of FlUVial Streams",
by Simons, Li, and Associates.
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Bed forms also change with water temperature. Because water is more
viscous at lower temperatures, it becomes more erosive, reducing the height
and the length of the dunes. At higher temperatures, when the water is less
viscous, the dunes are higher and of greater length. Since the larger dunes are
more resistant to flow, the same flow will pass at a higher stage in the summer
than in the winter. Larger rivers such as the Mississippi River and the
Missouri River show these trends. Figure 8.27 shows the seasonal shift for
the Mississippi River at St. Louis.

Figure 8.27 Changes in Roughness due to Temperature in The
Mississippi River.

River and Floodplain Storage

Cross Sectional Storage. The active flow area of a cross section is the
region in which there is appreciable velocity. This part of the cross section is
conveying flow in the downstream direction. Storage is the portion of the
cross section in which there is water, but it has little or no velocity. Storage
can be modeled within a cross section by using the ineffective flow area
option in HEC-RAS. The water surface elevation within the cross section
storage is assumed to have the same elevation as the active flow portion of the
cross section.

The storage within the floodplain is responsible for attenuating the flood
hydrograph and, to some extent, delaying the flood wave.
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Effects of Overbank Storage. Water is taken out of the rising side ofthe
flood wave and returned on the falling side. An example of the effects of
overbank storage is shown in Figure 8.28. In this example, the water goes out
into storage during the rising side of the flood wave, as well as during the
peak flow. After the peak flow passes, the water begins to come out of the
storage in the overbank and increases the flow on the falling side of the
fIoodwave.
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Figure 8.28 Example of The Effects of Overbank Storage

Off Line Storage. Off line storage is an area away from the main river in
which water can go from the main river to the ponding area. The connection
between the ponding area and the river may be a designed overflow, or it may
just be a natural overflow area. The water in the ponding area is often at a
different elevation that the main river, therefore, it must be modeled
separately from the cross sections describing the main river and floodplain.
Within HEC-RAS, ponding areas are modeled using what we call a storage
area. Storage areas can be connected hydraulically to the river system by
using a lateral weir/spillway option in HEC-RAS.

The effect that off line storage has on the hydrograph depends on the
available volume and the elevation at which flow can get into and out of the
storage area. Shown in Figure 8.29 is an example of an off-line storage area
that is connected to the river through a lateral weir/spillway. The flow
upstream and downstream of the offline storage area remains the same until
the water surface elevation gets higher than the lateral weir. Water goes out
into the lateral storage facility the whole time it is above the weir (i.e. the
storage area elevation is always lower than the river elevation in this
example). This continues until later in the event, when the river elevation is
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below the lateral weir and flow can no longer leave the river. In this example,
the flow in the storage area does not get back into the river system until much
later in the event, and it is at a very slow rate (possible drained by culverts to
a downstream location).
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Figure 8.29 Example effects of off-Iiue Storage

Hydraulic Structure Coefficients

Bridges and culverts tend to have a local effect on stage, and a minimum
affect on the flow hydrograph (this depends on the amount of backwater they
cause). The coefficients that are important in bridge modeling are: Manning's
n values; contraction and expansion coefficients; pier loss coefficients, and
pressure and weir flow coefficients for high flows. Culvert hydraulics are
dependent upon the size of the culverts and shape of the entrance. Additional
variables include Manning's n values and contraction and expansion
coefficients.

The effects of Inline weirs/spillways can be substantial on both the stage and
the flow attenuation of the hydrograph. The effects on the hydrograph will
depend upon the available storage volume in the pool upstream of the
structure, as well as how the structure is operated. Lateral weir/spillway
structures can have a significant impact on the amount of water leaving the
river system. Therefore gate and weir coefficients for these structures can be
extremely critical to getting the right amount of flow leaving the system.
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Steps To Follow in The Calibration Process

The following is a general list of steps to follow when calibrating an unsteady
flow model:

I. Run a range of discharges in the Steady-Flow mode, and calibrate n
values to established rating curves at gages and known high water
marks.

2. Select specific events to run in unsteady flow mode. Ensure each
event goes from low flow to high flow, and back to low flow.

3. Adjust storage and lateral weirs to get good reproduction of flow
hydrographs (Concentrate on timing, peak flow, volume, and shape).

4. Adjust Manning's n values to reproduce stage hydrographs.

5. Fine tune calibration for low to high stages by using "Discharge­
Roughness Factors" where and when appropriate.

6. Further refine calibration for long-term modeling (period of record
analysis) with "Seasonal Roughness Factors" where and when
appropriate.

7. Verify the model calibration by running other flow events or long
term periods that were not used in the calibration.

8. If further adjustment is deemed necessary from verification runs,
make adjustments and re-run all events (calibration and verification
events).

General Trends When Adjusting Model Parameters

In order to understand which direction to adjust model parameters to get the
desired results, the following is a discussion of general trends that occur when
specific variables are adjusted. These trends assume that all other geometric
data and variables will be held constant, except the specific variable being
discussed.

Impacts of Increasing Manning's n. When Manning's n is increased the
following impacts will occur:

I. Stage will increase locally in the area where the Manning's n values
were increased.

2. Peak discharge will decrease (attenuate) as the flood wave moves
downstream.

8-44



Chapter 8 Performing a Unsteady Flow Analysis

3. The travel time will increase.

4. The loop effect will be wider (i.e. the difference in stage for the same
flow on the rising side of the flood wave as the falling side will be
greater). An example of this is shown in Figure 8.30.
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Figure 8.30 Example of Wider Loop for Higher Manning's n

Impacts of Increasing Storage. When storage within the floodplain is
increased, the following impacts will occur:

I. Peak discharge will decrease as the flood wave moves downstream.

2. The travel time will increase.

3. The tail of the hydrograph will be extended.

4. The local stage (in the area of the increased storage) may increase or
decrease. This depends upon if you are trading conveyance area for
storage area, or just simply increasing the amount of storage area.
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Calibration Suggestions and Warnings

The following is a list of suggestions and warnings to consider when
calibrating an unsteady flow model:

1. Calibrate mostly to stages. Flow data is derived from stage. Be wary
of discharge derived from stage using single value rating curves.

2. Do not force a calibration to fit with unrealistic Manning's n values or
storage.

3. If using a single-valued rating curve at the downstream boundary,
move it far enough downstream so it doesn't effect the results in the
study reach.

4. Discrepancies may arise from a lack of quality cross-section data.

5. The volume of off-channel storage areas is often underestimated,
which results in a flood wave that travels to fast.

6. Be careful with old HEC-2 and RAS studies done for steady flow
only. The cross sections may not depict the storage areas. Defining
storage is not a requirement for a steady flow model.

7. Calibration should be based on floods that encompass a wide range of
flows, low to high.

8. For tidally influenced rivers and flows into reservoirs, the inertial
terms in the momentum equation are very important. Adjusting
Manning's n values may not help. Check cross sectional shape and
storage.

9. You must be aware of any unique events that occurred during the
flood. Such as levee breaches and overtopping.
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Model Accuracy, Stability, and Sensitivity

This section of the manual discusses model accuracy, stability, and
sensitivity. In order to develop a good unsteady flow model of a river system,
the user must understand how and why the solution of the unsteady flow
equations becomes unstable. This knowledge will help you figure out why
your particular model may be having stability problems. Additionally, it is
important to understand the trade-offs between numerical accuracy
(accurately solving the equations) and model stability. Finally, model
sensitivity will be discussed in order to give you an understanding of what
parameters affect the model and in what ways.

Model Accuracy

Model accuracy can be defined as the degree of closeness of the numerical
solution to the true solution. Accuracy depends upon the following:

1. Assumptions and limitations of the model (i.e. one dimensional
model, subcritical flow only for unsteady flow).

2. Accuracy of the geometric Data (cross sections, Manning's n values,
bridges, culverts, etc ... ).

3. Accuracy of the flow data and boundary conditions (inflow
hydrographs, rating curves, etc ... ).

4. Numerical Accuracy of the solution scheme (solution of the unsteady
flow equations).

Numerical Accuracy. Ifwe assume that the I-dimensional unsteady flow
equations are a true representation of flow moving through a river system,
then only an analytical solution of these equations will yield an exact
solution. Finite difference solutions are approximate. An exact solution of the
equations is not feasible for complex river systems, so HEC-RAS uses an
implicit finite difference scheme.

Model Stability

An unstable numerical model is one for which certain types of numerical
errors grow to the extent at which the solution begins to oscillate, or the errors
become so large that the computations can not continue. This is a common
problem when working with an unsteady flow model of any size or
complexity. The following factors will affect the stability and numerical
accuracy of the model:

I. Cross section spacing.
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2. Computation time step.

3. Theta weighting factor for numerical solution.

4. Solution iterations.

5. Solution tolerances.

6. Weir and spillway stability factors.

7. Weir and spillway submergence factors.

Cross-Section Spacing. Cross sections should be placed at representative
locations to describe the changes in geometry. Additional cross sections
should be added at locations where changes occur in discharge, slope,
velocity, and roughness. Cross sections must also be added at levees, bridges,
culverts, and other structures.

Bed slope plays an important role in cross section spacing. Steeper slopes
require more cross sections. Streams flowing at high velocities may require
cross sections on the order of 100 feet or less. Larger uniform rivers with flat
slopes may only require cross sections on the order of 1000 ft or more.
However, most streams lie some where in between these two spacing
distances.

The general question about cross section spacing is "How do you know if you
have enough cross sections." The easiest way to tell is to add additional cross
sections (this can be done through the HEC-RAS cross section interpolation
option) and save the geometry as a new file. Then make a new plan and
execute the model, compare the two plans (with and without interpolated
cross sections). If there are no significant differences between the results
(profiles and hydrographs), then the original model without the additional
cross sections is ok. If there are some significant differences, then additional
cross sections should be gathered in the area where the differences occur. If it
is not possible to get surveyed cross sections, or even cross sections from a
GIS, then use the HEC-RAS interpolated cross sections. However, at least
check the reasonableness of the interpolated cross sections with a topographic
map. Edit any cross sections that do not look reasonable.
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Computational Time Step. Stability and accuracy can be achieved by
selecting a time step that satisfies the Courant Condition:

Therefore:

Where: Vw

V
6x
6t

Flood wave speed, which is normally greater than the
average velocity.
Average velocity of the flow.
Distance between cross sections.
Computational time step.

For most rivers the flood wave speed can be calculated as:

v =:;dQ
W dA

However, an approximate way of calculating flood wave speed is to multiply
the average velocity by a factor. Factors for various channel shapes are
shown in the table below.

Table 8-2 Factors for Computing Wave Speed From Average Velocity

Channel Shape
Wide Rectangular
Wide Parabolic
Triangular
Natural Channel

Ratio VwlV
1.67
1.44
1.33
1.5

Practical Time Step Selection. For medium to large rivers, the Courant
condition may yield time steps that are too restrictive (i.e. a larger time step
could be used and still maintain accuracy and stability). A practical time step
IS:
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Tr
!1t '5.-

20

Where: T, = Time of rise of the hydrograph to be routed.

However, you may need to use a smaller time step when you have lateral
weirs/spillways and hydraulic connections between storage areas and the river
system. Also, if you are opening and closing gates quickly, or modeling a
Dam or Levee breach, you will need to use very small time steps (less than a
minute, maybe even as low as 5 seconds).

Theta Weighting Factor. Theta is a weighting applied to the finite
difference approximations when solving the unsteady flow equations.
Theoretically Theta can vary from 0.5 to 1.0. However, a practical limit is
from 0.6 to 1.0
Theta of 1.0 provides the most stability. Theta of 0.6 provides the most
accuracy. The default in HEC-RAS is 1.0. Once you have your model
developed, reduce theta towards 0.6, as long as the model stays stable.

Larger values oflheta increase numerical diffusion, but by how much?
Experience has shown that for short period waves that rapidly rise, theta of
1.0 can produce significant errors. However, errors in the solution can be
reduced by using smaller time steps.

When choosing theta, one must balance accuracy and computational
robustness. Larger values of theta produce a solution that is more robust, less
prone to blowing up. Smaller values of theta, while more accurate, tend to
cause oscillations in the solution, which are amplified if there are large
numbers of internal boundary conditions. Test the sensitivity oflheta to your
data set. If reducing theta does not change the solution, then the larger value
should be used to insure greater stability.

Solution Iterations. At each time step derivatives are estimated and the
equations are solved. All of the computation nodes are then checked for
numerical error. If the error is greater than the allowable tolerances, the
program will iterate. The default number of iterations in HEC-RAS is set to
20. Iteration will generally improve the solution. This is especially true
when your model has lateral weirs and storage areas.

Solution Tolerances. Two solution tolerances can be set or changed by the
user: water surface calculation (0.02 default) and Storage area elevation (0.10
default). The default values should be good for most river systems. Only
change them if you are sure! Making the tolerances larger can reduce the
stability of the solution. Making them smaller can cause the program to go to
the maximum number of iterations every time.
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Weir and Spillway Stability Factors. Weirs and Spillways can often be a
source of instability in the solution. Especially lateral structures, which take
flow away or bring it into the main river. During each time step, the flow
over a weir/spillway is assumed to be constant. This can cause oscillations by
sending too much flow during a time step. One solution is to reduce the time
step. Another solution is to use Weir and spillway stability factors, which can
smooth these oscillations by damping the computed flows. However, using
these stability factors can reduce the accuracy of the computed values.

The weir and spillway stability factors can range from 1.0 to 3.0. The default
value of 1.0 is essentially no damping of the computed flows. As you
increase the factor you get greater dampening of the flows (which will
provide for greater stability), but less accuracy.

Weir and Spillway Submergence Factors. When you have a weir or
spillway connecting two storage areas, or a storage area and a reach,
oscillations can occur when the weir or spillway becomes highly submerged.
The program must always have flow going one way or the other when the
water surface is above the weir/spillway. When a weir/spillway is highly
submerged, the amount of flow can vary greatly with small changes in stage
on one side or the other. This is due to the fact that the submergence curves,
which are used to reduce the flow as it becomes more submerged, are very
steep in the range of95 to 100 percent submergence. The net effect of this is
that you can get oscillations in the flow and stage hydrograph when you get to
very high submergence levels. The program will calculate a flow in one
direction at one time step. That flow may increase the stage on the receiving
side of the weir, so the next time step it sends flow in the other direction.
This type of oscillation is ok if it is small in magnitude. However, if the
oscillations grow, they can cause the program to go unstable.

To reduce the oscillations, the user can increase the Weir/Spillway
Submergence Factor. This factor can vary from 1.0 to 3.0. A factor of 1.0
leaves the submergence criteria in its original form. Using a factor greater
than 1.0 causes the program to use larger submergence factors earlier, and
makes the submergence curve Jess steep at high degrees of submergence. A
plot of the submergence curves for various factors is shown in Figure 8.3 I.
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Weir/Spillway Submergence Factors
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Degree of Submergence

Figure 8.31 Weir/Spillway Submergence Factors

Common Stability Problems. The following is a list of some of the most
common reasons for instabilities occurring in an unsteady flow model like
HEC-RAS

Too lwge ofa time step: When the solution scheme solves the unsteady flow
equations, derivatives are calculated with respect to distance and time. If the
changes in hydraulic properties at a give cross section are changing rapidly
with respect to time, the program will go unstable. The solution to this
problem is to decrease the computational time step.

Not enough cross sections: When cross sections are spaced far apart, and the
changes in hydraulic properties are great, the solution can become unstable.
In situations where the flow area, depth, and/or velocity are changing rapidly,
it is necessary to add additional cross sections to keep the solution stable.

Model goes to critical depth: The default solution methodology for unsteady
flow routing within HEC-RAS is generally for subcritcal flow. However, the
software does have an option to run in a mixed flow regime mode. This
option should not be used unless you tnily believe you have a mixed flow
regime river system. If you are running the software in the default mode
(suberitical only, no mixed flow), and if the program goes down to critical
depth at a cross section, the changes in area, depth, and velocity are very
high. This sharp increase in the water surface slope will often cause the
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program to overestimate the depth at the next cross section upstream. and
possible underestimate the depth at the next cross section downstream (or
even the one that went to critical depth the previous time step). One solution
to this problem is to increase the Manning's n value in the area where the
program is fIrst going to critical depth. This will force the solution to a
subcritical answer and allow it to continue with the nm. Obviously, this is
creating a solution that may be higher than the true solution, but it may be
necessary in order to allow the program to continue with the run. If you feel
that the true water surface should go to critical depth, or even to a
supercritical flow regime, then the mixed flow regime option should be turned
on.

Bad downstream boundary condition: If the user entered downstream
boundary condition causes abrupt jumps in the water surface, or water surface
elevations that are too low (approaching or going below critical depth), this
can cause oscillations in the solution that may lead to it going unstable and
stopping. Examples of this are rating curves with not enough points or just
simply to low of stages; and normal depth boundaries wbere the user has
entered to steep of a slope.

Bad cross section properties: All of the cross sections get converted to tables
of hydraulic properties (elevation versus area, conveyance, and storage). If
the curves that represent these hydraulic properties have abrupt changes with
small changes in elevation, this can also lead to instability problems. This
situation is cOlrunonly caused by: levees being overtopped with large areas
behind them (since the model is one dimensional, it assumes that the water
surface is the same all the way across the entire cross section); and ineffective
flow areas with large amounts of storage that are turned on at one elevation,
and then turn off at a slightly higher elevation (this makes the entire area now
used as active conveyance area). There are many possible solutions to these
problems, but the basic solution is to not allow the hydraulic properties of a
cross section to change so abruptly. If you have a levee with a large amount
of area behind it, model the area behind the levee separately from the cross
section. This can be done with either a storage area or another routing reach,
whichever is most hydraulically correct for the flow going over the levee or if
the levee breaches. With large ineffective flow areas, the possible solutions
are to model them as being permanently on, or to put very high Manning's n
values in the ineffective zones. Permanent ineffective flow areas allow water
to convey over top of the ineffective area, so the change in conveyance and
area is small. The use of high Manning's n values reduces the abruptness in
the change in area and conveyance when the ineffective flow area gets turned
off and starts conveying water.

Cross section property tables that do not go high enough: The program
creates tables of elevation versus area, conveyance, and storage area for each
of the cross sections. These tables are used during the unsteady flow solution
to make the calculations much faster. By default, the program will create
tables that extend up to the highest point in the cross section, however, the
user can override this and specify their own table properties (increment and
number of points). Ifduring the solution the water surface goes above the
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highest elevation in the table, the program simply extrapolates the hydraulic
properties from the last two points in the table. This can lead to bad water
surface elevations or even instabilities in the solution.

Not enough definition in cross section property tables: The counter problem
to the previous paragraph is when the cross section properties in a given table
are spread too far apart, and do not adequately define the changes in the
hydraulic properties. Because the program uses straight-line interpolation
between the points, this can lead to inaccurate solutions or even instabilities.
To reduce this problem, we have increased the allowable number of points in
the tables to 100. With this number of points, this problem should not
happen.

Bad Bridge/Culvert Family o/rating curves. The program creates a family of
rating curves to define all the possible headwater, tailwater, and flow
combinations that can occur at a particular structure. One free flow curve
(headwater versus flow, with no influence from the tailwater) is calculated
with fifty points to define it, then up to fifty submerged curves (headwater
versus flow, staring at a particular tailwater) are calculated with up to 20
points to define each curve. The user can control how many submerged
curves get calculated, how many points in each curve, and the properties used
to define the limits of the curves (maximum headwater, maximum tailwater,
maximum flow, and maximum head difference). By default, the software will
take the curves up to an elevation equal to the highest point in the cross
section just upstream of the structure. This may lead to curves that are too
spread out and go up to a flow rate that is way beyond anything realistic for
that structure. These type of problems can be reduced by entering specific
table limits for maximum headwater, tailwater, flow, and head difference.

Wide andflat Lateral Weirs/Spillways: During the computations, there will
be a point at which for one time step no flow is going over the lateral weir,
and then the very next time step there is flow going over the weir. If the
water surface is rising rapidly, and the weir is wide and flat, the first time the
water surface goes above the weir could result in a very large flow being
computed (i.e. it does not take a large depth above the weir to produce are
large flow if it is very wide and flat). This can result in a great decrease in
stage from the main river, which in tum causes the solution to oscillate and
possibly go unstable. This is also a common problem when having large flat
weirs between storage areas. The solution to this problem is to use smaller
computational time steps. If this is not sufficient, there is also the option to
use weir/spillway stability factors, as described previously in the chapter.

Opening gated spillways to quickly: When you have a gated structure in the
system, and you open it quickly, if the flow coming out of that structure is a
significant percentage of the flow in the receiving body of water, then the
resulting stage, area and velocity will increase very quickly. This abrupt
change in the hydraulic properties can lead to instabilities in the solution. To
solve this problem you should use smaller computational time steps, or open
the gate a littler slower, or both if necessary.
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Very shallow depths ojwaler: When starting a simulation it is very common
to start the system at low flows. If you have some cross sections that are
fairly wide, the depth will be very small. As flow begins to come into the
river, the water surface will change quickly. The leading edge of the flood
wave will have a very steep slope. Sometimes this steep slope will cause the
solution to reduce the depth even further downstream of the rise in the water
surface, possibly even producing a negative depth. This is due to the fact that
the steep slope gets projected to the next cross section downstream when
trying to solve for its water surface. The best solution to this problem is to
use what is called a pilot channel. A pilot channel is a small slot at the
bottom of the cross section, which gives the cross section a greater depth
without adding much flow area. This allows the program to compute shallow
depths on the leading edge of the flood wave without going unstable.
Another solution to this problem is to use a larger base flow at the beginning
of the simulation.

Detecting Stability Problems. One of the hardest things about using an
unsteady flow model is to get the model to be stable, as well as accurate, for
the range of events to be modeled. When you first start putting together an
unsteady flow model, undoubtedly you will run in to some stability problems.
The question is, how do you know you are having a stability problem? The
following is a list of stability problem indicators:

)

I. Program stops running during the simulation with a math error, or
states that the matrix solution went unstable.

2. Program goes to the maximum number of iterations for several time
steps in a row (this is not always a stability problem).

3. There are oscillations in the computed stage and flow hydrographs, or
the water surface profiles.

If you detect a possible stability problem, in order to find the location of the
problem you will need to turn on the detailed log output for debugging.
Detailed log output is turned on by selecting Options and then Output
Options from the Unsteady Flow Simulation manager. When this option is
selected the following window will appear:
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HEC-RA5 .'

Restart File

r Write Initial Condition file.

File: ILevee8feach.p01.rst

r.- Hows from begining of sirnulatiCln:

(" Fixed Reference: Date:

Detailed Log Output

~ Echo Input Hydr,:rgraphs 10 Detailed Log Output File.
r;;- Echo Computed H}'drographs to Detailed Log OIJlput File.

~ Virile Det.3lied Log Output for Debuging

Time window is optional:

Time:

Slartir1g Date: 12/1 O/199~3

Ending Dale· 12/11/1999

Figure 8.32 Detailed Log Output Control

Siorting Time: 11 000

Ending Time: 11600

As shown in Figure 8.32, the seclion at the bottom half of this editor is used
for controlling the detailed log outpu!. Three check boxes are listed. The
first box can be used to turn on an echo of the hydrograph input to the model.
This can be used to ensure that the model is receiving the correct flow data.

The second check box can be used to him on an echo of the computed
hydrographs that will be written to the HEC-DSS. This is a good option for
checking what was computed. However, if the user has selected to have
hydrographs computed at many locations, this could end up taking a lot of file
and disk space. The third check box is used to control the detailed output of
results from the unsteady flow simulation. Selecting this options will cause
the software to write detailed information on a time step by time step basis.
This option is useful when the unsteady flow simulation is going unstable or
completely blowing up (stopping). Checking this box turns on the detailed
output for every time step. The user has the option to limit this output to a
specitic time window during the unsteady flow simulation. Limiting the log
output is accomplished by entering a starting date and time and an ending
date and time.

Viewing Detailed Log Output. After the user has turned on the detailed log
output option, re-TUn the unsteady flow simulation. The user can then view
the detailed log output by selecting View Computational Log File from the
Options menu of the Unsteady Flow Simulation window. When this option
is selected the detailed log output file will be loaded into the default text file
viewer for your machine (normally the NotePad.exe program, unless you
have changed this option within HEC-RAS).
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The detailed log output file will contain the following output:

RDSS Output: Shows all of the hydrograph data that will be used as input to
the model, including data read from HEC-DSS.

UNET Output: Detailed unsteady flow calculations including:

- Job control parameters
- Initial conditions calculations
- Detailed output for each time step

Table Output: Final computed hydrographs that are written to HEC-DSS.

The program lists the computed initial conditions from a backwater
calculation for each of the riverlreaches. They are listed in the order they
were computed during the backwater analysis, which is downstream to
upstream. An example of the initial conditions output is shown in Figure 8.33
below.

leveeBreach.bco - f'ltotepad -~ ,... -,
Ede t.dil: FQrmat Help

In; t; a1 cend; t ions from Backw.ner

RIVER N.Al'ulE REACH NAME RIVER STATION FLO\'l' WSEL eRIT DEPTH EG SLOPE ARE,o.,
Beaver creek I<ent\>iood I S.O 3000.00 209.30 207.02 0.0012071 2178.8·1
Beaver" Creek Kentwood 5.016 3000.00 209.40 207.13 0.0011585 2036.65
Beaver creek Kentwood" 5. 032 3000.00 209.49 207.23 0.0011494 1950.81
Beaver Cr eek Kentwood 5. (/48 3000.00 209.58 207.30 0.0011500 1913.43
Beaver creek Kemwood 5.065 3000.00 209.67 207.36 0.0011672 1874.69
Beaver creek Kenhiood 5. 081 3000.00 209.75 207.40 0.0012010 1834,46
Beaver Creek Kentwood 5.097 3000.00 209.82 207.41 0.0013485 1788,69
Beaver Cree~ Kentwood 5.113 3000.00 209.92 207.46 0.0013873 1773.18
Beaver cree~ kenh,..ood 5.13 3000.00 210.03 207.46 0.0014094 1757.82
Beaver Creek Kent'r:lood 5.146 3000.00 210.17 207.90 0.00143 58 1769.25
Beaver Creek Kentwood 5.162 3000.00 210.31 208.27 0.0014840 1781. 54
Beaver creek Kentwood 5.178 3000.00 210.45 208.61 0.0015081 1801. 07
Beaver Creek Kentwood 5.194 3000.00 210.60 208.86 0.0015066 1824.42
Beaver Creek Kent""ood 5.21 3000.00 210.75 209.17 0.0014833 1847.64
Beaver Creek Kent""ood 5.226 3000.00 210.89 209.50 0.0014471 1869.46
Beaver Creek KentVw"Ood 5.242 3000.00 211.02 209.68 0.0013911 1887.72
Beaver Cr eek Kentwood 5.258 3000.00 211.15 209.74 0.0013163 1900.66
Beaver creek Kentwood 5.274 3000.00 211.26 209.76 0.0012231 1905.77
Beaver creek Kentwood 5.2~ 3000.00 211.37 209.67 0.0010797 1900.07
Beaver Creek Kent"'lJod 5.31 3000.00 211.36 210.30 0.0021558 1609.68
Beaver Creek Kentwood 5.33 3000.00 211. 38 210.22 0.0025166 1330.87
Beaver Creek Kentwood 5.35 3000.00 211.48 209.15 0.0018303 1197.09
Beaver Creek Kent"'lJod 5.37 3000.00 211. 60 208.10 0.0011982 1217.8'J
Beaver creek Kent.....ood 5.39 3000.00 211.70 207.21 O. 0007646 1353.02
Beaver Creek Kentwood 5.41 3000.00 211. 77 207.22 0.0007778 1049.97
Beaver Creek Kentwood 5.425 3000.00 211.77 208.41 0.0012525 898.97
Beaver Creek Kent>o.uod 5.44 3000.00 211.82 209.15 0.0016949 999.32
Beaver Creek Kent"ottlJod 5.457 3000.00 211.96 209.44 0.0018008 1016.67
Beaver Creek Kentwood 5.474 3000.1)0 212.11 209.77 0.0018442 1069.78
Beaver Creek Kentwood 5.491 3000.00 212.29 210.14 0.0017970 1161. 52
Beaver Creek Kent''''lJod 5.508 3000.00 212.46 210.99 0.0016890 1267.34
Beaver Creek Kenh,uod 5. 525 3000.00 212.61 211. 22 O. 0016485 1365.06
Beaver creek Kent .....ood 5. 542 3000.00 212.76 211. 29 0.0015495 1478.80
Beaver Creek Kenn;ood 5. 559 3000.00 212.90 211. 25 0.0014375 1598.4~

Figure 8.33 Example of Initial Conditions Output
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During the unsteady flow computations, the program will output detailed
information for cross sections, bridges/culverts, inline weir/spillways, lateral
weir/spillways, storage areas, and storage area connections. This information
should be reviewed closely when the software is having stability problems.
An example of the detailed output for cross sections is shown in Figure 8.34
below.

.@Ibeaver.bco·Notepad "

CCf1PUTEO STAGES AND OISCHA.r:'.GES A.T T 0.1167 HOURS - ~/lo/1999 AT 0007 ~JURS -'

Riv. Stdtion z
5.951 212.83
5.89-J 212.38
5.83!,) 211.74
5.779 211.24

5.72 210.91
5.666 210.48

5.61 210.21
5.55':1 20~.93

5. 508 209.72
5.457 209.61

5.41 209.57
5.35 209.48
5.29 209.15

5.242 208.21;\
5.19J '207.15
5.146 206.75
5.097 206.59
5.048 206.39

5.0 206.13

Beaver Creek Kentwood

Riv. Stat; on Z Q v R;v. station z Q v
5.99 213.03 599. 1. 09 5.97 212.94 588. 1. 22
5.93 212.71 57!. 1. 56 5.913 212.56 5t>J . 1. 79

5.875 212.19 552. 2.34 5.855 211.98 547. 2.65
5.81 211.52 540. 2.96 5.798 211. 36 536. 2'.45
5.76 211.17 528. 1.18 5.741 211. 07 523. 1.64

5.70:; 210. 75 519. 2.31 5.685 210.61 517. ;::.30
5.647 210.37 515. 1. 92 5.628 210.27 514 . 1. 62
5. 593 210.13 512. 1. 52 5. 576 210.03 51!. 1.80
5. 542 209.55 510. 2.23 S.5:?5 209.78 510. 2.24
5.491 209.67 '!l0. 1. 94 5.474 209.64 510. 1. 76

5.44 209.58 510. 1.47 5.425 20"'.58 509. 1.11
5.39 209.54 509. 0.83 5.37 209.52 509. 1.11
5.33 209.40 510. 1. 67 5.31 209.28 510. 1. 67

5.274 208.95 Sl0. t. 66 5.258 208.68 511. 1. 9~,

5.226 207.85 511. 3.05 5.21 207 . .:16 51~. 3.29
5.178 206.95 513 . 2.68 5.162 206.83 513. 2.16

5.13 206.71 514. 1. 4 5 5 113 206.M 51S. 1. 50
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Figure 8.34 Detailed Output at a Cross Section.

When the program has stability problems, it will generally try to solve them
by iterating. An example ofa stability problem is shown in Figure 8.35. In
this example the program did 110t solve the equations to the specified
tolerances, and therefore it was iterating to improve the solution. As shown
in Figure 8.35, the program iterated to the maximum number of iterations. At
the end of the iterations a warning message states "WARNING USED
COMPUTED CHA GES I FLOW AND STAGE AT MI IMUM
ERROR. MINIMUM ERROR OCCURRED AT ITERATION XX."
This message means that the program could not solve the unsteady flow
equations to the required tolerance within the specified number of iterations
(default number of iterations is 20). Therefore it used the iteration that had
the least amollnt of error in the numerical solution.
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4) leveeBreach.bco - Notepad ~,
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3 seaver cl'eek 5.0 209.60 -0.89442 STo #1, Seaver' Cr'eek 5.0 208.96 -0.91305 STo #1
5 Beaver creek 5.0 208.28 -0.96582 STo #1
6 seave(' Creek 5.0 207.56 -1. 03982 STo #1
7 Beaver Creek 5.016 211.95 2.44811 STO 11
8 Beaver Creek 5.032 216.98 7.38552 STO 11
9 Beaver Cr eek 5.0 203.31 -1. 34783 STO 11

10 Beaver Creek 5.162 218.46 7.18687 5To H
11 Beaver' Creek 5.0 1915.49 -0.83206 STo 11
12 Beaver' Creek 5.0 198.30 -0.26222 STo 11
13 Beaver C('eek 5.0 198.25 -0.07942 STO 11
14 Beaver' cr'eek 5.016 223.05 19.42409 5To #1
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16 Beaver creek 5.0 195.82 -0.79409 STo 11
17 Seaver Cr eek 5.0 195.36 -0. iS6080 STo 11
18 Beaver creek 5.065 210.10 3.19042 STO #1
19 Beaver' Creek 5.031 210.03 1.40783 STO #1
20 Beaver Creek 5.0 193. 35 -0.92478 STo #1

.4!J~

~
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205.00 0.00000 Beaver Creek 5. "205.00 0.00000 Beaver Cr'eek 5.0
205.00 0.00000 Beaver cr'eek 5.0
205.00 0.00000 Beaver Creek 5.0
205.00 0.00000 Beaver Creek 5.0
205.00 0.00000 Beaver creek 5.0
205.00 O. 00000 8eaver creek 5.0
205.00 0.00000 Beaver' creek 5.0
205.00 O. 00000 Beaver Creek 5.0
205.00 0.00000 Beaver Creek 5.0
205.00 0.00(100 Beaver Creek '.0

!\.IA.RNHJG, US EO CO/'-1PUTED CH.ANGES IN FLOW AND STAGE AT MINH1U~l ERROI1.. MINII'\UM ERI1DR OCCUREO DURING ITERATION

Lateral weirs

JRIVER
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STATION
5.4

QTOTAL
0.00

Q\>IEIR
0.00

(~ATE SU8~<\ERGENCE

0.00 0.000
Q PER CROSS SECTION

0.00 0.00 0.00

Hydrographs wri-r-ren aT 3.2Shours.

opTirtial time step for the next 15 minutes is

THETA_l 000

15.00 minUTes; r,ISTEPS ~

COMPUTED STAGES AND DISCHARGES AT T

!.'! I

Beaver Creek Kenht'Ood

J.2500 HOURS - 2/10/1999 AT 0315 HOUP5

) Figure 8.35 Example Detailed Time step Output for Cross Sections.

One way to find and locate potential stability problems with the solution is to
do a search in the file for the word "WARNING". The user then needs to
look at the detailed output closely to try and detect both where and why the
solution is going bad.

The variables that are printed out during the iterations are the following:

Iter = Iteration Number
River = The name of the river in which the largest stage error is occurring.
Station = River station with the largest error in the calculated stage.
ELEV = Computed water surface elevation at that river station
DZ = The "Numerical Error" in the computed stage at that location
Storage= Name of the storage area.
Zsa = Computed elevation of the storage area
Dzsa = The "Numerical Error" in the computed storage area elevation.
River = The name of the river in which the largest flow error is occurring.
Station = River station with the largest error in the calculation of flow
Q = Computed flow
DQ = The "Numerical Error" in the computed flow at the listed river

station
After the iterations output, the program will show the computed stages and
flows for all of the cross sections in which the user has selected to have
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hydrographs computed. This is also useful information for detecting model
stability problems. It is not always obvious as to which cross section or
modeling component is causing the problem. Sometimes the program may
blow up at one cross section, but the real problem is caused by a cross section
upstream or downstream from this location. Detecting, finding, and fixing
stability problems will require lots of experience to become proficient at it.
Good luck, and don't get to discouraged" I

Model Sensitivity

Model sensitivity is an important part of understanding the accuracy and
lmcertainty of the model. There are two types of sensitivity analysis that
should be perfonned, Numerical Sensitivity and Physical Parameter
Sensitivity.

Numerical Sensitivity. Numerical Sensitivity is the process of adjusting
parameters that affect the numerical solution in order to obtain the best
solution to the equations, while still maintaining model stability. The
following parameters are typically adjusted for this type of sensitivity
analysis:

Complllational Time Step - The user should try a smaller time step to see if
the results change significantly. If the results do change significantly, then
the original time step is probably too large to solve the problem accurately.

Theta Weighting Factor - The default value for this factor is 1.0, which
provides the greatest amount of stability for the solution, but may reduce the
accuracy. After the user has a working model, this factor should be reduced
towards 0.6 to see if the results change. If the results do change, then the
new value should be used, as long as the model stays stable. Be aware that
using a value of 0.6 gives the greatest accuracy in the solution of the
equations, but it may open the solution up to stability problems.

Weir/Spillway Stability Factors - Jfyou are using these factors to maintain
stability, try to reduce them to the lowest value you can and still maintain
stability. The default value is 1.0, which is no stability damping.

Weir/Spillway Submergence Exponents - In general these parameters will not
affect the answers significantly, they only provide greater stability when a
spillway/weir is at a very high submergence. Try reducing them towards 1.0
(which is no factor) to see if the model will remain stable.

Physical Parameter Sensitivity. Physical Parameter Sensitivity is the
process of adjusting hydraulic parameters and geometric properties in order to
test the uncertainty of the models solutions. This type of sensitivity analysis
is often done to gain an understanding of the possible range of solutions,
given realistic changes in the model parameters. Another application of this
type of sensitivity analysis is to quantify the uncertainty in the model results
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for a range of statistical events (2, 5,10, 25, 50,100 yr, etc... ). The following
data are often adjusted during this type of sensitivity analysis:

Manning's n Values - Manning's n values are estimated from physical data
about the stream and floodplain. Sometimes Manning's n values are
calibrated for a limited number of events. Either way, the values are not
exact' The modeler should estimate a realistic range that the n values could
be for their stream. For example, if you estimated an n value for a stream as
0.035, a realistic range for this might be 0.03 to 0.045. The modeler should
run the lower Manning's n values and the higher Manning's n values to
evaluate their sensitivity to the final model results.

Cross Section Spacing - Cross section spacing should always be tested to
ensure that you have enough cross sections to accurately describe the water
surface profiles. One way to test if you have enough cross sections is to use
the HEC-RAS cross section interpolation routine, and interpolate enough
cross sections to cut the average distance between cross sections in half. Re­
run the model, if the results have not changed significantly, then your original
model was probably fine. If the results do change significantly, then you
should either get more surveyed cross sections or use the interpolated cross
sections. If you use the interpolated cross sections, then you should at least
look at a topographic map to ensure that the interpolated cross sections are
reasonable. If the interpolated cross sections are not reasonable in a specific
area, then simply edit them directly to reflect what is reasonable based on the
topographic map.

Cross Section Storage - Portions of cross sections are often defined with
ineffective flow areas, which represents water that has no conveyance. The
extent of the storage within a cross section is an estimate. What if the
ineffective flow areas were larger or smaller? How would this effect the
results? This is another area that should be tested to see the sensitivity to the
final solution.

Lateral Weir/Spillway Coefficients - lateral weir/spillway coefficients can
have a great impact on the results of a simulation, because they take water
away or bring water into the main stream system. These coefficients can vary
greatly for a lateral structure, depending upon their angle to the main flow,
the velocity of the main flow, and other factors. The sensitivity of these
coefficients should also be evaluated.

Bridge/Culvert Parameters -In general, bridge and culvert parameters
normally only effect the locally computed water surface elevations just
upstream and downstream of the structure. The effect that a bridge or culvert
structure will have on the water surface is much greater in flat streams (a
small increase in water surface can back upstream for a long distance if the
river is flat). However, the sensitivity of the water surface elevations around
a bridge or culvert may be very important to localized flooding. The bridge
and culvert hydraulic parameters should also be evaluated to test their
sensitivity.
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CHAPTER 9

Viewing Results

After the model has finished the steady or unsteady flow computations the
user can begin to view the output. Output is available in a graphical and
tabular format. The current version of the program allows the user to view
cross sections, profiles, rating curves, hydrographs, X- Y-Z perspective plots,
detailed tabular output at a single locations, and limited tabular output at
many cross sections. Users also have the ability to develop their own output
tables.

Contents

• Cross Sections, Profiles, and Rating Curves

• Stage and Flow Hydrographs

• X- Y-Z Perspective Plots

• Tabular Output

• Viewing Results From The River System Schematic

• Viewing Ice Information

• Viewing Data Contained in an HEC-DSS File

• Exporting Results to HEC-DSS

Cross Sections, Profiles, and Rating Curves

Graphical displays are often the most effective method of presenting input
data and computed results. Graphics allow the user to easily spot errors in the
input data, as well as providing an overview of the results in a way that tables
of numbers cannot.

Viewing Graphics on the Screen

To view a graphic on the screen, select Cross Sections, Profiles, or Rating
Curves from the View menu on the HEC-RAS main window. Once you
have selected one of these options, a window will appear with the graphic
plotted in the viewing area. An example cross-section plot is shown in Figure
9.1. The user can plot any cross section by simply selecting the appropriate
reach and river station from the list boxes at the top of the plot. The user can
also step through the cross section plots by using the up and down arrows.
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Figure 9,1 Example Cross Section Plot

An example profile plot is shown in Figure 9.2. The profile plot displays the
water surface profile for the first reach in the river system. If there is more
than one reach, additional reaches can be selected from the Options menu on
or the reach button at the top of the window.

An example rating curve plot is shown in Figure 9.3. The rating curve is a
plot of the water surface elevation versus flow rate for the profiles that were
computed. A rating curve can be plotted at any location by selecting the
appropriate reach and river station from the list boxes at the top of the plot.
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Graphical Plot Options

Several plotting features are available from the Options menu on all of the
graphical plots. These options include: zoom in; zoom out; selecting which
plans, profiles, reaches and variables to plot; and control over labels, lines,
symbols, scaling, grid options, zoom window location, font sizes, and land
marks. In addition to using the options menu at the top of each graphic
window, if a user presses the right mouse button while the cursor is over a
graphic, the options menu will appear right at the cursor location. In general,
the options are about the same on all of the graphics.

Zoom In. This option allows the user to zoom in on a portion of the graphic.
This is accomplished by selecting Zoom In from the Options menu, then
specifying the area to zoom in on with the mouse. Defining the zoom area is
accomplished by placing the mouse pointer at a corner of the desired zoom
area. Then press down on the left mouse button and drag the mouse to define
a box containing the desired zoom area. Finally, release the left mouse button
and the viewing area will display the zoomed-in graphic. A small window
showing the entire graphic will be placed in one of the corners of the graphic.
This window is called the Zoom Window. The Zoom Window shows the
entire graphic with a box around the zoomed in area. The user can move the
zoom box or resize it in order to change the viewing area.

Zoom Out. This option doubles the size of the currently zoomed in graphic.

Full Plot. This option re-displays the graphic back into its original size
before you zoomed in. Using the Full Plot option is accomplished by
selecting Full Plot from the Options menu.

Pan. This option allows the user to move the graphic around while in a
zoomed in mode. After zooming in, to move the graphic around, select Pan
from the Options menu. Press and hold the left mouse button down over the
graphic, then move the graphic in the desired direction.

Animale. This option was developed for unsteady flow output analysis, but
can also be used for steady flow output. This option works with the cross
seclion, profile, and X, Y, Z perspective plots. When this option is selected, a
window will appear that allows the user to control the animation of any
currently opened graphics. The user has the option to too "play" a graphic,
which means to step through the time sequence of computed profiles. In a
steady flow analysis, it can be used to switch between the profiles
conveniently.

Plans. This option allows the user to select from the available Plans for
plotting. The default plan is the currently opened plan. The user can select
additional plans to view for comparison of results graphically.

Profiles. This option allows the user to select which profiles they would like
to have displayed on the graphic. This option does not apply to the rating
curve, it automatically plots all of the protiles.
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Reaches. This option allows the user to select which river reaches they
would like to have displayed. This option only applies to the profile plot.

Variables. This option allows the user to select whatever variables are
available for plotting. The number and type of variables depends on what
type of graphic is being displayed. The following is a list of variables that
can be found on the profile plot: water surface, energy, critical water surface,
observed water surfaces, reach labels, and left and right main channel bank
stations, ice cover, left and right levees, pilot channels, sediment elevations,
and lateral structures. The cross section plot is has the following eight
variables: water surface, filled in water surface, energy, critical depth,
observed water surface, ice cover, Manning's n values, and pilot channels.

Labels. This option allows the user to change the labels at the top of the plot.
The user can select any or all of the following items to be added to the
caption: project title, plan title, run date, run time, geometry title, flow title,
river and reach names, cross section descriptions, cross section river
stationing, and any user defined additional text.

Lines and Symbols. This option allows the user to change the line types,
line colors, line widths, symbol types, symbol sizes, symbol colors, fill
patterns, and the line labels. When the user selects this option, a window will
appear as shown in Figure 9.4.

Line style Options A.Ibr, •

r.- Current PIoILI1e ~I.vIes r Default Litle Styles

GfOund Ground • 1 pixel

~Bank Sla BankSta • 1-0516 * 2"\>is' \>iSPP~'
---------- •• - 1 0 01 31••~EG1 EG Pf~' ---------------- 'V 0

\>''02 \>is Pf~2 -1.5 X ~ 0 4 IIIII1
EG2 EG Pf~2

..._.....------- • -20[Q] <l> 0 5 .~
\>is] \>is PP~3 .-2.5 0 <It 0 6 .~
EG3 EG PFU3 ------- ...------.

•• -3.0 ..rnmWS4 \>iSPfM Z <2> 0 7

EG4 EG PPM ........._--_._- .-35 + <> 0 8 .~
WS5 "IS PP~5 • -4.0 -!i,f- <8> D 9

EG5 EG PFtt5 -_._---..-----..
~ D-4.5 '0

OK

Figure 9.4 Line and Symbol Options Window

Cancel

When tbe Line and Symbol Options window comes up, it will list only the
information from the current plot. When this window is in the "Current Pict
Line Styles" mode, the user can only cbange the information for the current
plot. If the user wants to change the default line and symbol options for all of
the plots, they must select Default Line Styles at the top of the window.
When this option is selected, the user will be able to change the label, line,
and symbol options for every vari.able that is plotted in the program. To use
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this option, the user finds the variable that they want to change from the list
on the left side of the window. Select that variable by clicking the left mouse
button while over top of the variable. Once a variable is selected, the options
that are set for that variable will be highlighted with a red box around each
option. The user can change whatever option they want, as well as changing
the label for that variable. If a variable does not have a default label, you
cannot enter one for that variable. Once the user has made all of the changes
that they want to all of the desired variables, they should press the OK button.
The changes will be saved permanently, and any plot that is displayed within
HEC-RAS will reflect the user-entered changes.

Scaling. This option allows the user to define the scaling used for the plol.
Users are allowed to set the minimum, maximum, and labeling increment for
the X and Yaxis. Scaling can be set temporarily, or scaling can be set to be
persistent (scaling stays constant for all cross sections). Persistent scaling is
only available for the cross section and rating curve plots.

Grid. This option allows the user to overlay a grid on top of the graphic.
Users have the option to have both major and minor tics displayed, as well as
a border around the plol.

Zoom Window Location. This option allows the user to control which
corner of the plot that the zoom window will be placed, and the size of the
window.

Font Sizes. This option allows the user to control the size of all of the text
displayed on the graphic.

Land Marks. This option is specific to profile plots. With this option the
user can turn on additional labels that will be displayed as land marks below
the invert of the channel. Two types of land marks can be displayed, cross
section river stations or cross section descriptions. In addition to these two
variables, once one of the two are displayed, the user can select to edit the
land mark labels.

Plotting Velocity Distribution Output

The user has the option of plotting velocity distribution output from the cross
section viewer. Velocity distributions can only be plotted at locations in
which the user has specified that flow distribution output be calculated during
the computations. To view the velocity distribution plot, first bring up a cross
section plot (select "Cross Sections" from the view menu of the main HEC­
RAS window). Next, select the cross section in which you would like to see
the velocity distribution outpul. Select Velocity Distribution from the
Options menu of the cross section window. This will bring up a pop up
window (Figure 9.5) that will allow you to set the minimum velocity,
maximum velocity, and velocity increment for plotting. In general, it is better
to let the program use the maximum velocity range for plotting. Next, the
user selects Plot Velocity Distribution, then press the "OK" button and the
velocity distribution plot will appear as shown in Figure 9.6.
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For details on how to select the locations for computing the velocity
distribution, see Chapter 7 and 8 of the User's Manual. For infonnation on
how the velocity distribution is actually calculated, see Chapter 4 of the
Hydraulic Reference Manual.
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Figure 9.6 Velocity Distribution Plot
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Plotting Other Variables in Profile

To plot variables other than the water surface in profile, select General
Profile from the View menu oftbe main HEC-RAS window. Any variable
that is computed at a cross section can be displayed in profile. An example
would be to plot velocity versus distance. Other variables can be selected
from the Variables option under the Options menu of the plot. The user can
plot several different variable types at one time ( e.g., velocity and area versus
distance), but the scaling may not be appropriate when this is done. An
example of plotting other variables in profile is shown in Figure 9.7 .
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Figure 9.7 General Profile Plot of Variables Versus Distance

Plotting One Variable Versus Another

The rating curve plotting window has the ability to plot other variables
besides discharge versus water surface elevation. Any variable that is
computed at a cross section can be displayed against anolher computed
variable (or variables). An example of this capability is shown in Figure 9.8.
In this example, Discharge (x-axis) is being plotted against total flow area and
main channel flow area (y-axis).

9-8



Chapter 9 Viewing Results

To plot other variables, the user selects the X Axis Variable and Y Axis
Variable from the Options menu of the rating curve plotting window. When
selected variables to plot, keep in mind that all variables selected for a
particular axis should have a similar range in magnitude.
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Figure 9.8 Example of Plotting One Variable Against Other Variables

Sending Graphics to the Printer or Plotter

All of the graphical plots in HEC-RAS can be sent directly to a printer or
plotter. The printer or plotter used depends on what you currently have set as
the default printer or plotter in the Windows Print Manager. To send a
graphic to the printer or plotter, do the following:

1. Display the graphic of interest (cross section, profile, rating curve, X­
Y-Z, or river system schematic) onto the screen.

2. Using the available graphics options (scaling, labels, grid, etc.),
modify the plot to be exactly what you would like printed.

3. Select Print Current (or just Print on the profile plot) from the File
menu of the displayed graphic. When this option is selected, a pop up
window will appear allowing you to modify the default print options.
Change any desired options and press the Print button. The graphic will
be sent to the Windows Print Manager. The print manager will then send
the plot to the default printer or plotter.
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Note: The user can print multiple cross-sections at one time by using the
Print Multiple option from the File Menu of the cross section and rating
curve plots. This option also allows the user to establish how many cross
sections or rating curves they would like to have printed on each page.

Sending Graphics to the Windows Clipboard

All of the HEC-RAS graphics can be sent to the Windows Clipboard.
Passing a graphic to the clipboard allows that graphic to then be pasted into
another piece of software (i.e., a word processor or another graphics
program). To pass a graphic to the windows clipboard, and then to another
program, do the following:

1. Display the graphic of interest on the screen.

2. Using the options menu, modify the plot to be exactly what you want.

3. Select Copy to Clipboard from the File menu of the displayed
graphic. The plot will automatically be sent to the Windows
Clipboard.

4. Bring up the program that you want to paste the graphic into. Select
Paste from the Edit menu of the receiving program. Once the
graphic is pasted in, it can be re-sized to the desired dimensions.

HEC-RAS sends and displays all graphics in a Window's Meta file format.
Since Meta files are vector based graphics, the graphic can be resized without
causing the image to distort.

Stage and Flow Hydrographs

[f the user has performed an unsteady flow analysis, then stage and flow
hydrographs will be available for viewing. To view a stage and/or flow
hydrograph, the user selects Stage and Flow Hydrographs from the View
menu of the main HEC-RAS window. When this option is selected a plot
will appear as shown in Figure 9.9. The user has the option to plot just the
stage hydrograph, just the flow hydrograph, or both as shown in the figure.
Additionally, there are three tabs on the plot. The tabs are for plotting (Plot),
viewing the data in tabular fonn(Table), and plotting a rating curve of the
event (Rating Curve). By default the window comes up in a plotting mode.

The stage and flow hydrograph plot also has a menu option to select the
specific node types to be viewed. By default the plot comes up with a node
type of cross section selected. This allows the user to view hydrographs at
cross sections only. Other available node types include: Bridges/Culverts;
Inline Structures; Lateral Structures; Storage Areas; Storage Area
Connections; and Pump Stations.
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There are several options available for viewing this graphic. These options
are the same as described previously for the cross section, profile, and rating
curve plots. Additionally, this graphic can be sent to the windows clipboard,
or the printer, as described under the previous plots.

Additional output for the hydrograph plot includes statistics about the
hydrographs (peak, time to peak, and volume). Also, the user can
simultaneously plot observed hydrograph data at locations where they have
gaged information stored in a DSS file. The user attaches gaged hydrograph
information to cross section locations from the Unsteady Flow Data editor.

I!!Stage and Row Hydrog<aphs .-~

Ede Type Qptions t:!elp

R,ve, IBatd Eagle :::J~ I IPeak Slage
Tome

Reach'!LocHav :::J Rr,e,S'a 145805.37 :::J .!J.!JlpeakFIOW
hoe

r;7 Plot Stage ~ Plot Flow rObs St<3ge rObs Flow r Use Ref Stage Volume

Stage Flow 1 Table 1 Rat~1q Curve 1

=574 06(11)
=21 Febl999 0200
·3835735 (cis)
=20Febl999 1800
=218452.83Iac,o·ll)

:Slage

Flow

legend
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Figure 9.9 Stage and Flow Hydrograph Plot

X-Y-Z Perspective Plots

Another type of graphic available to the user is the X-Y-Z Perspective PloL
The X-Y-Z plot is a 3-dimensional plot of multiple cross sections within a
reach. An example X- Y-Z Perspective plot is shown in Figure 9.10.
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I X-V-Z Perspective Plot ., .

File Options

::J[!][!] ~ Jjf-
~.:JRlvel Sta Start· 112 "

River St•. End. 11 ::J Rotation Angle rz-.-l
AZimuth Angle rs-.:J

Critical Creek· Example 't Plan: Modified Geometry Conditions
Geom: Base Geometry Data + rrterpolated Flow: 100 Year Profile - Up and Down Bndry

.J

Figure 9.9 Example X-Y-Z Perspective Plot

Legend
i i

WS100yr

Ground.
Bank Sta

Ground

The user has the ability to select which reaches to be plotted, the range of the
river stations, and which plans and profiles to be displayed. The plot can be
rotated left and right, as well as up and down, in order to get different
perspectives of the river system. Zoom in and zoom out features are
available, as well as the ability to move around with scroll bars, The user can
choose to overlay the water surface or not. The user has the ability to overlay
a grid on the plot, as well as a legend and labels at the top. The graphic can
be sent to the printer/plotter or the clipboard just like any other plot. Sending
the graphic to the printer or clipboard is accomplished by selecting the Print
or Clipboard options from the File menu, The user also has the option to
reverse the order in which the water surface profiles are displayed. This
option allows the user to display the higher water surfaces first, such that the
lower profiles are not covered lip.

9-12



Chaoter 9 Viewjng Results

Tabular Output

Summary tables of the detailed water surface profile computations are often
necessary to analyze and document simulation results. Tabular oulput allows
the user to display large amounts of detailed information in a concise format.
HEC-RAS has two basic types of tabular output, detailed output tables and
profile summary tables.

Detailed Output Tables

Detailed output tables show hydraulic information at a single location, for a
single profile. To display a detailed output table on the screen, select
Detailed Output Table from the View menu of the main HEC-RAS window.
An example detailed output table is shown in Figure 9.10.

~ (ross Section Output .' .

E~e !ype Qptions tlelp

River ICritical Cr.

Reach: IUpper Reach

3 PlOlie. 1100 yl 3
3 AS 1"",,12c---3 -±J!J Plan: IModifIed Geo 3

". - . .'. Plan: Modified Geo Critical Cr U '" Reach AS' 12 p,ofae 100 I " ''".' '>1:

E.G. Elev (II) 181602 Element Left 08 Channel Right 08
Vel Head (ItI 0.48 WI. n.\!al. 0.100 0.040 0.100
W.S. Elev (It) 1815.54 Aeach Len. (II) 100.00 100.00 100.00
C,'W.S (It) 181446 Fk>w Area (sq II) 247462 342.54 17799
E G. Slope lltlftl 0.004561 A,ealsq III 247462 342.54 17799
QTolal (els) 9000.00 Flow (els) 5748.97 3067.32 183. 71
Top Widlh [ft] 91534 Top Widlh (ItI 699.72 45.00 170.62
Vel Total (fth) 3.00 Avg Vel. (III,) 232 8.95 1.03
Max Chi Dpth 1ft) 11.94 Hydr. Depth lit) 3.54 7.61 104
Cony. Totallels) 133261.3 Cony. (cis) 85123.8 45417.2 2720.2
Length ·v/td. (II) 100.00 Welled Per. (II) 70257 50.80 170.65
Min Ch EI (II) 1803.60 Sheal (Iblsq II) ............. 100: 192 0.30

Alph., 3.41 Sheam Power (Ib/ft s) 2 ~..... 17.19 0.31..,).,)

F,cln Loss [ft) 0.54 Cum VohJme (acre·ftl 21733 42.91 10.42
CH Loss (It) 0.04 Cum SA (acles) 79.70 6.44 7.93

. .~

Shear stress in left overbank.

Figure 9.10 Example Cross Section Detailed Output Table

By default, this table comes lip displaying detailed oulput for cross sections.
Any cross seclion can be displayed in the table by selecting the appropriate
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river, reach and river station from the list boxes at the top of the table. Also,
any of the computed profiles can be displayed by selecting the desired profile
from the profile list box. Additionally, different plans can be viewed by
selecting a plan from the plan list box.

Users can also view detailed hydraulic information for other types of nodes.
Other table types are selected from the Type menu on the detailed output
table window. The following types are available in addition to the normal
cross section table (which is the default):

Culvert. The culvert table type brings up detailed culvert information. This
table can be selected for normal culverts, or for culverts that are part of a
multiple opening river crossing. An example culvert specific table is shown
in Figure 9.12.

ECulvert Output . 1:
E~e lype Qptions tjelp

River: jSpring Creek

Reach. jCuJvrt Reach

4:]Profile·150yr 3lCulvGroup: Culvert"' <::]
::oJ RS 1"'20""'.2C:C37::---::oJ -!J-!J Plan IBase Plan -=:J

''''Plan Base Plan' S rin Creek>' CulvrtReach RS 20237 CulvGro Culvert II 1 Profile' 50 r'<

Culv Q (cis) 972.24 Culv Full Len (II) 50.00

" Barrels 1 Culv Vel US (Ills) 6.98
Q Ba"el (cis) 972.24 Culv Vel OS (1I/sl 6.98
E.G. US. (Ill 34.10 Culv In,. EI Up {Ill 25.10
VIS US. (II) 34.03 Culv In" EI On (III 2500
E.G OS (III 33.06 Culv Fretn Ls {ItI 0.06
VIS OS (II) 32.90 Culv E,;t Loss (II) 0.58
OeUa EG (III 1.03 Culv Entr Loss (II) 0.38
Delra VIS (II) 1.13 Q\.\feir Iefs)

.........
?'Lt~...•..~~......... ..........• ......•

E.G.IC{II) 30.85 We. Sta Lltlfll 959.77
E.G. DC Ill) 34.10 We, Sta Rgt (ItI 104061
Culvelt Conllal Outlet We~ Submelg 0.00
Culv WS Inlet {III 31.10 We, Ma:< Depth (II) 0.40
CulvWS Dullet (III 31.00 We, Avg Depth (U) 0.25
Culv Nrnl Depth (II) Wr Flw Alea Isq III 20.40
Cui'; Crt Depth (II) 332 MIn El Weir Flow {tt} 3371

..•" Errors, Warrun and Notes

Duri-tg the cul.....ert inlet computations, the program could not balance the culvert/weir flow.
The reported inlet enerw grade answer may not be valid.

Flow over the weir.

Figure 9.12 Example Culvert Type of Cross Section Table

Bridge. The bridge table type brings up detailed output for the cross sections
inside the bridge as well as just upstream of the bridge. The bridge table type
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can be selected for normal bridge crossings, or for bridges that are part of a
multiple opening river crossing. An example of the bridge specific cross
section table is shown in Figure 9.13.

~ Bridge Output .
File Type Options Help

River IButte Creek

Reach IT ributary

3 Profile: !50yr 3 Opening ISlngleBR

3 Riv Sta 17":0.2-=--2--3 [!][!]
" . Plan lan2 ~ Butte C.eek Tribular AS' 022 ; Profil8: 50 0 rm S' BA
E.G. US. (ItI ..__..- ,._.._.. ~2.~~ .. Element Inside BR US I Ins,de BR DS
'lis. US. (II) 82.76 E.G. Elev (ItI 82.89 8287
oTolal (cis) SOO.OO 'liS Elev(ltl 82.76 8258
oB,idge (cisl 33754 Crrl '11.5. (ttl 76.73 76.73
oWei, (cis) 162.46 Max Chi Dplh (ttl 12.76 12.58
Wei Sta LIt (ItI 21889 Vel Tolal (Itlsi 4.12 4.65
Wei Sla RgI (It) 29864 Flow A,ea (sq Itl 121.28 107.48
\A/eir Submerg 0.27 Froude nChi 0.08 009
Wei, Max Depth (It) 0.89 Specif Force [eu ft) 577.68 566.92
Min Wei, EI (ItI 82.01 Hl,d, Deplh (III 1.55 142
Min EI Prs (It) 7900 WP. Tolal (It) 13085 12831
Delta EG (It) 0.47 CCirW. Total [cfs)
DeltaWS (Ii) 0.51 Top Widlh (Ii) 7801 7554
SR OpenA,ea (sq iii 6566 Frein Loss (It)
SR Open Vel (li/s) 5.14 C&E Loss (Ii)
Coel 01 0 Shea, Total (Iblsq II)
S, Sel Melhod Press/v/eir Powe, Tolal (Ibltt s)

!!S">:-;;,~ ..' ~t) .IW: -;'i.f~)~~.~<: EnOfs. Wamin and Notes '". . "

Hote Yarnell answer is not valid t the water surface is above the lOIN chord or If there is weir How ....

The Yarnell answer ha-~ been dIsregarded.
Momentum answer IS not valid if trte water surface is above the low chord or If there IS weir
flow The momentum answer has been disregarded.
The downstream water surface is above the minimum elevation for pressure flow. The ..,1
lirificp. p.nll?lth,n!:: WAIP. IJ<:.P.r1 !n, nrp<';~IJrp. flli"'_' -.:..I

EnerQ}' grade elevation at budge or culvert [final answer}

Figure 9.13 Example Bridge Type of Cross Section Table

Multiple Opening. The multiple opening type of table is a combination of
the cross section table and the bridge and culvert tables. That is, if the user
has defined multiple opening (bridges, culverts, and conveyance areas), then
this table can be used to view the hydraulic results for each specific opening.

lnline Structure. The Inline Structure type of table can be used to view
detailed output for any inline weirs and/or gated spillways that have been
entered by the user.

Lateral Structure. The Lateral Structure type of lable can be used for
viewing detailed oulput from a lateral weir, gated spillway, culvert, and rating
curves.
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Storage Area. This table provides output about an individual storage area.
lnfonnation includes water surface elevation, total inflow, total outflow, and
net inflow.

Storage Area Connection. This table provides detailed information about
storage area connections. Storage area connections can consist of weirs,
gated spillways, and culverts.

Pump Stations. This table provides detailed infonnation about pump
stations. Pump station output includes to and from water surface elevations,
total flow, flow through each pump group, flow through each pump, head
difference, and efficiency.

Flow Distribution In Cross Sections. The Flow Distribution table type can
be used to view the computed flow distribution output at any cross section
where this type of output was requested. An example of the flow distribution
table output is shown in Figure 9.14.

, I

File Type OptIon.. Help

River: ICritical Cr.

Reach [Uppef Reach

:::J PlOlile 1100 y' :::J

:::J Riv 51.: j"i2:----:::J [!]oo
. "".:0;'; Plan: ModihedGeo C"ticalCr "U ',Reach R5:12 Profile: 100 I '~""<>'•.~f.K

Left St. Right Sta Flow Area Hydr D. Velocity A

1ft) [III Ids) [sq It) 1ft) lftis)
000 7200 ~~~~Q: 150.01 3.32 2.90 1.99

72.00 144.00 912.27 333.48 72.08 10.14 4.63 2.74
144.00 21600 804.58 309.20 7205 894 4.29 260
21£.00 28800 326.78 181.00 7297 363 2.51 1.81
28800 360.00 585.69 257.11 73.14 6.51 357 2.23
360.00 43200 755.81 297.79 72.03 8.40 4.14 2.54
432.00 504.00 603.51 26015 7201 6.71 3.61 2.32
50400 57600 498.87 23205 7200 5.54 3.22 2.15
576.00 64800 557.22 247.99 7201 6.19 3.44 2.25
648.00 720.00 404.78 204.82 72.10 450 2.84 1.98

LB 720.00 724.50 46.34 12.43 567 0.51 2.76 3.73
724.50 TL9.00 179.78 28.47 5.89 2.00 6.33 6.31
729.00 733.50 403.52 44.07 5.22 4.48 9.79 9.16~

Errors. Warnln s and Notes

Flow in subsection dehned by left ~nd right st3tions

Figure 9.14 Example of the Flow Distribution Type of Table
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At the bottom of each of the detailed output tables are two text boxes for
displaying messages. The bottom text box is used to display the definition of
the variables listed in the table. When the user presses the left mouse button
over any data field, the description for that field is displayed in the bottom
text box. The other text box is used to display any Errors, Warnings, and
Notes that may have occurred during the computations for the displayed cross
section.

Detailed Output Table Options

Plans. This option allows the user to select which plan, and therefore output
file, they would like to view. This option is available from a list box at the
upper right hand side of the window.

Under the Options menu of the cross section table window, the user has the
following options:

Include Interpolated XS's. This option allows the user to either view
interpolated cross-section output or not. Turning the "include interpolated
XS's" option on (which is the default), allows interpolated sections to be
selected from the river station box. Turning this option off gets rid of all the
interpolated sections from the river station selection box, and only the user
entered cross-sections are displayed.

Include Errors, Warnings, and Notes in Printout. This option allows the
user to have the errors, warnings, and notes information printed below the
table, when the option to print the table is selected.

Units System For Viewing. This option allows the user to view the output in
either English or Metric units. It does not matter whether the input data is in
English or Metric, the output can be viewed in either system.

Profile Summary Tables

Profile summary tables are used to show a limited number of hydraulic
variables for several cross sections. To display a profile summary table on
the screen, select Profile Summary Table from the View menu of the main
HEC-RAS window. An example profile summary table is shown in Figure
9.15.
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~Proftle Output Table - Standard Table 1

File Options Std. Tables Help

Reach Rr(t'l Sta aT",,,
IclsJ

MnChEI WS Elev C,'WS E.G E~v E.G S~pe

1"1 1"1 tt) I"} 1M')
VelCW

I"hl

Reload Dala I
FlowAJea TopWidth Floude *# ru ...

1"1 f1) {"I
Upper Reach
Uppel Reach
UPpel Reach
UPPel Reach
Uppel Reach
UPpei Reach
UPPeI Reach
UPPeI Reach
Uppel'Reach

12
11 B"
116'
11 4'
11.2'
11

10 /5'
105"
1025'

9JJO.1Xl
9000.00
9000.00
900100
9000.00
9000.00
9000.00
9000.00
3000.00

1803.60 1815.54 1814.46 1816.02 0.004567
180302 181458 181414 1815.44 0.1ffil43
1802.44 181340 181340 1814.67 OOOB3B6
1801.86 1812.43 181247 1813.82 0008533
1801.28 1811.29 181146 1812.89 0.00$21
1BOO. 70 1810 68 1810 42 1811.90 0.007043
1799.13 180951 180951 1810.91 0008530
179755 180793 1808.34 1809.61 0012265
1795.97 180590 180641 180769 0019512

8.96
10.78
1214
1225
12-73
11.20
1222
13.89
15.59

2993.81 915.30
2403 45 81751
2043.65 764.50
189UI8 698 93
1701.14 64620
11388.44 651.48
1854.70 699.37
1866.64 830.45
1795 08 857.69

0.57
0.89
080
081
0.86
075
082
0.96
1.16 •

Tolal flow In cro,;s SectIOn
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Figure 9.15 Example Profile Table

There are several standard table (Std. Tables) types available to the user.
Some of the tables are designed to provide specific information at hydraulic
structures (e.g., bridges and culverts), while others provide generic
information at all cross sections. The standard table types available to the
user are:

Standard Table I. The is the default profile type of table. This table gives
you a summary of some of the key output variables.

Standard Table 2. This is the second of the standard summary tables. This
table provides information on the distribution of flow between the left
overbank, main channel, and right overbank. This table also shows the
friction losses, as well as contraction and expansion losses that occurred
between each section. Energy losses displayed at a particular cross section
are for the losses that occurred between that section and the next section
downstream.

Four XS Culvert. This standard table provides summary results for the four
cross sections around each of the culverts in the modeL The four cross
sections are the two immediately downstream and the two immediately
upstream of the culvert. This table will list all of the culverts in the model for
the selected reaches.

Culvert Only. This standard table provides hydraulic information about the
culvert, as well as the inlet control and outlet control computations that were
performed.

Six XS Bridge. This table provides summary results for the six cross
sections that make up the transition of flow around a bridge. The six cross
sections include the two cross sections just downstream of the bridge; the two
cross sections inside of the bridge; and the two cross sections just upstream of
the bridge. The program will display results for all the bridges in the model
within the selected reaches. When viewing this table, on occasion there will
be no displayed results for the cross sections inside of the bridge. This occurs
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only when the user has selected a bridge modeling approach that does not
compute results inside of the bridge. This includes: Yarnell's method; both
pressure flow equations; and pressure and weir flow solutions.

Bridge Only. The bridge only table shows summary information specifically
for bridges.

Bridge Comparison. The bridge comparison table shows the results for all
of the user selected bridge modeling approaches that were computed during
the computations. For example, the program can calculate low flow bridge
hydraulics by four different methods. The resulting upstream energy for the
user selected methods will be displayed in this table.

Multiple Opening. This table shows a limited number of output variables for
each opening of a multiple opening river crossing.

Four XS Inline Struetnre. This table displays summary results of the four
cross sections immediately around an inline weir and/or gated spillway. The
four cross sections are the two immediately upstream and the two
immediately downstream of the inline weir and/or gated spillway.

lnline Structure Only. This table shows the final c0l11puted water surface
and energy just upstream of each of the inline weir and/or gated spillways. In
addition to these elevations, the table displays the total flow, the flow over the
weir, and the total flow through all of the gates.

Lateral Structure. This table shows a limited set of output variables for all
of the lateral weir/spillway structures within the selected reaches.

Encroachment I, 2, and 3. These three standard tables provide various
types of output for the computations of flood way encroachments.

HEC-FDA. This table provides information that can be exported to the HEC
Flood Damage Analysis (FDA) program. The table displays total flow,
channel invert elevation, and water surface elevation.

HEC-SQ. This table provides information that can be exported to the HEC­
5Q (river and reservoir water quality analysis) program. The table displays
only the specific parameters required by the HEC-5Q program.

lee Cover. This table shows summary output of ice information. This table
was designed for performing a study that includes ice cover.

Junctions. This summary table provides a limited set of output for all of the
cross sections that bound a junction. This table will show this output for all
of the junctions found in the model.

Storage Areas. This table shows a limited amount of output for all of the
storage areas in the model. Output includes: water surface elevation;
minimum storage area elevation; surface area; and volume.
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Pump Stations. This table shows a limited amount of output for any of the
pump stations contained within the model.

To view one of the types of tables, select the desired table type from the Std.
Tables menu on the profile summary table. in addition to the various types
of profile tables, the user can specify which plans, profiles and reaches to
include in the table. The plans, profiles and reaches options are available
from the Options menu on the profile plot.

The user also has the ability to turn the viewing of interpolated cross sections
on or off. The default is to view all cross-sections, including the interpolated
ones. To prevent the interpolated sections from showing up in the table, de­
select Include Interpolated XS's from the Options menu.

Another feature available to users is tbe ability to set the number of decimal
places that will be displayed for any variable of the pre-defined tables. Once
a pre-defmed table is selected from the Tables menu, select Standard Table
# Dec Places from the Options menu. A window will appear displaying the
current number of decimal places for each variable. The user can change the
number of decimal places to what ever they wish.

User's also have the ability to view profile output tables in either English or
metric units. This is available from the Options menu 011 the profile tables.
It does not matter whether the input data is in English or metric, the output
can be viewed in either system.

User Defined Output Tables

A special feature of the profile summary tables is the ability for users to
define their own output tables. User defined output tables are available by
selecting Define Table from the Options menu of the profile table. When
this option is selected, a window will appear, as shown in Figure 9.16. At the
top of the window is a table for the user selected variable headings (Table
Column Headings), the units, and the number of decimal places to be
displayed for each variable. Below this table is a table containing all of the
available variables that can be included in your user-defined table. The
variables are listed in alphabetical order. Below the list of variables is a
message box that is used to display the definition of the selected variable.

To get a definition of a particular variable, simply click the left mouse button
once while the mouse pointer is over the desired variable. The description of
the variable will show up at the bottom of the window. To add variables to
the column headings, simply double click the left mouse button while the
mouse pointer is over the desired variable. The variable will be placed in the
active field of the table column headings. To select a specific column to
place a variable in, click the left mouse button once while the mouse pointer
is over the desired table column field. To delete a variable from the table
headings, double click the left mouse button while the mouse pointer is over
the variable that you want to delete. The number of decimal places for each
variable can be changed by simply typing in a new value.
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User defined tables are limited to 15 variables. Once you have selected all of
the variables that you want, press the OK button at the bottom of the window.
The profile table will automatically be updated to display the new table.

Create a Table Heading ~ q,

Select Variables 1 Additional Ootions I
"', .... r'" ....'... • .' Table Column Headin -

Column . 2 3 4 5
E.G. Elev

(llJ
2
~

Clear All Table Headings I

Cfit \1./.5.
{Iii

2

\I/.S. Elev
(III
2

Inserl Cob.Jrnn

Min Ch EI
(ItJ
2

QTolal
(efs)

2
Units
Variable

~alPls

Delete ColtMnn

Perc Q LeavinQ
ower Chan

PO....·Jer LOB
Power ROB
Power ToI.a1
Plol Oella EG

Plol Delta WS
Profile
PIS 0 EG
PIS 0 WS
PIS/....\/r EG
PISNlrWS

Q Barrel
oBridge
Q Channel
Q DS
QLeaving Tolal
oLell

CI Pelc Chan
Q Perc L
oPelc R
Q Right
Q Tolal
QUS

QWei,
R. Freeboard
R Levee Frbld
Rghl Sta Eff
ROB Elev
SAP.lea

Tola! stream pcll....,ter in m·:iln channel.

OK Cancel Help

Figure 9.16 User Defined Tables Window

Once you have the table displayed in the profile table window, you can save
the table headings for future use. To save a table heading, select Save Table
from the Options menu on the profile table window. When this option is
selected, a pop up window will appear, prompting you to enter a name for the
table. Once you enter the name, press the OK button at the bottom of the pop
up window. The table name will then be added to a list of tables included
under the User Tables menu on the profile table window. To delete a table
from the list of user defined tables, select Remove Table from the Options
menu of the profile table window. When this option is selected, a pop up
window will appear displaying a list of all the user-defined tables. Click the
left mouse button over the tables that you want to delete, then press the OK
button. The selected tables will then be deleted from the User Tables menu
list.

Sending Tables to the Printer

To send a table to the printer, do the following:

I. Bring up the desired table from the tabular output (cross section or
profile tables) section of the program.
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2. Select Print from the File menu of the displayed table. When this
option is selected, a pop up window will appear allowing you to
modify the default print options. Once you have set the printer with
the desired options, press the Print button. The table will be sent to
the Windows Print Manager. The Windows Print Manager will
control the printing of the table.

The profile summary type of tables, allow you to print a specific portion of
the table, rather than the entire table. If you desire to only print a portion of
the table, do the following:

I. Display the desired profile type table on the screen.

2. Using the mouse, press down on the left mouse bulton and highlight
the area of the table that you would like to print. To get an entire row
or column, press down on the left mouse button while moving the
pointer across the desired row or column headings.

3. Select Printer from the File menu of the displayed table. Only the
highlighted portion of the table and the row and column headings will
be sent to the Windows Print Manager.

Sending Tables to the Windows Clipboard

To pass a table to the Windows Clipboard, and then to another program, do
the following:

I. Display the desired table on the screen.

2. Select Copy to Clipboard from the File menu of the displayed table.

3. Bring up the program that you want to pass the table into. Select
Paste from the Edit menu of the receiving program.

Portions of the profile tables can be sent to the Clipboard in the same manner
as sending them to the printer.

Viewing Results From the River System Schematic

The user has the option of either bringing up graphics and tables from the
View menu on the main HEC-RAS window (as discussed above), or from the
river system schematic (found under geometric data). Once data have been
entered, and a successful simulation has been made, the user can interact with
the river system schematic. When the left mouse button is pressed over the
river system schematic, a pop up menu will appear listing options that are
relevant to the area of the schematic that is located under the mouse pointer.
An example of this is shown in Figure 9.17.
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In Figure 9.17, the pop up menu shown comes up whenever the user presses
the left mouse bunon over a cross section. In this particular example, Ihe
mouse bulton was pressed over the cross section localed at river slalion 10.0
of the Upper reach of Fall river. As shown in the menu, the user has Ihe
choice of editing the cross section data; plaiting Ihe cross section; plotting the
profile for the reach containing Ihis cross section; bringing up the XYZ plot
for that reach; viewing tabular output; plotting the computed rating curve at
this cross section; or viewing a picture of the location. Olher pop up menus
are available for bridges; culverts; junctions; and reach data.
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Viewing Ice Information

River ice information can be viewed both in a graphical and tabular format.

Viewing Graphical Ice Information on the Screen

To view graphical ice information on the screen, select either Cross Sections,
Profiles, or X-Y-Z Perspective Plot from the View menu on the HEC-RAS
main window.

Cross Section Plot. Figure 9.18 is an example cross section plot displaying
ice. The ice cover is displayed by selecting Variables under the Options
menu, then selecting the Ice Cover option. The ice thicknesses in the right
overbank, main channel, and left overbank are displayed. The default color
and fiJi pattern can be changed by the user by selecting Lines and Symbols
under the Options menu. Note that multiple profiles and multiple plans can
be displayed on the same plot.
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Figure 9.18 Cross section Plol with ice

Profiles Plot. An example of a profile plot with ice is shown in Figure 9. J9.
In this case, the WS-EG Prolile was selected. As with the Cross Section plot,
the ice cover is displayed by selecting Variables under the Options menu,
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then selecting the lee Cover option. The ice thicknesses in the right
overbank, main channel, and left overbank are displayed. The default color
and fill pattern can be changed by the user by selecting Lines and Symbols
under the Options menu. Note that multiple profiles and multiple plans can be
displayed on the same plot.
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Figure 9.19 Profile plot witb ice cover

Ice information can also be displayed in profile plots by selecting the
General Profile option and then selecting Variables under the Options
menu. This provides a number of ice variables, including ice volume in the
channel, left, and right overbanks; ice thickness in the channel, left, and right
overbanks; top of ice elevation in the channel, left, and right overbanks; and
bottom of ice elevations in the channel, left, and right overbanks. These plots
can all be viewed in different widow sizes and printed.

x-Y-Z Perspective Plot. As with the Cross Section plot, the ice cover is
displayed by selecting Variables under the Options menu, then selecting the
lee Cover option. The ice thicknesses in the right overbank, main channel,
and left overbank are displayed. The default color and fill pattern can be
changed by the user by selecting Lines and Symbols under the Options
menu.
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Viewing Tabular Ice Information

Tabular information describing the results of the ice calculations can be
displayed by selecting Profile Summary Table under the View menu on the
HEC-RAS main window. Ice information is available directly by selecting the
Ice Cover option under the Std. Tables menu of the Profile Table window. Tbe
Ice Cover option provides a table that includes the ice volume. ice thickness, and
composite Manning's n value for the main channel, left overbank, and right
overbank. In addition, the lee Cover Table includes the water surface elevation
and the cumulative ice volume starting from the downstream end of the channel.
An example table of ice information is shown in Figure 9.20. Tables of ice
information can also be created using the Define Table option under the Options
menu of the Profile Table window.
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Figure 9.20 Ice Cover Table

Viewing Data Contained in an HEC-DSS File

The HEC-RAS software can write and read data to and from the HEC-DSS
(Data Storage System) database. The steady flow portion of HEC-RAS can
read flow data to be used as profile information, and can write water surface
profiles, storage-outflow information, and rating curves. The unsteady flow
portion of HEC-RAS can read complete hydrographs (stage and flow), as
well as gate settings to be used during a simulation. Observed data contained
in a DSS file can be attached to specific cross sections for comparison with
computed results at those locations, and computed profiles and hydrographs
are written to the DSS file during an unsteady flow simulation.
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Because a DSS file can be used to share information between different HEC
programs (such as HEC-HMS and HEC-RAS), it is often necessary to be able
to view data contained within a DSS file. A DSS viewer is available from
within the HEC-RAS software. To bring up the DSS viewer select DSS Data
from the View menu of the main HEC-RAS window (Or press the button
labeled DSS on the main window). When this option is selected a window
will appear as shown in Figure 9.21.
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Figure 9.21 HEC-DSS Viewer Window

As shown in Figure 9.21, the user selecrs a DSS file by pressing the open file
button located next to the DSS Filename field. When a DSS file is selected, a
list of the available pathnames within that file will show up in the table. Each
DSS pathname represents a record of data stored within the DSS file. The
user can select one or more DSS pathnames to be plotted and/or tabulated. A
pathname is selected by using the left mouse button to select a row(s) in the
table, then the button labeled Select highlighted DSS Pathnames is pressed
and the pathname shows up in the lower box. The final step is to hit the
Plot/Tabulate Selected Pathnames button, and the data will be plotted. An
example plot is shown in Figure 9.22.

As shown in Figure 9.22 there are two tabs on the window. one says Plot and
the other says Table. By default the window comes up plotting the data. To
view the data as a table, simply press the table tab.
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Figure 9.22 Example Plot From The HEC-RAS DSS Viewer

Data can be viewed from one or more DSS files simultaneously. The user
simple opens one DSS file and picks the desired pathnames, then opens
another DSS file and selects additional pathnames. When the Plot/Tabulate
button is pressed, the data from both DSS files will be plotted and/or
tabulated.

A rew utilities are also available from the DSS viewer. These utilities
include: Time Series Importer; Delete Selected Pathnames; and Squeeze the
DSS file. The time series importer allows the user to enter regular interval
time series data into a table, which can then be imported into a DSS file. To
use this option select Time Series Import from the Utilities menu of the DSS
Data Viewer. When this option is selected a window will appear as shown in
Figure 9.23.
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.. .I.
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Figure 9.23 DSS Time Series Data Import Utility

As shown in Figure 9.23, the user first selects a DSS file to import data into.
Next a DSS Pathname must be entered for the data to be written to the DSS
file. The pathname parts are separated with a "/" between each pathname
part. Some parts can be left blank, but the Band C part must be entered at a
minimum. Next the user enters the date and time of the first data point, as
wen as the interval of the data (the interval is selected from the available DSS
intervals). Next the data units and data type are selected from the drop down
lists. If the lists do not contain the units of your data you can enter them
directly into the field. The data is then entered into the table at the bottom.
You can cut and paste infonnation into this table, using the standard windows
keys of Ctrl-C for cut, and Ctr!- V for paste. There are buttons available to
perform the fonowing tasks: set the number of rows in the table (the default is
99); linearly interpolate missing values; delete a row; insert a row; add a
constant to a highlighted section of the table; multiply the highlighted section
by a factor; and set a highlighted section to a specific value.

The utility labeled Delete Selected Paths is used to delete data from the DSS
file. The user simply selects the pathnames they want to delete, then selects
this option from the Utilities menu. A window win appear to asking if yOll
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are sure you want to delete the selected pathnames. If you answer OK, then
the data will be deleted from the DSS file.

The utility labeled Squeeze DSS File is used to compress the DSS file, such
that it takes significantly less hard disk space. This is a convenient function if
you are working with very large DSS files. To use this option just select
Squeeze DSS File from the Utilities menu. A window will come up asking
you if you want to squeeze the currently opened DSS file. If you answer OK
then the file will be compressed.

Exporting Results To HEC-DSS

The HEC-RAS software has the ability to export a limited set of results to a
HEC-DSS file for both steady and unsteady flow simulations. When
performing an Unsteady flow simulation, the program automatically writes
stage and flow hydrographs to the DSS file, but only for the user-selected
hydrograph output locations. Water surface profiles are also automatically
written to the DSS file. The profiles are written for the user selected detailed
output interval, as well as the overall maximum water surface profile (profile
of the maximum stage at every cross section).

Once a steady flow or unsteady flow simulation is performed, the user can
write the following information to a DSS file: water surface profiles;
computed rating curves; and storage-outflow information. To export
computed results to a DSS file the user selects Export To HEC-DSS from
the File menu of the main HEC-RAS window. When this option is selected a
window will appear as shown in Figure 9.24.
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Select Reaches to ExportPlOfiles

I
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DSS Filename IC:\HEC\Ras30\MissOhioRiv\MissOhioRiv.dss

P,ofiles 1 Ratino Curves 1 Siolaoe Ou/f1ow I
Output Options

P Export V·/ater Surface Profiles and Channel Invert
r Export Flow Profiles

Prof~es and Locations
Select Profiles to E:-;port

EKporting To D55 .- -,

Aeach stalling station: Iin feet starting at lowest rivel station (assuming rivel station is in feet) :::J
E>:port Profile Data I

OK Cancel I

Figure 9.24 Export Computed Results to DSS Window
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As shown in Figure 9.24, there are three tabs on the window; one for profiles,
rating curves, and storage outflow. To export computed water surface
profiles, select the Profiles tab from the window. Select the type of profiles
that you want to export (water surface elevations or flow). Next select the
specific profiles to be exported, as wel1 as the reaches that you want to have
profiles for. Select how you want the stationing to be labeled. This is
accomplished by selecting one of the options under the field labeled Reach
Starting Station. The user can have the river stationing labeled in feet or
miles, and have it start at zero or whatever the magnitude is of the most
downstream cross section. The final option is to press the Export Profile
Data button, and the data will then be written to the DSS file.

To write computed rating curves to the DSS file select the Rating Curve tab.
When the rating curve tab is selected, the window wil1 change to what is
shown in Figure 9.25.

Exporting To D55 . .:;.

DSS Filename: 1C:\HEC\RasJO\MissOh<>Riv\MissOhioRiv.dss Bfowse I

Profiles Rating Curves 1StQraae Olliflow I
Selected Locations for rating curves (2 selected)

River: rOhio Rivel

Reach: IMain Stern

3 OhiQ River Main Stem 0.9
Ohio Ri··...er r.,·lain Stern 10

::J
RIver Sta 12

11 Q

~9'--.--l dJ
B
7 ~

r Sort flm....'s in lating curves

Export Rating Curves

OK Cancel I

Figure 9.25 Exporting Computed Rating Curves to HEC-DSS

As shown in Figure 9.25, to export a computed rating curve to DSS, select the
river, reach, and river stations that you want to have exported to the DSS file.
Then simply press the Export Rating Curves button to have the program
write the data to the DSS file. If your profiles are not in the order from
lowest flow to highest flow, turn on the option that says Sort flows in raling
curve. This option will ensure that the curve is written in the order of
increasing flow rate.

The HEC-RAS program computes cumulative storage volumes for each of
the water surface profiles. This information can be used for hydrologic
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routing in a hydrology model such as HEC-HMS or HEC-I. The HEC-RAS
program allows the user to write out storage versus volume information to a
DSS file. To use this option select the Storage Outflow tab from the Export
to DSS window. When this option is selected a window will appear as shown
in Figure 9.26.
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DSS Filename: IC:\HEC\Ra,3O\MissOhioRiv\MissOhi"Riv.d,s
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)owos:tream React DowtlttJeam RS

Upper 26.7

Upper 0

Main Stem 0

4

5

6

Export Volume OLllflow Dala

OK

~

I
Cancel I

Figure 9.26 Exporting Storage-OutOow Information to I-IEC-DSS

As shown in Figure 9.26, the user selects the River, upstream reach, upstream
river station, downstream reach, and downstream river station to completely
define a routing reach in which they want to have storage-outflow
infonnation written to the DSS file. This can be dooe for as many reaches as
you want within the model. After all of the reaches are defined, simply press
the button labeled Export Volume Outflow Data to write the information to
the DSS file.
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Chapter 10 Performing a Floodwav Encroachment Analysis

CHAPTER 10

Performing a Floodplain Encroachment
Analysis

The evaluation of the impact of floodplain encroachments on water surface
profiles can be of substantial interest to planners, land developers, and
engineers. Floodplain and flood way evaluations are the basis for floodplain
management programs. Most of the studies are conducted under the National
Flood Insurance Program and follow the procedures in the "Flood Insurance
Study Guidelines and Specifications for Study Contractors," FEMA 37
(Federal Emergency Management Agency, 11085).

FEMA 37 defines a floodway "...as tbe channel of a river or other
watercourse and the adjacent land areas that must be reserved in order to
discharge the base flood without cumulatively increasing the water-surface
elevation by more than a designated height" Nonnally, the base flood is the
one-percent chance event (IOO-year recurrence interval), and the designated
height is one foot, unless the state has established a more stringent regulation
for maximum rise. The floodway is usually determined by an encroachment
analysis, using an equal loss of conveyance on opposite sides of the stream.
For purposes of floodway analysis, the floodplain fringe removed by the
encroachments is assumed to be completely blocked.

HEC-RAS contains five optional methods for specifying floodplain
encroachments. For information on the computational details of each of the
five encroachment methods, as well as special considerations for
encroachments at bridges, culverts, and multiple openings, see Chapter 10 of
the HEC-RAS hydraulics reference maoual. This chapter describes how to
enter floodplain encroachment data, how to perform the encroaclunent
calculations, viewing the floodplain encroachment results, and how to
perform a floodplain encroachment analysis within the unsteady flow
computations module.

Contents

• General

• Entering Floodplain Encroachment Data

• Performing the Floodplain Encroachment Analysis

• Viewing the Floodplain Encroachment Results

• Floodplain Encroachments With Unsteady Flow
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General

The HEC-RAS floodplain encroachment procedure is based on calculating a
natural profile (existing conditions geometry) as the first profile in a multiple
profile run. Other profiles, in a run, are calculated using various
encroachment options, as desired. Before performing an encroachment
analysis, the user should have developed a model of the existing river system.
This model should be calibrated to the fullest extent that is possible.
Verification that the model is adequately modeling the river system is an
extremely important step before attempting to perform an encroachment
analysis.

Currently, the HEC-RAS steady flow program has 5 methods to determine
floodplain encroachments. These methods are:

Method 1 ­
Method 2­
Method 3 ­
Method 4­
Method 5 -

User enters right and left encroachment stations
User enters fixed top width
User specifies the percent reduction in conveyance
User specifies a target water surface increase
User specifies a target water surface increase and
maximum change in energy

For unsteady flow analysis, only method one has been implemented so far in
HEC-RAS. For a detailed discussion on each of these methods, the user is
referred to Chapter 10 of the Hydraulic Reference Manual.

The goal of performing a floodplain encroachment analysis is to determine
the limits of encroachment that will cause a specified change in water surface
elevation. To determine the change in water surface elevation, the program
must first determine a natural profile with no encroachments. This base
profile is typically computed using the one percent chance discharge. The
computed profile will define the floodplain, as shown in Figure 10.1. Then,
by using one of the 5 encroachment methods, the floodplain will be divided
into two zones: the flood way fringe and the floodway. The floodway fringe
is the area blocked by the encroacbment The floodway is the remaining
portion of the floodplain in which the one-percent chance event must flow
without raising the water surface more than the target amount.
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Figure 10.1 Fluodway Definition Sketch

Entering Floodplain Encroachment Data

Within HEC-RAS, the data for performing a steady flow floodplain
encroachment analysis are entered from the Steady Flow Analysis window.
Encroachment information is not considered as permanent geometry or flow
data, and is therefore not entered as such. The encroachment information is
saved as part of the existing Plan data.

To bring up the floodplain encroachment data window, select the
Encroachments option from the Options menu of the Steady Flow Analysis
window. When this option is selected an Encroachment window will appear
as shown in Figure 10.2 (except yours will be blank when you first open it).

As shown in Figure 10.2, there are several pieces of data that the user must
supply for an encroachment analysis. The encroachment analysis can only be
performed for profiles 2 through 15 (or what ever number has been set by the
user in the flow data editor). Encroachments are not performed on profile one
because most of the encroachment methods rely on having a base profile for
companson.
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IX Equal Conveyance Reduction

Left bank ollset 110 Right bank oflset: r;o--'---
River IBeaver Creek ::o:J Profile: IpF#2 3
Reach: !Kentwood 3 Import to Method 1 I

Set Range of Values

UpstreamRS: 1-5.-9-9---3 Method Inone ~

Oc)\>w-,stream RS: 15.0 ~]

Set Selected Range I
F;iver Sta Method I Value 1 I Value 2

1 5.99 14 [.6
2 5.875" 4 .95
3 5.76 4 1.4
4 5.685" 4 1.8
5 5.61 4 2
6 5.49" 4 2
7 5.41 4 1.1

OK Cancel Clear Profile I
~

Clear ,6,11 Profiles I
Edit encro.3chment dala directl}'.

Figure 10.2 Floodplain Encroachment Data Editor

The data for an encroachment analysis should be entered in the following
manner:

Global Information. Global information is data that will be applied at every
cross section for every profile computed. The first piece of global
information is the Equal Conveyance Reduction selection box at the top of
the Encroachment data editor window. Equal conveyance reduction applies
to encroachment methods 3, 4, and 5. When this is turned on, the program
will attempt to encroach, such that an equal loss of conveyance is provided on
both sides of the stream. If this option is turned off, the program will
encroach by trying to maintain a loss in conveyance in proportion to the
distribution of natural overbank conveyance. The default is to have equal
conveyance reduction turned on.

The second item under global information is the Left bank offset and the
Right bank offset. The left and right offsets are used to establish a buffer
zone around the main channel for further limiting the amount of the
encroachments. For example, if a user established a right offset of 5 feet and
a left offset of 10 feet, the model will limit all encroachments to 5 feet trom
the right bank station and 10 feet from the left bank station. The default is to
have no right or left offset, this will allow the encroachments to go up to the
main channel bank stations, if necessary.
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River, Reach and River Station Selection Boxes. The next piece of dala for
the user to select is the river and reach in which to enter encroachment data.
The user is limited to seeing one reach at a time on the encroachment data
editor. Once a reach is selecled, the user can then enter a Starting and
Ending River Station to work on. By default, the program selects all the
sections in the reach. The user can change this to any range of cross sections
within the reach.

Prolile. Next, the user should select a profile number to work on. Profiles
are limited to 2 through the maximum number set in the currently opened
flow data (e.g., 2 through 4, if the user has set 4 profiles in the flow data
editor). The user can not set encroachments for profile I.

Method and Target Values. The next step is to enter the desired
encroachment method to be used for the currently selected profile. Once a
method is selected, the data entry boxes that corresponds to that method will
show up below the method selection box. Some of the methods require only
one piece of data, while others require two. The user should then enter the
required information that corresponds to the method that they have selected.
For example, if the user selects encroachment method 4, only one piece of
information is required, the target change in water surface elevation. The
available encroachment methods in HEC-RAS are:

Method 1 ­
Method 2 ­
Method 3­
Method 4­
Method 5 -

User enters right and left encroachment station
User enters a fixed top width
User specifies the percent reduction in conveyance
User specifies a target water surface increase
User specifies target water surface increase and
maximum change in energy

Set Selected Range. Once the encroachment method is selected, and its
corresponding data are entered, the user should press the Set Selected Range
button. Pressing this button will fill in the table below with the selected range
of river stations; the selected method; and the corresponding data for the
method. Note that, if the selected method only has one data item, that
method's data will go under the Value 1 column of the table. If the selected
method has two data items, the first goes into the Value 1 column and the
second goes into the Value 2 column. Once the data is put into the table, the
user can change the method and corresponding data values directly from the
table.

At this point the user should repeat these tasks until all of the encroachment
data are entered (i.e., for all the reaches and locations in the model, as well as
all of the profiles for which the user wants to perform the encroachment
analysis). Once all of the encroachment data are entered, the user presses the
OK button and the data will be applied and the window will close. The user
can return to the encroachment window and edit the dala at any time. The
encroachment data are not saved to the hard disk at this time, they are only
saved in memory. To save the data to the hard disk, the user should either
select Save Project from the File menu of the main HEC-RAS window, or

10-5



Chapter 10 Performing a Floodwav Encroachment Analvsis

select Save Plan from the File menu of the Steady Flow Analysis window.

The Import Method 1 option, allows the user to transfer the computed
encroachment stations from a previous run (output file) to the input data for a
future run. For example, if the user performs a preliminary encroachment
analysis using any of the methods 2 through 5, they may want to convert the
results from one of the runs to a method I encroachment method. This will
allow the user to further define the flood way, using method I, without having
to enter all of the encroachment stations. The import of encroachment
stations, in this manner, is limited to the results of a single encroachment
profile for each reach.

Performing The Floodplain Encroachment Analysis

The HEC-RAS flood way procedure is based on calculating a natural profile
(no encroachments) as the first profile of a multiple profile run. Subsequent
profiles are calculated with the various encroachment options available in the
program.

[n general, when performing a floodway analysis, encroachment methods 4
and 5 are normally used to get a first cut at the encroachment stations.
Recognizing that the initial floodway computations may provide changes in
water surface elevations greater, or less, than the "target" increase, initial
computer runs are usually made with several "target" values. The initial
computer results should then be analyzed for increases in water surface
elevations, changes in velocities, changes in top width, and other parameters.
Also, plotting the results with the X-Y-Z perspective plot, or onto a topo map,
is recommended. From these initial results, new estimates can be made and
tested.

After a few initial runs, the encroachment stations should become more
defined. Because portions of several computed profiles may be used, the
final computer runs are usually made with encroachment Method I defining
the specific encroachment stations at each cross section. Additional runs are
often made with Method I, allowing the user to adjust encroachment stations
at specific cross sections to further define the floodway.

While the flood way analysis generally focuses on the change in water surface
elevation, it is important to remember that the floodway must be consistent
with local development plans and provide reasonable hydraulic transitions
through the study reach. Sometimes the computed floodway solution, that
provides computed water surfaces at or near the target maximum, may be
unreasonable when transferred to the map of the actual study reach. If this
occurs, the user may need to change some of the encroachment stations,
based on the visual inspection of the topo map. The floodway computations
should be re-run with the new encroachment stations to ensure that the target
maximum is not exceeded.
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Viewing the Floodplain Encroachment Results

Floodplain encroachment results can be viewed in both graphical and tabular
modes. Graphically, the encroachment results show up on the cross section
plots as well as the X-Y-Z Perspective plot. An example cross-section plot is
shown in Figure 10.3.

[ross Section ~

Eile Qptlon$ tielp

River. IBeaver Creek

Reach IKentwood

iJ~~ I +COJ!
iJ River 51a.: l-=-s·g,..,-g----iJ iJ!J

Floodway Determination· Example G Plan: Method 5 Encroachment
GeOtn: Existing Conditions Flow: Base + 1 ft Target Depth

RS = 599 Upstream Boundary Cross Section

1-+-14-11· .14 'I222 0 Legend

220 ]~
.

~ (a-~ I
W3PF#2

I
2'18 1 INSPF#11

2·16
... •

~ Grounde -c 214
.Q Levee

" 212 •:> Bank St~~

W
210 Encroachment

208

206

204
0 500 1000 ·1500 2000

Station (n)

Figure 10.3 Example Cross Section Plot With Encroachments

As shown in Figure 10.3, the encroachments are plotted as outlined blocks.
In this example, the water surface profile for the base run (first profile) is
plotted along with one of the encroached profiles. The user can plot as many
profiles as they wish, but it may become a little confusing with several sets of
encroachments plotted at they same time.

Another type of graphic that can be used to view the encroachments is the X­
Y-Z perspective plot, an example is shown in Figure 10.4. In this example,
the base profile (profile I) as well as one of the encroached profiles is plotted
at the same time over a range of cross sections. This type of plot allows the
user to get a reach view of the floodplain encroachment. The user can
quickly see if the encroachments transition smoothly or if they are erratic. In
general, the final encroachments should have a consistent and smooth
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transition from one cross section to the next. With the assistance of this type
of plot, the user may want to further refine the final encroachment stations
and re-run the model.

I X-Y-Z Perspective Plot 1 ...

Floodway Determination - Example 6 Plan: Method 5 Encroachment
Geom: EXisting Conditions Flow: Base + 1 tt Target Depth

Eile Qptions

Upslream RS:

Downstream RS

15 99 :::J ~l!J
1
=:-----,--15.0 -.J

~ J
RoI:atlon Angle

AZimuth Angle

.J

Legend

Base 100 yr
I I

Encroached 100 yr

Ground
----0---

Levee
•

Bank S1a

EncrOoe'lctlrnent

Ground

[netf

Figure 10.4 Example X-Y-Z Perspective Plot with Base and Encroached Profiles

Encroachment resuits can also be viewed in a tabular mode from the Profile
Output Tables. Seleci Profile Table from the View menu of the main HEC­
RAS window. When the table comes up, the user can select from three
different pre-defined encroachment tables. To bring up one of the
encroachment tables, select Encroachment 1 from the Std. Tables menu on
the Profile table window. An example of Encroachment I table is shown in
Figure 10.5. The table shows the basic encroachment resuits of: computed
water surface elevation; change in water surface from the base profile: the
computed energy; top width of the active flow area; the flow in the left
overbank, main channel, and right overbank; the left encroachment station;
the station of the left bank of the main channel; the station of the right bank of
the main channel. and the right encroachment station.
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Figure 10.5 Example of the Encroachment I Standard Table

Encroachment 2 table provides some additional information that is often used
when plotting the encroachments onto a map. This table includes: the change
in water 5urface elevations from the first profile; the top width of the active
flow area; the percentage of conveyance reduction in the left overbank; the
left encroachment slation; the distance from the center of the main channel to
the left encroachment station; the station of the center of lhe main channel;
the distance from the center of the main channel to the right encroachment
station; the righl encroachment station; and the percentage of conveyance
reduction in the right overbank. An example of the Encroachment 2 standard
table is shown in Figure 10.6.
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Figure 10,6 Example of the Encroachment 2 Standard Table

The last encroachment table, Encroachment 3, provides the minimum
floodway data for reporting. This table includes: the active flow top width;
the flow area (including any ineffective flow area); the average velocity of the
entire cross section; the computed water surface elevation; the base waler
surface elevation (profile I); and the change in water surface from the first
profile. An example of this table is shown in Figure 10.7
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Figure 10.7 Example of the Encroachment 3 Standard Table

Floodway Encroachments With Unsteady Flow

Encroachment analyses can also be performed with the unsteady flow
computations module within HEC-RAS. However, only method one (user
placed encroachments) has been added to the unsteady flow computations. A
suggested methodology for perfonning an encroachment analysis with an
unsteady flow model is the foJlowing:

I. First, develop the unsteady flow model of the river system and
calibrate it to the extent possible.

2. Develop an unsteady flow plan of the 100 yr event in order to
establish the base floodplain,
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3. Develop a steady flow plan that incorporates the peak flows from the
unsteady flow run as the 100 yr event for the model. Set up the model
for two profiles with the same flows.

4. Perform a steady flow encroachment analysis using the available
steady flow encroachment methods to calculate an approximate
f1oodway.

5. Copy the unsteady flow plan to a new plan (using the Save As
option), and give it a name that represents the encroached plan.

6. Adjust the boundary conditions file to reflect an increased water
surface elevation at the downstream boundary for the range of
possible flows. If using a rating curve, you will need to develop a
new rating to reflect the encroached condition at the downstream
boundary. If you are using normal depth or critical depth, no change
is necessary, since the program will calculate a new water surface
with the encroachments.

7. Go to the Options menu of the unsteady flow analysis window and
select Unsteady Encroachments. This will bring up the Unsteady
flow Encroachment editor shown in Figure 10.8.

8. Import the final encroachments from the steady flow encroachment
run in to the unsteady flow encroachment editor. This is
accomplished by pressing the button labeled "Get Encroachments
From Steady Flow Plan", and then selecting the appropriate plan
and profile number from the steady flow encroachment analysis.

9. Run the unsteady flow model with the encroachments and compare
the output of the encroached unsteady flow plan with the output from
the base unsteady flow plan.

10. Adjust the encroachments as necessary to stay within the limits for
increased water surface elevations. Re-run the unsteady flow model.
Repeat this process until a final f100dway is achieved.
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Figure 10.8 Unsteady Flow Encroachment Editor.
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CHAPTER 11

Troubleshooting With HEC-RAS

For a steady flow analysis, the HEC-RAS software is designed to continue its
computations all the way through completion, even when the user has entered
poor data. Because of this, the fact that the program executes a complete run
does not necessarily mean that the results are good. The user must carefully
review the results to ensure that they adequately represent the study reach and
that they are reasonable and consistent. The HEC-RAS software is an
engineering tool, it is by no means a replacement for sound engineering.

The HEC-RAS software contains several features to assist the user in the
development ofa model; debugging problems; and the review of results.
These features include: built in data checking; an Errors, Warnings, and Notes
system; and a computational Log Output file. In addition to these features,
the user can use the graphical and tabular output to review the results and
check the data for reasonableness and consistency. Most of the information
contained within this chapter is based on performing a steady flow analysis.
Much of the information is also useful when performing an unsteady flow
analysis. More assistance for solving unsteady flow stability problems can be
found in Chapter 8 of this manual.

Built in Data Checking

The HEC-RAS user interface has two types of built in data checking. The
first type of data checking is performed as the user enters the data. Each data
field of the data entry editors has some form of data checking. The second
type of data checking occurs when the user starts the steady flow or unsteady
flow computations. When the user presses the compute button, on the steady
flow or unsteady flow analysis window, the entire data set is processed
through several data checks before the computations begin. A detailed
discussion of each of these two data checking features is described below.

Checking the Data as it is Entered

This type of data checking occurs whenever the user enters data into a single
data field or table. Once the user leaves a particular data entry field or table,
the program will automatically check that data for reasonableness. The
following is a list of some of the types of data checks that are performed:

I. Minimum and maximum range checking for variables.

2. Alpha and numeric data checks. This is done to ensure that the right
type of data is entered in each field.
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3. Increasing order of station for cross sections, bridge deck/roadway,
and abutments.

4. Data consistency checks (i.e., when the main channel bank stations
are entered, the program checks to see if they exist in the cross section
station and elevation data).

S. Data deletion warnings. When you delete data the software will give
you a warning before it is deleted.

6. File management warnings (i.e., program will give you a chance to
save the data to the hard disk before the program is closed, or a
different data set is opened).

7. Data geometry checks (i.e., when a bridge deck/roadway is entered,
the program checks to ensure that the deck/roadway intersects with
the ground data).

Data Checking Before Computations are Performed

The second type of data checking is performed to evaluate the completeness
and consistency of the data. This type of data checking occurs before the
computations take place. When the user presses the Compute button on the
Steady Flow or Unsteady Flow Analysis window, the program will perform a
series of data checks before the computations are allowed to proceed. If any
data errors are found, the program will not perform the computations. The
following is a list of some of the types of checks that are made during this
time:

1. Data completeness. These data checks insure that all of the required
data exists for the entire data sel. If any missing data are found, a
complete list of all the missing data and their specific locations is
displayed on the screen. An example of this is shown in Figure ILL

2. Data consistency. This type of data checking is performed to ensure
that the data is consistent with the computations that are being
requested. For example, if the user asks to perform a mixed flow
regime computation, the program checks to ensure that upstream as
well as downstream boundary conditions have been specified.
Likewise, if an encroachment analysis is requested, the program
checks to ensure that the number of profiles lines up with the number
specified in the encroachment data. There are several other checks of
this type.
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Figure 11.1 Data Completeness Checking Window

Errors, Warnings, and Notes

The HEC-RAS software has a system of Errors, Warnings, and Notes that are
passed from the computation programs to the user interface. During the
computations. the computation programs will set flags for at a particular node
(nodes are cross sections, bridges, culverts, or multiple openings) whenever it
is necessary. These message flags are written to the standard output file,
along with the computed results for that node. When the user interface reads
the computed results from the output file. if any errors, warnings, or notes
exist, they are interpreted and displayed in various locations from the
interface.

The user can request a summary of all the errors, warnings, and notes that
occurred during the computations. This is accomplished by selecting
Summary Errors, Warnings, and Notes from the View menu on the main
HEC-RAS window. Once this is selected, a window will pop up displaying
all of the messages. The user can select a specific River and Reach. as well
as which Profile and Plan to view. The user has the options of expanding the
window; printing the messages; or sending them to the windows clipboard.
An example of the Errors, Warnings, and Notes window is shown in Figure
11.2.
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The energy equation caud not be balanced WIthin the spec-lied number of ItelatlOns. The program
selected the walel sUlface thai had the least amoWlt of eflOl bet'....!een computed and assumed vallJes.

Divided flow computed for thiS cro-t -seellon
During the standard step iterations. when the assumed ......ater surface was set equal to critical depth.
the calculated water SUllace came back below cntlCal depth. This indicates that the-Ie is not. a va~d

subcritical am'Nel. The plogram defaulted 10 critical depth.
River: Cntical CI. Reach: Upper Reach RS: 11 4" Prol~e: 100 yrLocation:

Figure 11.2 Summary of Errors, Warnings, and Notes Window

Besides the summary window, messages will automatically appear on the
cross section specific tables. When a cross section or hydraulic structure is
being displayed, any errors, warnings, or notes for that location and profile
will show up in the Errors, Warnings, and Notes message box at the bottom
of the table. An example of this table is shown in Figure 11.3.

In general, the errors, warnings, and notes messages should be self
explanatory. The three categories of messages are the following:

ERRORS: Error messages are only sent when there are problems that
prevent the program from being able to complete the run.

WARNINGS: Warning messages provide information to the user that may
or may not require action on the user's part. In general, whenever a warning
is set al a location, the user should review the hydraulic results at that location
to ensure that the results are reasonable. If the hydraulic results are found to
be reasonable, then the message can be ignored. However, in many instances,
a warning level message may require the user to take some aclion that will
cause the message to disappear on future runs. Many of the warning
messages are caused by either inadequate or bad dala. Some common
problems that cause warning messages to occur are the following:

Cross sections spaced to far apart. This can cause several warning
messages to be set.

Cross sections starting and ending stations not high enough. If a
computed water surface is higher than either end point of the cross sectioll, a
warning message will appear.
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Bad Starting Water Surface Elevation. !fthe user specifies a boundary
condition that is not possible for the specified flow regime, the program will
take action an set an appropriate warning message.

Bad Cross Section Data. This can cause several problems, but most often
the program will not be able to balance the energy equation and will default
to critical depth.

NOTES: Note level messages are set to provide information to the user
about how the program is performing the computations.

~ Cross Section Output' • ~.

Ele Iype Qptions !:!elp

Rlvel ICiitical Cr. 3 Profile' 1100yr ::oJ
Reach IUppel Reac.h :::lRS 112 ::oJ ~.!J Plan IE~st Cand :::l

E.G. Elev (II) 1815.76 Element Lell DB Channel Right DB
Vel Head (II} 0.71 ."It. nVal. 0100 0040 0100
W.S. Ele., III) 181506 Reach Len (II} 500.00 500.00 500.00
C"IVIS.(II\ 1814.46 Flow Area I~Q ttl 21}ijf 320.32 100.25
E.G Slope (filii) 0006851 Alea (sq II) 2137.33 320.32 100.25
QTolal (cfs) 9000.00 Flow (cis) 5528.62 3370.57 100.31
Top Widlh (II) 378.61 Top Widlh (II) 698.04 45.00 135.57
Vel TDial (Ills) 3.52 Avg. Velill/s) 2.59 1051 1.01
Max Chi Oplh III) 1146 Hydr. Deplh {III 306 7.13 0.74
Conv. Tolal (cis) 1087314 Conv (cis) 66792.7 40720.8 1217.9
Length Wtd. (II) 500.00 Welled Pel (II) 700.82 50. SO 135.59
Min Ch EI (It) 1803.60 Shear (b/sq II) 130 2.70 032
Alpha 3.67 St,eam Powe, lib/II s) 3.37 28.38 032
F,cln Loss (Ill 3.82 Cum Volume (ac-Ie·lt) 22537 41.64 1089
C &E Loss III) 0.07 Cum SA (ac,es) 79.06 6.43 7.75

The veloc.ity head has c.hanged by mOle than 0 5 It (O.15 m) This: may indicate the need fOI

additional cross seclrons
The enelQ.Y loss was greatel than 1.0 ft (0.3 mJ. between the cunenl and plevious cross section.
This may indicate the need for additional cross sections

Area of left overbank active flow.

Figure I J.3 Cross Section Table with Errors, Warnings, and Notes
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Log Output

Steady Flow Log Output

This option allows the user to set the level of the Log file for a steady flow
analysis. This file contains information tracing the program process. Log
levels can range between 0 and 10, with 0 resulting in no Log output and 10
resulting in the maximum Log output. In general, the Log file output level
should not be set unless the user gets an error during the computations. If an
error occurs in the computations, set the log file level to an appropriate value.
Re-run the computations and then review the log outpnt, try to determine why
the program got an error.

When the user selects Set Log File Ontput Level from the Options menu, a
window will appear as shown in Figure 11.4. The user can set a "Global Log
Level," which will be used for all cross sections and every profile. The user
can also set log levels at specific locations for specific profiles. In general, it
is better to only set the log level at the locations where problems are
occurring in the computations. To set the specific location log level, first
select the desired reach and river station. Next select the log level and the
profile number (the log level can be turned on for all profiles). Once you
have everything set, press the Set button and the log level will show up in the
window below. Log levels can be set at several locations individually. Once
all of the Log Levels are set, press the OK button to close the window.

Warning I!! - setting the global log output level to 4 or 5 can result in very
large log file output. Global log level values of6 or larger can result in
extremely large log files.

Output Log level ' ;;

Set Global Log Level

Global Log Level.

Set Specific Log Level Locations

River: ICritical Cr ::::J Profile: 11::oJ
Reach: IUpper Reach iJ
Starting Riv Sta 112 ::oJ Log Level 16::oJ
Ending Riv Sta 110 ::oJ 1r:=::~:=5~~e.~~[~i1[1~iige== .1

Critical CI. Reach::Uppel Reach RS::12 profile= 1 LL=6
Ciilical Cl. Reach=Upper Reach RS=l1 profile= 1 LL=6
Critical Cr. Reach::Upper Reach RS=10 profile:: 1 LL=6

OK Cancel Help Clear All
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Unsteady Flow Log Output

The unsteady flow computation program can write out a detailed log file of its
computations. This file is very different from the steady flow program, but
serves the purpose of debugging computational problems. This option is
turned on by selecting Output Options from the Options menu on the
Unsteady Flow Analysis window. When this option is selected a window will
appear as shown in Figure 11.5.

HEC-RA5 -'"

. -, Set 0 ut Control 0 irons "',' .;C - , ,

Restart File
r- \drite Initial Condition file.

File: !beaver.p03.rst

r.- Hours from begining of simulation:

r Fixed Reference: 0 ate: Time:

Detailed Log Output

P Echo Input H9drogr..5phs to 0 etailed Log OIJlput File.
fY' Echo C1xnpuled H}idrographs to Detailed Log Output File.

fY' Write Det.:.lied Log Oll'Pllt for Debuging
Time Window is optional:

Starling Dale: IOSJAfl2002 Starting Time: 101 00

Ending Dale: IOSJAfl2002 Ending Time: 11500

Figure 11.5 Unsteady Flow Output Control Window

As shown in Figure 11.5, this option controls various types of output. To turn
on the detailed log output, the user must check the box labeled Write
Detailed Log Output for Debugging. The user has the option for setting a
time window, which will limit the output to only within this time frame.
After this option is selected, the computations must be rerun in order for the
output to be produced,

Viewing The Log File

This option allows the user to view the contents of the log file. For steady
flow analyses, the user brings up the log output by selecting View Log File
from the Options menu of the Steady Flow Analysis window, For unsteady
flow analyses, the user brings up the log output by selecting View
Computation Log File from the Options menu of the Unsteady Flow
Analysis window. The interface uses the Windows Write program to
accomplish viewing the output (unless the user has set a different program to
be used as the default file viewer). It is up to the user to set an appropriate
font in the Write program. If the user sets a I,mt that uses proportional
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spacing, the information in the log file will not line up correctly. Some fonts
that work well are: Line Printer; Courier (8 pt.); and Helvetica (8 pt.).
Consult your Windows user's manual for infonnation on how to use the Write
program.

Reviewing and Debugging the Normal Output

After the user has successfully completed a run, and reviewed all the errors,
warnings, and notes, the normal output should be reviewed for consistency
and reasonableness.

Viewing Graphics

In general, the graphical oulput should be used as much as possible to get a
quick view of the results. The user should look at all of the cross sections
with the cross section plotting capability. The cross seclion plots will assist
the user in finding data mistakes, as well as possible modeling mistakes
(mistakes in ineffective flow areas, levees, n values, etc.).

The profile plotting capability is a good way to get a quick overview of the
entire study area. The user should look for sudden changes to the energy
grade line and the water surface. In general, these two variables should
transition smoothly along the channel. If the user finds rapid changes in the
energy or the water surface, the results at those locations should be reviewed
closely to ensure that they are correct.

The X-Y-Z Perspective Plot can also be used to get a quick view of an entire
reach. This plot is very helpful for viewing the top width of the flow area. If
the user finds dramatic changes in the top width from one cross section to the
next, then the results at those locations should be reviewed closely. Dramatic
changes in top width may indicate the need for additional cross sections.

Viewing Tabular Output

There are several types of tabular output. The user should try to make use of
all of them when viewing tabular results. In general, the profile summary
types of tables should be used to get an overview of some of the key variables
at several locations. If any problems are found, or any results that seem
suspect, the user should use the detailed output specific tables to get detailed
results at a single location.

The Occurrence of Critical Depth

During the steady flow water surface profile calculations, the program may
default to critical depth at a cross section in order to continue the calculations.
Critical depth can occur for the following reasons:
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I. Sad cross section data: If the energy equation can not balance because
of bad cross section data, the program defaults to critical depth.

2. Program can not balance the energy equation above or below the top
of a levee or ineffective flow area: On occasion, when the program is
balancing a water surface that is very close to the top of a levee, or an
ineffective flow area, the program may go back and forth (above and
below the levee) without being able to balance the energy equation.
When this occurs, the program will default to critical depth.

3. Cross sections spaced too far apart: If the cross sections are spaced to
far apart, the program may not be able to calculate enough energy
losses to obtain a subcritical water surface at the upstream section.

4. Wrong flow regime: When calculating a subcritical profile, and the
program comes to a reach that is truly supercritical, the program will
default to critical depth. Likewise, when calculating a supercritical
profile, if the reach is truly sUbcritical, the program will default to
critical depth.

Computational Program Does Not Run To Completion

While running the computational part of the software, when the steady flow
program is finished you should get the message "Finished Steady Flow
Simulation" or "Finished Post Processing," for an unsteady flow run. If the
user has entered bad data, the computational program may not be able to run
to completion. When this happens the program will stop and write an error
message to the screen. This message may be a trapped error by the program,
or it could be just a generic Fortran error message. Fortran error messages
come from the Fortran compiler that was used to develop the computational
program. The message basically says that a math error occurred and therefore
the program could not continue. When this type of error occurs, it is most
often a data input problem. There is a possibility that it could be a bug in the
program, but the user should exhaust all the possible data input errors before
assuming that the program has a "Sug."

The first step in finding the problem is to realize where the error is occurring.
For a steady flow analysis, the program will display which cross section it is
working on, and for which profile. This means that the error occurred at that
cross section (or hydraulic structure, such as a bridge). Go to the Geometric
Data editor and review the input data closely at the problem location.

During an unsteady flow analysis, the program displays the time step that il is
working on and the number of iterations it took to solve the equations. As the
program is running, if it consistently goes to the maximum number of
iterations (20 is the default), the user should take not of the time step that this
started to occur. The user must turn on the detailed log output, and then
review that output in the vicinity of that particular time step, in order to figure
out what is going wrong.
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Computational errors often occur at bridges. Check your data closely for any
inconsistencies in the bridge geometry. Many of the problems that occur at
bridges are due 10 bad Deck/Roadway data. Go to the Bridge/Culvert Data
editor and turn on the option Highlight Weir, Opening Lid and Ground
from the View menu. This option will assist you in finding any geometric
mistakes in Ihe bridge data.
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CHAPTER 12

Computing Scour at Bridges

The computation of scour at bridges within HEC-RAS is based upon the
methods outlined in Hydraulic Engineering Circular No. 18 (FHWA, 2001).
Before performing a scour analysis with the HEC-RAS software, the engineer
should thoroughly review the procedures outlined in the Hydraulic
Engineering Circular No. 18 (HEC 18) report. This chapter presents the data
input required for computing contraction scour and local scour at piers and
abutments.

For infonnation on the bridge scour equations, please see Chapter 10 of the
HEC-RAS Hydraulic Reference Manual.

Contents

• General Modeling Guidelines

• Entering Bridge Scour Data

• Computing Total Bridge Scour
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General Modeling Guidelines

In order to perform a bridge scour analysis, the user must first develop a
hydraulic model of the river reach containing the bridge to be analyzed. This
model should include several cross sections downstream from the bridge,
such that any user defined downstream boundary condition does not affect the
hydraulic results inside and just upstream of the bridge. The model should
also include several cross sections upstream of the bridge, in order to evaluate
the long term effects of the bridge on the water surface profile upstream.

The hydraulic modeling of the bridge should be based on the procedures
outlined in Chapter 5 of the Hydraulic Reference Manual. If observed data
are available, the model should be calibrated to the fullest extent possible.
Once the hydraulic model has been calibrated (if observed data are available),
the modeler can enter the design events to be used for the scour analysis. In
general, the design event for a scour analysis is usually the 100 year (I
percent chance) event. In addition to this event, it is recommended that a 500
year (0.2 percent chance) event also be used in order to evaluate the bridge
foundation under a super-flood condition.

The next step is to turn on the flow distribution option in the HEC-RAS
software. This option allows for additional output showing the distribution of
flow for multiple subdivisions of the left and right overbanks, as well as the
main channel. The output of the flow distribution option includes the
following items for each flow slice: percentage of flow; flow area; wetted
perimeter; conveyance; hydraulic depth; and average velocity. The user can
control the number of slices in each flow element (left overbank, main
channel, and right overbank), up to a maximum of 45 total slices. The flow
distribution output is controlled from the Options menu of the Steady Flow
Analysis window (see Chapter 7, Simulation Options).

The user must request the flow distribution output for the cross sections
inside the bridge, the cross section just upstream of the bridge, and the
approach section (cross section upstream of the bridge at a distance such that
the flow lines are parallel and the flow has not yet begun to contract due to
the bridge constriction). Flow distribution output can be requested at
additional cross sections, but these are the only cross sections that will be
used in the bridge scour computations. The flow distribution option must be
turned on in order to get more detailed estimates of the depth and velocity at
various locations within the cross section. Once the user has turned this
option on, the profile computations must be performed again in order for the
flow distribution output to be computed and included in the output file.

After performing the water surface profile calculations for the design events,
and computing the flow distribution output, the bridge scour can then be
evaluated. The total scour at a highway crossing is comprised of three
components: long-term aggradation and degradation; contraction scour; and
local scour at piers and abutments. The scour computations in the HEC-RAS
software allow the user to compute contraction scour and local scour at piers
and abutments. The current version of the HEC-RAS software does not allow
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the user to evaluate long-term aggradation and degradation. Long tenn
aggradation and degradation should be evaluated before perfonning the
bridge scour analysis. Procedures for perfonning this type of analyses are
outlined in the HEC No. 18 report.

Entering Bridge Scour Data

The bridge scour computations are performed by opening the Hydraulic
Design Functions window and selecting the Scour at Bridges function.
Once this option is selected the program will automatically go to the output
file and get the computed output for the approach section, the section just
upstream of the bridge, and the sections inside of the bridge. The Hydraulic
Design window for Scour at Bridges will appear as shown in Figure 12-1.
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Figure 12,1 Hydraulic Design Window For Scour at Bridges
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As shown in Figure 12-1, the Scour at Bridges window contains the input
dala, a graphic, and a window for summary results. Input data tabs are
available for contraction scour, pier scour, and abutment scour. The user is
required to enter only a minimal amount of input and the computations can be
performed. If the user does not agree with any of the data that the program
has selected from the output file, the user can override it by entering their
own values. This provides maximum flexibility in using the software.

Entering Contraction Scour Data

Contraction scour can be computed in HEC-RAS by either Laursen's clear­
water (Laursen, 1963) or live-bed (Laursen, 1960) contraction scour
equations. Figure 12-2 shows all of the data for the contraction scour
computations. All of the variables except K I and 050 are obtained
automatically from the HEC-RAS output file. The user can change any
variable to whatever value they think is appropriate. To compute contraction
scour, the user is only required to enter the 050 (mean size fraction of the bed
material) and a water temperature to compute the K I factor.
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Figure 12.2 Example Contraction Scour Calculation
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Each of the variables that are used in the computation of contraction scour are
defined below, as well as a description of where each variable is obtained
from the output file.

YI: The average depth (hydraulic depth) in the left overbank, main channel,
and the right overbank, at the approach cross-section.

VI: The average velocity of flow in the left overbank, main channel, and
right overbank, at the approach section.

YO: The average depth in the left overbank, main channel, and right
overbank, at the contracted section. The contracted seclion is taken as the
cross seclion inside the bridge at the upstream end of the bridge (section BU).

Q2: The flow in the left overbank, main channel, and right overbank, at the
contracted section (section BU).

W2: The top width of the active now area (not including ineffective now
area), taken at the contracted section (section BU).

050: The bed material particle size of which 50% are smaller, for the left
overbank, main channel, and the right overbank. Thcse particle sizes must be
entered by the user.

Equation: The user has the option to allow the program to decide whether to
use the live-bed or clear-water contraction scour equations, or to select a
specific equation. If the user selects the Default option (program selects
which equation is most appropriate), the program must compute V" the
critical velocity that will transport bed material fmer than 050. If the average
velocity at the approach cross section is greater than Y,. the program uses the
live-bed contraction scour equation. Otherwise, the clear-water contraction
scour equation will be used.

Ql: The flow in the left overbank, main channel, and right overbank at the
approach cross-section.

WI: The top width of the active now area (not including ineffective flow
area), taken at the approach cross section.

Kl: An exponent for the live-bed contraction scour equation that accounts for
the mode of bed material transport. The program can compute a value for K I
or the user can enter one. To have the program compute a value, the KI
button must be pressed. Figure 12-3 shows the window that comes up when
the Kl button is pressed. Once a water temperature is entered, and the user
presses the OK button, the K I factor will be displayed on the main
contraction scour window. K I is a function of the energy slope (S I) at the
approach section, the shear velocity (Y') at the approach section, water
temperature, and the fall velocity (w) of the 050 bed material.
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Compute 1:1 for Contrac

LOB Channel ROB

51 : III 000531 10000531 10000531

If" IIVs]: 10.26 10.38 10.26

Waler Temp IF) 1600

w litIs] 109302 109302 10.9302

V'/w: 10280 10409 102130

K1· 10590 10590 10590

OK Cancel

EG slope In apPlOdch section

Figure 12.3 Computation of the Kl Factor

Approach XS River Sta.: The river station of what is being used as the
approach cross section. The approach cross section should be located at a
point upstream of the bridge just before the flow begins to contract do to the
constriction of the bridge opening. The program assumes that the second
cross section upstream of the bridge is the approach cross section. If this is
not the case, the user can select a different river station to be used as the
approach cross section.

As shown in Figure 12-2, the computation of contraction scour is performed
separately for the left overbank, main channel, and right overbank. For this
example, since there is no right overbank flow inside of the bridge, there is no
contraction scour for the right overbank. The summary results show that the
computed contraction scour, Y" was 2.26 feet (0.69 m) for the left overbank,
and 6.67 feet (2.03 m) for the main channel. Also note that the graphic was
updated to show how far the bed would be scoured due to the contraction
scour.

Entering Pier Scour Data

Pier scour can be computed by either the Colorado State University (CSU)
equation (Richardson, et ai, 1990) or the Froehlich (1988) equation (the
Froehlich equation is not included in the HEC No.18 report). The CSU
equation is the default. As shown in Figure 12-4, the user is only required to
enter the pier nose shape (K I), the angle of attack for flow hitting the piers,
the condition of the bed (K3), and a 095 size fraction for the bed material.
All other values are automatically obtained from the HEC-RAS output file.
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As shown in Figure 12-4, the user has the option to use the maximum velocity
and depth in the main channel, or the local velocity and depth at each pier for
the calculation of the pier scour. In general, the maximum velocity and depth
are used in order to account for the potential of the main channel thalweg to
migrate back and forth within the bridge opening. The migration of the main
channel thalweg could cause the maximum potential scour to occur at anyone
of the bridge piers.

Each of the variables that are used in' the computation of pier scour are
defined below, as well as a description of where each variable is obtained
from the output file.

Maximum VI YI: If the user selects this option, the program will find the
maximum velocity and depth located in the cross section just upstream and
outside of the bridge. The program uses the flow distribution output to obtain
these values. The maximum V I and Y I will then be used for all of the piers.
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Figure 12.4 Example Pier Scour Computation
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Local VI YI: If the user selects this option, the program will find the
velocity (VI) and depth (Y I) at the cross section just upstream and outside of
the bridge that corresponds to the centerline stationing of each of the piers.

Method: The method option allows the user to choose between the CSU
equation and the Froehlich equation for the computation of local scour at
bridge piers. The CSU equation is the default method.

Pier #: This selection box controls how the data can be entered. When the
option "Apply to All Piers" is selected, any of the pier data entered by the
user will be applied to all of the piers. The user does not have to enter all of
the data in this mode, only the portion of the data that should be applied to all
of the piers. Optionally, the user can select a specific pier from this selection
box. When a specific pier is selected, any data that has already been entered,
or is applicable to that pier, will show up in each of the data fields. The user
can then enter any missing infonnation for that pier, or change any data that
was already set.

Shape: This selection box is used to establish the pier nose (upstream end)
shape. The user can select between square nose, round nose, circular
cylinder, group of cylinders, or sharp nose (triangular) pier shapes. When the
user selects a shape, the Kl factor for the CSU equation and the Phi factor for
the Froehlich equation are automatically set. The user can set the pier nose
shape for all piers, or a different shape can be entered for each pier.

a: This field is used to enter the width of the pier. The program automatically
puts a value in this field based on the bridge input data. The user can change
the value.

DSO: Median diameter of the bed material of which 50 percent are smaller.
This value is automatically filled in for each pier, based on what was entered
for the left overbank, main channel, and right overbank, under the contraction
scour data. The user can change the value for all piers or any individual pier.

YI: This field is used to display the depth of water just upstream of each pier.
The value is taken from the flow distribution output at the cross section just
upstream and outside of the bridge. If the user has selected to use the
maximum Y1 and V1 for the pier scour calculations, then this field will show
the maximum depth of water in the cross section for each pier. The user can
change this value directly for each or all piers.

VI: This field is used to display the average velocity just upstream of each
individual pier. The value is taken from the flow distribution output at the
cross section just upstream and outside of the bridge. If the user has selected
to use the maximum Y I and VI for the pier scour calculations, then this field
will show the maximum velocity of water in the cross section for all piers.
The user can change this value directly for each or all piers.
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Angle: This field is used to enter the angle of attack of the flow approaching
the pier. If the flow direction upstream of the pier is perpendicular to the pier
nose, then the angle would be entered as zero. If the flow is approaching the
pier nose at an angle, then that angle should be entered as a positive value in
degrees. When an angle is entered, the program automatically sets a value for
the K2 coefficient. When the angle is > 5 degrees, K1 is set to 1.0.

L: This field represents the length of the pier through the bridge. The field is
automatically set by the program to equal the width of the bridge. The user
can change the length for all piers or each individual pier. This length is used
in determining the magnitude of the K2 factor.

Kl: Correction factor for pier nose shape, used in the CSU equation. This
factor is automatically set when the user selects a pier nose shape. The user
can override the selected value and enter their own value.

K2: Correction factor for angle of attack of the flow on the pier, used in the
CSU equation. This factor is automatically calculated once the user enters the
pier width (a), the pier length (L), and the angle of attack (angle).

K3: Correction factor for bed condition, used in the CSU equation. The user
can select from: clear-water scour; plane bed and antidune flow; small dunes;
medium dunes; and large dunes.

D95: The median size of the bed material of which 95 percent is finer. The
095 size fraction is used in the computation of the K4 factor, and must be
entered directly by the user.

K4: The K4 factor is used to decrease scour depths in order to account for
armoring of the scour hole. This factor is only applied when the 050 of the
bed material is greater than 0.006 feet (0.002 m) and the 095 is greater than
0.06 feet (0.02 m). This factor is automatically calculated by the program,
and is a function of 050; 095; a; and the depth of water just upstream of the
pier. The K4 factor is used in the CSU equation.

a!: The projected pier width with respect to the direction of the flow. This
factor should be calculated by the user and is based on the pier width, shape,
angle, and length. This factor is specific to Froehlich's equation.

Phi: Correction factor for pier nose shape, used in the Froehlich equation.
This factor is automatically set when the user selects a pier nose shape. The
user can override the selected value and enter their own value.

For the example shown in Figure 12-4 the CSU equation was used, resulting
in a computed pier scour of 10.85 feet (3.31 m) at each pier (shown under
summary results in Figure 12-4). Also shown in Figure 12-4 is an updated
graphic with both contraction and pier scour shown.
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Entering Abutment Scour Data

Abutment scour can be computed by either the HIRE equation (Richardson.
1990) or Froehlich's equation (Froehlich, 1989). The input data and results
for abutment scour computations are shown in Figure 12-5.
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Figure 12.5 Example Abutment Scour Computations

As shown in Figure 12-5, abutment scour is computed separately for the left
and right abutment. The user is only required to enter the abutment type
(spill-through, vertical, vertical with wing walls). The program automatically
selects values for all of the other variables based on the hydraulic output and
default settings. However, the user can change any variable. The location of
the toe of the abutment is based on where the roadway embankment intersects
the natural ground. This stationing is very important because the hydraulic
variables used in the abutment scour computations will be obtained from the
flow distribution output at this cross section stationing. If the user does not
like the stationing that the model picks, they can override it by entering their
own value.
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Each of the variables that are used in the computation of abutment scour are
defined below, as well as a description of where each variable is obtained
from the output file.

Toe Sta at Bridge: This field is used to define the stationing in the upstream
bridge cross section (section BU), where the toe of the abutment intersects the
natural ground. The program automatically selects a value for this stationing
at the point where the road embankment and/or abutment data intersects the
natural ground cross-section data. The location for the abutment toe
stationing can be changed directly in this field.

Toe Sta at App.: This field is used to define the stationing in the approach
cross section (section 4), based on projecting the abutment toe station onto the
approach cross section. The location for this stationing can be changed
directly in this field.

Length: Length of the abutment and road embankment that is obstructing the
flow. The program automatically computes this value for both the left and
right embankments. The left embankment length is computed as the
stationing of the left abutment toe (projected up to the approach cross section)
minus the station of the left extent of the active water surface in the approach
cross section. The right embankment length is computed as the stationing of
the right extent of the active water surface minus the stationing of the toe of
the right abutment (projected up to the approach cross section), at the
approach cross section. These lengths can be changed directly.

Yl: This value is the computed depth of water at the station of the toe of the
embankment, at the cross section just upstream of the bridge. The value is
computed by the program as the elevation of the water surface minus the
elevation of the ground at the abutment toe stationing. This value can also be
changed by the user. This value is used in the HIRE equation.

Kl: This value represents a correction factor accounting for abutment shape.
The user can choose among: vertical abutments; vertical with wing walls; and
spill-through abutments.

Skew: This field is used to enter the angle of attack of the flow against the
abutment. A value of 90 degrees should be entered for abutments that are
perpendicular to the flow (normal situation). A value less than 90 degrees
should be entered if the abutment is pointing in the downstream direction. A
value greater than 90 degrees should be entered if the abutments arc pointing
in the upstream direction. The skew angle is used in computing the K2
factor.

K2: Correction factor for angle of attack of the flow on the abutments. This
factor is automatically computed by the program. As the skew angle becomes
greater than 90 degrees. this factor increases from a value of one. As the
skew angle becomes less than 90 degrees, this value becomes less than one.
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Equation: This field allows the user to select a specific equation (either the
HIRE or Froehlich equation), or select the default mode. When the default
mode is selected, the program will choose the equation that is the most
applicable to the situation. The selection is based on computing a factor of
the embankment length divided by the approach depth. If this factor is
greater that 25, the program will automatically use the HIRE equation. If the
factor is equal to or less than 25, the program will automatically use the
Froehlich equation.

L!: The length of the abutment (embankment) projected nonnal to the flow
(projected up to the approach cross section). This value is automatically
computed by the program once the user enters an abutment length and a skew
angle. This value can be changed by the user.

Ya: The average depth of flow (hydraulic depth) that is blocked by the
embankment at the approach cross section. This value is computed by
projecting the stationing of the abutment toe's up to the approach cross
section. From the flow distribution output, the program calculates the area
and top width left of the left abutment toe and right of the right abutment toe.
Ya is then computed as the area divided by the top width. This value can be
changed by the user directly.

Qe: The flow obstructed by the abutment and embankment at the approach
cross section. This value is computed by projecting the stationing of the
abutment toes onto the approach cross-section. From the flow distribution
output, the program calculates the percentage of flow left of the left abutment
toe and right of the right abutment toe. These percentages are multiplied by
the total flow to obtain the discharge blocked by each embankment. These
values can be changed by the user directly.

Ae: The flow area that is obstructed by the abutment and embankment at the
approach cross section. This value is computed by projecting the stationing
of the abutment toes onto tl,e approach cross-section. From the flow
distribution output, the program calculates the area left of the left abutment
toe and right of the right abutment toe. These values can be changed by the
user directly.

VI: The velocity at the toe of the abutment, taken from the cross section just
upstream and outside of the bridge. This velocity is obtained by finding the
velocity in the flow distribution output at the corresponding cross section
stationing of the abutment toe. These values can be changed by the user
directly.
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In addition to the abutment input data, once the compute button is pressed, the
bridge scour graphic is updated to include the abutment scour and the
summary results window displays the computed abutment results. For the
example shown in Figure 12-5, the program selected the HIRE equation and
computed 10.74 feet (3.27 m) of local scour for the left abutment and 14.90
feet (4.54 m) of local scour for the right abutment.

Computing Total Bridge Scour

The total scour is a combination of the contraction scour and the individual
pier and abutment scour at each location. Table 12.1 shows a SUlTImary of the
computed results, including the total scour.

Table 12.1
Summary of Scour Computations

Right O.B.
000 ft (0.0 m)

Contraction Scour
Main Channel
6.67 ft (2.03 m)
Live-Bed

Left O.B.
Ys = 2.06 ft (0.63 m)
Eqn = Clear-Water

Piers 1-6
Pier Scour
Ys= 10.85 ft(3.31 m)
Eqn. = CSU equation

Abutment Scour

Ys=
Eqn =

Left Right
10.74 ft (3.27 m) 14.90 It (4.54 m)
HIRE equation HIRE equation

Total Scour
Left Abutment
Right abutment
Piers 1-2 (left 0.8.)
Piers 3-6 (main ch.) =

13.00 It (3.96 m)
21.57 It (6.58 m)
13.11 It (400 m)
17.52 It (5.34 m)

Once all three types of scour data are entered, and the compute button is
pressed, the bridge scour graphic is updated to reflect the total computed
scour. Shown in Figure 12-6 is the graphic of the final results (the graphic
has been zoomed in to see more detail). The graphic and the tabular results
can be sent directly to the default printer, or they can be sent to the Windows
Clipboard in order to be pasted into a report. A detailed report can be
generated, which shows all of the input data, computations, and final results.
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The bridge scour input data can be saved by selecting Save Hydraulic
Design Data As from the File menu of the Hydraulic Design Function
window. The user is only required to enter a title for the data. The computed
bridge scour results are never saved to the hard disk. The computations can
be performed in a fraction of a second by simply pressing the compute button.
Therefore, when the Hydraulic Design Function window is closed, and later
re-opened, the user must press the compute button to get the results.
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CHAPTER 13

Performing Channel Modifications

The channel modification option in HEC-RAS allows the user to perform a
series of trapezoidal cuts into the existing channel geometry. In general, this
option is used for planning studies, but it can also be used for hydraulic
design of flood control channels.

This chapler does not cover the concepts of stable channel design. This
software is designed to evaluate the hydraulics of various channel
modifications. It is up to the user to ensure that any channel modification will
not cause further scour of the channel bed and banks. Discussions on stable
channel design can be found in many hydraulic text books, as well the Corps
Engineering Manual "Hydraulic Design of Flood Control Channels"
(US ACE, 1991).

This chapter discusses: general modeling guidelines for using the channel
modification option; how to enter the necessary input data; performing the
channel modifications; and how to compare existing condition and modified
condition results.

Contents

• General Modeling Guidelines

• Entering Channel Modification Data

• Performing The Channel Modifications

• Comparing Existing and Modified Conditions

13-1



Chapler 13 Performing Channel Modifications

General Modeling Guidelines

In order to perform a channel modification analysis, the user should first
develop a hydraulic model of the existing river reach containing the area in
which the channel modification will be analyzed. This model should include
several cross sections downstream from the study reach, such that any user
defined downstream boundary condition does not affect the hydraulic results
inside the channel modification region. The model should also include
several cross sections upstream of the study reach, in order to evaluate the
effects of the channel modification on the water surface profile upstream.

Once a model of the existing river system is completed, the user can use the
Channel Modification option to perfonn trapezoidal cuts and fills into the
existing geometry. Once the user has performed all of the desired channel
modifications, then the modified geometry data is saved into a new geometry
file. The user can then create a new plan, which contains the modified
geometry and the original flow data that was used under the existing
conditions plan. Computations can then be performed for the modified
condition, and the user can compare the water surface profiles for both
existing and modified conditions.

The channel modification option in HEC-RAS allows for:
• Multiple trapezoidal cuts (up to three)
• Independent specification oflef! and right trapezoidal side slopes
• Ability to change the Manning's n value for the trapezoidal cut
• Separate bottom widths for each trapezoidal cut
• Ability to set new channel reach lengths
• Multiple ways of locating the main channel centerline
• User can explicitly define the elevation of the new channel invert, or it

can be based on the original channel invert, or it can be based on
projecting a slope from a downstream cross section or an upstream cross
section

• The centerline ofrhe trapezoidal cut can be entered directly, or it can be
located midway between the original main channel bank stations

• Option to fill the existing channel before performing cuts
• Cut and fill areas and volumes are computed

Entering Channel Modification Data

Within HEC-RAS, the data for perfonning a channel modification analysis
are entered from the Geometric Data window. The channel modification data
are stored within the geometry file of the base geometric data ( the geometric
data set in which the channel modification is being performed on).
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To bring up the Channel Modification Data window, select Channel
Modification from the Tools menu of the Geometric Data window. When
this option is selected, a Channel Modification window will appear as shown
in Figure l3.l (except yours will not have any data in it the first lime you
hring it up).
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Figure 13.1 Channel Modification Data Editor

As shown ill Figure 13.1, there are several pieces of data that the user must
enter in order to perform a channel modification analysis. The editor is
divided into three separate areas. The top portion of the window contains
selection boxes for the River and Reach; titles for the base geometry file and
the modified geometry file; buttons for performing the cuts and viewing cut
and fill volumes; and controls for rotating the graphic. The middle portion of
the window contains a data input area for entering channel modification
information over a range of cross sections, as well as a graphic of the cross
sections that are being modified. The bottom portion of the window contains
a table that lists the channel modification data for all of the cross sections in
the selected Reach of a particular River.
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The first step in performing a channel modifkation is to select the River and
Reach in which you want to perform the analysis. This is accomplished from
the River and Reach selection boxes in the upper left corner of the window.
The next step is to select a range of cross sections in which you would like to
perform a channel modification. This is accomplished by first selecting a
cross section from the Starting Riv Sta box and then from the Ending Riv
Sta box. Once this is done, all of the cross sections within the range of the
specified starting and ending river stations will appear in the graphic on the
right. The next step is to specify the channel modification data that you
would like to apply to this range of cross sections. This is accomplished by
entering information into the table contained in the "Set Range of Values"
area of the window. This table allows the user to enter information for up to
three cuts, which can then be applied to the selected range of cross sections.
The information contained in this table is as follows:

Center Cuts (yin): This column in the table is used to define how the
trapezoidal cuts will be centered within the existing cross section data. If the
user enters a "y" in this column, then that particular cut will be centered
between the existing cross-section main channel bank stations. When all of
the cut information is entered, and the Apply Cuts to Selected Range button
is pressed, the program will automatically fill in the center stationing of the
trapezoidal cuts in the lower table. If an "n" is entered, then it is up to the
user to specify the center stationing for each cross section, and each cut, in
the table at the bottom of the window.

Bottom Width: This column is used for entering the bottom width of the
trapezoidal cuts. If this column is left blank, it is assumed that the bottom
width will be zero. The user always has the option of directly entering the
bottom width for each cross section in the table at the bottom of the window.

Invert Elevation: This column is used to specify the invert elevation of the
trapezoidal cuts. If this column is left blank for a particular cut, then it is
assumed that the invert elevation of that trapezoidal cut will be set equal to
the invert elevation of the existing channel. If the user wants to have invert
elevations that are not equal to the existing channel inverts, then they must
enter elevations into this column and select one of the slope projection
options below this table. The user has the option to use the specified invert
elevations for each of the cross sections in the selected range; or they can
enter elevations for the most upstream cross section and have the other invert
elevations computed by projecting the cuts on a constant slope; or the
elevations entered can be applied to the most downstream cross section of the
range, and all others will be computed by projecting a user specified slope
upstream.
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Left Slope: This column is used to specify the slope of the left bank for each
of the trapezoidal cuts. The slope is entered in units of horizontal distance to
one unit in the vertical. (e.g., a value of 2 means the left bank slope will
project 2 feet horizontally for every I foot vertically).

Right Slope: This column is used to specify the slope of the right bank for
each of the trapezoidal cuts. The slope is entered in units of horizontal
distance to one unit in the vertical. (e.g., a value of2 means the right bank
slope will project 2 feet horizontally for every I foot vertically).

Cut n Val: This column is used to specify the new Manning's n value to be
applied to each of the trapezoidal cuts. If this column is left blank for any
cut, then the existing n values will be used for that cut.

Once this table has been filled out, the user must select one of the three slope
projection options listed below the table. The three options are:

Same Cut to all sections: If this option is selected, then the channel
modification data entered into the table will be applied to all of the cross
sections in the selected range.

Project cut from upper RS at slope: When this option is selected, the invert
elevations that were entered into the table will be applied to the most
upstream cross section in the selected range. The invert elevation of all of the
other cross sections will be based on projecting a user entered slope from the
Inost upstream cross section to each cross section downstream. The user must
enter a slope when this option is selected. The elevations of each cross
sections trapezoidal cuts are based on the user entered slope times the
distance that each cross section is from the most upstream cross section. The
distance is the cumulative main channel reach length for each of the
individual cross sections.

Project cut from lower RS at slope: When this option is selected, the invert
elevations that were entered into the table will be applied to the most
downstream cross section in the selected range. The invert elevation of all of
the other cross sections will be based on projecting a user entered slope from
the 1110st dowI1strean1 cross section to each cross section upstream. The user
must enter a slope when this option is selected. The elevations of each cross
section's trapezoidal cuts are based on the user entered slope times the
distance that each cross section is from the most downstream cross section.
The distance is the cumulative main channel reach length for each of the
individual cross sections.

A final option that can be applied to the selected range of cross sections is the
Fill Channel option. When this option is turned on, the main channel of the
base cross-section data will be filled before any of the trapezoidal cuts are
applied. The main channel is filled to an elevation equal to the elevation of
the lower of the two main channel bank stations.
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Once the user has filled in all of the desired data in the "Set Range of Values"
data area, then the Apply Cuts to Selected Range button should be pressed.
When this button is pressed, the lower table is filled with the specific
information that will be applied to each of the cross sections in the selected
range. The cut infonnalion is then applied to each of the cross sections, and
the graphic is updated to show both the existing cross section and the
modified cross sections.

The user has the option of entering and modifying the channel modification
data directly in the table at the bottom of the window, or they can use the "Set
Range of Values" data area to apply a set of channel cut properties to a range
of cross sections (this can be done several times for different ranges of cross
sections within the reach).

A final option available to the user is Cut cross section until cut daylights
once. This is a global option lhat will be applied to all of the channel
modification data. When this option is selected, as the program performs the
cutting of the trapezoidal channel, the left and right banks of the channel will
slarl at the bottom of the trapezoid and cut through the ground until they
reach open air, then the cutting will stop. If this option is turned off, the left
and right banks of the trapezoid will be projected to infinity, continually
cutting any ground that lies above them.

Performing the Channel Modifications

Once all of the desired channel modification data are entered for a reach, the
user should press the Compute Cuts button al the top of the graphic. When
this button is pressed, all o[ the channel modification data from the lower
lable is applied and the graphic is updated to retlect the new cut information.
The user can continue to modify the data and press the Compute Cuts button
as many times as is necessary to get the desired cuts. The cut information is
always applied to the base geometry data.

Once the user has completed the desired channel modifications [or the reach,
they can view the cut and fill quantities by pressing the Cut and Fill Areas
button. When this button is pressed, a window will appear as shown in
Figure 13.2.
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River: CriticaIC," Reach: Upper Re &
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Figure 13.2 Channel Modification Cut and Fill Quantities

The cut and fill quantities table shows the cut, fill, and net areas and volumes
for each of the individual cross sections, as well as the totals for the reach.
The table shows the cut and fill quantities that were necessary in order to
transform the existing cross-section data into the modified cross-section data.
The areas and volumes are provided in the categories of left overbank, main
channel, right overbank, and total. These categories are based on the main
channel bank stalions of the base geometry data. The volumes listed at a
particular cross section, represent the volume between that cross section and
the next downstream cross section. The total volume and area at a particular
cross section is the Sll111 of the Jeft overbank, main channel, and right
overbank quantities for that individual cross section only. Total volumes for
the entire reach are listed at the bottom ofrhe table. The Cut and Fill
Quantities table can be printed, sent to a file, or copied to the clipboard, by
pressing the desired button at the bottom of the window.

The channel modification option has been set up to work with one Reach of
the model al a time. If the user needs to perform channel modifications to
more than one reach of a multiple reach model, they can simply select a new
reach at any time. While the information in the tables and the graphic only
show a single reach, the channel modification information is stored for all of
the reaches.
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Once the user has finished all of the desired channel modifications, for all of
the desired reaches, a new geometry file should be created for the modified
geometry. To create a modified geometry file, the user must enter a title for
the modified geometry file in the upper right hand side of the window. Once
the new geometry file title is entered, the file can be created by pressing the
Create Modified Geometry button at the bottom of the window. When this
button is pressed, a Save Geometry Data As window will appear. The user
has the options to change the directory in which the geometry file will be
stored, change the name of the geometry file title, or select an existing
geometry file to over write. Once the user has decided on a title and a
directory, the OK button can be pressed to save the modified geometry to the
hard disk. However, the original geometry file is still the one that is in
memory. If the user wants to work with the new modified geometry file, they
will need to open it from the Geometric Data Editor window.

Note: the data entered into the channel modification editor is saved as part of
the base geometry file (i.e., it is not saved with the modified geometry file).
This allows the user to open the base geometry file and recreate the modified
geometry. In order for this data to be saved, the user must select Save
Geometry Data from the file menu of the geometric data editor, after they
have entered the channel modification data.

Comparing Existing and Modified Conditions

Once a modified geometry file is created, the user can create a new plan that
will incorporate the modified geometry and the previously defined flow data.
This is accomplished by first opening the modified geometry file from the
Geometric Data window. The next step is to open the Steady Flow Analysis
window and create a new Plan. Creating a plan is accomplished by selecting
New Plan from the File menu of the Steady Flow Analysis window. Once a
new plan is created, the computations can be performed.

After the water surface profile computations have been performed for the
modified channel conditions, the user can compare the results of the existing
and modified conditions on any of the graphics and tables. An example
cross-section plot of the two plans is shown in Figure 13.3. Figure 13.3
shows the geometry of the modified and existing conditions, along with the
computed water surface elevations from both the existing and modified plans.
To display the geometry and results from more than one plan on a graphic,
the user can select Plan from the Options menu on any of the graphics. At
the top of the plan selection window, turn on the option that says "Compare
Geometry As Well As Output." Select the two plans to be viewed and hit
the OK button. The geometry and output for both plans will be displayed.

In addition to graphical output, the user can review the computed results from
both plans in a tabular form. Figure 13.4 shows the computed results for both
plans in Standard Table I of the Profile Output table.
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C HAP T E R 14

Using GIS Data With HEC-RAS

HEC-RAS has the ability to import three-dimensional (3D) river schematic
and cross section data created in a GIS or CADD system. While the HEC­
RAS software only utilizes two-dimensional data during the computations,
the three-dimensional information is used in the program for display
purposes. After the user has completed a hydraulic analysis, the computed
water surface profiles can be exported back to the GIS or CADD system for
development and display of a flood inundation map.

The importing and exporting of GIS or CADD data is accomplished through
the use of formatted ASCII text files. The text files provide a generic way of
exchanging data between G IS/CADD systems and HEC-RAS, without
adopting any single GIS/CADD system. Appendix B of this manual
provides a detailed description and examples of the l1Ie formats used for
importing and exporting GIS or CADD data.

The HEC has developed an ArcYiew GIS extension called GeoRAS, that was
specifically designed to process geospatial data for use with ~IEC-RAS. The
GeoRAS software allows a user to write geometric data to a file in the
required format for HEC-RAS. Additionally, the users can read the HEC­
RAS results into GeoRAS and perform the flood inundation mapping. This
software is not part of the HEC-RAS program. The software and a user's
manual are provided as a separate program to be used with ArcYiew. Also,
the Intergraph Corporation has adding the capability to exchange data with
HEC-RAS in their Software package called Stonn and Sewer Works
(lntergraph, 1999)

This chapter discusses how to import GIS or CADD data into HEC-RAS;
what additional information will need to be added to complete the data; and
how to export the results back to the GIS or CADD system.

Contents

• General Modeling Guidelines

• Importing GIS or CADD Data Into HEC-RAS

• Completing The Data and Performing The Computations

• Exporting Computed Results To The GIS or CADD
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Chapter 14 Using GIS Data With HEC-RAS

General Modeling Guidelines

The current version of HEC-RAS has the ability to import the following
geometric data from a GIS/CADD system:

River System Schematic. The structure of the stream network as
represented by a series of interconnected reaches. Each reach is represented
as a multi-point line, which is assumed to follow the invert of the main
channel. The River and Reach labels, as well as the Junction labels, are also
imported from the GIS/CADD.

Cross Section Data. The following cross section data can be imported from
a GIS/CADD:

I. River, Reach, and River Station identifiers.

2. Cross Section Cut Lines (X and Y coordinates of the plan-view line
that represents the croSS section). This is a multi-point line that can
have two or more points.

3. The cross section surface line. This line is sent to HEC-RAS as a
series of X, Y, Z coordinates for each point in the cross section.
HEC-RAS transforms these coordinates into station and elevation
points (X and Y) for computational purposes. The first station of the
cross section is always set to zero. The true (real world) coordinates
of the cross section are recomputed from the cross section cut line for
the purposes of displaying the data (3D plot).

4. Cross section main channel bank stations.

5. Downstream reach lengths for the left overbank, main channel, and
right overbank.

6. Manning's n values.

7. Levee locations and elevations.

8. Ineffective flow areas.

9. Top of road station and elevation for bridges and culverts.

10. Storage area boundaries and elevation versus volume relationship.

At this time, contraction and expansion coefficients, optional cross section
properties (blocked obstructions, etc.), and hydraulic structure data (bridges,
culverts, etc..) are not imported from a GIS/CADD system. Many of these
variables will be added in future versions of the software.

The general procedure for utilizing GIS/CADD data with HEC-RAS is the
following:
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I. The first step is to start a ew Project. This is accomplished from the
File menu of the main HEC-RAS window.

2. The next step is to go to the Geometric Data editor and import the
GIS/CADD data into HEC-RAS. G1S/CADD data are imported by
selecting Import Geomtric Data, and then GIS Format from the
File menu on the Geometric Data window. This is assuming that you
have already used a GIS system to write the required geometry data
into a text file, using the required HEC-RAS format. The format of
this file is described in Appendix B of this manual.

3. After the GIS data are imported, the user will need to add any
additional geometric data that is needed to represent the physical
system.

4. The next step is to perform the water surface profile calculations for
the desired flow rates.

5. Once the water surface profiles are calculated, the user can then
output the results to a text file using the Export GIS Data option
from the File menu of the main HEC-RAS window.

6. The last step is to import the HEC-RAS results file into the
GIS/CADD system and develop the floodplain maps for each of the
profiles.

Once the user has a project that is utilizing GIS data, then additional data can
be imported directly into an existing HEC-RAS geometry file without starting
a new project. This allows the user to go back to the GIS and extract
additional cross sections on an as-needed basis. The HEC-RAS program will
automatically place the new cross sections into the appropriate River and
Reach, based on the identifiers defined for each cross section in the GIS
import file.

After the user has performed the hydraulic analyses, the computed water
surface profiles information can be written to a text file, which can then be
imported into the GIS for development and display of floodplain maps. HEC­
RAS exports the cross section Cut Line coordinates (X and V), as well as the
water surface elevation for each profile. This is done for every cross section
in the model. Additionally, the program exports a series of bounding
polygons (one per river reach) for each computed profile. For information
on the HEC-RAS GIS export file format, review the detailed write up found
in Appendix B of this manual.
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Importing GIS or CADD Data Into HEC-RAS

Within HEC-RAS, GIS data are imported from the Geometric Data Window.
To import geometric data from a GIS/CADD system into HEC-RAS, the
following steps should be followed:

I. The first step is to extract the necessary geometric information from a
GIS/CADD system and write it to a text file in the required HEC­
RAS format. As mentioned previously, HEC has developed an
ArcView GIS extension called GeoRAS to help you do this.
Likewise, the Intergraph Corporation has added this capability to their
program called Stream and Storm Works. You have the option of
obtaining the GeoRAS software from HEC (for use in ArcView);
using the software developed by Intergraph; or developing your own
routines to extract this data from the GIS/CADD system of your
choice. The file formats for the required text file are outlined in
Appendix B of this manual.

2. The next step is to start a new project in HEC-RAS. This is
accomplished by selecting the New Project option from the File
menu of the main HEC-RAS window. This option will allow the user
to enter a project title and filename.

3. After a new project is started, the user should open the Geometric
Data Editor. Once the editor is opened, the user can import
GIS/CADD data into HEC-RAS by selecting the Import Geometry
Data - GIS Format option from the File menu of the Geometric Data
window. When this option is selected, a window will appear (Figure
14.1) in which the user can select the file that contains the geometry
data from the GIS.

Import #G15 Format data file .:-

C \HEC\Ras30\Data

DiectOfies
-----=~~---
File Name

IWAILUPE GEO

Hie

...:jC:\
...:jHEC
...:jRas30
_Data

OK Cancel Help Creale Di,eciOlY I
lSelect GIS Format file to import

Figure 14.1 Window for Selecting GIS Data File To Import
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4. Once the user selects the file containing the GIS data, and then
presses the OK button, a window will appear that will show you what
is available within the import file, and it will allow you to select what
you want to import (Figure 14.2)

Import Options "~.

Intro 1 Riyer Reach Shearn Lines i::£IQsi:S·e~ilOns::ar';,;fi:6:N~:a:e:i::\1 StOfaQe to.reas and Connections I

Import River I[.6.11 Rivers) iJ Import .a.s: It new AS '" 9llt r,ew RS to import'" 91

Import Reach I .-:oJ lmpOitAs: Check onl}' the new river stations

~~Thelll1 Oiled AS canbee<f,.<lhere ella lhei II Rl\Ier and Reach names on the revlOUs tab
Import File Import ne Impo/t File ImpoltAs IImport IImport jRiver Reach RS RS I Status I Data

1 Kulai GOlge headwaters 031 0.3t rr.w P"
2 Kulai Gorge headwaters 0.2'3 0.28 r.ew P"
3 Kula< GOlQe heddwalels 027 027 ne'.... P"
4 Kula! Gorge headwaters 022 0.22 new P"
5 Kulao GOlQe headwatels 0.17 0.17 ne...... P"
6 Kula; GOlQe headwalefS 014 0.14 new P"
7 Kulai Gorge headwatels 011 0.11 r1E".~1 P"
B Kulal GOfge headwatels 008 0.09 roew P"
9 Kulai GOfQe headwaters 007 0.07 ne'''! P"

10 Wailupe upper 1.63 1.63 eXists P" -:J

P' GIS Cut Lines
W Station Elevation Data

P Reach Lengths
I
1;7 Bank StatIOns

I
I

I
I
I
I
I
I
I

(only available when lookinQ al a single reach)

Starting RS Value: rO--12 decimal plac,i]

Create RS In miles I Creale RS In feet I
Match ImpOII File RS to EXisting Geometl'y RS

Matching ToIelance ~ Match to Existmg I

Previous I Next I Finnhed -Impolt Data Cancel I

Figure 14.2 GIS Data Import Options Window

As shown in Figure 14.2, the user has several options when importing GIS
data. There are four tabs at the top of the window. The first tab is just an
introductory tab that explains how to proceed. The second tab River Reach
Steam Lines, allows the user to select which reaches found in the import file
will be imported. The next tab, Cross Sections and IB Nodes, allows the
user to select which cross sections and internal boundaries (bridges and
culverts) will be imported, as well as what specific cross section properties to
import. The final tab, Storage Areas and Connections allows the user to
select which storage areas and connections between storage areas to import.

After making the selections of what to import, The user presses the Finished
- Import Data button. The data will be imported and a schematic of the river
system will show up in the Geometric Data window (Figure 14.3). Once the
importing of the data is completed, the user should save the geometric data by
selecting Save Geometry Data As from Ihe File menu of the Geometric Data
window.
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Geometric Data - Imported From GIS .
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Figure 14.3 River System Schematic of Imported GIS Data
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Completing The Data and Performing The
Computations

Completing The Geometric Data

Once the user has imported the geometric data from a GIS/CADD system, the
next step is to add any additional data required to perform the analyses.
Depending on what data was extracted from the GIS (i.e. ifn-values were not
extracted from the GIS), the user may be required to enter Manning's n
values for all of the cross sections. Manning's n values can be entered
directly from the cross section data editor (on a cross section by cross section
basis) or through the Manning's n-values table (this is the preferred way
because the n values can be entered more efficiently). The Manning's n value
table is available from the Tables menu on the Geometric Data window.

In addition to the Manning's n values, the user may need to enter the
following data to complete the geometry file: additional user entered cross­
section data; interpolated cross sections; optional cross section properties
(ineffective flow areas, levees, blocked obstructions, etc.); and hydraulic
structures (bridges, culverts, weirs and spillways).

Entering Additional Cross Section Data

If additional cross sections are entered by the user from the cross section
editor (or through the HEC-2 import feature), the user will need to enler the
coordinates of the cross section strike line in order to maintain a geospatially
correct schematic and XYZ plot. The cross section strike line coordinates can
be entered by selecting XS Schematic Lines from the Edit menu on the
Geometric Data window. When this option is selected a window will appear
as show in Figure 14.4.
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Edit (ross Section lines for plan view O!'.s _

::oJOO~[I
::OJ RiverSla.: 1c-0.3-1--::J~[!J

RlVel. IKulul Golge

Reach. IHeadwaters

Selected Area Global Edits
Add Constant I

Schematic X

Muliply Factor I Set Values

SchematlcY

Cancel

1??~)}1~..... .......•.............................•........
2 583567.8
3 583558.73
4 583567.8
5
6
7
8
9

10
11
12

OK

47441.98
47529.68
47575.04
47638.55

~

Help I

Figure 14.4 Cross Section Schematic Line X and Y Coordinates

The coordinates that are entered for the cross section schematic lines must be
consistent with the previously entered GIS data (i.e., if the GIS data is in state
plane coordinates, then the user entered data must also be in state plane
coordinates). Once all of the cross section schematic lines have consistent
coordinates, the schematic and XYZ plot will provide a geospatially correct
display of the cross sections.

14·8



Chapter 14 I Ising G'S Data With HEC-RA S

Performing The Computations and Viewing Results

Once the user has completed the geometric data file, flow data can be entered
and the computations can be perfonned. When utilizing GIS data, there are
no special requirements for entering flow data or perfonning the
computations. Once the hydraulic computations are completed, the user can
begin to review the output. When GIS data are utilized, the HEC-RAS XYZ
perspective plot has the ability to plot a true three dimensional pcrspective of
the river system and the water surface profiles. An example XYZ plot with
GIS data is shown in Figure 14.5.

I X-Y-l Perspective Plot ~

File Option:;

..!J
Rotation Angle

Azimuth Angle

Wailupe River with GIS data -Example 17
Geom: Final Geometry Data - GIS + Interp + Br

Plan: Final Geometry Run
Flow: 50, 100,500 yr flow data

Legend

VV3 50 y,'
I I

VVS '100 yr
I I

"lVS 500 yr

Ground.
Bank Sta

Gro~lnd

Levee

Figure 14.5 XYZ Perspective Plot With GIS Data
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Exporting Computed Results To The GIS or CADD

Once the user has completed all of the hydraulic calculations, the computed
water surface profiles can be exported to the GIS/CADD in order to develop
floodplain maps. The HEC-RAS results are exported to an ASCII text file,
which can then be imported by the GIS/CADD system. The fonnat of the
HEC-RAS results file is documented in Appendix 8 of this manual.

Exporting the HEC-RAS computed water surface profiles to a GIS/CADD
system is accomplished by selecting Export GIS Data from the File menu on
the main HEC-RAS window. Once this option is selected, a window will
appear as shown in Figure 14.6.

GIS Export :,.

Browse .. I

Select Profiles to E;.:port I

Export File. IC:IHECIRas3010aloIWAILUPE.gi,

Results E:~port Options

P Export Water SUifaces

~=------========'

•

' - '150 Y,
•• 100YI

500y,

r Er;pOIt Velocity Ddlibution Into/malion whele available.

I f!)i·~::~:~i:$.!Q~!::~:.'~J~:~p.9r:~::~9r:m~:~

Geometr~' Data Export Options
P Expolt River (Stream) Centerlines

':"t:Ia;':: CrofS Secbon Surface Line; ~ _..::~ Additional Pro ertles

I ExpOIt User Defined [rD.ss Sections
lallXS's excepllnle,polaledXS's)

r E:~polt Interpolated Cross Sections

r.- Entire Cross Section
r Channel only

r Reach Lengths

r Bank Stations
r Levees

I IneffectIVe A,eas

Expolt Data I Cancel Help

Figure 14.6 Window to Enter a Filename For Exporting
Results to GIS

As shown in Figure 14.6, the user ftrst enters a ftlename for the HEC-RAS
Export file. Next, the user can select what they would like to export.
Normally the user would select "Export Water Surfaces," and then select
which profiles to export by using the Select Profiles to Export bunon. Once
these options are selected, the information can be exported by pressing the
Export Data button.

Additional options are available to export geometry data from HEC-RAS to
the GIS/CADD system. This option can be very useful for supplementing
terrain data with additional surveyed cross sections. It is a common
occurrence for terrain models to have good information in the overbank areas,
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but not as good, if at all, in the main channel. HEC-RAS allows the user to
export the entire cross section, or just the main channel portion only. Also.
the user can send all cross sections, including interpolated sections, or they
can turn off the interpolated cross sections. Additionally, there are options to
send reach lengths, bank stations, levees, and ineffective flow areas to the
GIS system.

In order to use the feature of sending terrain data from HEC-RAS to the GIS,
the user must enter geospatial coordinates for all of the cross sections, and the
stream centerline before exporting the data. These coordinates are required in
order to correctly locate the data spatially within the terrain model.
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CHAPTER 15

Stable Channel Design Functions

The channel design functions within HEC-RAS are based upon the methods
available in the SAM Hydraulic Design Package for Channels (US ACE,
1998), developed by the U.S. Army Corps of Engineers Waterways
Experiment Station. This chapter presents the data input required for
computing uniform flow parameters, stable channel dimensions, and sediment
transport capacity for a given cross section.

For information on the Channel Design Functions equations and theory,
please see Chapter 15 of the HEC-RAS Hydraulic Reference Manual.

Contents

• General Modeling Guidelines

• Uniform Flow Computations

• Stable Channel Design

• Sediment Transport Capacity
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General Modeling Guidelines

The Stable Channel Design Functions within HEC-RAS are meant to be used
as an aid in the design of stable channels. The purpose of this application is
to provide the qualitative, easy-to-use methodology of the SAM software
package within the HEC-RAS framework. Specifically, the Stable Channel
Design Functions will allow the user to easily compute the hydraulic
parameters of a given cross section, use that information to design a stable
channel with regard to its size and annoring, and determine the sediment
transport capacity of that cross section.

General Command Buttons

The general command buttons can be seen in the top right-hand corner of the
window shown in figure 15.1. The Defaults button restores the current
hydraulic design function's fields to the default values. The Apply button
will store the entries on the current window into memory. These values will
remain in memory until a new hydraulic design file is opened or the user exits
HEC-RAS. The Compute button initiates the computations for whatever
hydraulic design function is currently active. The Report button displays a
printable report providing detailed hydraulic design information. Output will
be displayed in the report window if the computations have been run.

Uniform Flow Computations

The uniform flow computations are perfonned by opening the Hydraulic
Design Functions window and selecting the Uniform Flow from the Type
menu item.. Once this option is selected the program will automatically go to
the geometry file and plot a cross section with the station and elevation data
entered into the table. The user can select any cross section from the available
rivers and reaches. The Hydraulic Design window for uniform flow will
appear as shown in Figure 15.1.

As shown in Figure 15.1, the Uniform Flow window contains the input data, a
graphic, and a window for summary results. Input data tabs included are the
S/Q/y/n tab and the Width tab. The S/Q/y/n tab is used for calculating the
nomlal slope, discharge, depth, or roughness for the current cross section.
The Width tab is used to calculate the bottom width for a uniform flow
solution of a user-entered compound channel (with up to 3 trapezoidal
templates). The station, elevation, and roughness values for both the current
cross section and the user-defined cross section can easily be manipulated in
the table and applied to the current geometry file. The user is required to
enter only a minimal amount of input and the computations can be performed.
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Figure 15.1 Hydraulic Design Window For Uniform Flow

Solving for Slope, Discharge, or WIS Elevation

When the S/Q/y/n tab has been selected, to calculate a slope that satisfies the
uniform flow equations for the current cross section, simply enter values into
the Discharge and a W/S Elev fields and press the Compute button. A value
for the slope is then automatically entered into the Slope field. Likewise, for
solving for discharge or water surface elevation, enter values for the other two
parameters.

The roughness values are automatically taken from the geometry file, but
these can be changed to better represent the bed characteristics of the cross
section. In addition to changing the value of the roughness factor (in the
default case, Manning's n), the function for defining roughness can be
changed. To do this, click on any cell in the equation column of the table and
select a function from the dropdown list. The available functions to choose
from are Manning's, Keulegan. Strickler, Limerinos, Brownlie, and five
grass-lined channel methods. Each of these functions is discussed in detail in
Chapter 15 of the Hydraulic Reference Manual.

For the Limerinos and Brownlie functions, gradation distribution is necessary
and can be entered by pressing the Gradation button. Only one gradation
distribution can be used for a given cross section and should be applied only
to the main channel, as these functions were developed for bed material. The
Gradation window is shown in Figure 15.2. The following gradation
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variables are defined as the following:

d84: The sediment particle size for which 84% of the sediment mixture is
finer (mm).

d50: The sediment particle size for which 50% of the sediment mixture is
finer (mm).

d16: The sediment particle size for which 16% of the sediment mixture is
tiner (mm).

~

d84. mm. II

OK O;lncel

Figure 15.2 Gradation Window

The Brownlie function requires a sediment specific gravity to be entered and
the KeuJegan function requires a temperature to be entered. The Compute
button only becomes active once all required input is entered.

To solve for a roughness value, click on and delete only one of the roughness
values in the table. Only one roughness section can be solved for at a time.
Make sure Slope, Discharge, and W/S Elev are specified and all other
required input are entered. RAS then computes a Manning's n value to
satisfy the unifonn flow equation for the portion of the cross section that is
desired. Then, the roughness value is back-calculated to match the selected
roughness function. Only Manning, Keulegan, and Strickler functions can be
used to solve for roughness, since the other functions do not have a
representative roughness value to solve for.

Once one computation has been made, the value that was solved for will be
shown in bold font. For subsequent computations, any of the four uniform
flow parameters that is emboldened will be what is solved for to avoid having
to delete out the value every time. Once a new parameter is deleted out, it
will then be solved for and emboldened.

Solving for Bottom Width

Bottom width can be solved for the uniform flow equation only with a
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compound channel that is defined by the user. The compound channel may
contain up to three trapezoidal templates, a low flow channel, the main
channel, and the overbank channel. The bottom width of either the main
channel or the overbank may be solved for. The addition or subtraction of
width may be applied to right of centerline, left of centerline or equally to
both sides.

When the bottom width tab is selected, the window shown in Figure 15.3 is
displayed. To define the compound channel, enter the appropriate values into
the compound channel table, which is located below the station elevation
table. Data for the Overbank, Main, and Low Flow channels can be entered,
however data for the low flow channel can only be applied if a main channel
is also defined. The following variables are defined as follows:

SSL: The side slope of the left side of the channel. Entering a value of "0"
provides a vertical slope (1 Vertical: Horizontal).

SSR: The side slope of the right side of the channel. Entering a value of "0"
provides a vertical slope (I Vertical: _Horizontal).

WL: The bottom width of the left side of the channel from the centerline of
the channel to the toe ofthe side slope (ft or m).

WR: The bottom width of the left side of the channel from the centerline of
the channel to the toe of the side slope (ft or m).

Height: The height of the respective channel from its invert to the top of its
side slope (ft or m).

Invert: The invert of the respective channel (ft or m).

Once the channel template data is entered, the user may plot the data by
selecting Apply Geometry. When this button is selected, the channel design
is shown in the plot window and entered in the station elevation table with the
default roughness information. A Manning's n value of 0.03 will be applied
to each of the channel templates defined. The user may then adjust the
roughness values, change the roughness functions, or add more roughness
change locations within the cross section on the station elevation table. Any
changes made can be reapplied to the plot by pressing Apply Geometry. See
Figure 15.4. If either the Brownlie or Limerinos functions are chosen,
gradation data will have to be entered.

A value for the energy slope, discharge, and water surface elevation must be
entered in the appropriate fields. The user can then select how to solve for
the bottom width by using the dropdown boxes in the "Compute Widths"
section. Either the main channel or the overbank channel can be solved for
and the width can be applied to the left side of the channel (Left ofCL only),
the right side of the channel (Right of CL only), or equally to both (Total).
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When all required data is entered, the Compute button will become active.
The computations are constrained from creating unrealistic geometries. One
example is the overbank bottom width cannot become less than the top width
of the main channel. Likewise, the main channel bottom width cannot
become less than the low flow channel top width. If this situation occurs
within the computations, the user is notified and a course of action is
suggested. However, if the top width of a lower channel becomes greater
than the bottom width of the channel above it within the calculations, the
program automatically increases the upper channel's bottom width to
compensate.

When a solution is obtained, the new widths are updated in the compound
channel table, the station elevation table and the plot.

Applying Uniform Flow Data to the Geometry File

The resulting cross section, displayed in the plot window can be added to the
existing geometry data by clicking on the "Copy XS to Geometric Data"
command button. The following window will appear:

..
Seiad 0 River and Reach end than enter e river s:tation

'~ ,~" .0:;'1<'1' ~j tttO;\~ ...~F ~ ,~ \ ..

Rillel !Seever Creek

Reech lKent-Nood iJ RN8rSte

OK C"nee! .J

Figure 15,5 Copy Cross Section Window

Enter in the river station you want this cross section to be applied to. If the
selected river station already contains a cross section, RAS will ask if you
want to copy over it. If there is no cross section at the entered river station,
RAS will automatically adjust the distances between the new cross section
and its adjacent ones. Make sure that once the new cross section has been
copied to the geometry, appropriate values for the bed elevations are
reentered. This can easily be done by selecting "Adjust Elevations .. " in the
Option menu of the Cross Section Data window.

Saving Uniform Flow Data

To save the uniform flow data, click on File ... save. This will add all
pertinent data from all the HD Functions to an ascii file with the extension
*h##. The content of this file can easily be read within any word processing
program.
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Stable Channel Design

Stable channels can be computed using three different methods:

• Copeland
• Regime
• Tractive Force

To access the stable channel design window, click on Type ... Stable Channel
Design in the Hydraulic Design Window. The following window will
become active:
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Figure 15.6 Stable Channel Design Window

Copeland Method

To use the Copeland Method, select the tab named "Copeland." There are a
number of required and optional fields to enter data into for both the design
section and the upstream section. To enter in data for the design section,
simply add data to the fields shown.

Discharge: The design discharge. Can be the 2-year, IO-year, bankfull, etc.
Must represent the channel forming discharge (cfs or m'/s).

Specific Gravity: Self-explanatory. Default is 2.65.

Temperature: A representative temperature of tbe water. Default is 55
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degrees F or 10 degrees C.

Valley Slope: (Optional) The maximum possible slope for the channel invert
(i.e. no channel sinuosity). If the slope returned is greater than the valley
slope, HEC-RAS will indicate that this is a "sediment trap."

Med. Channel Width: (Optional) Median channel width. The median width
of the array of 20 bottom widths that are solved for. There will be 9 widths
less than and 10 widths greater than the median channel width all at an
increment of 0.1 X Med. Channel Width (ft or m). [fthis is left blank, the
median width assigned will be equal to the regime width by the following
equation: B = 2Q°.5

Side Slope: Slope of the left and right side slopes. (I Vertical: _Horizontal).

Equation: Can choose from Mannings or Strickler to solve for the side slope
roughness.

nor k: IfMannings is selected, enter a Mannings "n" value. If Strickler is
selected, enter a "k" value (ft or m for k values).

Gradation of the sediment is required for Copeland method and can be
entered by clicking on the Gradation command button. Values for d'4, dso,
and d 16 must be entered.

The user has the ability to designate the default regime for the computations.
The HEC-RAS default is lower regime, but this can be changed by clicking
on the "Default Regime ... " button and selecting "Upper Regime". Any time
the computations result in a solution that is in the transitional regime, the
default regime will be used and the user will be notified in the output table
that this occurred. See chapter 12 of the Hydraulic Design Manual for more
information.

Once all required data for the design section has been entered, click on the
"Inflow Sediment ... " command button to input information about the
upstream section for sediment concentration computations. The window
shown in figure 15.7 becomes active. The user can either enter in a value for
the inflowing sediment concentration or let HEC-RAS calculate it. If HEC­
RAS is to calculate the inflow sediment concentration, then the following
information about the upstream section must be entered:

Supply Reach Bottom Width: Width of the bed of the supply reach (ft or
rn).

Supply Reach Bank Height: A representative value of the bank elevation
minus the channel invert elevation of the supply section. This is only used in
the computations to target a depth and does not limit the solution to this
height (ft or m).

Supply Energy Slope: A representative energy slope at the supply section.
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Water surface slope is typically used.

Side Slope: Slope of the left and right side slopes of the supply section.
(1 Vertical: Horizontal).

Equation: Can choose from Mannings or Strickler to solve for the side slope
roughness of the supply section.

nor k: If Mannings is selected, enter a Mannings "n" value. If Strickler is
selected, enter a "k" value for the supply section (ft or m for k values).

Iii. tnnow Sediment

rEnter InllowSedlmenl Concenbotlon (ppm) I
r. let HEC--RAS cole%le the InHow Sediment

Concentration

Suppty Keach Bottom Width

Supply Keech Benk Height

Supply Energy Slope

8Mklnput

SIde Slope

Equation

nod,

Ok elmcel

Figure 15.7 Inflow Sediment Concentration Window

Click OK to apply the input and return to the main HD Functions window.
Once all of the required input has been eotered, the Compute button will be
activated. Click the Compute button to run the computations. When the
computations are complete, the output table will be shown. The output table
lists all of the channel widths solved for along with the corresponding depth,
slope, composite n value, hydraulic radius, velocity, Froude number, shear
stress and bed transport regime. An example is shown in figure 15.8. There
will be twenty different stable channel geometries plus one for the minimum
stream power. The user can select one of these geometries for display on the
plot window. Once the desired section is selected, click OK and the HD
Functions window will become active with the selected seclion plotted in the
plot window.

When the computations have been run, the Table button, the two Stability
Curve buttons and the Copy to Geometry button become active. The Table
button simply allows the user to pull up the output table again, and select a
different stable section, if desired. Clicking on the Stability Curve I button
will bring up a plot of Ihe stability curve showing slope versus width.
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indicating for what slope/width combination aggradation or degradation
can be expected. Figure 15.9 shows an example.
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Figure 15.8 Copeland Method Output Table
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Stability Curve 2 brings up a similar plot, only with slope compared to depth.
In addition to viewing the plots, the table tab can be clicked to view the
stability curves in tabular form.

As with the uniform flow computations, the section that has been plotted from
the Copeland Method can be applied to the current geometry file by clicking
on the Copy to Geometry button.

Regime Method

To use the Regime Method, select the tab named "Regime." The window
shown in figure 15.10 becomes active.
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Figure 15.10 Regime Method

Enter in all required input which are:

Discharge: Channel forming discharge (cfs or ml/s).

d50: Median particle size (mm).

Sediment Cone, C ppm: The bed material sediment concentration, in ppm.

Temperature: A representative temperature of the water. Default is 55
degrees F or 10 degrees C.
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Side Factor, Fs: The side factor as defined by Blench. Blench suggests 0.1
for friable banks, 0.2 for silty, clayey. or loamy banks. or 0.3 for tough clay
banks. Default value is 0.2.

Once these values are entered, the compute button becomes activated and the
stable channel regime values for depth, width, and slope will be solved for
and entered into the appropriate fields. In addition, the plot window will
display the resulting cross section.

The displayed cross section can be added to the existing geometry file by
clicking on "Copy XS to Geometric Data."

Tractive Force Method

To use the Tractive Force Method, select the tab named "Tractive Force."
The window shown in figure 15.11 becomes active.
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Figure 15.11 Tractive Force Method

Enter in all required input which are:

Discharge: Design discharge (cfs or m]/s).

Temperature: Temperature of the water. Default is 55 degrees F or 10
degrees C.
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Specific Gravity: Specific gravity of the sediments for the left side slope,
bed, and right side slope.

Angle of Repose: The angle of repose of the sediment for the left side slope,
bed, and right side slope. See figure 12-9 in the HEC-RAS Hydraulic
Reference Manual for suggested values.

Side Slope: Left side slope and right side slope (I Vertical: Horizontal).

Equation: the roughness equation for the left side slope, bed, and right side
slope. Mannings and Strick.ler are available for use.

nor k: If Mannings is selected, enter a Mannings "n" value. If Strick.Ier is
selected, enter a "k" value for the left side slope, bed, and right side slope (ft
or m for k values).

Method: Solve for critical shear using either Lane, Shields, or by entering in
your own critical mobility parameter.

The remaining values are the dependant variables. Only two can be solved
for at a time. The other two must be entered by the user. The three fields for
particle diameter (left side slope, bed, right side slope) are considered one
variable such that anyone of the remaining variables plus any or all of the
particle diameters can be solved for.

d50/d75: The particle diameter in which 50%/75% of the sediment is
smaller, by weight. d50 is used for Shields and user-entered. d75 is used for
Lane (mm).

D: The depth of the stable cross section (ft or m).

B: The bottom width of the stable cross section (ft or m).

S: The slope of the energy grade line at the stable cross section.

Once the required values plus two of the dependent variables are entered, the
compute button becomes activated and the stable channel values for the
remaining dependent variables will be solved for and entered into the
appropriate fields. In addition, the plot window will display the resulting
cross section.

The displayed cross section can be added to the existing geometry file by
clicking on "Copy XS to Geometric Data."
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Sediment Transport Capacity

The sediment transport capacity computations can only be run once steady or
unsteady flow computations have been run. Sediment Transport Capacity for
any cross section can be computed using any of the following sediment
transport functions:

• Ackers- White

• Engelund-Hansen

• Laursen

• Meyer-Peter Mtiller

• Toffaleti

• Yang

To access the sediment transport capacity window, click on Type... Sediment
Transport Capacity in tbe Hydraulic Design Window. The following window
will become active:

1'-'
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Figure 15.12 Sediment Transport Capacity Window

To perform sediment transport capacity computations, the user must define
one or more sediment reaches. A sediment reach indicates for which cross
sections transport rates will be computed and contains information necessary
to fulfill the computations. Sediment reacbes can vary spatially within the
geometry. can have different input parameters such as temperature, specific
gravity, and gradation, or can simply use different sediment transport
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functions. A sediment reach cannot span more then one river reach, however
there can be multiple sediment reaches within one river reach. Sediment
reaches cannot have overlapping cross sections.

When the sediment transport capacity window is opened, if there are not any
previously defined sediment reaches defmed for the current hd file, the user
will be automatically prompted to name a new sediment reach. To create a
new reach otherwise, click on File ... New Sediment Reach. The user also has
the option of copying, deleting, and renaming existing sediment reaches
under the File menu option. The name selected for the new sediment reach
will appear in the Sed. Reach dropdown box along with all other existing
sediment reaches for the particular hydraulic design fi Ie.

Once a new sediment reach has been named, the user must define its spatial
constraints by selecting the river, reach, and the bounding upstream and
downstream river stations. Next, one of the existing profiles must be
selected.

Sed.Reach: Indicates which sediment reach is active. This dropdown box
lists all existing sediment reaches for the current hydraulic design file.

River: The river where the current sediment reach is located.

Reach: The reach where the current sediment reach is located.

US RS: The upstream bounding river station of the current sediment reach.

DS RS: The downstream bounding river station oflhe current sediment
reach.

Profiles: The profile to be used in the sediment transport computations for
the current sediment reach.

River Sta: The river station currently displayed on the plot.

Temperature: Temperature of the water. Default is 55 degrees For 10
degrees C.

Specific Gravity: Specific gravity oflhe moveable sediments. Default is
2.65.

Bed Sta Left/Right: The cross section stations that separate the left
overbank from the main channel from the right overbank for sediment
transport capacity computations. Defaults are the main bank stations. These
values can be changed for evety cross section within the sediment reach. The
selected stations appear on the cross section plot as yellow nodes, and are
bracketed by '·MB" (mobile bed) location arrows on the top of the plot.
Cone. of Fines (opt),: The concentration of fine sediments (wash load) in the
current sediment reach. This is an optional value and is used to adjust the
transport rate based all Colby's (Colby, 1964) tindings regarding the effects
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of fine sediment and temperature on kinematic viscosity, and consequently
particle fall velocity. Values are given in parts sediment per one million parts
water, by weight.

Functions: The user can select one or more sediment transport functions
from this list box. By clicking the checkbox, a check will appear and RAS
will compute for that function. When clicking on the name of the function, a
brief description of the function and its applicability will appear in the text
box below.

Gradation: This is entered for the left overbank (LOB), main channel
(Main) and right overbank (ROB) as defined by the left and right bed stations.
The user can enter nothing or up to 50 particle size/percent finer relationships.
By right-clicking on one of the tabs, the grid can be expanded for easier
viewing. Right-click again to return the grid to its compact display.
Typically 5 to 10 gradation points are enough to represent a typical gradation
curve. The particle diameter is entered in mm under the column header
Diam, mm, and the percent of the representative sediment that is finer than
that particle diameter is entered under the column header %Finer. RAS then
takes this gradation input to determine the fraction of the sediment that is in
each standard grade size class. If a zero percent value and/or a 100% value
are not entered by the user, the program will assign zero percent to the next
lowest grade class and 100% to the next highest grade class. See the
hydraulic reference manual for more detail.

Plot Gradation: This button gives the user a graphical representation of the
sediment gradation.

The user has the option to compute sediment transport capacity rates for the
currently selected sediment reach (Compute for this Sediment Reach) or for
all existing sediment reaches (Compute for all Sediment Reaches) within
the currently opened hydraulic design file.

A text box is provided for brief descriptions of selected transport functions.
In addition to a summary of the selected function, the range of input
parameters, from both field and laboratory measurements, used in the
development of the respective function is also provided. Where available,
these ranges are taken from those found in the SAM package user's manual
(Waterways Experiment Station, 1998) and are based on the developer's
stated ranges when presented in their original papers. The ranges provided
for Engelund and Hansen are taken from the database (Guy, et ai, 1966)
primarily used in that function's development.

The following variables are used in the summaries:

• d, overall particle diameter
• dm, median particle diameter
• s, sediment specific gravity
• V, average channel velocity
• D, channel depth
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• S, energy gradient
• W, channel width
• T, water temperature

Defaults: The Defaults button will restore all input boxes for the currently
selected sediment reach to the default values.

Apply: The Apply button will be enabled any time new input has been added
which has not been stored into memory. By clicking on the Apply button, all
input for the current sediment reach will be stored to memory.

Compute: The compute button will be enabled once all required input is
entered. Pressing the compute button initiates the computations for sediment
transport capacity.

Options Menu: The Options Menu drop down list is on the top of the
Sediment Transport Capacity form and includes:

Fall Velocity: This option allows the user to select the method of fall velocity
computation. If "Default" is selected, the method used in the research and
development of the respective function is chosen. Otherwise, any functions
used in the computations will use the selected fall velocity method. The three
fall velocity methods available are: Toffaleti, Van Rijn, and Rubey.

DepthlWidlh: This allows the user to select which depth and width
parameters to use in the solution of tbe transport functions. If "Default" is
selected, the program will use the depth/width combination used in the
research of the selected functions(s). Ifany of the other depth/width
combinations is used, all selected functions will be solved using those
specific parameters.

Efr. Depth/Hr. Width: Used in HEC 6, this is the effective depth and
effective width. Effective Depth is a weighted average depth and the
effective width is calculated from the effective depth to preserve aD2

.
3

for the cross section:

Hyd. Depthrrop Width: The hydraulic depth is the area of the cross
section divided by the top width.

Hyd. Radiusrrop Width: The hydraulic radius is the Area divided by
the wetted perimeter. Is equivalent to hydraulic depth for relatively
wide, shallow streams.

Hiding FaClar(O,. Ackers-Whire: An optional "hiding factor" adjustment is
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available for the Ackers- White function only. The user can choose whether
or not to use this feature. The default is "No."

Complllefor Small Grains Outside Applicable Range: By default, RAS will
perform calculations for grain sizes which are smaller than the applicable
range of a given transport function. By selecting "No", the user can override
this and have RAS compute for only the grain sizes within the applicability
range of each sediment transport function, as defined in Table 12.7 in the
Reference Manual.

~Sediment Rating Curve Plot/Table: This button displays a plot of the
sediment transport capacity rates for a selected cross section within a
sediment reach. It is only enabled once computations for that reach have
been performed. Display options can be selected from the dropdown buttons.
Figure 15.13 shows a sediment rating curve plot. [n addition to viewing the
plots, the table tab can be clicked to view in tabular form.

sedment Rating CtJ've Plot , .. - IDL~J

FOe """ pt,~t

I RrvI.'I Sto'ion TIl FunOHlns T I[S~b Section T II Gr!llli S'I& l' I R8POIl I
AOll Tobie I DAc~.els·\'\ihile -1- ~Engel~nd·H~n,en It ~:",ach SII'~I'" C~rain-IOOOO Total All (~ralm J

'0 ~ L"UI~en legend

I~ 35
DMFM

Eng&lund·H&ns&no Tolfoleb
/' ~----

» 1::1. Y~r'9

~ ./' L<,'Jrs<>n
g " /'

,,~.,

.~• '",;
~

II " / ./'

10 .~M

~~
5 •.~-:~
0
100 om ." "" 500

Tut~1 (,ou $ee!oOn HOwlefs) 3%60:::01....1

-.J _J

I
Figure 15.13 Sediment Transport Capacity Rating Curve

[] Sediment Transport Profile Plotffable: This button displays a plot of
thc sediment transport capacity rates along a selected sediment reach. It is
only enabled once computations for that reach have been performed. Display
options can be selected from the dropdown buttons. Figure 15.14 shows the
sediment transport profile plot. In addition to viewing the plots. the table tab
can be clicked to view in tabular form.
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Figure 15.14 Sediment Transport Capacity Plot

"I

Both plot windows have a list box at the bottom with warning messages.
These warnings are meant to make the user aware of how sediment transport
rates are being computed. If the user selects the option to compute sediment
transport rates for all grade sizes within the user-specified range, a warning
stating this will be shown. If the user selects the option to compute sediment
transport rates for only those grade sizes within the respective function's
applicability range, then a warning a different warning message will appear.

The "Compute for Small Grains Outside Applicability Range"' option is
located in the menu item "Options"' on the Hydraulic Design window for
sediment transport capacity.

Report: The Report button is located in the plot window and generales a
report summarizing the input and output data. The output data is displayed as
per the selections made in the dropdown buttons. Because the amount of
output has the potential for being quite large, the report that is generated can
likewise be very large. Figure 15.15 shows an example of the sediment
transport capacity report. As with other report windows found in HEC-RAS,
the user has the ability to send this report to the clipboard, print it, or save it
as a text file.
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Figure 15.15 Sediment Transport Capacity Report
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Chapter 16 Advanced Featl/res for Unsteady Flow ROl/fing

CHAPTER 16

Advanced Features for Unsteady Flow
Routing

HEC-RAS has several advanced features that can be used when modeling
complex unsteady flow situations. These features include mixed flow regime
capabilities (subcritical, supercritical, hydraulic jumps, and draw downs); the
ability to perform a dam break analysis; levee overtopping and breaching; and
hinge pool calculations for navigation dams.

Content:

•
•
•
•
•

Mixed Flow Regime
Dam Break Analysis
Levee Breaching and Overtopping
Pump Stations
Navigation Dams
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Mixed Flow Regime

Modeling mixed flow regime (subcritical, supercritical, hydraulic jumps, and
draw downs) is quite complicated with an unsteady flow model. In general,
most unsteady flow solution algorithms become unstable when the flow
passes through critical depth. The solution of the unsteady flow equations is
accomplished by calculating derivatives (changes in depth and velocity with
respect to time and space) in order to solve the equations. When the flow
passes through critical depth, the derivatives become very large and begin to
cause oscillations in the solution. These oscillations tend to grow larger until
the program goes completely unstable.

In order to solve the stability problem for a mixed flow regime system, Dr.
Danny Fread (Fread, 1986) developed a methodology called the "Local
Partial Inertia Technique." The LPI method has been adapted to HEC-RAS
as an option for solving mixed flow regime problems when using the
unsteady flow analysis portion of HEC-RAS. This methodology applies a
reduction factor to the two inertia terms in the momentum equation as the
Froude number goes towards 1.0. The modified momentum equation is show
below:

and

a( jJQ
2 J

(J _aQ_ + -,-_A_
at ax + gA( ah + SI ) = 0ax

(16-1 )

(J = Fr - F,m (F, $ Fr ; m ~ I)

(J = 0 (F, > Fr )

16-2

where: "
FT

F,
m

h ;

Sr
Q ;

A
g =

LPI factor to multiply by inertial terms.
Froude number threshold at which factor is set to zero.
This value should range from 1.0 to 2.0 (default is 1.0)
Froude number.
Exponent of equation, which changes shape of the
curve. This exponent can range between I and 128
(default value is 10).
Water surface elevation
Friction slope
Flow rate (discharge)
Active cross sectional area
Gravitational force
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The default values for the equation are FT = 1.0 and m = 10. When the
Froude number is greater than the threshold value, the factor is set to zero.
The user can change both the Froude number threshold and the exponent. As
you increase the value of both the threshold and the exponent, you decrease
stability but increase accuracy. As you decrease the value of the threshold
and/or the exponent, you increase stability but decrease accuracy. To change
either the threshold or the exponent, select Mixed Flow Options from the
Options menu of the Unsteady Flow Analysis window. When this option is
selected, the mixed flow regime options window will appear as shown in
Figure 16.1.

As shown in Figure 16.1, the graphic displays what the magnitude of the LPI
factor will be for a give Froude number and a given exponent m. Each curve
on the graph represents an equation with a threshold of l.0 (FT) and a
different exponent (m).

E~:ponent for Froude number reduction factor m (m>O): Ino
Froude number threshold for eliminating accelation terms: r:-Il--~
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Figure 16.1 Mixed Flow Options Window

By default, the mixed flow regime option is not turned on, To turn this option
on you simple check the Mixed Flow Regime box, which is contained within
the computational settings area of the Unsteady Flow Analysis window. This
window and option is shown in the Figure below.
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E.~e Qptions Help

Plan IUNSTEADY FLOW ShortiD IUNSTEAOY Fl

Geometr)l File:

Unsleady Flow File'
Programs to Run
~ Geometry Preprocessor
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IMixed Flow Geomehy Data 3
I
----:--=~-----~
Unsleady Flow 01 ..:J
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I D
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ass 0 utpul Filename: Ic: IH ECIR as31 \MixedFlowTeslslM IXFlDW. dss ~

~ Mixed Flow Regime {see menu: "Options/Mixed Flow Options .. "J

lem

Figure 16.2 Unsteady Flow Analysis Window With Mixed Flow Regime
Option Turned On.

In general, if you are working on a river system that is completely subcritical
flow, you should 110t turn on this option. If you have a system thai is mostly
subcritical flow, with only a few areas that pass through critical depth, then
this option can be very useful for solving the stability problems. However,
there may be other options for modeling the areas that pass through critical
depth. If you have some areas that are drops in the bed, and flow passes
through critical depth over the drop, but is subcritical just downstream of the
drop. This would be a good location to model the drop as an inline weir
within HEC-RAS. By modeling the drop as an inline weir, the program is not
modeling the passing through critical depth with the momentum equation, it
is simply getting an upstream head water for a given flow from the weir
equation. If you are modeling a system that has several areas that pass
through critical depth, go supercritical, and go through hydraulic jumps, then
the mixed flow methodology will be the only way to get the model to work
for unsteady flow.
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A profile plot ofa mixed flow regime problem is shown in Figure 16.3. This
example was run with the unsteady flow simulation capability within HEC­
RAS, using the mixed flow regime option. The example shows a steep reach
flowing supercritical, which then transitions into a mild reach. A hydraulic
jump occurs on the mild reach. The mild reach then transitions back to a
steep reach, such that the flow goes from subcritical to supercritical. Because
of a high downstream boundary condition (for example backwater from a
lake), the flow then goes from supercritical to subcritical though another
hydraulic jump.

Mixed Flow Plan: UNSTEADY FLOW 2:59:20 PM

- Mixed Reach Mixed Reach

1000 1500

Main Channel Distance (It)

2000

. .

2500

•

, --~-T.egend---

! ws O~;;N2000 1700 !
: i Crit 01JAN2000 1700 I

! i Ground i
-I - - --~.~----- I

, OWS 01 JAN2000 1700
'~--------'

3000

Figure 16.3 Example Mixed Flow Regime Run With Unsteady Flow
Routing
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Dam Break Analysis

The failure of several darns in this country (Buffalo Creek, West Virginia
1972; Teton dam, Idahol976; Laural Run Dam and Sandy Run Dam,
Pennsylvania 1977; and Kelly Barnes Dam, Georgia 1977), as well as many
others, has led our nation to take a strong look at dam safety. One aspect of
dam safety is to answer the question, "What will happen if the dam were to
fai!?" The ability to evaluate the results of a dam failure has been added into
the HEC-RAS software.

HEC-RAS can be used to model both overtopping as well as piping failure
breaches for earthen dams. Additionally, the more instantaneous type of
failures of concrete dams (generally occurring from earthquakes) can also be
modeled. The resulting flood wave is routed downstream using the unsteady
flow equations. Inundation mapping of the resulting flood can be done with
the HEC-GeoRAS program (companion product to HEC-RAS) when GIS
data (terrain data) are available.

Dams are modeled within HEC-RAS by using the Inline Structure editor.
The Inline Structure editor allows the user to put in an embankment, define
overflow spillways and weirs, and gated openings (radial and sluice gates).
Gated openings can be controlled with a time series of gate openings or using
the elevation control gate operation feature in HEC-RAS. For more
information on modeling inline hydraulic structures within HEC-RAS, please
review Chapter 6 of this manual (Entering and Editing Geometric Data).

An example of using the Inline Structure feature to model a dam is shown in
Figure 16.4. As shown in the Figure, the user enters the embankment and
overflow spillway as one piece using the Weir/Embankment editor. The
embankment is shown as the gray filled in area above the ground. The
overflow spillway is the rectangular notch on the upper left hand side of the
embankment. The main outlet works consist of two rectangular gates, which
are entered through the gate editor. The gates are shown towards the bottom
of the embankment in this example.
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Figure 16.4 Inline Structure Editor With Example Dam Shown

Entering Dam Break Data

Entering dam breach information is accomplished by pressing the button
labeled Breach (Plan Data). The breach information is stored as part of the
current Plan. This was done to facilitate evaluating dam and levee breaching
in a real time river forecasting mode. By putting the breach information in
the Plan file, the geometric pre-processor does not have to be run again, thus
saving computation time during forecasting. The user can also get to the dam
breach information by selecting Dam Breach (Inline Structure) from the
Options menu of the Unsteady Flow Analysis window. Once the Breach
button is pressed, the Dam Breach window will appear as shown in Figure
16.5.
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Figure 16.5 Dam Breach Data Editor With Example Dam

The data required to perform a dam breach analysis is as follows:

Inline Structure. This field is used to select the particular inline structure
that you want to perform a breach analysis on. The user can enter breach data
and perform a breach for more than one dam within the same modeL

Delete This Breach. This button is used to clear all of the dam breach
information for the currently opened inline structure.

Delete All Breaches. This button is used to delete the dam breach
information for all of the inline structures in the modeL

Breach This Structure. This check box is used to turn the breaching option
on and off without getting rid of the breach data. This box must be checked
in order for the software to actually perform the dam breach. When this box
is not checked. no breaching will be performed on this structure.
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Center Station. This field is used to enter the cross section stationing of the
centerline of the breach. The stationing is based on the inline structure that is
shown in the graphic.

Final Bottom Width. This field is used to enter the bottom width of the
breach when it has reached its maximum size.

Final Bottom Elevation. This field is used to enter the bottom elevation of
the breach when it has reached its maximum size.

Left Side Slope. This field is used to enter the left side slope for the
trapezoid that will represent the final breach shape. If a zero is entered for
both side slopes, the breach will then be rectangular. Side slopes are entered
in values representing the horizontal to vertical ratio. for example, a value of
2 represents 2 feet horizontally for every J foot vertically.

Right Side Slope. This field is used to enter the right side slope for the
trapezoid that will represent the final breach shape. If a zero is entered for
both side slopes, the breach will then be rectangular. Side slopes are entered
in values representing the horizontal to vertical ratio. for example, a value of
2 represents 2 feet horizontally for every 1 foot vertically.

Full Formation Time (hrs). This field is used to enter the time required for
the breach to form. It represents the time from the initiation of the breach
until the breach has reached its full size. The user should be very careful in
selecting this time. If you are using a linear breach progression rate, you may
want to limit this time to when the breach really begins to significantly erode
and up to when the major portion of the breach is formed. More information
on the breach full formation time will be given later in this chapter.

Failure Mode. This selection box contains two options for the failure mode
of the breach, a Piping failure or an Overtopping failure. The overtopping
failure mode should be selected when the water surface overtops the entire
dam and erodes its way back through the embankment, or when flow going
over the emergency spillway causes erosion that also works its way back
through the embankment. The Piping failure mode should be selected when
the dam fails due to seepage through the dam, which causes erosion, which in
tum causes more flow to go through the dam, which causes even more
erosion. A piping failure will grow slowly at flrst, but tends to pick up speed
as the area of the opening begins to enlarge. At some point during the breach,
the embankment above the breach will begin to sluff, at which time a large
mass wasting of the embankment will occur.

Piping Coefficient. This field is only used if the Piping failure mode has
been selected. The user enters an orifice coefficient into this field. The
orifice equation is used to calculate the flow through the breach opening
while it is acting in a piping flow manner. Once the embankment above the
opening sluffs, and the water is open to the atmosphere, the program
transitions to a weir equation for computing the breach flow.
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Initial Piping Elev. This field is used to enter the elevation of the center of
the piping failure when it first begins to occur.

Trigger Failure At. This field is used to enter the mode in which the breach
initiation will be triggered. There are three options available within HEC­
RAS for initiating the start of the breach: a water surface elevation (WS
Elev), a specific instance in time (Set Time), and a combination of exceeding
a water surface elevation for a user specified duration (WS Elev + Duration).
With the third option (WS Elev + Duration) the user enters a threshold water
surface elevation to start monitoring the location. A duration is also entered.
If the water surface remains above the threshold value for the user entered
duration, then the breach is initiated. Additionally the user can enter a water
surface elevation labeled "Immediate Initiation WS." If the water surface
elevation gets up to or beyond this elevation, the breach is immediately
initiated.

Starting WS. This field is only used if the user has selected a trigger failure
mode of water surface elevation (WS Elev). The user enters a water surface
elevation into this field. The water surface represents the elevation at which
the breach will begin to occur, once the water behind the dam has reached
that elevation.

Start Date. This field is only used if the user has selected the Set Time
option for the failure trigger mode. The user enters the date at which the
breach will begin to occur. The time of the breach initiation is entered into
the next field. The date should be entered in a month/day/year format (ex.
OS/23/2002).

Start Time. This field is used to enter a starting time to initiate the breach.
The time is entered as a military time (ex. 1800 for 6:00 p.m.).

Breach Plot. When this tab is selected, a plot of the inline structure will
show up in the graphic window. The plot will show the proposed breach
maximum size and location in a red color.

Breach Progression. When this tab is selected a table will appear in the
graphic display window. The table is used to enter a user defined progression
curve for the formation of the breach. This is an optional feature. If no curve
is entered, the program automatically uses a linear breach progression rate.
This means that the dimensions of the breach wi II grow in a linear manner
during the time entered as the full breach formation time. Optionally, the user
can enter a curve to represent the breach fonnation as it will occur during the
breach development time. The curve is entered as Time Fraction vs. Breach
Fraction. The Time Fraction is the decimal percentage of the full breach
formation time. The breach fraction is the decimal percentage of the breach
size. Both factors are entered as numbers between zero and one. An example
of a user entered nonlinear breach progression rate is shown in Figure 16.6.
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Figure 16.6 Dam Breach Editor With Nonlinear Breach Progression

Once all of the Dam Breach data are entered, press the OK button to have the
data accepted. However, the data is not saved to the hard disk at this point,
you must save the currently opened plao in order for the breach information
to be save to the hard disk.

Estimating Dam Break Parameters

The key parameters that must be estimated in any dam breaching analysis are
the breach formation time and the maximum size of the breach opening.
Several researchers have developed regression equations to estimate breach
sizes and times from historical dam breach information. Additionally a few
researchers have tried to develop computer models to simulate the physical
breach process. The bulk of the research in this area has been summarized in
a 1998 publication entitled "Prediction of Embankment Dam Breach
Parameters", by Tony L. Wahl of the U.S. Bureau of Reclamation. This
publication documents the data from most of the historical dam breaches that
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have occurred in the world, as well as describing the equations and modeling
approaches developed for predicting the dam breach parameters.

For the HEC-RAS software, the user must estimate the maximum breach
dimensions and breach formation time outside of the program. Because the
breaching process is complex, it is suggested that the modeler try to come up
with several estimates of the breach parameters, and then put together a
matrix of potential breach sizes and times. One example would be to use two
different sets of regression equations and one of the breach simulation models
to estimate the breach parameters. In several studies perfonned at HEC we
have used both the Froelich (1995) and the MacDonald\Langridge-Monopolis
(1984) regression equations, as well as the BREACH model by Dr. Danny
Fread (Fread, 1988). All three methods give different answers for the breach
dimensions, as well as the time for the breach to fonn. One could simply run
each of these estimates as a separate trial within HEC-RAS, or a matrix could
be formed by trying all three breach times with each of the breach sizes, thus
ending up with 9 different runs. Either way, it is always good to test the
sensitivity of the breaching parameters, since they are the most unknown
factor in this process.

Each of the breach parameter estimates will yield a different outflow
hydrograph from HEC-RAS. However, once these hydrographs are routed
downstream, they will tend to converge towards each other. How close they
get to each other will depend on the distance they are routed, the steepness of
the stream, the roughness of the river and floodplain, and the amount of
floodplain storage available for attenuating the hydrograph. If the populated
areas below the dam are quite a distance away (say 20 miles or more), then
the resulting hydrographs from the various dam breaches may be very similar
in magnitude by the time they reach the area of interest. However, if the
areas of interest are closer to the dam, then the resulting breach hydrographs
could produce quite a range in results. In this situation, the selection of the
breach parameters is even more crucial.

HEC-RAS Output For Dam Break Analyses

Several plots and tables are available for evaluating the results of a dam break
analysis within HEC-RAS. Graphics include cross section, profile, and 3
dimensional plots, all of which can be animated on a time step by time step
basis in order to visualize the propagation of the flood wave. An example
cross-section plot ofa darn while it is breaching is shown in Figure 16.7.
Additionally, the corresponding water surface profile for the same instance in
time is shown in Figure 16.8. Hydrographs can be viewed at any location in
which the user requested hydrograph output. Shown in Figure 16.9 is a series
of hydrographs from the breach shown in the previous figures. These
hydrographs represent the flow leaving the dam and then subsequent
locations downstream as the flood wave moved through the river system.
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Figure 16.9 Flow Hydrographs From Dam to Downstream Locations.

Levee Overtopping and Breaching

Levee overlapping and breaching can be analyzed within HEC-RAS by
modeling the levee as a lateral structure. When modeling a levee with a
lateral structure, the area behind the levee should not be included in the cross
section data of the main river. The cross sections should stop right at the
bottom of the levee. The lateral structure (levee) can be connected to a
storage area or another river reach. How you model the area behind the levee
will depend upon what will happen to the water if the levee overtops or
breaches. If the water going over or through the levee will pond, then a
storage area would be more appropriate for modeling the area behind the
levee. If the water will continue to flow in the downstream direction, and
possibly join back into the main river, then it would be more appropriate to
model that area as a separate river reach. Shown in Figure 16.10 is an
example schematic with a levee modeled as a lateral structure connected to a
storage area to represent the area behind the levee. An example cross section
with a lateral structure (levee) on the right hand side is shown in Figure
16.11.
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Figure 16.10 Schematic With Example Levee and Storage Area

The user defines the levee by entering a series of station and elevation points
that represent the top of levee profile. This station and elevation data is then
used as a weir profile for calculating the amount of water going over top of
the levee. An example levee entered as a lateral structure is shown in Figure
16.12.
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Figure 16.12 Lateral Structure Editor With Levee Modeled as a Weir
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In the example shown in Figure 16.12, the levee is connected to a storage area
that will be used to represent the area bchind the levee. As the levee overtops
and/or breaches, the storage area will fill up until it reaches the same
elevation as the water in the river. After the flood passes, the water in the
storage area can pass back out any breach that may have occurred.

The levee information is entered as station and elevation data in the Lateral
Weir/Embankment editor shown on the Lateral Structure editor The station
elevation data represents the top of the levee. An example of this editor with
levee data is shown in Figure 16.13.

, .

. We> Station arid ElevationWeir Data

Distance to Upstream XS [5

Weir \Vidth (used for display): 1""'4:::0-­
Weir flow reference:!\.'/ater Surface

Weir Coefficient (Cd) 12
Weir Crest Shaoe
(i Broad Crested
r Ogee

Station
1 0
2 3E;O.
3 OJ.
4 650
5 1020.
6 1590.
7
8
9

10
11

OK

Elevation ....
220.
219
218.6
218.2
217.9
217.5

..:J
Cancel I

Enter distance between upstream cross section and the start of the weir

Figure 16.13 Lateral Weir/Embankment Editor With Example Levee
Data

As shown in Figure 16.13, the user enters the distance that the upstream end
of the levee is from the nearest upstream cross section; the width of the levee
(which is only used for drawing purposes); the head reference for weir flow
calculations; the lateral weir coefficient; and the station and elevation data
representing the top of levee.

Once the physical levee information is entered, the lIser can press the Breach
button in order to bring up the levee breach editor An example of this editor
is shown in Figure 16.14.
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Figure 16.14 Levee Breach Editor With Example Levee and Breach

As shown in Figure 16, I 4, the information required to perform a levee breach
is the same as performing a dam break, To get the details of each data field,
please review the information found under the Dam Break section of this
chapter.

After all of the data are entered and the computations are performed, the user
can begin to look at output for the lateral structure (levee), Plots such as the
profile plot, lateral structure hydrographs, and storage area hydrographs, cau
be very helpful in understanding the output for a levee overtopping and/or
breach, Shown in Figure 16,15 is an example profile plot with a levee breach,
Shown in Figure 16,16 is a stage and flow hydrograph plot for the lateral
structure, In this plot there are three stage Jines and three flow lines, The
stage lines represent; the stage in the river at the upstream end of the levee
(Stage HW US); the stage in the river at the downstream end of the levee
(Stage HW OS); and the stage in the storage area (Stage TW), The river is
always considered to be the headwater, and the storage area is the tailwater.
The flow lines on the plot represent: the flow in the river at the upstream end
of the levee (Flow HW US); the flow in the river at the downstream end of
the levee (Flow HW OS); and the flow leaving the river over the lateral weir
to the storage area (Flow Leaving),

16-18



Chanter 16 Advanced features {or Unsteady Flow Routing

...

I
legend

\IV'S l1FEB19890500
•

Ground

o

----.:I
File Qptions Help- -

~
See.ver Creek Kentwood I

-----------~---.-----
215

=
c

~
>
j! 210w

205

----~
•

~-~

1400 ·1600 1800 2000 220

M~in Channel Distance (rt)

Figure 16.15 Profile Plot With Levee Breach

16-19



Chapter 16 Advanced Features for Unsteady Flow Routing

, "

Type Qptions tielp

. ~" .

.J

= 218.79
= 11 Febl

Stage TvV

FIO\J,/ HvV US

Stage H....VUS

Flo"Pi H......·i DS
-~­

FlovlJ Leaving

Peak Stage
Time

....... ~,o

Plan: Unstead lat River: Beaver Creek Reach: Kentwood RS: ",5",4:;.'--7""-'
! ~, 40000 Legend

/.(' '~
~/1 /.-' .~~.// v-j ! - .-:::~>-

./ / /11 !/ -, '~:~''::'~___ 30000
/ /' I i .,../ '-' ~~":'~.'-:-'..........

/ / / i/ " ', • .;, , ••• ~

/ /, \ 'I '-'-
/ /' ./ ,'-f -...... '-"'. 20000 .[2

'/' ---- ~

I
! //,' .......~.

,. ,J 5:
.//~/ -10000 ~
'./ /
'/
.'

220

210

218

2'16

::0
'U 214'"m
Iii

212

River II:li1iUZ1JltiJi ::J~ I
Reach: !Kentwood 3 River Ste.: 15.4 LW 3-±J.!J
'" Piol Siage '" Piol Flow rOb, Siage r Db, Flow r Use Rei Siage

Slage Flow I Table I Ralinq Curye I

208 -10000
2400 0600 '1200 1800 2400 0600 1200 1800 2400 0800 1200 '1800 2400

I 10Feb1gg9 I 11Fi:b1999 I 12Fetdgg9 I
Time

Figure 16.16 Inline Structure Stage and Flow Hydrographs

In addition to the profile plot and the lateral structure hydrographs, it is
normally a good idea to plot the stage and flow hydrographs for the storage
area. This allows the user to easily see the amount of flow coming into and
out of the storage area, and the change in the water surface elevation. Shown
in Figure 16.17 is the stage and flow hydrograph for the storage area in this
example.
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Figure 16.17 Stage and Flow Hydrograph Plot for Storage Area

Referring to Figures 16.16 and 16.17, as the levee breaches, the flow going
into the storage area and the stage increase quickly, while the stage and flow
in the main river drop. In addition to the graphics in HEC-RAS, tabular
results are also available. Shown in Figure 16.18 is a detailed output table for
the lateral structure. The user can select a specific time line for viewing the
output.
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Figure 16,18 Detailed Tabular Output for Lateral Structure

Modeling Pump Stations

Pump stations can be connected between storage areas; a storage area and a
river; and between river reaches. The user can have up to ten different pump
groups, and each pump group can have up to twenty identical pumps. Each
pump can have its own on and offtrigger elevation. To (earn how to connect
a pump and how to enter pump data, please review the section on pumps in
Chapter 6 of the user's manual.

Pump stations can be used for many purposes, such as pumping water stored
behind a levee (interior sump) into the main river. An example schematic of
an interior ponding area behind a levee is shown in Figure 16.19. Note that
the pump is connected from the storage area to a river station at the
downstream end of the levee.
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Figure 16.19 Example Pumping Station for Interior Ponding Area

In the example shown in Figure 16.19, a lateral structure was entered to
represent the levee. This structure has a gravity draining culvert with a flap
gate. The flap gate only allows water to drain from the storage area to the
river. Additionally, a pump station is included to pump flows over the levee
during a rainfall event. The pump station was drawn by selecting the Pump
Station tool, then drawing a connection from the storage area to the cross
section at river station 5.39.

In this example there is a hydrograph attached to the upstream end of the river
reach, which represents the incoming flood wave to this reach. There is also
a lateral inflow hydrograph attached to the storage area, which represents the
local runoff collecting behind the levee. The pumps are used to pump water
from the storage area, over the levee, to the river. The top of the levee is
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around elevation 220 feet. Therefore, the pump station is constantly pumping
to a head of 220 feet. The data for the pump station is shown in Figure 16.20.

Pump Sialion Name: ::J [!][!] Rename Pump Station I

Pum EfflCJenc Cwve!l!.l
Headlll) Flowlcls) •

1 0 300
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10
11 ~

OK Cancel
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r Bias group operations to on (stead}' flow onl.Y)

Figure 16.20 Pump Station Editor With Example Data.

As shown is Figure 6.20, there is one pump group with three identical pumps
(pumps are the same size and capacity). However, each of the pumps has a
different on and off trigger elevation. The pump efficiency curve is used for
all three of the pumps.

After the computations are performed the user can view output for the pump
station by selecting the stage and flow piotter, then selecting Pump Stations
from the Type menu at the top of the window. An example stage and flow
plot for the pump station is shown in Figure 16.2). As shown in the figure,
the stage for the tailwater location (Stage TW) is a constant 220 ft. This is
due to the fact that the pump is constantly pumping over the levee at elevation
220. The stage at the headwater location (stage HW) is the water surface
elevations in the storage area. The storage area elevation starts ou( at an
elevation of 205 ft., goes up to around 206.6, and then back down to around
205.1. The flow through the pnmps was zero until an elevation of206 was
reached within the storage area. The second pump turned on when the
storage area got (0 elevation 206.2, and the third at elevation 206.5. On the
following side of the hydrograph the pumps began to turn off as the stage
went down in the storage area. Shown in Figure 16.22 are the stage and net
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inflow to the storage area. The net inflow represents all the inflows minus the
outflows at each time step.
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Figure 16.21 Stage and Flow Hydrographs for Pump Station
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Figure 16,22 Stage and Flow Hydrographs for the Storage Area

Navigation Dams

This section discusses the navigation dam option in HEC-RAS. For a
navigation dam, the program will try to maintain both a minimum and
maximum water surface in one or more locations along a navigation channel.
The program does this by controlling the gate settings on an inline structure.
The user enters a target water surface (and various other calibration data) and
the program will adjust the gate settings at user specified time intervals in
order to meet the target water surface as closely as possible, This section
describes the data requirements for a navigation dam and includes a general
discussion of how the gate operations are performed,

The first step in modeling a navigation dam is to add the physical data for the
navigation dam by selecting the Inline Structure option on the Geometry Data
editor and entering the appropriate information. The next step is to add the
inline weir as a boundary condition on the Unsteady Flow editor and then
click the Navigation Dams button. The editor, as shown in Figure 16,23,
will appear (note: the fields will be blank when first brought up).
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IHinge Point and Min Pool Operations

Flow Monitor IHinqe Control 1 Min Pool Control 1

Slea Prolile Lir.,l. Table 0 liona

Flow 1\\iSM" 1\\iSMin ·1
o 645.7 645.3 --l

5000 645.67 645.27
10000 645.59 64,,19'
15000 645.45 645.01
20000 645.23 644.77
25000 644.95 644.45
30000 644.56 643.99
35000 644.03 E:4337
40000 643.29 642.41
45000 64224 640.86
50000 640.76 640 76 ..:J

Generale \'-/S Limits
Hinge Point Maximum:

Hinge Point Minimum:

Cc'mpllte Limits.

River; IMISSISSIPPI

Reach: IREACH #11
:::1
:::1 RS

OK

17501

Cancel~

Figure 16.23. Navigation Dam Editor with Flow Monitor

Normal gate change time increment ~ This field states how often the program
will adjust the gate settings. In the example shown in Figure 16.23, the
program will only make adjustments to the gates every six hours under
normal operations.

Rapidly varying flow change increment - This field represents the minimum
length of time between gate setting adjustments. For example, during rapidly
changing conditions, the program can adjust the gates up to once an hour in
order to maintain the appropriate water surfaces.

Initial gate change time - This field is the military style time for when the
first gate change will take place. In this example, it is 10:00am. !fthe
simulation starts after 10:00am then the gates will be first adjusted at 4:00pm,
!0:00pm, or 4:00am as appropriate.

Gate minimum opening - This field is the minimum opening for the first gate
group (the first gate group as defined on the Geometry editor). The program
will keep the gates on this gate group open to at least 0.1 feet. The other gate
groups may be closed completely (see discussion of gate opening and closing
below).
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The final two fields [Gale opening and Gate closing rate] are the maximum
speed that the gates in any gate group can be opened or closed. Generally this
rate is determined by the physical speed with which the gates can be adjusted.
Sometimes. however, opening or closing the gates too quickly can cause
instability in the unsteady solver. In this case, it may be necessary to reduce
the opening or closing rate. But a shorter time step may also help.

Pool Only Control

There are several types of navigation dam operations. The simplest is pool
only control (as shown in Figure 16.23). In this case, the program tries to
maintain the water surface immediately upstream of the dam within user
specified targets. In the other operations (see below), the target water surface
is located some distance upstream of the dam and there mayor may not be
limits on the water surface right at the dam.

In order to keep the water surface at the dam within the user specified limits,
while only infrequently changing the gate settings (i.e., every six hours), the
program needs to know what the approximate inflow at the dam will be some
time into the future. This is done by monitoring the flow at an upstream cross
section. The user must enter this location. In the above example (Figure
16.23), the Flow Monitor tab has been activated and the flow monitor
location has been entered as river station 315.5. The flow monitor location
should be chosen so that the river travel time between the monitor location
and the navigation dam is on the order of (or somewhat less than) the normal
gate increment. In this example (Figure 16.23) the gate time increment is
every six hours, so a location a few hours upstream would be appropriate.

The calibration of the navigation dam control data involves some empirical
decisions and trial and error experimentation. This is true of the flow monitor
location as well as most of the remaining data below.

The flow monitor location must be a normal cross section in the model. This
means that cross sections must be extended far enough upstream of the dam
to account for this location. At some point, an option may be added for the
navigation dam to see into the upstream hydrograph so that there is no
minimum requirement of upstream cross section distance. Note also that the
monitor point can be located upstream of other hydraulic structures including
other navigation dams. As long as another upstream navigation dam does not
have a significant storage capacity, it should not affect the results of the flow
monitor. The ability of one navigation dam to "talk" to a downstream dam
may be added in the future.

After the flow monitor location has been chosen, the Pool Control tab can be
pressed bringing up the editor shown in Figure 16.24.
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Navigation Controlled Gates ~¥(.~>

Navi ation Dam at RlVer.MISSISSIPPI Reach.REACH 1117 RS 30115 IS· '.- ., ". ,':",.

Normal gate change time inClement (hrs):

Rapidly varying flow gate change increment:

Initial gate change lime [ex 0800):

16
[1-

11000

Gate minimum opening:

Gate opening rate [It/min):

Gate closing rate (fVmin]:

101

105

105

IPool Only Control Operations

Flow Monitor L:PooiCorJiioiU

\I/ater Surface Elevations Flows and Flow Factors

Open River: 14599 >Flow Open River: 1130000
Mi3>:imum High: /4597 >Flow Factor Max: /107
Maximum: 14595 >Flow Factor Target High: 1103
Target High: 1459.4

Target 1459.35

Target Low: 14592 >Flow Factor Target Low: 1097
Minimum: 14591 >Flov·! Factor Min: 1093
Minimum Low: 1459 >Flow Minimum: 13000
Close Gates: 1400 "~o.I. .•

OK I _ Cancel

Figure 16.24. Navigation Dam Editor with Pool Control

The user enters a range of water surfaces and corresponding Flow Factors. In
this example, the ideal target water surface has been entered as 459.35. The
primary target range is from 459.2 (Target Low) to 459.5 (Target High). In
general, if the water surface is between Target Low and Target High and it is
time to change the gate settings, then the program will adjust the gates to get
an average of the current !low at the dam and the monitor !low.

For instance, assume that at time 10:00 the current discharge from the
navigation dam is 10,000 cfs, 11,000 cfs of !low is observed at the monitor
location, and the water surface at the dam is 459.4 feet. Since 459.4 is in the
primary target range, the program will compute the average of the !lows,
10,500 cfs. By trial and error, the program will change the gates (and
compute the corresponding !low) until there is 10,500 cfs (plus or minus the
tolerance) of discharge at the dam. The tolerance is I% of the !low, in this
case 105 cfs. So the program will actually stop iterating whenever it first
determines a gate setting that results in a flow that is between 10395 cfs and
10605 cfs. After the gates have been changed, they won't (normally) be
adjusted for the next six hours. The !low from the dam will, of course, still
vary as the water surface at the dam fluctuates.
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As the water surface at the dam gets out of the primary target range, then the
flow (that is, the discharge from the dam) is adjusted by the Flow Factors. In
general, when the stage is between Target High and Maximum, then the flow
is multiplied by Flow Factor Target High (in this case 1.03). Between
Maximum and Maximum High, it is multiplied by at least 1.07. Between
Maximum High and water surface Open River, the flow is rapidly increased
up to at least Flow Open River (listed as 50,000). Flow Open River does not
represent a cap. If the flow at the monitor location gets high enough, the
discharge at the dam can go above Flow Open River based on the Flow
Factors. Above water surface Open River, all the gates are opened all of the
way.

The operations below the target zone work the same way. Flow Factor Target
Low and Flow Factor Minimum are applied in the same way. Between
Minimum Low and water surface Close Gates, the flow will be rapidly
decreased to Flow Minimum, but again, this is not an absolute minimum. If
the water surface remains low enough, the program will continue to close the
gates and reduce flow. The only absolute minimum is that the program will
not close the first gate group below the gate minimum opening.

The water surface targets are basically calibration knobs and no particular
water surface targets have to exactly match the operationally prescribed limits
on the pool surface. However, the best response will probably be obtained if
the Maximum and Minimum are close to the prescribed limits.

Hinge Point Only Control

The next type of navigation dam operation is hinge point control. This is
similar to pool control. The main difference is that instead of the water
surface targets being located right at the face of the dam, the water surface
targets are located some distance upstream. Figure 16.25 shows the Hinge
Point Only editor. (Hinge point control is selected by clicking on the drop
down box near the top right of the editor.)

In this example, the navigation dam is located at river station 714.35, and the
hinge point is located at 728.28. The program will adjust the gates at the dam
in order to maintain an approximate water surface of 645.55 feet (the target
water surface) at river station 728.28. The target water surfaces and Flow
Factors behave the same as for pool control. A flow monitor location is still
needed. It should be located an appropriate distance upstream of the hinge
point. For this dam, it is located a few hours upstream at river station 750.1
(see Figure 16.25).

The Steady Profile Limits Table is an optional feature (see Figure 16.25). 11
can make the navigation dam operations more robust for rapidly changing
flow. 11 addresses the situation where the water surface for a give flow at the
dam diverges signilicantly from the water surface that would be expected at
the dam for a steady state, uniform flow condition.
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A typical example is the trailing end of a high flow hydrograph. For instance,
the flows at the hinge point and monitor location may have fallen
considerably below the Open River condition, but the water surface at the
dam is still a little high (compared to the flow). When the program computes
a desired flow at the dam, e.g. 10,000 cfs, it adjusts the gates to get this flow.
Over the next six hours, however, as the water surface at the dam continues to
fall toward a lower equilibrium, the discharge can drop significantly below
10,000. This means that the navigation dam response is either sluggish in
returning to the target water surface at the hinge point and/or the gates have to
be changed more frequently. This is where the table becomes useful.

The data in this table give the water surfaces at the dam that will produce the
target water surfaces at the hinge point for steady state conditions. For this
navigation dam, it is desired to keep the water surface at the hinge point
between 645.3 and 645.7 feet. If, for instance, there is a long tenn (steady
state) flow of 10,000 cfs between the hinge point and the dam, then
maintaining a water surface at the dam of 645.19 feet will result in a water
surface of 645.3 feet at the hinge point. Similarly, a water surface of 645.59
at the dam will result in a water surface of 645.7 feet at the hinge point, for
the same 10,000 cfs flow. The table can be semi-automatically generated by
HEC-RAS. After entering the hinge points limits (inside the Generate WS
Limits box) and entering a range of flows (left-most column of the table), the
user can click on the Compute Limits button and the program will use the
steady state run model to fill in the rest of the table.
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Navigation Controlled Gates 1?'.
NaV! allon Dam al Rive, MISSISSIPPI ReacnREACH 1111 RS 71435 IS

Slead P,ofile Llimls Table 0 lona

Flow I '.lSMa' I WSMin .J
---.! 0 645.7 6453I~
~ 5000 645.67 64527

~ 10000 64559 645.19

~ 15000 645.45 645.01

-2 20000 645.23 644.77

~ 25000 64495 644.45
7 30000 644.56 64399

8 35000 64403 643.37
9 40000 64329 642.41
10 45000 642.24 640.86
11 50000 64076 64076 ..:J

Generate 'WS Limits
Hinge Point Maximum:

Hinge Point Minimum:

Compute Limits... J
OK

Figure 16.25. Navigation Dam Editor with Hinge Control

Cancel

Continuing on with the 10,000 cfs flow example, before the program starts to
iterate, it checks the current water surface at the dam against the table. Ifthe
current water surface is between the limits (in this case 645.19 and 645.59),
the program continues normally as it would if the table was nol being used
(that is, the user had left it blank). However, lets assume Ihat the water
surface at the dam is 646.0 feet. This would mean that the water surface at
the dam is above the limits. In this case the program will temporarily assume
a headwater of 645.59 feet at the dam and determine the gate settings that will
result in a discharge of 10,000 cfs for this lower, assumed, headwater. After
this has been done, the program will use this gate setting and continue on
nonnally. This will result in the flow at the dam initially being above the
10,000 cfs target. However, as tbe water surface at the dam drops, the flow
should also drop down towards the 10,000 cfs range. This will, hopefully,
produce a faster response without over shooting the target water surface at the
dam.

If the water surface is on the low side, it works the same way except the lower
limit is used. If the water surface al the dam were 645.0 then Ihe gate setting
would be based on an assumed waler surface of 645.19. The profile table is
optional. It can be ignored, by leaving it blank. However, it can produce a
better response, at least for some data sets. That being said, it should also be
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noted that the table will not perform as well when the flow at the dam is being
heavily influenced by tailwater conditions.

Navigation Controlled Gates '~;.

. Navi alion Oam at River.MISSISSIPPI Reaclr.RE/>.CH n11 RS·7t4 35 IS

No/mal gate change time increment (hrsJ:

Rapidl}) valying flow gate change increment:

Initial gate change time {ex 0800):

I~

11000

Gate minimum opening: 10.01

Gate opening rate (ft/min]: j"'0""'5:---

Gate dosing late (ft/min): 10.5

IHinge Point and Min PaolO perations

Flow Monitor } Hinqe Control I Min Pool Control I

Ste- Profile LimJls Table a tiona
Flow T WSI~a:<1 WSMin ~l

l---.l 0 6457 645.3 :=J
,-.:? 5000 645,67 645,27

,..--3 10000 64559 645.19

---.:4 15000 64545 64501

.2 20000 645.23 644.77

~ 25000 64435 644.45 '

-.l. 30000 644.56 64399

..JI 35000 64403 643.37

..JI 40000 64329 64241

IlQ 45000 642.24 640.86
11 50000 64076 64076~

Genelate \I/S Limits
Hinge Point Maximum:

Hinge Point Minimum·

Compute Limits ..

River: IMISSISSIPPI

Reach: IREACH n11
::J
::J RS

OK

17501

C.,nc.1 II
Figure 16.26. Navigation Dam Editor with Steady Protile Limits Table

Hinge Point and Minimum Pool Operations

The hinge point navigation dam operation can also be combined with limits
on the water surface at the dam. Hinge point and minimum pool operation
will try to maintain the water surface within targets at the hinge point, but
only when the water surface at the dam is above certain limits. When the
water surface at the dam drops too low, the program will adjust the gates
based on the water surface at the dam, essentially reverting to pool only
control.

The hinge point and the minimum pool operation are each treated as separate
control points. In addition to the water surfaces and Flow Factors for the
Hinge control, the pool minimum has its own full set of water surfaces and
Flow Factors as shown in Figure 16.27 (these are accessed by clicking on the
Min Pool Control button). Even though the minimum pool control is only
trying to maintain a minimum water surface at the dam, a full range of water
surFaces and Flow Factors are needed. These include the "too high" numbers
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such as Maximum High and Flow Open River. This allows the program to
smoothly transition between hinge control and pool control. It also allows the
pool control response to be fully calibrated between sluggish and overly
sensitive transitions.

For hinge and pool minimum navigation dams, the program independently
detennines a desired flow for each control point (that is, the hinge and the
pool minimum). It will then take the lower of the two flows and use that for
detennining the gate settings.

For instance, assume the flows at the monitor location and the hinge point are
40,000cfs and that the water surfaces at the hinge point and the dam are 645.6
and 644.9 respectively. Based on the hinge point conditions (water surface at
hinge point, Targets and Flow Factors for the hinge point), the program might
compute a desired flow of41,000cfs. Next the program will look at the
conditions, targets, and Flow Factors at the dam and compute a desired flow
of, perhaps, 42,000 cfs. Since the desired flow for the hinge point targets is
lower than the desired flow for the navigation dam targets, the pool minimum
is not a limiting factor. The program will adjust the gate settings to get
41,000 cfs and the navigation dam is operating under hinge control.

Navigation Controlled Gates " " .' ,

, .. Navi ahon Darn at R,ver.MISSISSiPPI ReachREACH ij 11 RS'71435 i5: .; , .,

Normal gate change time increment {hrs}:

Rapidly varying flow gate change increment:

Initial gate ch.:mge time (e:~ 0800):

Gate mInimum opening:

Gate opening rate (fl/min].

Gate closing rate (ft/min):

1001

105

105

Slea F'tofile Limit, Tabl. 0 IOrial

Flow I WSMa, I WSMin ·1
,---!: 0 645.7 645.3I~

? 5000 645.67 645.27,--:':
l---.l 10000 645.59 645.19

,~ 15000 64545 645.01

,-.2 20000 645.23 644.77
6 25000 644.95 64445

'7 30000 64456 643.99

'8 35000 644.03 643.37
'9 40000 [;4329 642.41
10 45000 642.24 640.86
11 50000 640. 76 640.76 ..cJ
Generate v.;S Limits

Hinge Poinl Maxirrll;H'l:

Hinge Point Minimllm:

COmptlte Limits ..

IHinge Point and Min Pool Operations

Flow Monitor I Hinqe Control C:MTr;:p.QQi:t;;~-~QUl

vv'atel Swface Elevations Flo'NS and FlolN Factors

Open River: 16451 >Flow Open River: 130000
Maximum High: 16449 >Flow Factor Max: 1107
MaximlJm: 164465 >Flow Factor Target High: 1103
Target High: 164455

Target 16445

Target Low: 164445 >FlovoJ Factor Target Low: 1097
Minimum: 164435 " 1093

16441
./ Flow Factor Min:

Minimum Low: >Flo';'" Minimum: 11000
Clo:se Gates: 16439

OK Cancel

Figure 16.27. Navigation Editor with Hinge Point and Minimum Pool
Operations and Control
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The next time the gates are adjusted, assume the flow at the monitor and
hinge point are still basically 40,000 cfs, but that the water surfaces have
dropped to 645.5 feet at the hinge and 644.4 feet at the dam. The new
computed flows might be 40,000 cfs at the hinge and 39,000 at the dam. In
this case the program would use the 39,000 cfs figure and the dam would be
under pool minimum control. In other words, the water surface at the dam
has dropped to the point that the program has to operate the gates to maintain
a minimum water surface at the dam regardless of what is happening at the
hinge point.

The hinge and pool minimum operation is usually under hinge control for low
and normal flows. At high flows the water surface at the dam must be
lowered in order to keep the hinge point within the target range. At even
higher flows, the water surface at the dam cannot be lowered far enough to
keep the hinge point in range, thus the dam reverts to pool minimum control.
Ideally, the pool would be kept at the specified absolute minimum (perhaps
644.1 feet in the above example) until the hinge point dropped back down
into the target range. This is not possible without continuous adjustments of
the gates, which is not practicable.

Instead, the water surface at the dam will fluctuate slightly even when it is
operating under pool minimum control Uust like it would fluctuate for pool
only control). This is reflected in the range of target water surfaces for pool
minimum control. The spacing of the target water surfaces have to be
detennined by trial and error. For instance, if the water surface Target,
Target High, and so on, are set to relatively high elevations (compared to the
desired value), then the water surface at the dam might stay significantly
above the minimum of 644.1. This is not desired when the water surface at
the hinge point is above the targeted range. Moving the dam target water
surfaces closer together (closer to 644.1) will cause the program to increase
the flows more quickly in order to drive the water surface back down.
However, this can also cause the program to overshoot the desired target
leading to frequent gate changes and/or bouncing water surfaces.

If the pool minimum is a hard minimum (a hard minimum might be, the pool
should not be allowed to drop below 644.1 feet), then this minimum should
be coded as one of the lower target water surfaces. For instance, if644.1 is
the operationally prescribed absolute minimum and the user coded the
primary water surface Target as 644.1, then the pool would fluctuate around
the value of 644. I during pool control. It would be better, in this case, to
code it to the Minimum Low, for example. On the other hand, if the
minimum is a "soft" minimum (a soft minimum might be 644.45 +/- .25 feet)
then setting Target Low or even perhaps the primary Target to 644.45 might
give better results. As already mentioned, the user should be prepared to take
a trial and elTor approach in order to get the best results.

For hinge point and minimum pool operation, the Steady Profile Limits table
can still be optionally used. This table is only used when the dam is operating
under hinge control. The water surface values in the table can be lower
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elevations than the actual limits on the pool. These values are still used, but
the pool control minimum will still apply. For instance, the values in the
table go below the 644.1 desired minimum at the pool. During rapidly
changing conditions, when the water surface for a given flow diverges from
the steady state water surface (for that flow), these lower values can still be
used and will (in some cases) give a faster response. However, if the water
surface actually drops down to around the 644 to 645 level, the flow based on
pool control will eventually be lower than that based on the Hinge/Steady
Profile table and the dam will revert to pool control (which, again, does not
use the tables).

Hinge Point and Minimum and Maximum Pool Control

The final type of navigation dam operations is combining hinge point control
with both a minimum and maximum limit on the water surface at the dam.
This editor has a third button as shown in Figure 16.28 and Figure 16.29.

The minimum and maximum pool controls are treated as separate control
points even though they are both located immediately upstream of the dam.
They each have a full set of target water surfaces and Flow Factors. The
program will compute a desired flow for each control point. So there will be
a flow based on the hinge point targets, a flow based on the minimum pool
elevation, and a flow based on the maximum pool elevation. During normal
operations, the flow will be based on the hinge point target. However, the
desired flow will not be allowed to go below the minimum pool control flow
and it will not be allowed to go above the maximum pool control flow.

Having separate control points for the minimum and maximum control allows
a smooth transition between pool control (either high or low) and hinge
control for a full range of flows. It also provides the greatest control and
sensitivity for allowing the water surface at the pool to be maintained within
the tightest tolerances.
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The optional steady profile limits table may still be used. As before, it only
applies to hinge control.

Navigation Controlled Gates >I • .'

Navi alion Dam al AlVer.MISSISSIPPI Aeach:AEACH # 17 RS 27347 IS .

Normal gate change time increment (hts):

Rapidly varying flow gate change increment:

Inilial gate change lime (e, 0800). 11000

Gate minimum operling: /0.1

Gale opening lale Itt/min). 1;;0"'.5'---

Gale closing rale (It/min). 10.5

Slea Profile LlITl1ls Table 0 IOnal

Flow I WSMa, I WSMin ·1

Generate WS Limits
Hinge Point Ma:-:imum:

Hinge Point Minimum.

Compute Limits

IHinge Pomt and Min and t-,·lax Pool Operations iJ
Flow Monilor I Hinoe Conlrol L'd"lPooi:c"tiii"U1 Ma' Pool Conhol I

Water Surface Elevations Flows and Flow FactOfs

Open River: 14461 >Flow Open River. 1150000
1446Maximum High: >Flow FactOf Max: /107

Maximum: 14459
) Flow Faclor Targel High: 1103

Talgal H9h: 14458

~ Target 1445.7

Target Low: 14456 "- 1097
14455

/ Flow Factor Target Low:
Minim~jm: >Flow Factor Min: 1093

14454Minimum Low:
) Flow Minimum: 13000

Close Gales: 14453

OK Cancel

Figure 16.28. Navigation Editor with Hinge and Maximum and
Minimum Control (Min Pool Control Shown)
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Navigation Controlled Gates :i~ _

_ 'N""i alion Dam at RlVer.MISSISSIPPI Reach.REACH #17 RS.273.47 IS -. '. .

Normal gate change time increment (his):

Rapidly varying flow gate change inclement

Initial gale change time lex 0800): 11000

Gate minimum opening: 10.1

Gate opening rate Iltiroin}: 1""0""5---

Gate closing rate (ft/min): 10.5

Stead Profile Lrmrts Table 0 'onal
Flow I WSMax I WSMin I£ I

Generate \/"/S Limits

Hinge Point Maximum:

Hinge Point Minimum:

Compute Limits ..

IHinge Point and Min and Max Pool Operations 3
Flow Monitor 1Hinoe Cantrall Min Pool Conlrol :j~O;:i'QQi:tQr.;~oCI

\I/ater Surface Elevations Flows and Flow Fact.ors

Open River: 14492 >Flow Open River: 1150000
Maximum High. 14491 >Flow Factor Max: 1107
Maximum: 1449 >Flow Factor Targel High: 1103
Target High: 14489

..:J Target 14488

Targel Low: 14487 >Flow Factor Taroel Low: 1097
Minimum: 14485 >Flow Factor Min: 1093
Minimum Low: 14485 >Flow Minimum: 13000
Close Gates: 14484

OK Cancel

Figure 16.29. Navigation Editor with Hinge and Minimum and
Maximum Control (Max Pool Control Shown)
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Appendix B

HEC-RAS Import/Export Files for
Geospatial Data

At version 2.0, HEC-RAS has introduced three-dimensional (3D)
geometry for the description of river networks and cross-sections. This
capability makes it possible to import channel geometry from CADD or
GIS programs without conversion from real-world coordinates to station­
elevation descriptions for the cross sections, as HEC-2 required.
Similarly, water-surface elevations calculated at cross sections can be
exported to CADD or GIS programs, where they can be used to create
model water surfaces for inundation mapping.

Supported HEC-RAS Data Exchange

Using a f0n11alled ASCII text file, HEC-RAS will import a basic
description of the channel geometry including:

• The structure of the stream network, as represented by
interconnected reaches.

• The location and description of cross sections.
• Manning's n values for each cross section.
• Levee alignment infonnation for each cross section.
• Ineffective flow area locations for each cross section.
• Storage area information for each cross section.

Using the same file format, HEC-RAS can write a file exporting the
results of a hydraulic model run to a CADD or GIS program. At a
minimum, reported results include the locations of cross sections and the
calculated water-surface elevations at those cross sections.

The Import/Export Data File Structure

This section gives general niles for the construction of an HEC-RAS
geometric data import or export file. It is not necessary to understand all
these rules to build an import file, but they may be useful when debugging
failed imports. The rules given here are a portion of the definition of a
general-purpose geometric data exchange format being developed at HEC
for its NexGen model programs. Note: These file formats are evolving,
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in that additional data types will be added, and some of the existing
ones may be modified for future versions. If you are writing software
to read and write these file formats, please keep in mind that you may
need to modify your software to stay compatible with future versions
ofHEe-RAS.

Records and Keywords

The HEC-RAS geometric data import file is composed of records, which
in turn are composed of keywords and values. All records must contain
one keyword, and all keywords end with a colon (:). A record can also
contain a value or a set of values following the keyword, i.e., after the
colon. Spaces, tabs, or line ends can be placed between a keyword and
values within a record.

A record that contains a keyword and no value marks the beginning or the
end ofa group of related records (for example, the record "BEGIN
HEADER:" marks the beginning of the header section ofa data file). A
record that contains a keyword and a value assigns that value to the part of
the model named by the keyword.

When a keyword is read, all spaces up to the colon are removed and all
letters are capitalized. The keywords "Begin Header:", "Begin header:",
and" Be GiNH eadEr:" are all equivalent to "BEGlNHEADER:". For
readability, keywords named in this manual will contain internal spaces.

Values

A record can assign a single value to a single variable, or multiple values
to an array. Values can be integers, floating point numbers, text strings, or
locations (X,Y,Z, label). A single value in an array of values is called an
"element" of that array.

A numerical value (integer or floating point) cannot contain internal
blanks. A floating point number can contain a decimal point; an integer
cannot. Elements in an array of numerical values can be separated by
commas, blanks, tabs, or line ends.

A text string can contain internal blanks, tabs, and commas, but cannot
contain internal line ends. Elements in an array of text strings must be
separated by line ends.

A location consists of three coordinate values and a label (X, Y, Z, label).
The first two coordinates are planar, the third gives elevation. The
coordinate values are floating point numbers, and the label can be any
type of value (although the label can be restricted to a particular data type
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in a particular context). In certain contexts, the elevation value or the label
may not be required. If a label is used, all three coordinate values must be
given; the value "NULL" is valid for the elevation coordinate only. The
coordinate values and the label can be separated by commas, blanks, or
tabs, but a location cannot contain internal line ends. Elements in an array
oflocations must be separated by line ends.

Data Groups

Records in the data file can be collected in two types of groups: objects
and file sections. An object is a group of records that combine to describe
an entity within the model, a cross-section for example. A file section is a
logical or functional grouping of data, the file header, for example, is a
section that contains a description of the whole file.

Objects and file sections begin and end with records that contain
keywords, but no values. A file section starts with a record containing a
keyword composed of the word "BEGIN" followed by the section name
and a colon, and ends with a keyword composed of the word "END"
followed by the section name and a colon. For example, records
containing only the keywords "BEGIN HEADER:" and "END HEADER:"
are used to start and end the header section of a fi Ie. An object starts with
a record containing a keyword naming the object type and ends with a
record containing the keyword "END:" only. For example, a cross-section
object begins and ends with records containing the keywords "CROSS­
SECTION:" and "END:" only.

Comments

Hash characters (#) are used to identifY comments. When a hash character
is encountered in the file, all data from the hash to the next line end are
ignored. A line that begins with a hash is equivalent to a blank line.

HEC-RAS Channel Geometry Import File

HEC-RAS reads channel geometry from a text file composed of three data
sections:
I. A header containing descriptions that apply to all data in the file.
2. A description of the stream network identifYing reach locations

and connectivity.
3. A description of the model cross-sections containing their location

on the stream network and data required to SUppOl1 the HEC-RAS
model.

An example HEC-RAS Channel Geometry Import file and HEC-RAS
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model results export file is shown at the end of this appendix.

Header

The header is bounded by the records "BEGIN HEADER:" and "END
HEADER:" and must contain a record to identify the units system used in
the imported data set. The units system can be ENGLISH or METRIC.

I BEGIN HEI\DER:

I
UNITS: ENGLISH
END HEI\DER:

Records that may be included in the header are listed in the Table B.I:

Table B.J

Keyword Value Type Value

UNITS: string ENGLISH or METRIC

PROFILES: string array List of profiles exported from HEC-RAS.
Not used on import.

DTM TYPE: string type (e.g., TIN or raster)

DTM: string name of digital terrain model

STREAM LAYER: string name of stream layer in CADD or GIS

NUMBER OF REACHES integer number of hydraulic reaches contained in
the file.

CROSS-SECTION LAYER: string name of cross-section layer in CADD or
GIS

UMBER OF CROSS- integer number of cross sections in the file
SECTIONS:

MAP PROJECTIO string projection (coordinate) system used (e.g.,
STATEPLANE)

PROJECTION ZONE: string projection zone (if applicable, e.g., 5 101)

DATUM: string reference datum for planar coordinates

VERTrCAL DATUM: string reference datum for vertical coordinates
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Stream Network

The stream network section is bounded by the records "BEGIN STREAM
NETWORK:" and "END STREAM NETWORK:" and contains records
describing reaches and reach endpoints. At a minimum, the stream
network section must contain at least two endpoints and one reach. The
minimum requirements for a stream network are shown below.

BEGIN STREAM
ENDPOINT:
ENDPOINT:

NETWORK:
476132.66,
478144.53,

65291.86, 155.28, 1
64296.61, 123.72, 2

REACH:
STREAM ID: Below Springfield
REACH ID: Blue River
FROM POINT: 1
TO POINT: 2
CENTERLINE:

476132.66, 65291.86, 155.28, 23.13
476196.08, 65196.61, 154.47, 23.09

lines omi t ted
478144.53, 64296.61, 123.72, 22.41

END:
END STREAM NETWORK:

A reach endpoint is represented by a record containing the keyword
"ENDPOINT:" followed by four comma-delimited fields containing the
endpoints X,Y,Z coordinates and an integer 10.
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A reach is represented by a multi-record object that begins with a record
containing only the keyword "REACH:" and ends with a record containing
only the keyword "END:". At a minimum, a reach object must contain
records setting values for a stream 10, a reach ID, a FROM point, and a TO
point. A reach's FROM and TO point IDs must match IDs for endpoints
listed before the reach object in the file. The reach object must also contain
an array of locations defining the stream centerline. This array begins with
a record containing only the keyword "CENTERLINE:" and ends when
any keyword is encountered. A location element in the array contains the
X, Y, and Z coordinates ofa point on the stream centerline, and the point's
river station. In HEC-RAS, elevation and stationing are optional in the
stream network definition. If a location element includes a station value, it
must occupy the fourth field in the element. If the elevation is not known,
the word "null" must take its place.

Station values are assumed to be in miles for data sets in English units, and
in kilometers for data sets in metric units. Stationing is used for indexing
locations along reaches, and is not used to precisely locate objects in the
model.

Records that may be included in a stream network section are listed in
Table 8.2:

Table B.2

Keyword Value Type Value

ENDPOfNT: location coordinates and integer ID

REACH: none marks beginning of reach object

END: none marks end of reach object

The following records are required for a reach object.

STREAM ID: string identifies reach's membership in stream

REACHID: string unique ID for reach within stream

FROMPOfNT: string integer reference to upstream endpoint

TO POfNT: string integer reference to downstream endpoint

CE TERLINE: location array elements contain coordinates and
array (optionally) floating point station value.
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Cross Sections

The cross-sectional file section begins with a record containing the only the
keyword "BEGIN CROSS-SECTIONS:" and ends with a record containing the
only the keyword "END CROSS-SECTIONS:." A cross section is represented
by multi-record object beginning with a record containing only the keyword
"CROSS-SECTION:" and ending with a record containing only the keyword
"END:. tI

A cross-sectional object must include records identifying the stream, reach,
and station value of the cross-section, a 2D cut line, and a series 000
locations on the cross section. A cut line is composed of the label "CUT
LI E:" followed by an array of20 locations. A cross-sectional polyline
consists of the label "SURFACE LI E:" plus 3D coordinates written as
conuna-delimited X,Y, Z real-number triples, one triple to a line.

Records that may be included in the cross-section file section are listed in
Table B.3:

Table 8.3

Keyword Value Type Value

CROSS-SECTION: none marks beginning of cross-section object

END: none marks end of cross-section object

The following records are required for a cross-section object.

STREAM 10: string identifiers for stream and reach where cross-

REACH 10: string section is located (must refer to existing
streams and reaches in the model)

STATION: floating point relative position of cross-section on stream

CUTUNE: location array elements contain 2D coordinates of
array cross sectione stike line

SURFACE LINE: location array elements contain 3D coordinates of
array cross section points

The following records are optional for a cross-section object.

BANK POSITIONS: floating point Fraction of length along cut line where main
(2 elements) channel bank stations are located. (values 0.0

- 10)

REACH LENGTHS: floating point Distance along left overbank, center channel,
(3 elements) and right overbank flow paths to next cross-

section downstream (units are feet or meters).

NVALUES: floating point Manning's n values expressed as fraction
(n paired along cut line to start of n-value (fraction, 11-

elements) value).
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Keyword Value Type Value

LEVEE POSITIONS: mixed array Levee positions expressed as a unique ID,
elements fraction along the cut line and levee elevation

(Levee ID, fraction, elevation)

LEVEE ID: integer Unique integer value identifying a levee

INEFFECTIVE POSITIONS: floating point Ineffective flow area information along the
(paired cut line is specified by a unique ID, beginning
element and ending fraction along the cut line, and
arrays) elevation (IneffectivejD, BeginPct, EndPct,

Elevation)

INEFFECTIVE ID: integer Unique integer value identifying ineffective
flow area.

SA 10: integer Unique integer value identifying a storage
area.

POLYGON: floating point Location of ineffective flow areas or storage
(n paired areas used for plotting.
elements)

ELEVATION-VOLUME: floating point Elevation-volume information for a storage
(n paired area (elevation, volume).
elements)

TERRAIN: floating point Elevation data describing the land surface at a
(n X,y,z storage area (x: Y,Z).
elements)

WATER ELEVATION: floating point Water surface elevation values. Used for
array export of model results. Not read on import.

HEC·RAS Model Results Export File

HEC-RAS exports model results to a text file using the same fomlat as the
data import file. The contents of the files, however, are not identical. The
stream network section is not required for data export, and the surface line
may be omitted from the cross-section objects. An example HEC-RAS
model export file is shown at the end of this discussion. Model results are
reported with the following elements (Table B.4), which are not required
(and are not read) in the import file.

B-8



Appendix B - HEC-RAS Import/Export Files for Geaspatial Data

Table BA

Keyword Value Type Value

The following record is optional in the Header section of the export file.

PROFILE NAMES: string array name(s) of water surface profiles reported in
the file. This record is required if more than
one profi Ie is reported.

The following record is required for each cross-section object.

WATER ELEVATIONS: floating point Elevation of water surface at the cross-
array section. The array must contain one value for

each profile.

The following records are optional for a cross-section object.

PROFILE ID: string Water surface profile name. This must match
a name in the Profile ames record in the
header.

VELOCITIES: floating point Fraction along cut line and value of velocity
(pair) !fraction, value). Velocities record must

follow Profile JD record.

The following records make up a section defining a bounding polygon of the water surface
limits.

BEGIN BOUNDARIES: none Marks start of boundaries file section.

END BOUNDARIES: none Marks end of boundaries file section.

PROFILE LIMITS: none Marks start of an object defining the limits of
a single water surface profile.

PROFILE ID: string Name of profile. This must march a name in
the Profile Names record in the header.

POLYGON location A series of2D locations marking the limits of
array a water surface. A single profile limit can be

merged from multiple polygons.

I. HEC-RAS allows the user 16 character profile names. However,
profile names can contain up to 9 characters for HEC-GeoRAS
ArcView Extension Version 3.0 or 11 characters for HEC­
GeoRAS for ArcInfo. They must begin with a letter.

2. If no profile name is provided, only one water elevation will be
written for each cross section.
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Water Surface Bounding Polygon

In addition to a water surface elevation at each cross section (one for each
profile), the HEC-RAS program sends a bounding polygon for each
hydraulic reach in the model (the program outputs a new set of bounding
polygons for each profile computed). The bounding polygon is used as an
additional tool in assisting the GIS (or CADD) software to figure out the
boundary of the water surface on top of the terrain.

In most cases, the bounding polygon will represent the outer limits of the
cross section data, and the actual intersection of the water surface with the
terrain will be inside of the polygon. In this case, the GIS software will use
the water surface elevations at each cross section and create a surface that
extends out to the edges of the bounding polygon. That surface is then
intersected with the terrain data, and the actual water limits are found as the
location where the water depth is zero.

However, is some cases, the bounding polygon may not represent the
extents of the cross-section data. For example, if there are levees
represented in the HEC-RAS model, which limit the flow of water, then the
bounding polygon will only extend out to the levees at each cross section.
By doing this, when the infonnation is sent to the GIS, the bounding
polygon will prevent the GIS system from allowing water to show up on
both sides of the levees.

In addition to levees, the bounding polygon is also used at hydraulic
stmctures such as bridges, culverts, weirs, and spillways. For example, if
all of the flow is going under a bridge, the bounding polygon is brought
into the edges of the bridge opening along the road embankment on the
upstream side, and then back out to the extent of the cross-section data on
the downstream side. By doing this, the GIS will be able to show the
contraction and expansion of the flow through the hydmalic stmctures,
even if the hydraulic stmctures are not geometricaly represented in the GIS.

Another application of the bounding polygon is in FEMA floodway
studies. When a floodway study is done, the first profile represents the
existing conditions of the flood plain. The second and subsequent profiles
are run by encroaching on the floodplain until some target increase in water
surface elevation is met. When the encroached profile is sent to the GIS,
the bounding polygon is set to the limits of the encroachment for each cross
section. This will allow the GIS to display the encroached water surface
(floodway) over the terrain, even though the water surface does not
intersect the ground.
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Import/Export Guidelines

The following rules apply to channel and cross-section importiexport data.

Defining The Stream Network

I. The stream network is represented by a set of interconnected
reaches. A stream is a set of one or more connected reaches that
share a ConUTlon stream !D.

2. A stream is composed of one or more reaches with the same stream
1D, and each reach in a stream must have a unique reach ID. Every
reach must be identified by a unique combination of stream and
reach IDs.

3. Stream IDs and Reach IDs are alphanumeric strings up to 16
characters long. Reach endpoint IDs are integers.

4. Streams cannot contain parallel flow paths. (If three reaches
connect at a node, only two can have the same stream ID.) This
prevents ambiguity in stationing along a stream.

5. A reach is represented by an ordered series of 3D coordinates, and
identified by a stream ID, a reach ID, and IDs for its endpoints.

6. A reach endpoint is represented by its 3D coordinates and identified
by an integer ID.

7. Reaches are not allowed to cross, but can be connected at their
endpoints Uunctions) to form a network.

8. The normal direction of flow on a reach is indicated by the order of
its endpoints. One point marks the upstream or "from" end of the
reach, the other marks the downstream or "to" end of the reach.

Defining Cross Sections

I. Each cross section is defined by a series of3D coordinates, and
identified by a stream name and reach name (which must refer to an
existing stream and reach) and a station, indicating the distance
from the cross-section to the downstream end of the stream.

2. Careful attention must be given to cross-sectional stationing.

3. A cross-section line can cross a reach line exactly once, and cannot
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cross another cross-section line.

Results of a water surface calculation are exported in a file that contains
cross-section locations in plane (20) coordinates, water-surface elevations
for the cross-sections, and boundary polygons for the reaches.

The Following Rules Apply to Water-Surface Export
Data

1. A cross-section is represented by a water surface elevation and a
series of20 coordinates on the cross-section cut line. The full
width of the cross-section is included.

2. One bounding polygon is created for each reach in the stream
network, and for each profile.

3. A reach's bounding polygon is made up of the most upstream cross­
section on the reach, the endpoints of all cross-sections on the
reach, and the most upstream cross-sections of reaches downstream
of the reach.

4. For purposes of defining bounding polygons only, the endpoints of
a cross-section are adjusted to the edge of the water surface at the
cross-section if the cross-section is part of a f1oodway, a leveed
section of the reach, or the water extent is controlled by a hydraulic
structure. This allows calculated water surfaces that are higher than
the land surface to be reported back to the CAOD or GIS program.
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Sample HEC-RAS Geometry Import File

# RAS input file created on Thu Nov 18 13:12:37 1999
# by ArcView extension HEC-GeoRAS

BEGIN HEADER:

DTM TYPE: TIN
DTM: d:\georas\wailupe\wai tin
STREAM LAYER: d:\georas\waIlupe\stream3d.shp
NUMBER OF REACHES: 3
CROSS-SECTION LAYER: d:\georas\wailupe\xscutlines3d.shp
NUMBER OF CROSS-SECTIONS: 40
MAP PROJECTION: STATEPLANE
PROJECTION ZONE: 5103
DATUM: NAD27
UNITS: ENGLISH

END HEADER:

BEGIN STREAM NETWORK:

ENDPOINT: 582090.487, 49258.898, 218.609, 1
ENDPOINT: 582331.707, 47063.536, 114.164, 2
ENDPOINT: 583735.405, 47715.344, 278.222, 3
ENDPOINT: 584138.295, 41249.225, 1.140, 4

REACH:
STREAM ID: Wailupe
REACH ID: Upper
FROM POINT: 1
TO POINT: 2
CENTERLINE:

582090.487, 49258.898, 218.609, 8640.151
many lines omitted

582331.707,47063.536,114.164,6402.057
END:

REACH:
STREAM ID: Kulai Gorge
REACH ID: Tributary
FROM POINT: 3
TO POINT: 2
CENTERLINE:

583735.405, 47715.344, 278.222, 1813.116
many lines omitted

582331.707,47063.536,114.164, -0.000
END:

REACH:
STREAM ID: Wailupe
REACH ID: Lower
FROM POINT: 2
TO POINT: 4
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CENTERLINE:
582331.707, 47063.536, 114.164, 6402.057

many lines omitted
584138.295, 41249.225, 1.140, 0.000

END:

END STREAM NETWORK:

BEGIN CROSS-SECTIONS:

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Lov'er
STATION: 220.827
BANK POSITIONS: 0.503, 0.515
REACH LENGTHS: 87.418, 220.827, 159.365
NVALUES:

0.000, 0.150
0.501, 0.035
0.532, 0.150

LEVEE POSITIONS:
1, 0.312, 6.234

INEFFECTIVE POSITIONS:
1, 0.000, 0.478, 5.789

CUT LINE:
586214.122, 42127.918
581980.991, 40806.059

SURFACE LINE:
586214.122, 42127.918, 4.007

many lines omitted
581980.991, 40806.059, 6.390

END:

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Lower
STATION: 346.249
BANK POSITIONS: 0.506, 0.518
REACH LENGTHS: 128.209, 125.422, 199.366
NVALUES:

0.000, 0.066
0.021, 0.150
0.503, 0.035
0.532, 0.150

LEVEE POSITIONS:
1, 0.345, 7.123

INEFFECTIVE POSITIONS:
1, 0.000, 0.412,5.987

CUT LINE:
586190.939, 42248.509
583923.687, 41543.517
581883.624, 41116.812

SURFACE LINE:
586190.939, 42248.509, 13.293
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many lines omitted
581883.624, 41116.812, 7.145

ENO:

many cross sections omitted

CROSS-SECTION:
STREAM 10: Wai1upe
REACH 10: Lower
STATION: 6269.258
BANK POSITIONS: 0.524, 0.569
REACH LENGTHS: 170.100, 164.521, 158.965
NVALUES:

0.00, 0.066
0.19, 0.150
0.47, 0.035
0.56, 0.150
0.94, 0.066

CUT LINE:
582723.174, 46846.449
582426.438, 46878.916
581953.514, 47082.992

SURFACE LINE:
582723.174,46846.449,161.917

many lines omitted
581953.514, 47082.992, 165.010

ENO:

CROSS-SECTION:
STREAM 10: Wai1upe
REACH 10: Upper
STATION: 6822.378
BANK POSITIONS: 0.492, 0.555
REACH LENGTHS: 142.689, 139.905, 126.201
NVALUES:

0.00, 0.066
0.27, 0.150

CUT LINE:
582774.257, 47502.740
582593.433, 47493.464
582343.062, 47465.635
582083.418, 47502.740

SURFACE LINE:
582774.257, 47502.740, 170.548

many lines omitted
582083.418, 47502.740, 164.059

ENO:

many cross sections omitted

CROSS-SECTION:
STREAM 10: Wai1upe
REACH 10: Upper
STATION: 6682.474
BANK POSITIONS: 0.380, 0.472
RZACH LENGTHS: 454.362, 413.216, 375.704
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NVALUES:
0.00, 0.150

CUT LINE:
582641.922, 47366.533
582444.447, 47335.449
582336.567, 47337.277
582062.296, 47381.161

SURFACE LINE:
582641. 922, 47366.533, 149.810

many lines omitted
582062.296, 47381.161, 160.799

END:

CROSS-SECTION:
STREAM IO: Ku1ai Gorge
REACH IO: Tributary
STATION: 1089.584
BANK POSITIONS: 0.373, 0.579
REACH LENGTHS: 263.179, 255.877, 223.864
NVALUES:

0.00, 0.150
0.48, 0.055
0.59, 0.150
0.70, 0.066

CUT LINE:
583337.968, 47187.952
583207.930, 47327.062
583153.496, 47381.496
583126.279, 47608.306

SURFACE LINE:
583337.968, 47187.952, 257.736

many lines omitted
583126.279, 47608.306, 326.921

END:

CROSS-SECTION:
STREAM IO: Ku1ai Gorge
REACH ID: Tributary
STATION: 273.138
BANK POSITIONS: 0.541, 0.655
REACH LENGTHS: 139.815, 273.138, 79.293
NVALUES:

0.00, 0.150
0.37, 0.055
0.62, 0.035
0.64, 0.150

CUT LINE:
582546.842, 47088.605
582555.984, 47189.171
582550.499, 47240.368
582552.327, 47295.223

SURFACE LINE:
582546.842, 47088.605, 145.787

many lines omitted
582552.327, 47295.223, 144.778

END:
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END CROSS-SECTIONS:

BEGIN LEVEES:

LEVEE ID: 1
SURFACE LINE:

584579.800,41808.166,7.222
many lines omitted

584631.334, 41572.921, 5.922
END:

END LEVEES:

BEGIN INEFFECTIVE AREAS:

INEFFECTIVE ID: 1
POLYGON:

584422.114, 41883.166
584452.132, 41787.626

many lines omitted
584552.852, 41577.321

END:

END INEFFECTIVE AREAS:

BEGIN STORAGE AREAS:

SA ID: 1
POLYGON:

581919.014, 43565.358
many lines omitted

581895.224, 43443.864
END:

ELEVATION-VOLUME:
20.000, 0
22.000, 675000

many lines omitted
30.000, 421300

END:

TERRAIN:
581898.124, 43566.478, 33.442
582361.222, 43216.332, 20.369

many lines omitted
581867.484, 43432.612, 33.356

END:

END STORAGE AREAS:
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Sample HEC·RAS Geographic Data Export File

BEGIN HEADER:
UNITS: ENGLISH
DTM TYPE: TIN
DTM: d:\georas\wai1upe\wai_tin
STREAM LAYER: d:\georas\wai1upe\stream3d.shp
CROSS-SECTION LAYER: d:\georas\wai1upe\xscut1ines3d.shp
MAP PROJECTION: STATE PLANE
PROJECTION ZONE: 5103
DATUM: NAD27
VERTICAL DATUM:
NUMBER OF PROFILES: 3
PROFILE NAMES:

Big
Bigger
Biggest

NUMBER OF REACHES: 3
NUMBER OF CROSS-SECTIONS: 103

END HEADER:

BEGIN STREAM NETWORK:

ENDPOINT: 582090.487, 49258.898, 218.609, 1
ENDPOINT: 582331.707, 47063.536, 114.164, 2
ENDPOINT: 583735.405, 47715.344, 278.222, 3
ENDPOINT: 584138.295, 41249.225, 1.140, 4

REACH:
STREAM ID: Wai1upe
REACH ID: Upper
FROM POINT: 1
TO POINT: 2
CENTERLINE:

582090.487, 49258.898, 218.609, 8640.151
many lines omitted

582331.707, 47063.536, 114.164, 6402.057
END:

REACH:
STREAM 10: Ku1ai Gorge
REACH ID: Tributary
FROM POINT: 3
TO POINT: 2
CENTERLINE:

S83735.405, 47715.344, 278.222, 1813.116
many lines omitted

582331.707, 47063.536, 114.164, -0.000
END:

REACH:
STREAM 10: Wai1upe
REACH 10: Lower
FRO~j POI NT: 2
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TO POINT: 4
CENTERLINE:

582331. 707, 47063.536, 114.164, 6402.057
many lines omitted

584138.295, 41249.225, 1.140, 0.000
END:

END STREAM NETWORK:

BEGIN CROSS-SECTIONS:

48663.49
48662.70
48659.49

582212.81,
582209.73,
582197.27,

3.61
6.82
13.32
13.44
12.59
6.09
3.64

CROSS-SECTION:
STREAM ID: Wai1upe
REACH ID: Upper
STATION: 8032.371
CUT LINE:

582496.067, 48736.476
582190.057, 48657.628
581893.321, 48625.161

BANK POSITIONS: 0.42600, 0.47700
WATER ELEVATION: 199.3957, 200.6774, 203.5746
WATER SURFACE EXTENTS:

582242.56, 48671.16,
582246.10, 48672.07,
582262.79, 48676.37,

PROFILE ID: Big
VELOCITIES:

0.43251, 5.29
0.44147, 11.31
0.45140, 11.48
0.46148, 10.50
0.46968, 4.35

PROFILE ID:Bigger
VELOCITIES:

0.42484, 1.25
0.43231, 5.93
0.44145, 12.24
0.45141, 12.40
0.46151, 11.44
0.47008, 4.88
0.47839, 1.21

PROFILE ID:Biggest
VELOCITIES:

0.41496,
0.43201,
0.44142,
0.45143,
0.46155,
0.47070,
0.48537,

END:
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many cross sections omitted

47336.59
47336.62
47336.69

582377.28,
582375.14,
582370.92,

2.52
5.05
10.10
10.52
7.84
3.38

CROSS-SECTION:
STREAM 10: Wailupe
REACH 10: Upper
STATION: 6682.474
CUT LINE:

582641. 922, 47366.533
582444.447, 47335.449
582336.567, 47337.277
582062.296, 47381.161

BANK POSITIONS:0.38000, 0.47199
WATER ELEVATION: 133.7104, 135.6018, 139.3349
WATER SURFACE EXTENTS:

582417.69, 47335.90,
582419.39, 47335.87,
582437.89, 47335.56,

PROFILE IO:Big
VELOCITIES:

0.39480,4.79
0.40794, 10.33
0.42583, 11.09
0.44240, 7.20
0.45444, 1.62

PROFILE IO:Bigger
VELOCITIES:

0.39368, 4.71
0.40788, 10.07
0.42586, 10.67
0.44287, 7.40
0.45565, 2.49

PROFILE IO:Biggest
VELOCITIES:

0.36681,
0.39108,
0.40781,
0.42589,
0.44336,
0.45805,

ENO:

CROSS-SECTION:
STREAM 10: Ku1ai Gorge
REACH 10: Tributary
STATION: 1089.584
CUT LINE:

583337.968, 47187.952
583207.93, 47327.062
583153.496, 47381.496
583126.279,47608.306

BANK POSITIONS: 0.37300, 0.57900
WATER ELEVATION: 219.1924, 220.2025, 221.5454
WATER SURFACE EXTENTS:

B·20



Appendix B - f/EC-RAS imparl/Export Files [or Geospalial Dala

583192.52, 47342.48,
583193.66,47341.33,
583195.18, 47339.81,

PROFILE 10: Big
VELOCITIES:

0.44533, 10.34
0.46033, 8.44

PROFILE 10: Bigger
VELOCITIES:

0.44432, 11.33
0.46129, 9.32

PROFILE 10: Biggest
VELOCITIES:

0.44296, 12.44
0.46257, 10.34

583177.65,
583176.64,
583175.29,

47357.34
47358.36
47359.70

END:

many cross sections omitted

47218.77
47219.30
47220.11

582552.81,
582552.76,
582552.67,

4.30
14.31
19.12
16.89

CROSS-SECTION:
STREAM 10: Kulai Gorge
REACH 10: Tributary
STATION: 273.138
CUT LINE:

582546.842, 47088.605
582555.984, 47189.171
582550.499, 47240.368
582552.327, 47295.223

BANK POSITIONS: 0.54099, 0.65500
WATER ELEVATION: 135.2666, 136.3284, 137.8818
WATER SURFACE EXTENTS:

582554.32, 47204.74,
582554.37, 47204.24,
582554.45, 47203.51,

PROFILE 10: Big
VELOCITIES:

0.56337, 1.54
0.57644, 10.95
0.59787, 15.34
0.61730, 13.10

PROFILE 10: Bigger
VELOCITIES:

0.56256, 2.97
0.57620, 12.59
0.59789, 17.18
0.61875, 14.67
0.63251, 1.86

PROFILE 10: Biggest
VELOCITIES:

0.56137,
0.57597,
0.59791,
0.61927,
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0.63330, 5.09
END:

46943.82
46943.87
46978.57

582276.02,
582275.92,
582195.49,

2.90
12.07
13.52
13.53
13.29
1. 42
1.12
0.35

CROSS-SECTION:
STREAM ID: Wai1upe
REACH ID: Lower
STATION: 6269.258
CUT LINE:

582723.174, 46846.449
582426.438, 46878.916
581953.514, 47082.992

BANK POSITIONS: 0.52401, 0.56900
WATER ELEVATION: 123.9078, 125.2825, 127.845
WATER SURFACE EXTENTS:

582309.53, 46929.36,
582309.55, 46929.35,
582326.40, 46922.09,

PROFILE ID: Big
VELOCITIES:

0.52365, 2.47
0.52857, 9.22
0.53762, 10.37
0.54643, 10.39
0.55542, 10.13
0.56408, 1.21

PROFILE ID: Bigger
VELOCITIES:

0.52363, 2.70
0.52856, 10.14
0.53761, 11.38
0.54644, 11.40
0.55543, 11.15
0.56380, 1. 27

PROFILE ID: Biggest
VELOCITIES:

0.51786,
0.52855,
0.53759,
0.54645,
0.55544,
0.56421,
0.60838,
0.66018,

END:

Many cross sections (and interpolated cross sections) omitted

CROSS-SECTION:
STREAM ID: Wai1upe
REACH ID: Lower
STATION: 220.827
CUT LINE:

586214.122, 42127.918
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41159.95
41139.70
40806.06

583114.30,
583049.46,
581980.99,

0.55
omitted

0.11

581980.991, 40806.059
BANK POSITIONS: 0.50300, 0.51500
LEVEE POSITIONS:

1, 0.345, 7.123
INEFFECTIVE POSITIONS:

1, 0.000, 0.412,5.987
WATER ELEVATION: 5.503006, 5.881266, 6.600093
WATER SURFACE EXTENTS:

586214.12, 42127.92,
586214.12, 42127.92,
586214.12, 42127.92,

PROFILE 10: Big
VELOCITIES:

0.00851, 0.55
many lines omitted

0.71676, 0.18
PROFILE 10: Bigger

VELOCITIES:
0.00855, 0.63

many lines omitted
0.72186,0.25

PROFILE 10: Biggest
VELOCITIES:

0.01783,
many lines

0.99398,
END:

END CROSS-SECTIONS:

BEGIN BOUNDS:

PROFILE LIMITS:
PROFILE 10: Big
POLYGON:

581893.32, 48625.16
many lines omitted

581908.77, 48563.31
POLYGON:

583126.27, 47608.3
many lines omitted

583090.99, 47539.75
POLYGON:

581953.51, 47082.99
many lines omitted

581934.96, 47008.78
END:

PROFILE LIMITS:
PROFILE 10: Bigger

581893.32, 48625.16
many lines omitted

581908.77, 48563.31
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POLYGON:
583126.27, 47608.3

many lines omitted
583090.99, 47539.75

POLYGON:
581953.51, 47082.99

many lines omitted
581934.96, 47008.78

END:

PROFILE LIMITS:
PROFILE 10: Biggest

581893.32, 48625.16
many lines omitted

581908.77, 48563.31
POLYGON:

583126.27, 47608.3
many lines omitted

583090.99, 47539.75
POLYGON:

581953.51, 47082.99
many lines omitted

581934.96, 47008.78
END:

END BOUNDS:

BEGIN LEVEES:

LEVEE 10: 1
SURFACE LINE:

584579.800, 41808.166, 7.222
many lines omitted

584631.334, 41572.921, 5.922
END:

END LEVEES:

BEGIN INEFFECTIVE AREAS:

INEFFECTIVE ID: 1
POLYGON:

584422.114, 41883.166
584452.132, 41787.626

many lines omitted
584552.852, 41577.321

END:

END INEFFECTIVE AREAS:

BEGIN STORAGE AREAS:

SA 10: 1
POLYGON:

581919.014, 43565.358
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many lines omitted
581895.224, 43443.864

END:

ELEVATION-VOLUME:
20.000, 0
22.000, 675000

many lines omitted
30.000,421300

END:

TERRAIN:
581898.124, 43566.478, 33.442
582361.222, 43216.332, 20.369

many lines omitted
581867.484, 43432.612, 33.356

END:

END STORAGE AREAS:
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Aopendix C - HEC-RAS Output Variables

Appendix C

HEC·RAS Output Variables

Variable Name Units

# Barrels #
Alpha
Area sq ft

Area Channel sq ft
Area Left sq ft
Area Right sq ft
Base WS ft

Beta
BR Open Area sq ft
BR Open Vel ft/s

Br Sel Mthd
Breach CL ft
Breach WO ft
Breach Bottom EI ft
Breach Top EI ft
Breach SSL ft
Breach SSR ft
C & E Loss ft
Center Station ft
Ch Sta L ft
Ch Sta R ft
ClvEG No Wr ft

CoefofQ
Conv. Chnl cfs
Conv.Left cfs
Conv. Ratio

Conv. Right cfs
Conv. Total cfs
Crit Depth ft
Crit E.G. ft

Crit Enrgy I ft
Crit Enrgy 2 ft
Crit Enrgy 3 ft
Crit Num #
Crit W.S. ft

Description

Number of barrels in a culvert.
Alpha - energy weighting coefficient.
Flow area of the entire cross section including ineffective
flow.
Flow area of the main channel including ineffective flow.
Flow area of the left overbank including ineffective flow.
Flow area of the right overbank including ineffective flow.
Water surface for first profile (used in comparison to
encroachment profiles).
Beta - momentum weighting coefficient.
Total area of the entire bridge opening.
Average velocity inside the bridge opening (Maximum ofBU
and BO).
Selected bridge hydraulic modeling method.
Center line of weir breach.
Bottom width of weir breach.
Bottom Elevation of weir breach.
Top Elevation of weir breach.
Left side slope of weir breach.
Right side slope of weir breach.
Contraction or expansion loss between two cross sections.
Stationing of the center of the main channel.
Left station of main channel.
Right station of main channel.
Energy grade elevation at the culvert when calculated without
the weir.
WSPRO bridge method coefficient of discharge.
Conveyance of main channel.
Conveyance of left overbank.
Ratio of the conveyance of the current cross section to the
conveyance of the downstream cross section.
Conveyance of right overbank.
Conveyance of total cross section.
Critical depth. Corresponds to critical water surface.
Critical energy elevation. Minimum energy on the energy
versus depth curve.
Energy associated with first critical depth.
Energy associated with second critical depth.
Energy associated with third critical depth.
Number of critical depths found.
Critical water surface elevation. Water surface corresponding
to the minimum energy on the energy versus depth curve.
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Crit W.S. I ft
Crit W.S. 2 ft
Crit W.S. 3 ft
Culv Crt Depth ft
Culv Depth Blocked ft
Culv EG In ft
Culv EG Out ft
Culv Ent Lss ft
Culv Ext Lss ft
Culv Frctn Ls ft
Cui v Ful Lngh ft
Cui v Inlet Mann n
Cui v Inv EI Dn ft
Culv Inv EI Up ft
Culv Length ft
Culv Nml Depth ft
Culv Outlet Mann n
Culv Q cfs
Culv Vel DS ft/s
Culv Vel US ft/s
Culv WS In ft
Culv WS Out ft
Cum Ch Len ft
Deck Width ft

Delta EG ft
Delta WS ft
Dist Center L ft
Dist Center R ft
E.G. DS ft
E.G. Elev ft
E.G IC ft
E.G.OC ft
E.G. Slope ft/ft
E.G. US. ft

Enc Method
Enc Sta L ft
Enc Sta R ft
Enc Val I ft
Enc Val 2 ft
Encr WD ft
Energy EG ft

Energy WS ft

Energy/Wr EG ft

Energy/Wr WS ft

C-2

Water surface elevation of first critical depth.
Water surface elevation of second critical depth.
Water surface elevation of third critical depth.
Critical depth inside the culvert.
Depth of fill in a culvert.
Energy gradeline inside the culvert at the inlet.
Energy gradeline inside the culvert at the outlet.
Culvert entrance loss (energy loss due only to entrance).
Culvert exit loss (energy loss due to exit).
Friction loss through the culvert barrel.
The length that the culvert flows full.
The composite n value at the culvert inlet.
Culvert inside invert elevation downstream.
Culvert inside invert elevation upstream.
Length of the culvert barrel.
Normal depth for this culvert (and flow).
The composite n value at the culvert outlet.
Flow through all barrels in a culvert group.
Velocity inside of culvert at inlet.
Velocity inside of culvert at outlet.
Water surface elevation inside the culvert at the inlet.
Water surface elevation inside the culvert at the outlet.
Cumulative Channel Length.
Width of bridge/culvert Deck (top of embankment), in
direction of flow.
Change in energy grade line through culvert(s) and bridge(s).
Change in water surface through culvert(s) and bridge(s).
Distance from center of channel to left encroachment.
Distance from center of channel to right encroachment.
Energy grade elevation at downsteam end of bridge or culvert.
Energy gradeline for calculated WS Elev.
Upstream energy gradeline at culvert based on inlet control.
Upstream energy gradeline at culvert based on outlet control.
Slope of the energy grade line.
Energy grade elevation at upstream end of bridge or culvert
(final answer).
Encroaclunent method used at this cross section.
Left station of encroaclunent.
Right station of encroachment.
Target for encroachment analysis.
Second target for encroachment analysis.
Top width between encroachments.
Energy grade elevation upstream of bridge for energy only
method.
Water surface elevation upstream of bridge for energy only
method.
Energy grade elevation upstream of bridge for low energy and
weir method.
Water surface elevation upstream of bridge for low flow
energy method and weir flow.



Flow Area sq ft
Flow Area Ch sq ft
Flow Area L sq ft
Flow Area R sq ft
Frctn Loss ft
Frctn Slope ft/ft
Frctn Sip Md
Froude # Chi
Froude # XS
Gate #Open #
Gate Area sq ft
Gate Group Q cfs
Gate Invert ft
Gate Open Ht ft
Gate Submerg

Headloss ft
Hydr Depth ft

Hydr Depth C ft

Hydr Depth L ft

Hydr Depth R ft

Ice Btm Chan ft
lee Btm LOB ft
lee BtmROB ft
lee Err ft
lee Thick Chan ft
Ice Thick LOB ft
lee Thick ROB ft
Ice Top Chan ft
Ice Top LOB ft
lee Top ROB ft
lee Vol Total cu ft
lee Vol. Chan cu ft
lee Vol. LOB cu ft
lee Vol. ROB cu ft

Ice WS Err ft
Ineff El Left ft
Ineff El Right ft
Inflow cfs
Invert Slope ft/ft

IW Gate Flow cfs

K Perc L ft
K Perc R ft

Appendix C - HEC-RAS Olltput Variables

Total area of cross section active flow.
Area of main channel active flow.
Area of left overbank active flow.
Area of right overbank active flow.
Friction loss between two cross sections.
Representative friction slope between two cross sections.
Friction slope averaging method used.
Froude number for the main channel.
Froude number for the entire cross section.
The number of gates opened in the current group.
The flow area in an opened gate.
Flow through all gate openings in a gate group.
Gate spillway invert elevation.
Height of gate opening.
Degree of gate submergence. The ratio of the downstream
depth above the gate to the upstream depth above the gate.
Total energy loss between two cross sections.
Hydraulic depth for cross section (Area/Topwidth of active
flow).
Hydraulic depth in channel (channel flow area/topwidth of
channel flow).
Hydraulic depth in left overbank (left overbank flow
area/topwidth of left overbank flow).
Hydraulic depth for right over bank (right overbank flow
area/topwidth of right overbank flow).
The bottom elevation of ice in the main channel.
The bottom elevation of ice in the len overbank.
The bottom elevation of iee in the right overbank.
Convergence error in ice thiekness for dynamic ice jam.
Ice thickness in the main channel.
lee thiekness in the left overbank.
Ice thickness in the right overbank.
The top elevation of ice in the main channel.
The top elevation of ice in the left overbank.
The top elevation of ice in the right overbank.
Cumulative volume of ice in an ice jam.
Cumulative volume of ice in the main channel for an ice jam.
Cumulative volume of ice in the left overbank for an ice jam.
Cumulative volume of ice in the right overbank for an ice
Jam.
Convergence error in water surface for dynamic ice jam.
The elevation of the left ineffective area.
The elevation of the right ineffective area.
Net inflow into a storage area.
The slope from the invert of this cross section to the next
cross section downstream.
Total flow through all of the gate groups of an inline
weir/spillway.
Conveyance reduction from len encroachment.
Conveyance reduction from right encroachment.
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L. Freeboard ft

L. Levee Frbrd ft
Left Sta Eff ft
Length Chnl ft
Length Left ft
Length Rght ft
Length Wtd. ft

Levee EI Left ft
Levee EI Right ft
LOB Elev ft
Mann Comp
Mann Wtd Chnl
Mann Wtd Chnl
Mann Wtd Rght
Mann Wtd Total
Max Chi Dpth ft
Min Ch El ft
Min EI ft
Min El Prs ft
Min Error ft

Min EI Weir Flow ft
Min Weir El ft
Momen. EG ft

Momen. WS ft

Net Flux cfs
Num Trials #

Obs WS ft
Outflow cfs
Perc Q Leaving
Piping Flow ft
Power Chan Ib/ft s

Power LOB Iblft s

Power ROB Ib/ft s

Power Total Iblft s

Prof Delta EG ft

C-4

The freeboard in the main channel at the left bank (left bank
elevation minus water surface elevation).
The freeboard before the left levee is over-topped.
Furthest left station where there is effective flow.
Downstream reach length of the main channel.
Downstream reach length of the left overbank.
Downstream reach length of the right overbank.
Weighted cross section reach length, based on flow
distribution, in left bank, channel, and right bank.
The elevation of the left levee.
The elevation of the right levee.
The ground elevation at the left bank of the main channel.
Composite Manning's n value for main channel.
Conveyance weighted Manning's n for the main channel.
Conveyance weighted Manning's n for the left overbank
Conveyance weighted Manning's n for the right overbank
Manning's n value for the total main cross section.
Maximum main channel depth.
Minimum main channel elevation.
Minimum overall section elevation.
Elevation at the bridge when pressure flow begins.
The minimum error, between the calculated and assumed
water surfaces when balancing the energy equation.
Elevation where weir flow begins.
Minimum elevation of a weir.
Energy grade elevation upstream of bridge for momentum
method.
Water surface elevation upstream of bridge for momentum
method.
Net inflow - outflow for a storage area.
Current number (or final number) of trials attempted before
the energy equation is balanced.
Observed water surface elevation.
Net outflow into a storage area.
Percentage of flow leaving through a lateral weir.
Flow from piping weir failure.
Total stream power in main channel (main channel shear
stress times main channel average velocity). Used in Yang's
and other sediment transport equations.
Total stream power in left overbank (left overbank shear
stress times left overbank average velocity). Used in Yang's
and other sediment transport equations.
Total stream power in right overbank (right overbank shear
stress times right overbank average velocity). Used in Yang's
and other sediment transport equations.
Total stream power (total cross section shear stress times total
cross section average velocity). Used in Yang's and
other sediment transport equations.
Difference in EG between current profile and EG for first
profile.



Prof Delta WS ft

Profile #
Prs 0 EG ft

PrsO WS ft

Prs/Wr EG ft

Prs/Wr WS ft

Pumping Head ft
Q Barrel cfs
Q Bridge cfs
Q Channel cfs
QCuiv cfs
QDS cfs
Q Lat RC cfs
Q Leaving Total cfs
Q Left cfs
Q Perc Chan ft
Q Perc L ft
Q Perc R ft
Q Pump Group cfs
Q Pump Station cfs
Q Right cfs
Q Total cfs
Q US cfs
Q Weir cfs
R. Freeboard ft

R. Levee Frbrd ft
Rght Sta Eff ft
ROB Elev ft
SA Area acres
SA Chan acres

SA Left acres

SAMin El ft
SA Right acres

SA Total acres

SA Volume acrc-ft
Shear Chan Ib/sq ft
Shear LOB lb/sq ft
Shear ROB Ib/sq ft
Shear Total Ib/sq ft

Aooendix C - HEC-RAS Output Variables

Difference in WS between current profile and WS for fust
profile.
Profile number.
Energy grade elevation upstream of bridge for pressure only
method.
Water surface elevation upstream of bridge for pressure only
method.
Energy grade elevation upstream of bridge for pressure and/or
weir method.
Water surface elevation upstream of bridge for pressure
and/or weir method.
Pumping head for the pump station.
Flow through one barrel in a culvert group.
Flow through the bridge opening.
Flow in main channel.
Total flow in all culvert groups.
Flow in cross section downstream of lateral weir.
Lateral rating curve flow.
Total flow leaving in a lateral weir including all gates.
Flow in left overbank.
Percent of flow in main overbank.
Percent of flow in left overbank.
Percent of flow in right overbank.
Pump group flow.
Total flow in all pump groups in a pump station.
Flow in right overbank.
Total flow in cross section.
Flow in cross section upstream of a lateral weir.
Flow over the weir.
The freeboard in the main channel at the right bank (right
bank elevation minus water surface elevation).
The freeboard before the right levee is over-topped.
Furthest right station that still has effective flow.
The ground elevation at the right bank of the main channel.
Surface area of a storage area.
Cumulative surface area for main channel from the bottom of
the reach.
Cumulative surface area for left overbank from the bottom of
the reach.
Minimum elevation of a storage area.
Cumulative surface area for right overbank from the bottom
of the reach.
Cumulative surface area for entire cross section from the
bottom of the reach.
Storage volume of a storage area.
Shear stress in main channel (yRCH Sf).
Shear stress in left overbank'< yRLOB Sf).
Shear stress in right overbank'< yRROB Sf).
Shear stress in total section .< yRT Sf).
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Spc Force PR cU ft

SpecifForce cu ft

Sta W.S. Lft ft
Sta W.S. Rgt ft
Std Stp Case #

Top W Act Chan ft

Top W Act Left ft

Top W Act Right ft

Top W Chnl ft

Top W Left ft

Top WRight ft

Top Wdth Act ft

Top Width ft
Total Gate Flow cfs

Trvl Tme Avg hrs

Trvl Tme Chi hrs

Vel Chnl ftls
Vel Head ft
Vel Left ftls
Vel Right ftls
Vel Total ftls
Vol Chan acre-ft

Vol Left acre-ft

Vol Right acre-ft

Volume acre-ft

W.P. Channel ft
W.P. Left ft
W.P. Right ft
W.P. Total ft
W.S. OS ft
WS. Elev ft
WS Inlet ft
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Specific force prime. For mixed flow, the specific force at
this cross section for the flow regime that does not control.
The specific force for this cross section at the computed water
surface elevation. SF = ATY"m + (Q')/(gA,,,)
Left station where water intersects the ground.
Right station where water intersects the ground.
Standard step method used to detennine WSEL (I =

successful convergence, 2 ~ minimum error, 3 = resorted to
critical depth).
Top width of the wetted channel, not including ineffective
flow.
Top width of the wetted left bank, not including ineffective
flow.
Top width of tbe wetted right bank, not including ineffe~tive

flow.
Top width of the main channel. Does not include 'islands', but
it does include ineffective flow.
Top width of the left overbank. Does not include 'islands', but
it does include ineffective flow.
Top width of the right overbank. Does not include 'islands',
but it does include ineffective flow.
Top width of the wetted cross section, not including
ineffective flow.
Top width of the wetted cross section.
Total flow through all of the gate groups of an inlinellateral
weir.
Cumulative travel time based on the average velocity of the
entire cross section, per reach.
Cumulative travel time based on the average velocity of the
main channel, per reach.
Average velocity of flow in main channel.
Velocity head.
Average velocity of flow in left overbank.
Average velocity of flow in right overbank.
Average velocity of flow in total cross section.
Cumulative volume of water in the channel (including
ineffective flow).
Cumulative volume of water in the left overbank (including
ineffective flow).
Cumulative volume of water in the right overbank (including
ineffective flow).
Cumulative volume of water in the direction of computations
(including ineffective flow).
Welled perimeter of main channel.
Wetted perimeter of left overbank.
Wetted perimeter of right overbank.
Welled perimeter of total cross section.
Water surface downstream of a bridge, culvert, or weir.
Calculated water surface from energy equation.
WS at the inlet of a pump station.



WS Outlet ft
W.S. Prime ft

W.S. US. ft
Weir Avg Depth ft, Weir Max Depth ft

I
Weir Sta OS ft
Weir Sta Lft ft
Weir Sta Rgt ft
Weir Sta US ft
Weir Submerg

WrFlw Area sq ft
Wr Top Wdth ft
WS Air Entr. ft
WSPROEG ft

WSPRO WS ft

Wtd. n Chnl
Wtd. n Left
Wtd. n Right
XS Delta EG ft

XS Delta WS ft

Yarnell EG ft

Yarnell WS ft

Apoendix C ~ HEC-RAS Outout Variables

WS at the outlet of a pump station.
Water surface prime. For mixed flow, the water surface of the
flow regime that does not control.
Water surface elevation upstream of bridge or culvert.
The average depth of flow over the weir.
The maximum depth of flow over the weir.
Downstream station where weir flow ends.
Station where flow starts on the left side of weir.
Station where flow ends on the right side of weir.
Upstream station for weir flow starts.
The ratio of the downstream depth above the weir to the
upstream depth above the weir.
Area of the flow going over the weir.
Top width of water over the weir.
Water surface elevation accounting for air entrainment.
Energy grade elevation upstream of bridge for the WSPRO
method.
Water surface elevation upstream of bridge for the WSPRO
method.
Conveyance weighted Manning's n for the main channel.
Conveyance weighted Manning's n for the left overbank.
Conveyance weighted Manning's n for the right overbank.
Change in energy gradeline between CUlTent section and next
one downstream.
Change in water surface between CUlTent section and next one
downstream.
Energy grade elevation upstream of bridge for Yarnell
method.
Water surface elevation upstream of bridge for Yarnell method.
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